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About This Book

This book introduces Version 5.0 of the Trusted Key Entry (TKE) customized
solution for ICSF.

It includes information to support the following tasks for the solution:
* Planning

 Installing

* Administering

» Customizing

* Using

Who Should Read This Book

This book is for technical professionals who will be installing, implementing and
administering Version 5.0 of the IBM Trusted Key Entry product. It is intended for
anyone who manages cryptographic keys, usually a security administrator.

To understand this book you should be familiar with z/OS, OS/390, RACF, ICSF,
VTAM, and TCP/IP program products. You should also be familiar with cryptography
and cryptographic terminology.

The documentation provided with ICSF provides the background information you
need to manage cryptographic keys. For more information, see|z/OS Cryptographid
Services ICSF Overview| and |z/OS Cryptographic Services ICSF Administrator’d

Guid§|r
How to Use This Book

The major topics by chapter are:

[Chapter 1, “Overview,] gives a high-level explanation of the TKE workstation, its
relationship to ICSF, the environment it requires for operation, and also provides
details on migrating from previous versions of TKE to TKE 5.0.

[Chapter 2, “Using Smart Cards with TKE,] gives an explanation of the smart card
support for the TKE workstation.

[Chapter 3, “TKE Up and Running,”| provides preliminary setup and initialization
tasks that are necessary for operation.

[Chapter 4, “Main Window,] explains the beginning window of the TKE program and
the functions and utilities accessible from it.

[Chapter 5, “Crypto Module Notebook,] explains the uses of this notebook. The
status of the master keys and key parts are displayed. This window is where the
keys can be generated, loaded, reset and the key queue cleared. The domain
controls are set here. The zeroize domain function is accessed from here. RSA
handling is described here.

[Chapter 6, “Managing Keys: TKE and ICSF with CCF,”| explains how ICSF is used
when loading and importing keys for CCF and PCICC.
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[Chapter 7, “Managing Keys: TKE and ICSF with PCIXCC/CEX2C,”| explains how
ICSF is used when loading and importing keys for IBM @server zSeries 990, 890,
z9-109, and PCIXCC/CEX2C.

[Appendix A, “TKE Workstation Setup and Customization,’] explains how to configure
the TKE workstation for TCP/IP and initialize the TKE workstation.

[Appendix B, “TKE TCP/IP and Host Considerations,”| provides information on using
TCP/IP and on the host files needed by TKE.

[Appendix C, “Cryptographic Node Management Utility (CNM),”| provides information
on the CNM utility tasks.

[Appendix D, “Smart Card Utility Program (SCUP),”| provides information on the
SCUP tasks.

[Appendix E, “Secure Key Part Entry,”| provides information on secure entry of key
parts.

[Appendix F, “Access Control Points and Callable Services,”| provides information on
their correlation to each other.

[Appendix G, “LPAR Considerations,”| discusses logical partitions, the TKE host and
TKE targets.

[Appendix H, “Auditing,”| provides information on auditing.

[Appendix I, “Clear RSA Key Format,] provides information on the format of
RSA-entered keys.

[Appendix J, “Key Token Migration for the 4753,”| provides information on migrating
internal DES key tokens from the 4753 to ICSF.

[Appendix K, “Trusted Key Entry - Workstation Cryptographic Adapter Initialization,’|
provides information on the TKE Workstation Cryptographic Adapter Initialization.

[Appendix L, “Trusted Key Entry - Utilities,”| provides information on TKE Utilities.

[Appendix M, “System Management - Service Applications,”| provides information on
System Management Service Applications.

[Appendix N, “System Management - Configuration,] provides information on System
Management Configuration.

[Appendix O, “System Management - Maintenance,”| provides information on System
Management Maintenance.

[Appendix P, “Media Devices,”| provides information on Media Devices.

provides information on notices, programming interface information, and
trademarks.

Where to Find

More Information

The information in this book is supported by other books in the ICSF/MVS library
and other system libraries. The ICSF library is shown on [Figure 1 on page xxivj
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Using LookAt to look up message explanations

LookAt is an online facility that lets you look up explanations for most of the IBM®
messages you encounter, as well as for some system abends and codes. Using
LookAt to find information is faster than a conventional search because in most
cases LookAt goes directly to the message explanation.



You can use LookAt from these locations to find IBM message explanations for

z/0S® elements and features, z/VM®, VSE/ESA™, and Clusters for AIX® and

Linux ":

* The Internet. You can access IBM message explanations directly from the LookAt
Web site at www.ibm.com/servers/eserver/zseries/zos/bkserv/lookat/ |

* Your z/OS TSO/E host system. You can install code on your z/OS or z/OS.e
systems to access IBM message explanations using LookAt from a TSO/E
command line (for example: TSO/E prompt, ISPF, or zZ0S UNIX® System
Services).

* Your Microsoft® Windows® workstation. You can install LookAt directly from the
z/0OS Collection (SK3T-4269) or the z/OS and Software Products DVD Collection
(SK3T-4271) and use it from the resulting Windows graphical user interface
(GUI). The command prompt (also known as the DOS > command line) version
can still be used from the directory in which you install the Windows version of
LookAt.

* Your wireless handheld device. You can use the LookAt Mobile Edition from
[www.ibm.com/servers/eserver/zseries/zos/bkserv/lookat/lookatm.html| with a
handheld device that has wireless access and an Internet browser (for example:
Internet Explorer for Pocket PCs, Blazer or Eudora for Palm OS, or Opera for
Linux handheld devices).

You can obtain code to install LookAt on your host system or Microsoft Windows
workstation from:

* A CD-ROM in the z/OS Collection (SK3T-4269).
* The z/OS and Software Products DVD Collection (SK3T-4271).

» The LookAt Web site (click Download and then select the platform, release,
collection, and location that suit your needs). More information is available in the
LOOKAT.ME files available during the download process.

Using IBM Health Checker for z/OS

IBM Health Checker for z/OS is a z/OS component that installations can use to
gather information about their system environment and system parameters to help
identify potential configuration problems before they impact availability or cause
outages. Individual products, zZOS components, or ISV software can provide checks
that take advantage of the IBM Health Checker for z/OS framework. This book
refers to checks or messages associated with this component.

For additional information about checks and about IBM Health Checker for z/OS,
see [IBM Health Checker for z/OS: User’'s Guidg, Starting with z/OS V1R4, z/0OS
users can obtain the IBM Health Checker for z/OS from the z/OS Downloads page
at fwww.ibm.com/servers/eserver/zseries/zos/downloads/}

SDSF also provides functions to simplify the management of checks. See
[SDSF Operation and Customizatior| for additional information.
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Summary of Changes

Summary of Changes
for SA23-2211-01
z/OS Version 1 Release 8

This book contains information previously presented in zZOS Cryptographic Services
ICSF TKE PCIX Workstation User’'s Guide, SA23-2211-00, which supports z/OS
Version 1 Release 7.

New information
* FMID HCR7731 WD#6 Support for Danu GA2
— Access Control Points for Remote Key Loading:
- Remote Key Export - CSNDRKX
- Trusted Block Create - CSNDTBC
» Subtype 22 of SMF Record Type 82 to track the Trusted Block Create Service

* PKA Key Generate - Permit Regeneration Data or Permit Regeneration Data for
Retained Keys must be authorized in order to use regeneration data to create a
particular RSA private-public key-pair.

» Xlock Configuration Utility

* Rebuild Vital Product Data

* View Console Service History

* New TKE Crypto Adapter/CCA Code

Changed Information
* PTR Enhanced PIN Security for the following callable services:
— Clear PIN Encrypt - CSNBCPE
— Clear PIN Generate Alternate - CSNBCPA
— Encrypted PIN Generate - CSNBEPG
— Encrypted PIN Translate - CSNBPTR

- Encrypted PIN Translate enhanced further to produce return code 8,3016 -
The value of the PAD data is not valid.

— Encrypted PIN Verify - CSNBPVR
— PIN Change/Unblock - CSNBPCU

Deleted Information
¢ None.

This document contains terminology, maintenance, and editorial changes. Technical
changes or additions to the text and illustrations are indicated by a vertical line to
the left of the change.

You may notice changes in the style and structure of some content in this document
-- for example, headings that use uppercase for the first letter of initial words only,
and procedures that have a different look and format. The changes are ongoing
improvements to the consistency and retrievability of information in our documents.

Summary of Changes
for SA23-2211-00
z/OS Version 1 Release 7
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This document is a major revision of z/OS Cryptographic Services ICSF TKE
Workstation User’s Guide, SA22-7524-07, which supports z/OS Version 1 Release

6.

New information

New TKE Crypto Adapter/CCA Code

System Management tasks for maintaining and servicing the TKE workstation
Patch Process

Migrate Previous TKE Version to TKE 5.0

Mixed case support for RACF passwords

Changed Information

Framework Presentation
Invocation of TKE related tasks
Backing up TKE related data
File Chooser

No command line support
Editing TKE files

Deleted Information

None.
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Chapter 1. Overview

The ICSF Program Product provides secure, high-speed cryptographic services in
the z/OS and OS/390 environment. By using cryptographic keys on ICSF, you can
perform functions such as protecting data, verifying messages, generating and
verifying signatures, and managing personal identification numbers. Cryptographic
systems use a variety of keys that must be securely managed. ICSF uses a
hierarchical key management approach and provides a master key to protect all the
keys that are active on your system.

Trusted Key Entry (TKE) is an optional feature of ICSF that provides a basic key
management system. Your key management system allows authorized persons a
method for key identification, exchange, separation, update, backup, and
management. It is a tool for security administrators to use in setting up and
establishing the security policy and placing it into production.

Trusted Key Entry with smart card support provides an additional level of data
confidentiality and security.

Trusted Key Entry Components

The Trusted Key Entry feature is a combination of workstation hardware and
software network-connected to S/390, System z9 and z/Series hardware and
software.

Hardware

There is no support for TKE on z990, z890, z9-109, z9 EC or z9 BC servers without

a PCI X Cryptographic Coprocessor or Crypto Express2 Coprocessor
(PCIXCC/CEX2C).

PCI X Cryptographic Coprocessor or Crypto Express2
Coprocessor (PCIXCC/CEX2C)

The PCI X Cryptographic Coprocessor (PCIXCC) replaces the Cryptographic
Coprocessor Feature and the PCI Cryptographic Coprocessor. The Crypto Express2
Coprocessor (CEX2C) provides equivalent function as the PCIXCC, but is packaged
differently.

The PCIXCC and CEX2C are available on the following servers:

* IBM @server zSeries 990, IBM @server zSeries 890, IBM System z9-109, z9
EC and z9 BC with feature code 0868. Feature code 3863 for CP Assist for
Cryptographic Functions is a prerequisite.

Cryptographic Coprocessor Feature (CCF)

The Cryptographic Coprocessor Feature, is a high-speed extension of the central
processor and contains both DES and PKA cryptographic engines. It includes one
or two cryptographic coprocessor chips protected by tamper-detection circuitry and
a cryptographic battery unit.

It is available on the following servers:

1. S/390 Multiprise Server with feature code 0800 plus one of the following feature
codes (0801, 0802, 0803, 0804, 0805)

© Copyright IBM Corp. 2000, 2006 1



2.

3.

IBM S/390 Parallel Enterprise Server - Generation 5 or Generation 6: with
feature code 0800 plus one of the following feature codes (0811, 0812, 0813,
0814, 0815, 0832, 0833, 0834, 0835)

IBM @server zSeries 800 and IBM @server zSeries 900 feature code 0800
plus one of the following feature codes (0874 or 0875)

PCI Cryptographic Coprocessor (PCICC)

The IBM 4758 Model 2 PCI Cryptographic Coprocessor is a programmable PCI
card containing a 486-compatible microprocessor, custom hardware to perform DES
and public key cryptographic algorithms and a hardware random number generator.
It also has protective shields, sensors, and control circuitry to protect against a wide
variety of attacks against the system.

It is available on the following servers:

IBM S/390 G5 or G6 Enterprise Server with field upgrade and with feature codes
0864 or 0865. Feature code 0860 is needed for each PCI Cryptographic
Coprocessor.

IBM @server zSeries 800 and IBM @server zSeries 900 with feature codes
0861 and 0865.

Host System Software

TKE Hardware

For z/OS V1R3 and OS/390 Release 10, you will need to install APAR OW44816
and APAR OW46381.

For z/OS V1R3 and higher and OS/390 Release 10 without the z990
Cryptographic Support web deliverable, you will need to install APAR OW53666.

For z990 Cryptographic CP Assist support, you will need FMID HCR7708 or later.

For z990 PCI X Cryptographic Coprocessor support, you will need FMID
HCR770A or later.

For z990 and z890 Crypto Express2 Coprocessor support, you will need FMID
HCR7720 or toleration APAR OA09157 on FMID HCR770A and HCR770B.

For systems with FMID HCR770A and below, you need to install APAR
OA07393.

To use TKE 4.1 or higher to load operational keys, you must be running
HCR770B or higher.

For systems with FMID HCR770B and above using TKE 4.1 and above, you
need to install APAR OA15044 if you want to load operational keys.

TKE Workstation
IBM 4764 Cryptographic adapter

The cryptographic adapter supports a broad range of DES and public-key
cryptographic processes. It is the TKE workstation engine and has key storage
for DES and PKA keys.

Optional TKE Features
Also available with a TKE workstation are:

Feature 0887: 2 smart card readers and 20 smart cards
Feature 0888: 10 smart cards

Note: These optional features require at least TKE 4.2 code - FC 853
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TKE Software

The following software is preinstalled on the TKE workstation:
» IBM Cryptographic Coprocessor Support Program Release 3.10SC.
» Trusted Key Entry Version 5.0

Note: TKE software should not be changed without instructions from IBM service.

Introducing Trusted Key Entry

z/OS Version 1 Release 3 and higher and OS/390 Version 2 Release 10 support
the Trusted Key Entry (TKE) feature. It is an optional feature and gives users an
alternative method of securely loading DES and PKA master keys and operational
keys.

The TKE workstation allows you to create a logical, secure channel through which
master keys and operational keys can be distributed to remote locations. This
logical, secure channel ensures both the integrity and the privacy of the transfer
channel. It is well suited to the distributed computing environment that requires
remote key management of one or more systems.

For added security, you can require that multiple security officers perform critical
operations.

ICSF and the Trusted Key Entry Feature

TKE works in concert with ICSF in managing keys and requires an active TSO
session on the TKE workstation or another workstation located nearby. The ICSF
ISPF panels are used to load operational and master keys from the key part queue
(CCF systems only), load operational keys from key part registers (PCIXCC/CEX2C
only), set the master key and to initialize or reencipher the CKDS. The TSO session
is also required to disable and enable PKA services so that the PKA master keys
can be reset and changed, the PKDS initialized and reenciphered and the PKDS
activated.

Cryptographic Coprocessor Feature and PCI Cryptographic
Coprocessor Feature

The Cryptographic Coprocessor Feature (CCF) provides a crypto-storage unit and
crypto-computational unit on a single chip. It uses public keys and digital signatures
over a public channel. The dual-control function is enhanced by means of a
signature requirement array. The Cryptographic Coprocessor Feature is made
secure by means of physical packaging and tamper-detection circuitry.

The PCI Cryptographic Coprocessor Feature (PCICC) provides a secure processing
environment with hardware to perform DES, random number generation and
modular math functions for RSA and similar public-key cryptographic algorithms.
The PCI card includes sensors to protect against attacks involving probe
penetration, power sequencing, radiation and temperature manipulation.

You must have at least one Cryptographic Coprocessor Feature on your system.

You can order a PCICC at the time you order your zSeries (800 or 900) hardware.
Multiple PCICCs are allowed on your system.
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These features are not supported on the z890, z990, z9-109, z9 EC or z9 BC
hardware.

PCI X Cryptographic Coprocessor and Crypto Express2 Coprocessor

Features

Crypto Module

The PCI X Cryptographic Coprocessor (PCIXCC) and Crypto Express2
Coprocessor (CEX2C) provide a secure processing environment with hardware to
provide DES, TDES, RSA, and SHA-1 cryptographic services with the IBM
Common Cryptographic Architecture (CCA) secure key management and
finance-industry special function support. They also perform random number
generation and modular math functions for RSA and similar public-key cryptographic
algorithms. The PCIXCC/CEX2C includes sensors to protect against attacks
involving probe penetration, power sequencing, radiation and temperature
manipulation.

To use TKE on z990, z890, z9-109, z9 EC or z9 BC systems, you must have at
least one PCIXCC/CEX2C on your system. You can order a PCIXCC/CEX2C at the
time you order your zSeries hardware - z990, z890,z9-109 z9 EC or z9 BC. A
maximum of eight (8) PCIXCC/CEX2C are allowed.

The Cryptographic Coprocessor Feature, the PCI Cryptographic Coprocessor
Feature, the PCI X Cryptographic Coprocessor and the Crypto Express2
Coprocessor are the Host system hardware devices performing the cryptographic
functions, referred to as the crypto module.

During the manufacturing process, several values are generated for the crypto
module:

* Crypto-Module ID (CMID)

» For CCF, this is a unique 16-byte hexadecimal number generated for each crypto
module. For PCICC and PCIXCC/CEX2C, this is a unique 8-byte character string
generated for each crypto module. The CMID is returned in all reply messages
sent by the crypto module to the TKE workstation.

* RSA Key
This is a unique 1024-bit RSA key generated for each crypto module. The public

modulus part of this RSA key is called the crypto-module public modulus
(CMPM).

TKE Concepts and Mechanisms

The TKE program uses the following terms on its window displays:
Host Refers to the name of the currently-defined logical partition or single image.

Crypto Module
Performs the cryptographic functions and is identified by the crypto module
index.

Domain
Holds master keys and operational keys. There are sixteen domains
(00-15).

Authority
A person or TKE workstation that is able to issue signed commands to the
crypto module. All administration of crypto modules is done by authorities.
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Integrity

Authorities

Role (PCICC and PCIXCC/CEX2C only) Privileges assigned to one or more
authorities.

TKE security consists of separate mechanisms to provide integrity and secrecy. At
initialization time, security is built up in stages: first, integrity of the crypto module,

then integrity of the authorities, and finally, these integrity mechanisms are used as
part of the process to establish secrecy.

The authenticity of the commands issued by an authority at the TKE workstation to
a crypto module is established by means of digitally signing the command. The
command is signed by the TKE workstation using the secret RSA signature key of
the authority. It is verified by the crypto module using the public RSA key of the
authority previously loaded into the crypto module.

In the same way, the authenticity of the reply from the crypto module to the TKE
workstation is digitally signed. The reply is signed by the crypto module using its
own secret RSA key and verified by the TKE workstation using the public RSA key
of the crypto module.

In order to eliminate the possibility of an attacker successfully replaying a previously
signed command or reply, a sequence number is included in all signed messages.
Sequence numbers are maintained for each crypto module and for each authority
communicating with that crypto module.

An authority is a person who is able to issue signed commands to the crypto
module.

All administration of CCF, PCICC, PCIXCC and CEX2C crypto modules is done with
authorities. An authority is identified to the crypto module by the authority index. For
CCEF, there are 16 authorities for each crypto module with indices 00-15. For
PCICC, PCIXCC and CEX2C, there are up to 100 authorities for each crypto
module with indices 00-99. In a system with multiple crypto modules, there is no
requirement that an authority have the same authority index for each crypto module.
However, it is highly recommended that you do.

If your system has multiple crypto modules you will find it convenient to assign
authorities the same index on each of your crypto modules. This will give each
authority the ability to update all crypto modules on the system after loading their
signature key. If an authority has a different index on each crypto module, they will
have to change their index as they work with different crypto modules.

In addition to the ease of use from crypto module to crypto module, if you intend on
creating groups, then everything relating to the crypto modules (authority index,
signature keys, signing requirements, roles, etc) within the group needs to be the
same.

Authority Signature Key

An authority signs commands by using the secret key of its signature key pair and
the crypto module verifies the signature by using the public key of the same RSA
key pair.
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Previous to signing and verifying command signatures, the signature key pair must
be generated, the secret key associated with the authority and the public key sent
to the crypto module. All authorities have a public exponent value of 65537.

Authority Default Signature Key

During the crypto module initialization, the public key of a default signature key pair
is loaded into the crypto module. The secret key of the default signature key pair is
known to the TKE workstation and used until valid authority signature keys are
generated and made known to the crypto module. You are able to reload the public
key of a default signature key pair to the crypto module.

For CCF, the same default signature key is assigned to authorities 0-13. Authorities
14 and 15 have their own unique default signature keys.

Attention: Authorities 14 and 15 cannot be used for signing commands until their
default signature keys have been changed. Either these authority signature keys
must be changed or they should not be defined in the Signature Requirements
Array as authorized or required to sign commands.

For PCICC and PCIXCC/CEX2C, the initialization process creates the authority 00
and assigns the authority default signature key to this authority.

Crypto Module Signature Key

The replies from each crypto module are signed by a crypto module signature key.
This key is a unique RSA key for each crypto module. The public modulus part of
this RSA key is called the crypto module public modulus (CMPM) and can be
displayed. The public exponent for all crypto module RSA keys is a fixed value of
65537.

The RSA signature key is loaded into the crypto module during the manufacturing
and initialization processes. The public part of the RSA key is sent to the TKE
workstation at the very first communication between the crypto module and the
workstation.

Multi-Signature Commands

6

All commands to the crypto module are signed. Depending on the command and
the setup, the command is either executed immediately or is pending (waiting to be
co-signed by other authorities before being executed) Commands requiring more
than one signature are called multi-signature commands.

Cryptographic Coprocessor Feature

All the CCF commands are multi-signature commands. The number and identity of
required signatures for each command are defined by the installation. Ten different
multi-signature commands are implemented, but only six are currently used by TKE:

Load Authorization Public Modulus (LAP)

Load PKSC Control Block (LCB)

Zeroize Domain (ZD)

Load Environmental Control Mask (LEC)

Load Key Part (LKP)

Load and Combine PKA Master Keys (LCS/LCR)

ook wn =
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PCI Cryptographic Coprocessor Feature / PCI X Cryptographic
Coprocessor Feature / Crypto Express2 Coprocessor Feature
The PCICC/PCIXCC/CEX2C single signature commands deal with master key
management and disabling the crypto module:

Load / combine new symmetric master key parts
Clear new symmetric master key register

Load / combine new asymmetric master key parts
Clear new asymmetric master key register

Set new asymmetric master key

Disable crypto module

o o~ N~

The PCICC/PCIXCC/CEX2C multi-signature commands always require two
signatures. These commands deal with:

1. Access Control

2. Zeroize Domain

3. Enable Crypto Module
4. Domain Controls

PCI X Cryptographic Coprocessor and Crypto Express2
Coprocessor Feature only
The PCIXCC/CEX2C single signature commands for operational keys:

1. Load first key part

2. Load additional key part

3. Complete key

4. Clear operational key register

Access Control

Access control is administered quite differently for CCF and PCICC/PCIXCC/
CEX2C.

CCF

The access control for CCF is administered by defining the security requirements
for each of the multi-signature commands. The requirement consists of a mask and
a count. The mask indicates which authorities are eligible to be counted for that
requirement. The count indicates how many signatures are necessary for that
requirement. A pending command is not executed until all requirements for that
command have been met. If the count is zero, the requirement is considered
satisfied and the signature mask is ignored.

Besides the signature requirement specification, you must also specify the domains
that can be changed.

Attention: Authorities 14 and 15 cannot be used for signing commands until their
default signature keys have been changed. Either these authority signature keys
must be changed or they should not be defined in the Signature Requirements
Array as authorized or required to sign commands.

The security requirements are initially defined so that all commands can be
executed by the initially created authorities 00—13.
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Key-Exchange

PCICC/PCIXCC/CEX2C

The access control for PCICC/PCIXCC/CEX2C is based on roles. Each authority is
assigned a role. The role definition specifies which of the PCICC/PCIXCC/CEX2C
signed commands the authority can issue or co-sign and which domains the
authority may change.

Initially the INITADM role is defined and the initial authority 00 is assigned to that
role. This authority is allowed to create, change and delete authorities and roles.

Protocol

TKE provides a Diffie-Hellman key-exchange protocol that permits an authority to
set up a basic transport key between the workstation and the crypto module. One
or more key parts can then be encrypted under the transport key.

For CCF, the basic transport key protects the DES master key and operational key
transfer from the TKE workstation to the crypto module. The PKA transport key
protects the PKA master key transfer from the TKE workstation to the crypto
module.

For PCICC and PCIXCC/CEX2C, there is a single transport key used for all key
transport from the TKE workstation to the crypto module.

Domains Controls

The Domains Controls settings control basic cryptographic capabilities for a
selected domain. Your installation should consider the ramifications of various
implementations.

TKE Operational Considerations

You can run your processor in single-image mode or physical partition mode. You
can have up to two Cryptographic Coprocessor Features and multiple PCI
Cryptographic Coprocessor Features on a CCF system.

On a z990, z890, z9-109, z9 EC or z9 BC, you must have at least one
PCIXCC/CEX2C for TKE usage.

Logically Partitioned (LPAR) Mode Considerations

Multiple Hosts

When you activate a logical partition, you can prepare it for running software
products that work with the Cryptographic Coprocessor Feature (CCF), the PCI
Cryptographic Coprocessor Feature (PCICC) or PCI X Cryptographic Coprocessor
(PCIXCC)/Crypto Express2 Coprocessor (CEX2C). Both the CCF and the PCICC
can be shared among several PR/SM logical partitions. The PCIXCC/CEX2C can
be shared among several PR/SM logical partitions provided unique domains are
assigned to each LPAR.

When you run in LPAR mode, each logical partition can have its own master keys,
CKDS and PKDS.

When you activate a logical partition, you prepare it for being a TKE host or a TKE
target. For details, refer to|Appendix G, “LPAR Considerations,” on page 311

One TKE workstation can be connected to several hosts.
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Multiple Workstations

Several users on different workstations can have sessions with one host
simultaneously. Whenever a user attempts to work with a crypto module, the
system checks if another user is working with that module. The first user has a
reserve on the crypto module. All other users open the crypto module in read-only
mode until the first user releases the crypto module by closing the notebook.

Defining Your Security Policy

Each installation should have its own unique policies. These policies should be
documented in a security plan. Security officers should periodically review their
corporate security policy and their current key management system.

The security plan might include the following areas:
* General

How many security officers does your organization have? How often is the
master key changed? Who is authorized to enter master key parts 1 and 2? Do
the key parts you enter from the keyboard need to be masked? Who has access
to the secure computer facility? What are the policies for working with service
representatives? Will you be using smart card support?

» Workstation Considerations

Who will use the TKE workstation? Where will your workstation be located? Is it
only accessible to the security administrators or security officers? How many
workstations will there be? Will you use group logon? Who will backup the
workstations? Where will the passwords of the security officers be saved?

e« Command Considerations

Which commands require multiple signatures? Which crypto modules should be
grouped together? How many signatures will be required? Will this affect the
availability of the system? Which commands require a single signature? Who will
make these decisions?

As an example, if you are using CCF, the Signature Requirements Array (SRA)
could be set up to permit any two out of three security officers to issue Load
Environment-Control Mask from any workstation. The SRA entry for Load PKSC
Control Block, on the other hand, might be set up to require a different set of
security officers and require signatures from both security officers and
workstations.

Migration

Migrating from TKE Version 2 to TKE Version 5.0

This migration includes both hardware and software. You now have a new TKE
workstation with TKE 5.0 installed and a new cryptographic adapter.

There are no migration tools provided for migrating to TKE V5.0. Personal Security
Cards (PSCs) available with TKE V2.0 are NOT usable on TKE V5.0. Because of
this, you must consider the impact on the following and perform the appropriate
actions described:

¢ Host Definitions

The TKE V2.0 Host Definitions are APPC connections. You must redefine your
existing hosts on TKE V5.0 and define the relevant TCP/IP information.

* CCF Crypto Modules, Domains, and Authority Definitions
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The TKE V2.0 TKECM data set is not compatible with TKE V5.0. You must
redefine CCF Crypto Modules, Domains, and Authority definitions. If you plan to
use the same data set name for TKE V5.0 that you used for TKE V2.0, you must
delete the existing data set or rename it. The TKEFLAGS data set from TKE
V2.0 is no longer used in TKE V5.0.

* Authority Signature Keys on PSCs

Authority signature keys saved on PSCs from TKE V2.0 are NOT usable with
TKE V5.0. Before operating TKE V5.0, the TKE V2.0 user must do ONE of the
following:

1. If you will be using binary files for TKE V5.0 authority signature keys

— Generate and load new signature keys to the host. From the Authority
Administration window, generate a new signature key and save it to a
binary file (hard drive or diskette). Read the PM (public modulus). From
the authority administration window, create a new authority and choose
the signature key you just created to be used with this authority. If this is a
CCF crypto module, select change authority and choose the signature key
you just created. Send the updated signature key to the host. If saved to a
hard drive, copy the binary file to diskette and restore the diskette files to
the TKE V5.0 workstation.

2. If you will be using the TKE V5.0 Smart Cards for TKE V5.0 authority
signature keys:

— Change the signature requirements so that signature keys stored on TKE
V2.0 PSCs are not required. From the Crypto Module window, update the
appropriate commands with the new signature requirements. Remove any
authority whose signature key was stored on TKE V2.0 PSCs. If you do
not have at least one signature key available that uses either a default key
(other than authorities 14 or 15) or a signature key saved to binary file,
generate and load a new signature key to the host using a binary file as
described above.

— From TKE V5.0, using a default signature key or a signature key saved to
a binary file, generate and load new signature keys to the host. From the
Authorities Page of the Crypto Module Notebook, generate a new
signature key and save it to a TKE V5.0 smart card that has been
initialized and personalized. Get the signature key. Send the updated
signature key to the host. Repeat for all authorities that will be using
signature keys on TKE smart cards.

Note: Each TKE smart card can hold only one authority signature key.

— After all the authority signature keys have been generated and loaded to
the host, define the signature requirements for each TKE command. From
the Access Control Page of the Crypto Module Notebook, update the
applicable commands with the new signature requirements for authorities
whose signature keys are now stored on TKE smart cards. Send the
updates to the host.

For additional details on generating signatures, creating or changing authorities,

and sending the updates to the Host, refer to [Chapter 5, “Crypto Module

[Notebook,” on page 69|
+ Authority Signature Key in Workstation PKA Key Storage

There is no direct migration for an authority signature key saved in key storage
on the TKE V2.0 4755 key storage to key storage on the TKE V5.0 adapter card.
You must perform the same tasks described above.

* IMP-PKA Keys in Workstation DES Key Storage
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There is no direct migration for IMP-PKA keys loaded in the TKE V2.0
workstation key storage to the TKE V5.0 workstation key storage. Depending on
how and where the key parts were stored/loaded, the IMP-PKA keys must be
reloaded to key storage on the TKE V5.0 workstation. Follow the process below
for operational key parts.

* Master and Operational Key Parts
— Key parts saved to binary files on TKE V2.0 hard drive

- Copy files to diskette

- Restore diskette files to the hard drive of the new TKE V5.0 workstation

using the TKE File Management Utility. See [‘TKE File Management Utility’]
on page 355

— Key parts entered via the keyboard
- Enter the key parts on the TKE V5.0 keyboard
- If the user wants the known key part values to be saved to a TKE V5.0
TKE smart card, see|Appendix E, “Secure Key Part Entry,” on page 297|for
details.
— Key parts saved on TKE V2.0 PSCs
Master and operational key parts stored on TKE V2.0 PSCs are NOT usable
on TKE V5.0. The data blocks on the PSCs must be copied to binary files
using the TSS HIKM utility. The utility is executed on the TKE V2.0
workstation as follows:
1. Open a DOS window on the OS/2 desktop.

2. At the DOS command prompt, issue the following commands:

CD WCS1O\UTIL
HIKM

The WCS utilities are installed on the C: drive.
Press ENTER
On panel CSUCM22, press PF2 (to logon with the public profile)
On panel CSUCM20 select option 9 and press ENTER.
On panel CSUCZ20 select option 3 and press ENTER.
On panel CSUCZ01 select option 4 and press ENTER.
On panel CSUCZO07 select option 2 and press ENTER.
9. On panel CSUCRS8S8 insert the PSC card.
10. On panel CSUCRS86 select the desired data block id and press ENTER.
11. On panel CSUCZ10 select the desired profile and press ENTER.

12. On panel CSUCDOS, follow the instructions to Enter the PIN on the
security interface unit, then press E on the security interface unit.

13. On panel CSUCZ03 enter Type Block Token and press ENTER.
14. On panel CSUCZO09 select option 1 and press ENTER.

15. On panel CSUCRS33 enter the Path for the Data File and press ENTER.
Message CSUCO0356! will be displayed on the screen. Press ENTER.

16. Copy the file from the hard drive to diskette.

17. Restore diskette files to hard drive of the new TKE V5.0 workstation
using the TKE File Management Utility, see [ TKE File Management|
[Utility” on page 355}

© N oA
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Migrating from TKE Version 3 or higher to TKE Version 5.0

TKE Version 5 continues to allow you to manage crypto modules on your legacy
machines and any PCIXCCs/CEX2Cs inside your z990, 2890, z9-109, z9 EC or z9
BC. Migration to TKE V5.0 requires a new TKE workstation and a new
cryptographic adapter card.

Backup TKE Configuration Files

Warning: The TKE Backup Diskette MUST have a volume identifier that is either
blank or ACTKEBKP. If a diskette with a blank VOLID is used, the backup program
rewrites it to ACTKEBKP.

1. Perform the following tasks on the existing TKE V3.X or 4.X workstation.
Insert the TKEWS Backup diskette into the TKE disk drive.

Minimize all windows until only the OS/2 Workplace is displayed.

Open the TKE Backup icon on the OS/2 Workplace.

Follow the instructions displayed on the windows to complete the backup of the
TKE data. Do not remove the TKEWS Backup diskette if you will be copying
user defined 4758 roles and profiles.

6. Copy any user defined 4758 roles and profiles to the TKEWS Backup diskette.
a. Open an OS/2 window

b. From the C: prompt, copy any 4758 roles and profiles that have been saved
to a binary file on the hard drive

c. If you do not have any customer unique data to copy (step 8), exit the OS/2
window.

7. After the backup is completed and any user defined roles and profiles have
been copied, remove the TKEWS Backup diskette for use on TKE V5.0.

8. Copy customer unique data to the TKEWS Binary Key Backup diskette. If
Authority Signature Keys, Master Key parts, or Operational Key parts have
previously been saved to a binary file or if the customer has previously
generated and loaded a new Master Key during 4758 initialization and saved
the key parts on the TKE hard drive, follow the steps below.

a. Open an OS/2 window if necessary

b. Insert the TKEWS Binary Key Backup diskette into the TKE disk drive.

c. From the C: prompt, copy any Authority Signature Keys, Master Key parts,
or Operational Key parts that have been saved to a binary file on the hard
drive.

d. After the files have been copied, remove TKEWS Binary Key Backup
diskette for use on TKE V5.0.

e. Exit the OS/2 window.
TKE Started Task

For TKE V3.0, 3.1, 4.0, 4.1 and 4.2 customers only:

o k0N

Note: If your host system is being converted from a z900 to a z990, z9-109, z9 EC
or z9 BC or from a z800 to a z890, the TKEv3.0, v3.1 v4.0, v4.1 and v4.2
TKECM data set is not compatible with TKEv5.0. If you plan to use the same
data set name for TKEv5.0 that you used for your current TKE, you must
delete the existing data set or rename it.

For additional details see ['TKE Host Transaction Program Setup” on page 226]

The tasks in the following sections are all performed on the TKE 5.0 workstation:
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Set the Workstation Clock

1.

2.

3.
4.

In the left frame of the Trusted Key Entry Console click on System Management
and then Configuration.

In the right frame of the Trusted Key Entry Console click on Customize Console
Date and Time.

Set the time and date, and if using local time, select the time zone.
Click on Customize. For additional details see [‘Setting the Clock” on page 209

Copy Customer Unique Data

If customer unique data (authority signature keys, master key parts, or operational
key parts) was copied to the TKEWS Binary Key Backup diskette and you want the
files on the TKE 5.0 hard drive, copy the files using the TKE File Management
Utilitity.

1.

7.

In the left frame of the Trusted Key Entry Console, click on Trusted Key Entry
and then click on Utilities.

In the right frame of the Trusted Key Entry Console, click on TKE File
Management Utility.

Insert the TKEWS Binary Key Backup Diskette into the Floppy drive

Copy from the Floppy to the appropriate Data Directory. Signature keys, Host
Master Key parts, and Operational Key parts should be copied to the TKE Data
Directory. Cryptographic adapter Master Key parts should be copied to the CNM
Data Directory.

Exit the File Management Utility. Click on File, then Exit.
Deactivate the Floppy Drive

a. In the right frame of the Trusted Key Entry Console, click on TKE Media
Manager.

b. From the Select Operation drop down, click on Deactivate floppy inserted in
floppy drive.

c. Click OK. When complete, click Cancel.
Remove the TKEWS Binary Key Backup Diskette.

For additional details see ['TKE File Management Utility” on page 355|and [‘TKE|

[Media Manager” on page 392

Passphrase and Smart Card Setup

TKE 5.0 continues to support both passphrase and smart card usage. While it's not
mandatory, it is recommended that one method be chosen and used and a mixture
of methods avoided.

All predefined roles and profiles are in the CNM data directory.

Passphrase Setup

1.

Run TKE’s IBM Crypto Adapter Initialization task.

a. In the left frame of the Trusted Key Entry Console, click on Trusted Key
Entry, if necessary, and then click on Applications.

b. In the right frame of the Trusted Key Entry Console, click on TKE’s IBM
Crypto Adapter Initialization.

c. From the csulcni.sh GUI, reply 'Y' to the "Warning! The following task will
initialize your cryptographic coprocessor. All modifications to the
cryptographic coprocessor will be lost. Would you like to continue? (Y/N)"
prompt.
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d. Reply 'P' to the "Would you like to prepare your cryptographic coprocessor
for Smart Card or Passphrase use? (S/P)" prompt.

e. When complete, press Enter to exit.

See [‘Initializing the TKE cryptographic adapter” on page 209 for additional
details.

2. Load Known Master Key Parts to the Cryptographic Adapter
To be able to use migrated DES and PKA Key Storages, you must load the

cryptographic adapter master key parts from your previous TKE workstation to
the TKE 5.0 workstation:

a. In the right frame of the Trusted Key Entry Console, click on Cryptographic
Node Management Utility 3.10SC.

Logon KEYMANT1. (Select: File => Passphrase Logon => KEYMANT).

Load the First known cryptographic adapter master key part. ((Select:
Master Key => Clear Parts => First => Enter the clear key value or select
Open (if Open, select the master key part in the File Chooser => Open) =>
Load => OK => Cancel).

Note: If the key part was loaded from the floppy drive you need to
deactivate the floppy drive before removing the floppy. You do not
have to close CNM to perform this function.

1) In right frame of the Trusted Key Entry Console, click on TKE
Media Manager.

2) From the select Operation drop down, click on deactivate floppy
inserted in floppy drive.

3) Click OK. When complete, click Cancel.

d. Logoff KEYMANT1 and logon KEYMANZ2. ((Select: File => Logoff =>Yes =>
OK => File => Passphrase Logon => KEYMAN2).

e. Load the Middle and Last known cryptographic adapter master key parts.
(Select: Master Key = Clear Parts => Middle => Enter the clear key value or
select Open (if Open, select the master key part file in the File Chooser =>
Open) => Load => OK => (if you have more than one Middle key part,
repeat) => Last => Enter the clear key value or select Open = > Load =>
OK => Cancel).

Note: If the key part was loaded from the floppy drive you need to
deactivate the floppy drive before removing the floppy. You do not
have to close CNM to perform this function.

1) In right frame of the Trusted Key Entry Console, click on TKE
Media Manager.
2) From the select Operation drop down, click on deactivate floppy
inserted in floppy drive.
3) Click OK. When complete, click Cancel.
f. Set the cryptographic adapter master key. (Select: Master Key => Set).
g. Exit CNM.
For additional details on loading cryptographic adapter master key parts see
[‘Loading a new master key from clear key parts” on page 257}
3. Migrate Previous TKE Version to TKE 5.0.
Execute the Migrate Previous TKE Version to TKE 5.0 task to migrate TKE
related data (TKE Host and Group definitions, 4758 roles and profiles, DES and

PKA key storages, 3270 emulator data and TCP/IP information) from your
current TKE workstation to your TKE 5.0 workstation.
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a. In the left frame of the Trusted Key Entry Console, click on Utilities.

b. In the right frame of the Trusted Key Entry Console, click on Migrate
Previous TKE Version to TKE5.0.

TEE Worksta

Insert a TKE backup disk into the floppy drive.

(0],9 Cancel

Figure 2. Migrate Previous TKE Version to TKES.0.

c. The prompt, "Insert a TKE backup disk into the floppy drive." is displayed.
Insert your TKEWS Backup Diskette and select 'OK'. The 'Data Migration
Progress' panel is displayed.

Data Migration Progress

Lactivating the floppy disk,

lActivation of the floppy disk completed,
Restoring file: host.dat.

Restoring file: keystore. aut

Restaring file: keymanl pro

Restaring file: keyrmanl.rol.

Restaring file: keyman2. pro

Restaring file: keymanz. rol.

Restoring file: miguser.pro

Restoring file: miguser.rol.

Restoring file: tkeadm.pro.

Restoring file: tkeadm42.rol

Restoring file: tkeuser pro

Restaring file: tkeusr42 ral

Restaring file: sctkeadm. pra.

Restoring file: sctkeadm.rol.

Restaring file: sctkeusr.pro,

Restoring file: sctkeusr.rol.

Festoring file: group. dat

Restoring file: desstore.dat

Restoring file: desstore NDX

Restoring file: pkastore dat

Restaring file: pkastore NDX,

Restaring file: fov_usa.cr.

Restaring file: config.dat.

Restoring tn3270 session file: hme.ws
Restoring tn2270 session file: pkedps 1 ws
Restoring tn2270 session file: pksthubl.ws
Restoring tn2270 session file: pokwmild.ws
Restoring tn2270 session file: s390wm ws
Restoring tn2270 session file: tke.ws.

Exit
zSeries--ETKE: We BETEE: Tr [Command W Command W/ Captura b I Mon May 9 09:23:24 2005

Figure 3. Data Migration Progress Panel

d. The migrate is complete when the Exit button is no longer greyed out. When
complete, click on the Exit button to close the task.

e. Deactivate the floppy Drive.
1) In the left frame of the TKE Console, click on Utilities.
2) In the right frame of the TKE Console, click on TKE Media Manager.

3) From the Select Operation drop down, click on Deactivate floppy
inserted in floppy drive.
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f.

4) Click OK. When complete, click Cancel.

Remove the TKEWS Backup Diskette.

See [‘Migrate Previous TKE Version to TKE 5.0” on page 354 for details.
4. Re-Initialize DES and PKA Key Storages if Master Key Parts were Unknown

If you did not load a known master key because you did not know the key parts
(Step 2), the migrated DES and PKA key storages will not be usable. You will
need to re-initialize both key storages. Any keys in DES Key Storage and the
Authority Signature Key in PKA Key Storage will need to be recreated as
appropriate using TKE 5.0.

a.
b.

f.

In the left frame of the Trusted Key Entry Console, click on Applications.

In the right frame of the Trusted Key Entry Console, click on Cryptographic
Node Management Utility 3.10SC.

Logon TKEADM. (Select: File => Passphrase Logon => TKEADM).
Initialize DES Key Storage. (Select: Key Storage => DES Key Storage =>
Initialize => Initialize => desstore.dat (in CNM Data Directory) => Save =>
OK).

Initialize PKA Key Storage. (Select: Key Storage => PKA Key Storage =>
Initialize => Initialize => pkastore.dat (in CNM Data Directory) => Save =>
OK).

If loading User Defined Roles and Profiles do not exit CNM. Otherwise, exit
CNM.

5. Load User Defined Roles and Profiles to the Cryptographic Adapter:

If you are currently not in CNM from Step 4, perform steps a-c, otherwise
proceed to step d.

a.
b.

In the left frame of the Trusted Key Entry Console, click on Applications.

In the right frame of the Trusted Key Entry Console, click on Cryptographic
Node Management Utility 3.10SC.

Logon TKEADM (Select: File => Passphrase Logon => TKEADM)

Load Roles. (Select: Access Control => Roles => Open (File Chooser input
can be either Floppy or CNM Data Directory) => Select the user defined role
=> Open =>Load => OK). Repeat for each role to be loaded. When
complete => Cancel.

Load Profiles, including any Group Profiles. (Select: Access Control =>
Profiles => Open (File Chooser input can be either Floppy or CNM Data
Directory) => Select the user defined profile => Open => enter Passphrase,
Confirm Passphrase

Note: Group profiles do not require a passphrase to be entered and
confirmed

See [‘Open or edit a disk-stored role” on page 242 and [‘Edit a Disk-Stored User|

[Profile” on page 254] for additional details.

6. Update User Defined Roles with Applicable Access Control Points thru CNM:

a.

If Step 4 or 5 was not performed, open the Cryptographic Node
Management Utility and logon to TKEADM or an equivalent profile. See Step
4 for details.

Add the applicable access control points to each user defined role.

(Select: Access Control => Roles => Select the applicable role => Edit =>
Based on the information below, Add the required access control points from
the Restricted Operations to the Permitted Operations => Save (if desired to
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the floppy or CNM Data Directory) => Load => OK). Repeat for each role to
be updated. When complete => Cancel.

For TKE V4.1 or previous customers only:

If you have any user defined profiles that you want to continue to use to
logon to the cryptographic adapter to use TKE, you must add several new
access control points to the roles that the profiles are mapped to. The new
access control points are:

« X'8002' - TKE Logon
+ X'0250' - Load Diffie-Hellman key mod/gen
+ X'0251' - Combine Diffie-Hellman key parts
* X'0252' - Clear Diffie-Hellman key values
» X'027A' - Unrestrict Combine key parts
If you have any user defined roles for TKE administrator functions, you must
add new access control points:
* X'030B' - Reset battery low indicator
* X'0107' - One-Way Hash SHA-1
For TKE V4.2 customers only:
If you have any user defined roles for TKE administrator functions, you must
add new access control points:
* X'0107' - One-Way Hash SHA-1
7. Create Passphrase Group Logon Profiles:
If you currently do not have passphrase group profiles defined and want to

require that multiple users logon to the cryptographic adapter before either TKE
or CNM can be used, define a group profile.

a. If Step 4, 5, or 6 was not performed, open the Cryptographic Node
Management Utility and logon to TKEADM or an equivalent profile. See Step
4 for detalils.

b. Select: Access Control => Profiles => New. From the Profile Management
pop-up, select Group.

c. Enter the Group ID, update the Expiration Date. Select the role for the group
profile, select passphrase profiles.

d. Update the number of Group members required for Logon (minimum is 1,
maximum is 10).

e. Highlight the profiles from the Available profiles list that you want added to
the group and select Add.

f.  When complete, select Load to load the group profile into the cryptographic

adapter. If you also want to save the profile to the hard drive or floppy, select
Save.

Note: The Role of the Group overrides the roles of the individual user profiles
in the Group. It is recommended that members in the group have their
individual user profiles mapped to the DEFAULT role to limit the access
the user profiles have outside of the Group.

For additional details on defining group profiles, see [‘Define a Group Profile” on|
For details on CNM passphrase group logon, see [‘Group Logon” on page 235|
For details on TKE group logon, see [‘Passphrase and passphrase group logon’|

8. Update TKE Preferences using the Preferences menu in TKE.
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By default only Blind Key Entry is enabled. Only Enable Smart Card Readers
requires a close and reopen of the TKE application to have the change take
effect.

a. In the left frame of the Trusted Key Entry Console, click on Applications.

b. In the right frame of the Trusted Key Entry Console, click on Trusted Key
Entry 5.0.

c. Logon TKE

d. Click on Preferences on the toolbar. Enable/Disable Blind Key Entry, Floppy
Drive Only, Enable Tracing, Enable Smart Card Readers, and Show ZKA
ECM bits as appropriate. Preferences are enabled or disabled by clicking on
the check box. A check indicates that the preference is enabled.

See [Chapter 4, “Main Window,” on page 51| for additional details.

For IBM System z9-109, z9 EC and z9 BC Customers Only - TKE 5.0 Additional

Tasks:

a. Create the IBM System z9-109, z9 EC or z9 BC Host

b. Create Groups for the IBM System z9-109, z9 EC or z9 BC Cryptographic
Coprocessors

c. Create roles on your host crypto modules

d. Create Authorities. If you want to use existing authority keys, upload the
authority keys saved on floppy or in the TKE Data Directory to the host.

Smart Card Setup

If you will be using smart cards, several setup tasks need to be completed. If you
are a migrating from TKE V4.2 and are currently using smart cards, you will be able
to skip many of the steps. The steps for smart card setup are described in more
detail below and include:

Activating smart card support in CNM

Loading smart card roles to the workstation cryptographic adapter
Initializing and personalizing a CA smart card

Backing up a CA smart card

Enrolling the local workstation cryptographic adapter

Enrolling the remote workstation cryptographic adapter, if applicable
Initializing and enrolling TKE smart cards

Personalizing TKE smart cards

Generating cryptographic adapter logon keys

Defining smart card user profiles

Defining smart card group profiles, if applicable

Resetting the DEFAULT role

Updating the TKE Preferences

Generating new authority signature keys and saving them to TKE smart cards
Uploading the new signature keys to the host.

Note: There is no migration path to get existing authority signature keys stored in

binary files to TKE smart cards. New authority signature keys must be
generated. Master and operational keys saved in binary files cannot be
transferred to a TKE smart card unless the key part value is known. In this
case, secure key part entry can be used (see|Appendix E, “Secure Key Parf]
[Entry,” on page 297). If the key parts in binary files are not known, there is
no migration path. If the key parts are required, you must continue to use the

18 2z/0S V1R8.0 ICSF TKE PCIX Workstation User's Guide



existing binary files. If the key parts are not required, then new key part
values can be generated and saved to TKE smart cards.

Note: If you will be moving the smart card readers from your existing TKE
Workstation to your TKE 5.0 workstation, follow the steps below:

1.

4.

Power down your existing TKE 4.2 workstation and remove the smart
card readers.

Power down your TKE 5.0 workstation.

a. In the left frame of the Trusted Key Entry Console, click on System
Management and then Maintenance.

b. In the right frame of the Trusted Key Entry Console, click on
Shutdown or restart.

c. Select Power Off/Shutdown Console and click on OK.
Plug the smart card reader cables into the correct ports.
a. 9 pin D-shell connector into the serial ports.

b. The first passthru cable/connector into the mouse PS2 port. Install
the second passthru cable/connector into the first one.

c. Install the mouse cable into the second passthru cable/connector.
Power on the TKE 5.0 Workstation.

Steps for smart card setup: The tasks are executed from the CNM utility, SCUP,
and TKE. All tasks need to be completed before the TKE workstation is fully
operational with smart cards.

Activate smart card support in CNM.

1.

a.

d.

In the left frame of the Trusted Key Entry Console, click on Trusted Key
Entry, and then Applications.

In the right frame of the Trusted Key Entry Console, click on Cryptographic
Node Management Utility 3.10SC.

Enable smart card support. (Select: File => Enable Smart Card Readers).
Smart Card support will be activated the next time you start CNM.

Exit CNM.

Run TKE’s IBM Crypto Adapter Initialization task.

a.
b.

e.
SCUP Initialization Tasks

Label the smart card readers 1 and 2 (for usability purposes).
a.
b.

In the left frame of the Trusted Key Entry Console, click on Applications.

In the right frame of the Trusted Key Entry Console, click on TKE’s IBM
Crypto Adapter Initialization.

From the csulcni.sh GUI, reply 'Y' to the "Warning! The following task will
initialize your cryptographic coprocessor. All modifications to the
cryptographic coprocessor will be lost. Would you like to continue? (Y/N)"
prompt.

Reply 'S' to the "Would you like to prepare your cryptographic coprocessor
for Smart Card or Passphrase? (S/P)" prompt.

When complete, press Enter to exit.

In the left frame of the Trusted Key Entry Console, click on Applications.

In the right frame of the Trusted Key Entry Console, click on Smart Card
Utility Program 1.20.

Note: TKE V4.2 customers with existing CA and TKE Smart Cards only
need to execute step e and/or step f.
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c. |Initialize and personalize a CA smart card. It is recommended that the first
and second CA PINs be entered by different administrators and have
different values. (Select: CA Smart Card => Initialize and Personalize CA
Smart Card => Follow prompts).

See [Initialize and personalize the CA smart card” on page 279}

d. Backup CA smart card. (Select: CA Smart Card => Backup CA Smart Card
=> Follow prompts).

See [‘Backup a CA smart card” on page 281}

e. Enroll local workstation cryptographic adapter. (Select: Crypto Adapter =>
Enroll Crypto Adapter => Local => Follow prompts)

See [‘Enroll a TKE cryptographic adapter” on page 287}
f. Enroll remote workstation cryptographic adapter if applicable.

1) On the remote TKE, in the right frame of the Trusted Key Entry
Console, click on Begin Zone Remote Enroll Process for an IBM Crypto
Adapter. Follow prompts.

2) Enroll the cryptographic adapter on the Local TKE
If the local TKE is TKE 4.2 then:
* Open SCUP by clicking on the icon on the Desktop
» Select: 4758 => Enroll 4758 => Remote => Follow prompts
If the local TKE is TKE 5.0 then:

* In the left frame of the Trusted Key Entry Console, click on
Applications

* In the right frame of the Trusted Key Entry Console Applications, click
on Smart Card Utility Program 1.20

» Select: Cryptographic Adapter => Enroll crypto adapter => Remote
=> Follow prompts

3) On the remote TKE, in the right frame of the Trusted Key Entry
Console, click on Complete Zone Remote Enroll Process for an IBM
Crypto Adapter. Follow prompts.

See [‘Enroll a TKE cryptographic adapter” on page 287}

g. Initialize and enroll TKE smart cards. (Select: TKE Smart Card => Initialize
and enroll TKE Smart Card; Follow prompts).

See Initialize and Enroll a TKE Smart Card [‘Initialize and enroll a TKE|
[smart card” on page 284

h. Personalize TKE smart cards. (Select: TKE smart card => Personalize TKE
Smart Card; Follow prompts)

See [‘Personalize a TKE smart card” on page 285,
i. Close the SCUP application.
4. Load Known Master Key Parts to the Cryptographic Adapter

To be able to use the migrated DES and PKA Key Storages, you must load the
cryptographic adapter master key parts from your previous TKE workstation to
the TKE 5.0 workstation.

a. In the right frame of the Trusted Key Entry Console, click on Cryptographic
Node Management Utility 3.10SC.

b. Itis not necessary to logon to the workstation cryptographic adapter, as the
TEMPDEFAULT role is still active.

c. Load the First known cryptographic adapter master key part. For key parts
saved on paper or in binary files: (Select: Master Key => Clear Parts =>
First => Enter the clear key value or select Open (if Open, select the
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master key part in the File Chooser => Open) => Load => OK). For key
parts saved on TKE smart cards: (Select: Master Key => Smart Card Parts
=> Insert TKE Smart Card => First => Select the master key part you want
to load => Load => Enter PIN => OK).

See Loading a new master key from clear key parts [‘Loading a new master
[key from clear key parts” on page 257| and Loading master key parts from
a TKE smart card [‘Loading master key parts from a TKE smart card” on|

Note: If the key part was loaded from the floppy drive you need to
deactivate the floppy drive before removing the floppy. You do not
have to close CNM to perform this function.

1) In right frame of the Trusted Key Entry Console, click on TKE
Media Manager.

2) From the select Operation drop down, click on deactivate floppy
inserted in floppy drive.

3) Click OK. When complete, click Cancel.

d. Load the Middle and Last known cryptographic adapter master key parts.
For key parts saved on paper or in binary files: (Select: Master Key = Clear
Parts => Middle => Enter the clear key value or select Open (if Open,
select the master key part file in the File Chooser => Open) => Load =>
OK => (if you have more than one Middle key part, repeat) => Last =>
Enter the clear key value or select Open = > Load => OK => Cancel). For
key parts saved on TKE Smart Cards: (Select: Insert TKE Smart Card (if
middle key part is on a different TKE Smart Card) => Middle => Select the
master key part you want to load => Load => Enter PIN (if middle key part
is on a different TKE Smart Card) => OK => (if you have more than one
Middle key part, repeat) => Insert TKE Smart Card (if last key part is on a
different TKE Smart Card) => Last => Select the master key part you want
to load => Load => Enter PIN (if last key part is on a different TKE Smart
Card) => OK => Cancel).

See Loading a new master key from clear key parts |“Loading a nev_v|
[master key from clear key parts” on page 257| and Loading master key
parts from a TKE smart card [‘Loading master key parts from a TKE smarf]
[card” on page 260

Note: If the key part was loaded from the floppy drive you need to
deactivate the floppy drive before removing the floppy. You do not
have to close CNM to perform this function.

1) In right frame of the Trusted Key Entry Console, click on TKE
Media Manager.

2) From the select Operation drop down, click on deactivate floppy
inserted in floppy drive.

3) Click OK. When complete, click Cancel.

e. Set the cryptographic adapter master key. (Select: Master Key => Set =>
Yes => OK).

f. Exit CNM
5. Migrate Previous TKE Version to TKE 5.0.

Execute the Migrate Previous TKE Version to TKE 5.0 task to migrate TKE
related data (TKE Host and Group definitions, 4758 roles and profiles, DES
and PKA key storages, 3270 emulator data and TCP/IP information) from your
current TKE workstation to your TKE 5.0 workstation.
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a. In the left frame of the Trusted Key Entry Console, click on Trusted Key
Entry and then click on Utilities.

b. In the right frame of the Trusted Key Entry Console, click on Migrate
Previous TKE Version to TKE 5.0.

c. The prompt, Insert a TKE backup disk into the floppy drive is displayed.
Insert your TKEWS Backup Diskette and select OK. The Data Migration
Progress panel is displayed.

d. The migrate is complete when the Exit button is no longer greyed out.
When complete, click on the Exit button to close the task.

e. Deactivate the Floppy Drive.

1) In the right frame of the Trusted Key Entry Console, click on TKE
Media Manager.

2) From the Select Operation drop down, click on Deactivate floppy
inserted in floppy drive.

3) Click OK. When complete, click Cancel.
f. Remove the TKEWS Backup Diskette.
See [‘Migrate Previous TKE Version to TKE 5.0” on page 354 for details.

6. Re-initialize DES and PKA Key Storages if the Master Key Parts were
Unknown. If you did not load a known master key because you did not know
the key parts (Step 3), the migrated DES and PKA key storages will not be
usable. You will need to re-initialize both key storages. Any keys in DES Key
Storage and the Authority Signature Key in PKA Key Storage will need to be
recreated as appropriate using TKE 5.0.

a. In the left frame of the Trusted Key Entry Console, click on Applications.

b. In the right frame of the Trusted Key Entry Console, click on Cryptographic
Node Management Utility 3.10SC.

c. Itis not necessary to logon to the workstation cryptographic adapter, as the
TEMPDEFAULT role is still active.

d. Initialize DES Key Storage. (Select: Key Storage => DES Key Storage =>
Initialize => Initialize => desstore.dat (in CNM Data Directory) => Save =>
OK).

e. Initialize PKA Key Storage. (Select: Key Storage => PKA Key Storage =>
Initialize => Initialize => pkastore.dat (in CNM Data Directory) => Save =>
OK).

f. Exit CNM.

7. CNM initialization tasks
a. In the left frame of the Trusted Key Entry Console, click on Applications.

b. In the right frame of the Trusted Key Entry Console, click on Cryptographic
Node Management Utility 3.10SC.

c. Itis not necessary to logon to the workstation cryptographic adapter, as the
TEMPDEFAULT role is still active.

Note: TKE V4.2 Customers Only. If you have existing roles and profiles
and TKE Smart Cards with Cryptographic Adapter Logon Keys
proceed to step g.

d. It is not necessary to create any new workstation cryptographic adapter
roles as SCTKEUSR, SCTKEADM, and MIGUSER are supplied with the
code and provide all the required access controls for logging on the
workstation cryptographic adapter for TKE, CNM and the Migration Utility
respectively. However, you can create new roles as appropriate for your
installation. If you do create new roles and want the user profiles that will
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be mapped to the roles to be suitable for workstation cryptographic adapter
logon for TKE, you must permit access control point X'8002' for TKE
Logon. If the role does not contain this access control point the user profile
will not be displayed for logon for TKE.

e. Generate a workstation cryptographic adapter logon key to a TKE smart
card that will be used for logon to the workstation cryptographic adapter.
You will need to generate a workstation cryptographic adapter logon key for
each user logging on. (Select: Smart Card => Generate Crypto Adapter
Logon key; Follow prompts)

See [‘Generate TKE Crypto Adapter logon key” on page 267}

f. Define user profiles for the TKE smart cards that have a workstation
cryptographic adapter logon key. (Select: Access Control => Profiles =>
New => Smart Card => Insert Smart Card => fill in fields; map to
SCTKEUSR or SCTKEADM roles => Save (If desired to the floppy or CNM
Data Directory => Enter File Name => Save => OK) => Load => OK)

See [‘Define a User Profile” on page 247 Define a User Profile.

Note: If the user profiles will be used in a group logon profile then they
should be mapped to the DEFAULT role to limit the functions
available to the user outside of the group.

g. Load User Defined Roles and Profiles to the Cryptographic Adapter.

1) Load Roles. (Select: Access Control => Roles => Open (File Chooser
input can be either Floppy or CNM Data Directory) => Select the user
defined role => Open => Load => OK). Repeat for each role to be
loaded. When complete => Cancel.

2) Load Profiles, including Group Profiles SCTKEADM and SCTKEUSR.
(Select: Access Control => Profiles => Open (File Chooser input can be
either Floppy or CNM Data Directory) => Select the user defined profile
=> Open => Load => OK). Repeat for each profile to be loaded. When
complete => Cancel.

Note: Any smart card profiles not saved to a binary file in TKE V4.2 will
need to be created as a New Smart Card profile in TKE 5.0. See
Step f above for details.

See Open or Edit a disk stored rold‘Open or edit an existing role” on page]

42| and Edit a disk-stored user profile [‘Working with User Profiles” on|

page 254

h. Update User Defined Roles with Applicable Access Control Points. Add the
applicable access control points to each user defined role. (Select: Access
Control =>Roles => Select the applicable role => Edit => Based on the
information below, Add the required access control points from the
Restricted Operations to the Permitted Operations => Save (if desired to
the floppy or CNM Data Directory) => Load => OK). Repeat for each role
to be updated. When complete => Cancel.

For TKE V4.1 or previous customers only:

» If you have any user defined profiles that you want to continue to use to
logon to the cryptographic adapter to use TKE, you must add several
new access control points to the roles that the profiles are mapped to.
The new access control points are:

— X'8002' - TKE Logon
— X'0250' - Load Diffie-Hellman key mod/gen
— X'0251' - Combine Diffie-Hellman key parts
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— X'0252' - Clear Diffie-Hellman key values
— X'027A' - Unrestrict Combine key parts
* If you have defined roles for TKE administrator functions, you must add
new access control points:
— X'030B' - Reset battery low indicator
— X'0107' - One-Way Hash SHA-1
For TKE V4.2 customers only:
» If you have defined roles for TKE administrator functions, you must add
new access control points:
— X'0107' - One-Way Hash SHA-1
i. Create Smart Card Group Logon Profiles
Note for existing TKE V4.2 Smart Card Users:
If you have already loaded your smart card group profiles from TKE V4.2
and will not be defining any new smart card group profiles, proceed to Step
j-
Empty group profiles SCTKEADM and SCTKEUSR are provided in the
CNM Data Directory. If you want to require that multiple users logon to the

cryptographic adapter before either TKE or CNM can be used, update the
appropriate group profile. A group may contain 1 to 10 members.

1) For empty group profiles sctkeusr.pro and sctkeadm.pro: (Select:
Access Control => Profiles => Open) For new smart card group profiles:
(Select: Access Control => Profiles => New => Group => Smart Card
Profile)

2) Update the number of Group members required for Logon (minimum is
1, maximum is 10).

3) Highlight the profiles from the Available profiles list that you want added
to the group and select Add.

4) When complete, select Load to load the group profile into the
cryptographic adapter. If you also want to save the profile to the hard
drive or floppy, select Save.

Note: The Role of the Group overrides the roles of the individual user
profiles in the Group. It is recommended that members in the group
have their individual user profiles mapped to the DEFAULT role to
limit the access the user profiles have outside of the Group.

For details on defining group profiles, see [‘Define a Group Profile” on page]

I
N

For details on CNM smart card group logon, see [‘Smart Card Group Logon’]
on page 237
For details on TKE group logon, see [‘Initializing TKE for smart cards” on|

j- Reset the Default role. The Default role is in the CNM Data Directory. Your
TKE Workstation is not secure until the Default role is reset. (Select: Access
Control => Roles => Open => default.rol => Open => Load => OK =>
Cancel)

See [‘Open or edit a disk-stored role” on page 242

k. Exit CNM.

8. Update TKE Preferences using the Preferences menu in TKE.
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By default only Blind Key Entry is enabled. Only Enable Smart Card Readers
requires a close and reopen of the TKE application to have the change take
effect.

a. In the left frame of the Trusted Key Entry Console, click on Applications.

b. In the right frame of the Trusted Key Entry Console, click on Trusted Key
Entry 5.0.

c. Logon to TKE

d. Click on Preferences on the toolbar. Enable/Disable Blind key Entry, Floppy
Drive Only, Enable Tracing, Enable Smart Card Readers, and Show ZKA

ECM bits as appropriate. Preferences are enabled or disabled by clicking
on the check box. A check indicates that the preference is enabled.

For additional details on updating TKE Preferences, see [‘TKE Customization]
9. Generate New Authority Signature Keys to TKE Smart Cards

For each authority with a signature key saved to a binary file, logon TKE and

generate a new authority signature key. Save the signature key to a TKE smart

card. Create or change the appropriate authority and upload the new authority

signature key to the Host.

Note: Each TKE smart card can hold only one authority signature key.
10. For IBM System z9-109, z9 EC and z9 BC Customers Only - TKE 5.0
Additional Tasks:
a. Create the IBM System z9-109, z9 EC or z9 BC Host
b. Create Groups for the IBM System z9-109, z9 EC or z9 BC Cryptographic
Coprocessors
c. Create roles on your host crypto modules

d. Create Authorities. If you want to use existing authority keys, upload the
authority keys saved on TKE smart cards to the host.

Enable TKE Access Control Points

For TKE V3.0 Customers Only: This section is only applicable to customers
whose workstation was at TKE V3.0 prior to the upgrade to TKE V5.0 and whose
configuration includes PCI cryptographic coprocessors. An authorized TKE Authority
must enable all applicable access control points for ICSF callable services.

APAR OW46381 must be installed on z/OS V1R1 and OS/390 V2R10 systems or
Access Control Failures could occur.

For z890 or z990 TKE V4.X Customers Only: This section is only applicable to
2890 or z990 customers whose workstation was at TKEV4.x prior to the upgrade to
TKE V5.0. If you are upgrading your ICSF level an authorized TKE Authority must
enable all applicable new access control points.

For IBM System z9-109, z9 EC and z9 BC Customers Only: An authorized TKE
authority must enable/disable access control points as appropriate.

See ['Working with Domains Controls Settings (PCICC/PCIXCC/CEX2C)” on page]

fiaz
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TKE Migration Utility

Note: APAR OA07393 must be installed on ICSF FMID HCR770A and below
systems, or errors could occur during the installation of converted keys into
the CKDS function of the Migration Utility process.

See [Install Converted Keys into the CKDS” on page 335|and ['Import and Install
[Keys into the CKDS” on page 336}

| TKE Enablement for 2990, z890, z9-109, z9 EC and z9 BC Systems

If you have a z890 or z990 system with May 2004 or later version of Licensed
Internal Code (LIC) installed or a z9-109, z9 EC or z9 BC system with MCL 029
Stream J12220 or later installed, TKE commands must be permitted on the Support
Element before any commands issued by the TKE workstation can be executed.
This is a requirement beginning with the May 2004 Licensed Internal Code. Default
setting for TKE commands is Denied.

To permit TKE commands on the Support Element, you must perform the following
tasks:

1. On the PCI Cryptographic Configuration panel, highlight a PCI Cryptographic
number (all PCIXCCs/CEX2Cs available on the server will be displayed) and
then click on the TKE Commands button.

2. On the TKE Command Configuration panel, permit TKE commands by clicking
the Permit TKE Commands check box and then press OK.

3. Repeat steps 1 and 2 for each PCIXCC/CEX2C card.

If TKE commands are not permitted on the Support Element, the following Details
Error will be displayed on the TKE Workstation when an attempt is made to open
the Host ID:

Error Message: Program CSFPCIX Interface

Error Type 2

Return Code 12
Reason Code 2073

Detail Message 'The Crypto Coprocessor has been disabled on the Support Element.
It must be enabled on the Support Element before TKE can access it.'

Note: A global zeroize issued from the Support Element will return the state of TKE
Commands back to the default value of Denied. All PCIXCCs/CEX2Cs must
have the state of the TKE Commands set to the value of Permitted before
TKE workstation commands can be issued from the TKE workstation.

TKE Navigation

On startup the TKE Console will be started automatically with the following
Welcome panel.
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Trusted Key Entry Console

<] Welcome Welenus

“5 Trusted Key Entry Welcame to the Trusted Key Entry Conzole (TKE). From here you can manage this TKE as well as the keys on your 2/05 Host
5 System Management systems. Click on the links in the navigation area at the left to begin,

(=] ]
% Trusted Key Entry
Work with TKE applications and utilities to manage cryptographic keys on a 2/0S host.

System Management
work with tasks and utilities to manage, configure and maintain the TKE console system.

ﬁ Status Bar

Displays the current status of the TKE Hardware. Status will be either OK or the Hardware Messages icon

TKE Documentation

Figure 4. Welcome Panel

The TKE Console consists of a tree view on the left for navigation between tasks.
The right side of the Welcome Page displays a brief description of the Framework
in the tree view, as well as a link to the TKE Documentation, where the TKE PCIX
Workstation User’'s Guide can be accessed. Expanding the Trusted Key Entry and
System Management tasks will display sub tasks where the various TKE
Applications, Utilities, and support tasks can be accessed.

The Applications task contains the primary TKE applications.
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Trusted Key Entry Console

4] Welcome Applications
B " Trusted Key Eniry

2 System Management

Trusted Fey Entry Appliation Tashe

Applications A ERN = Y
Utilities
Mame ~ | Description B

1 Begin Zone Remote Enrall Process for an 184 Crypto Adapter Used to begin the zone remate enroll process for an 1B

1] CCA CLU 3.105C Used ta manage the code on an IBM Crypto Adapter

A Complete Zone Remote Enroll Process for an IBM Crypta Adapter Used to complete the zane remate enroll process fr ar
M cryptographic Mode Management Batch Initialization 3.10SC Used to initialize an 18K Crypto Adapter using CHI file:

m Cryptographic Node kManagement Utilty 3105C Used to manage an IBM Crypto Adapter

1 Smart Card Utiit Program 1.20 Used to initialize Smart Cards

QTKE Ivedia Manager Used to activate and deactivate media

& TKE Migration Utility 1.5 Used to migrate 4753 keys to a /05 host

m TKE's IBM Crynto Sdapter Initialization Used to initialize an 1BM Crypto Adapter for TKE using
& Trusted Key Entry 5.0 Used to securely manage keys on a 2/05 Host

Total: 10 Filtered: 10

i o

Figure 5. Primary TKE applications tasks

Applications include:

Begin Zone Remote Enroll Process for an IBM Crypto Adapter - For use on the
Remote TKE to begin the zone enroliment process.

CCA CLU 3.10SC - For loading code onto the TKE 5.0 Workstation Crypto
Adapter.

Complete Zone Remote Enroll Process for an IBM Crypto Adapter - For use on
the Remote TKE to complete enrollment in a zone.

Cryptographic Node Management Batch Initialization 3.10SC - For using a Batch
interface to execute a user created CNI file. A user created CNI file can be used
to initialize a TKE crypto adapter differently than the TKE’s IBM Crypto Adapter
Initialization task. To create the user CNI, use the Cryptographic Node
Management Utility 3.10SC, CNI Editor function

Cryptographic Node Management Utility 3.10SC - For managing the TKE
workstation crypto adapter (create and manage Roles and Profiles, manage
workstation master keys, etc)

Smart Card Utility Program 1.20 - For creating, initializing, and enrolling
Smartcards and enrolling the TKE workstations.

TKE Media Manager - For activating and deactivating media drives for use by
TKE Applications and Utilities

TKE Migration Utility 1.5 - For migrating 4753 DES Key storage to an ICSF
CKDS

TKE’s IBM Crypto Adapter Initialization - For initializing the TKE Workstation
Crypto Adapter for Passphrase or Smartcard use.

Trusted Key Entry 5.0 - For managing Host cryptographic hardware use the main
TKE application
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The TKE Utilities task contains common utilities in support of TKE.

Trusted Key Entry Console

UHilities

47 Wel
come Trusted key Entry Utility Tasks

B % Trusted Key Entry
% Applications RN ENE ﬂ'
ST 5 b

- System Management

MName - | Description 2
& Edit TKE Files Used ta edit TKE Files

<f tigrate Previous TEE Version to TKE 5.0 Used to migrate data on a backup disk created by pravious TKE releases

43 TKE File NManagement Utilit Used to manage available files in all data directories
QTKE Media Manager Used to activate and deactivate madia
© TKE Workstation Code Information Used to query TKE YWarkstation cade information

Total 5 Filtered: 5

Figure 6. TKE common ultilities tasks

Utilities include:

» Edit TKE Files - A general purpose editor for creating/updating files on floppy
drive, CD/DVD drive, and in TKE related directories on the hard drive

* Migrate Previous TKE Version to TKE 5.0 - A utility for migrating TKE related
information from an existing TKE workstation to a new TKE 5.0 workstation

* TKE File Management Utility - Used to manage (copy, delete, and rename) files
on Floppy Drive, CD/DVD Drive, and in TKE related data directories on the hard
drive

* TKE Media Manager - For activating and deactivating media drives for use by
TKE Applications and Utilities

* TKE Workstation Code Information - Provides build/change dates for the current
TKE workstation code. This does not include any information for the code loaded
on the Crypto Adapter

The Service Applications task provides access to tasks for servicing the TKE
workstation, including formatting media and diagnostic aids.
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IBM Systems

7 Wel Service Applications
3! e Contains tasks for servicing the TKE system,
s Trusted Key Entry

=
g3 System Management e vl g 2l | £
& service Applications

Configuration
IMa\menamce

MName ~ | Description &
é Analyze Console Internal Code  Manage console's temporary internal code changes from IBM PE

= Authorize Internal Code Changes Enable or disable console's change management services
7 Change Console Internal Code Manage console's internal cade change levels

= Eormat Media Format a diskefte or DVD-RAKM
< Hardware IMessages Display hardware messages from selected objects

T hetwark Diagnastic Infarmation Display network diagnostic information for the console

Ew Rebuild the Console's vital product data

Y Transmit Conzale Service Data =end Console Service Data to 1B for problem determination
Total 8 Fitered: 8

‘Status: Messages

Figure 7. TKE Service application tasks

The Service Applications tasks include:

* Analyze Console Internal Code - Used to retrieve, activate, and deactivate
temporary code fixes.

* Authorize Internal Code Changes - Used to allow or disallow code updates.

» Change Console Internal Code - Used to retrieve, install and activate, remove,
and accept code updates.

* Format Media - Format diskettes or DVDs. Provides build/change dates for the
current TKE workstation code. This task cannot be run on a media type unless
the TKE Media Manager task shows that the media’s status is deactivated.

* Hardware Messages - Display hardware messages

* Network Diagnostic Information - Diagnostic tools to aide in debugging
connection problems

* Rebuild Vital Product Data - Rebuilds the TKE Console's vital product data

» Transmit Console Service Data - Send data (console logs and traces) to IBM for
problem determination

The Configuration Task contains tasks used for setting up the TKE workstation and
configuring 3270 sessions.
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Trusted Key Entry Console

& Confagiration
t_'-a- WIS Contains tasks for configuring the TKE system
Bl " Trusted Key Entry
& Applications ESREI NI NI A
Utilities
o 8 i Y MName Description
@ Shriiss Epoiaione @ Configure 3270 Emulators Customize the 3270 emulator sessions
Configuration & Customize Console DaterTime  Custamize the date and time
T Maintenance 2 Customize Network Settings Custamize the network configuration for the console

L Customize Scheduled Operations Customize schedule of automated console operations
Total: 4 Filtered: 4

| T sawsok

Figure 8. TKE Configuration Tasks

The TKE Configuration task contains the following tasks:

» Configure 3270 Emulators - Used to configure 3270 emulator sessions

* Customize Console Date/Time - Used to set the TKE workstation Date and Time
» Customize Network Settings - Used to set up the TCPIP configuration

» Customize Scheduled Operations - Provides the ability to schedule automatic
backups of critical console data, including patches applied and changes to TKE
related information

The Maintenance task contains tasks for managing the TKE workstation.
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Trusted Key Entry Console

Maintenance
i. Welcoms Contains maintenance tasks for managing the THE system
° Trusted Key Entry
B E system Management w ol | g (2] (=] |
Service Applications
Name - | Description &
Configuration = — |
ﬁf Maintenance 0 Backup Critical Console Data Make backup of consale's critical data
= Fomat Media Formal a disketie or DYD-RAM
< Hardware Iessages Display hardware messages fram selected ohjects
& |ock Cansole Lock the console
l?y Offload Yirtual RETAIM Data to DyvD-Rak Ofoad saved RETAIN problem data to DWD-RAM
L= gave Upgrade Data Save customizable data that is to be restored during an upgrade
& Shutdown or Restart Restart the application or shutdown/restan the console
a Users and Tasks Wiew the logged on users and their tasks
| Wiew Console Events Display console's event log
0 view Console Information Display console's internal code change information
= view Console Service Histor Display console's service history
[Z view Console Tasks Performed View record of console tasks performed by the cansole's users
= view Licenses Read the open-source licenses for the product
Total 13 Filtered: 13
Status: Messages

Figure 9. TKE Maintenance Tasks

The TKE Maintenance task includes the following tasks:

Backup Critical Console Data - Backup changed TKE and system related
(patches) data to DVD after the initial install of code. It is intended for use during
a hard disk restore operation which completely replaces the contents of the hard
drive using the original install CD and the Backup DVD

Format Media - Format diskettes and DVDs
Hardware Messages - Display hardware messages
Lock Console - Lock the TKE console

Offload Virtual RETAIN Data to DVD-RAM - Transmit Virtual RETAIN Data to
DVD-RAM for use in problem determination by IBM Support.

Save Upgrade Data - Save information, including TKE related data, TCP/IP data,
and emulator session data to the hard drive or DVD for use during an upgrade to
a new level of TKE code

Shutdown or Restart - Restart application, Restart console, or
Power-off/Shutdown console

Users and Tasks - View user details and active tasks

View Console Events - Display console events log

View Console Information - Display consoles internal code change information
View Console Service History - Display console service history

View Console Tasks Performed - View record of console tasks performed.
View Licenses - View License information for applicable workstation code.

32 2/0S V1R8.0 ICSF TKE PCIX Workstation User's Guide



Chapter 2. Using Smart Cards with TKE

Companies aiming for a high level of data confidentiality and integrity are likely to
install a hardware based cryptographic system, such as one provided by the
Trusted Key Entry (TKE) workstation. It allows you to keep your cryptographic keys
secret and protected from unauthorized access. When properly installed and
administered, using smart cards with the TKE workstation provides a high level of
security.

Smart Card support gives the user the ability to keep all key parts, signature keys,
and TKE Crypto Adapter logon keys from ever appearing in the clear.

Smart Card support requires:
* TKE V4.2 or higher code

« TKE Smart Card Reader, feature code 0887. This feature includes 2 smart card
readers and 20 smart cards.

* TKE workstation with an IBM Cryptographic Adapter Card.

Note: The card is a FIPS level 4 certified cryptographic adapter with a very
secure tamper resistant module. For TKE 5.0, card code level 3.10SC is
required for segments 2 and 3.

Optional feature code 0888 includes 10 additional smart cards.

The TKE V5.0 workstation with smart card support performs the following:

» Stores ICSF (host) key parts, specifically, master and operational key parts on
TKE smart cards

» Stores TKE crypto adapter workstation master key parts on TKE smart cards.
* Generates, stores, and uses a TKE authority signature key on TKE smart cards

* Generates, stores, and uses a TKE crypto adapter logon key on TKE smart
cards.

Terminology

There are several terms you should be familiar with to understand the smart card
support.

CNM Cryptographic Node Management utility. This utility
is a Java application that provides a graphical user
interface to initialize and manage the TKE
cryptographic adapter. See |Appendix C,|
“Cryptographic Node Management Utility (CNM),’]

on page 233.|

CNI Cryptographic Node Batch Initialization utility. The
CNI Editor is a utility within CNM that is used to
create CNI scripts to automate some of the
functions of CNM. CNI scripts can be used for
additional setup of the TKE cryptographic adapter.

Smart Card Reader Hardware where the PIN protecting the smart card
is entered. Also, where the key parts are entered
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with secure key entry. Two smart card readers must
be attached at all times to each TKE workstation to
use smart card functions.

PIN prompt PIN prompts appear as pop-ups from the

application and also on the smart card reader. The
smart card reader expects a PIN to be entered
promptly; otherwise a timeout condition occurs.

SCUP Smart Card Utility Program. Performs maintenance

operations, such as the creation/initialization and
personalization of CA and TKE smart cards and
zone enrollment of the TKE crypto adapter. See
Appendix D, “Smart Card Utility Program (SCUP),"|

on page 277.|

Zone A security concept ensuring that only members of

the same zone can exchange key parts. A zone is
established by a CA smart card. See
[creation” on page 36

Entity A member of a zone. Entities can be a CA smart

card, a TKE smart card, or a cryptographic adapter.

Group Logon Allows multiple users to co-sign the logon to the

TKE cryptographic adapter. A group may have a
minimum of one member and a maximum of ten
members.

Certificate Authority (CA) Smart Card

An entity that establishes a zone using the Smart
Card Utility Program (SCUP). Protected by two
6-digit PINs.

TKE Smart Card Used for the storing keys and key parts; Can hold a

maximum of 10 key parts, a TKE Crypto Adapter
logon key and a TKE authority key. Protected by a
4-digit PIN.

Preparation and Planning

Before beginning a smart card implementation, consider the following questions:

How many users will be using smart cards?

Will you be using group logon?

How many members will be in the group?

How many members in the group will be required to sign a logon?
What role will the group have?

What type of roles will users have?

Are there procedures requiring special security considerations?
Which tasks will have dual control?

Who should be involved in security, auditing, and operation procedures in a test
environment?

Who should be involved in security, auditing, and operation procedures in a
production environment?

How many TKE smart cards will you have?
How many backup CA smart cards will you have?
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* Where will you keep backup CA smart cards?

* How many users will have access to the CA smart cards? Who will know the two
CA PIN numbers? Where will the CA smart card and backups be secured?

» |If you have more than one TKE workstation, will they be in the same zone?

Using the smart card reader

The smart card reader has a PIN pad, a display window, and two lights. On the PIN
pad, the TKE smart card supports the numeric buttons (0-9), the red X cancel
button, and the yellow <== backspace button.

Each smart card reader has two lights above the PIN pad, one green, one yellow.
When opening a smart card application (SCUP, CNM or TKE), wait for the green
light to come on for both smart card readers before selecting a smart card function.
The green light should always be on when the readers are attached.

Only one smart card application may be opened at a time. If more than one is
opened, you will get an error message indicating that smart card functions are not
available or smart card readers are not available, depending on the application.

The smart card is usually white on one side and colored on the other. Half of the
colored side is solid blue with a gold plated contact. Insert the gold plated contact
facing you and pointing down into the smart card reader.

When prompted to insert a TKE smart card, push the smart card all the way in until
the yellow light comes on. If the yellow light does not come on, remove the smart
card and insert it again.

When prompted for a PIN, Enter PIN will appear on the smart card reader display
window and the PIN pad cursor will flash. Enter your PIN using the numeric buttons
on the PIN pad. If a PIN is not entered promptly, the PIN prompt will time out and a
timeout message will be issued from the application. You must restart the task.

Other active buttons on the PIN pad are: The X button will cancel the PIN prompt;
Abort will appear on the smart card reader window and the application PIN prompt
will close. The <== is a backspace button; if you press the wrong button, you can
backspace using <==.

The other buttons on the PIN pad are not operational.

Zone Concepts

Smart card support provides the ability to generate and enter a cryptographic key

part and then transfer the generated key parts to different smart cards. Smart card
support for TKE is designed around the concept of a zone. This is done to ensure
the secure transfers of key parts.

The following are members of a zone:
* CA smart card

* TKE cryptographic adapter cards

* TKE smart cards

A member of a zone will be referred to as an entity. Entities have to be in the same
zone before they can exchange key information.
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Authentication

Zone creation

The Zone ID is checked only when exchanging key parts. Other functions using
TKE smart cards (TKE crypto adapter logon) do not check the zone ID of the TKE
smart card against the zone ID of the TKE cryptographic adapter. In other words, a
TKE smart card from a different zone may be used to logon to the TKE
cryptographic adapter in another zone, but the key parts on the TKE smart card will
not be accepted in this zone (because the TKE smart card is enrolled in another
zone).

and Secure Communication

The entity authentication and generation of session keys is established through a
public key exchange process between entities. Session keys are symmetric keys
that are sent with the message and protected by encryption with a public key from
the intended recipient. Session keys are used for both encryption and decryption of
key parts between entities. In order to have a secure line for communication, the
session keys are established between any two entities.

Export of sensitive information (from TKE smart cards or TKE cryptographic
adapters) is only done when encrypted under a session key. An entity will only
establish a connection with other entities that are members of the same zone as
itself. This prevents sensitive information from being used outside the zone.

A zone is created when you use the Smart Card Utility Program (SCUP) to create a
CA smart card. The CA smart card issues a root certificate for itself and has the
ability to issue certificates to other TKE entities. A zone can have only one CA
smart card (plus optional backup smart cards).

CA Smart Cards

The CA smart card is protected by two six-digit PINs. To ensure dual control, the
two PINs should belong to different people. Both PINs must be entered for all
functions requiring a CA smart card. A CA smart card is only used by the SCUP
application. If either of the PINs of a CA smart card is entered incorrectly 5 times,
the CA smart card will be permanently blocked. A CA smart card cannot be
unblocked. You will be unable to unblock any blocked TKE smart cards — which
means you will be unable to retrieve key parts from the blocked TKE smart card;
nor will you be able to enroll TKE cryptographic adapters in the zone.

We strongly recommend that you have backups of the CA smart card available. CA
backup smart cards are necessary in case the original CA smart card is misplaced
or destroyed.

Zone description

When a CA smart card is created, the user is prompted to enter an optional zone
description. The zone description can be up to twelve characters in length and
cannot be changed.

When you enroll an entity (a TKE smart card or a TKE cryptographic adapter), the
entity inherits the zone description from the CA smart card performing the
enrollment. Similarly, when you backup a CA smart card, the zone description will
be the same for both cards.

Zone identifier (ID)

When a CA smart card is created, the system will generate an 8-digit zone number,
a zone ID. The zone ID has similar properties to the zone description. The main
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Multiple zones

difference is that the zone ID is created by the system. It is derived from the system
clock of the workstation that created the CA smart card.

The TKE application uses the zone ID to check if two cards belong to the same
zone. The zone ID acts as an 'early warning' that an illegal action is being
attempted; if this check fails, the entities themselves will eventually detect and stop
the illegal operation.

It may be desirable to have multiple zones, especially if you have multiple TKE
workstations. In fact, it is recommended that separate zones be created for testing
and production systems. This prevents keys from getting intermixed.

Note that entities can only be a member of one zone at any given time.

Production Test

Figure 10. Multiple zones

shows multiple zones for a production and test system. The production
system has a remote TKE workstation enrolled; the test system does not. There are
separate CA smart cards associated with each system.

Enrolling an entity

To enroll an entity into a zone, you need the CA smart card for the zone. Entities
that the CA smart card enrolls are:

* TKE cryptographic adapters
* TKE smart cards

For TKE cryptographic adapters, there are local and remote enrollments. Your
primary TKE workstations and any local backups will use local enroliment. Any
offsite TKE workstations that do not have direct access to the CA, will use remote
enrollment.

During enroliment, the entity receives and stores the root certificate of the CA smart
card.

A certificate is issued to the entity, enabling the entity to:

Chapter 2. Using Smart Cards with TKE 37



 verify that other entities have been enrolled into the same zone
» prove to other entities that it has been enrolled into the zone.

The certificate is destroyed if you initialize (zeroize) the TKE cryptographic adapter.

The entity only establishes cryptographic connections with entities that can prove
they are in the same zone, by using a challenge-response protocol. It is not
possible for a component or entity to be in more than one zone. Different zones
cannot exchange key parts.

TKE smart cards
TKE smart cards can hold:
* A maximum of 10 key parts:
— |ICSF master key parts
— ICSF operational key parts
— TKE Cryptographic Adapter workstation master key parts
* One TKE Crypto Adapter logon key
* One TKE authority signature key

After the TKE smart card is initialized, enrolled in a zone, and personalized, it can
be used for the storage and exchange of key parts.

A TKE smart card is protected by a 4-digit PIN. Enter this PIN when prompted to
access the TKE smart card. If the PIN of a TKE smart card is entered incorrectly 3
times, the TKE smart card will be blocked. It is possible to unblock a TKE smart
card using SCUP and a CA smart card in the same zone. The unblocking process
resets the PIN failure counter on the TKE smart card. It does not reset or change
the PIN value.

The zone environment is the primary security feature of the TKE smart cards (not
the PIN). Even if an attacker gets access to several TKE smart cards containing all
key parts for a certain key and manages to get access to the PIN’s of those smart
cards, there will not be any access to the key parts. The TKE smart card will only
export its key parts to other entities in the same zone and the key parts will always
be encrypted during such transfers.

Before a TKE smart card can be used for logging onto a TKE workstation, a TKE
Crypto Adapter logon key must be generated on the TKE smart card and the TKE
administrator must create a user profile for the user.

TKE Smart Card description

During the personalization of a TKE smart card, a PIN and an optional 20 character
card description can be entered. The description can be changed if the TKE smart
card is personalized again. The description can be used to distinguish between TKE
smart cards.

Steps to set up a smart card installation

Before using TKE smart card support, a number of hardware and software
components must be installed and initialized correctly.

Note: This setup is done in conjunction with [Table 2 on page 41} The tasks defined
here replace task 9: Customize the TKE cryptographic adapter card.
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Table 1. Smart card task checklist

TASK

RESPONSIBLE

WHERE

COMPLETED

1. Attach the smart card readers

IBM CE

TKE workstation

2. Initialize the crypto adapter for
smart card use; see |“Initia|izing|

[TKE for smart cards” on page 217

TKE Administrator

TKE workstation

3. Create CA smart card (zone);
see [Initialize and personalize the]
ICA smart card” on page 279

TKE Administrator

TKE workstation

4. Backup the CA smart card; see
“Backup a CA smart card” on page]
281

TKE Administrator

TKE workstation

5. Initialize and enroll TKE smart
cards into the zone; see |“Initia|ize|
land enroll a TKE smart card” on|

|Qage 284.|

TKE Administrator

TKE workstation

6. Personalize TKE smart cards;
see [‘Personalize a TKE smart]
[card” on page 285/

TKE Administrator

TKE workstation

7. Enroll the local TKE
cryptographic adapter (and any
remote TKE cryptographic
adapters) in the zone; see |“Enro|l|
la TKE cryptographic adapter” on|

|Eage 287.

TKE Administrator

TKE workstation

8. CNM utility - generate TKE
Crypto Adapter logon keys; define
and load profiles; reset default
role. see|§ppendix C,|
[‘Cryptographic Node Management|
[Utility (CNM),” on page 233

TKE Administrator

TKE workstation

Chapter 2. Using Smart Cards with TKE

39



40 2z/0S V1R8.0 ICSF TKE PCIX Workstation User's Guide



Chapter 3. TKE Up and Running

To use the Trusted Key Entry key management system, several complex tasks must
be in place.

Table 2. TKE management system task checklist

(for PCIXCC/CEX2C , ensure LIC
code has been loaded)

TASK RESPONSIBLE WHERE COMPLETED
1. Configure the CCF and PCICC |IBM CE or Client Operations | Support Element
or PCIXCC/CEX2C Representative
2. Load CCF and PCICC or IBM CE or Client Operations | Support Element
PCIXCC/CEX2C configuration data | Representative

3. If operating in LPAR mode,

IBM CE or Client Operations

Support Element

commands (if z990 with May 2004
version or later of Licensed
Internal Code (LIC), z890, or
z9-109 with MCL 029 Stream
J12220, is installed)

configure the processor Representative
4. For PCIXCC/CEX2C, permit IBM CE or Client Operations | Support Element
each PCIXCC/CEX2C for TKE Representative

5. Update TCP/IP profiles for TKE

Client Network or VTAM
personnel and ICSF
Administrator

Host MVS System

6. Customize TKE Host Program
started procs (delivered with ICSF)

Client Network or VTAM
personnel and ICSF
Administrator

Host MVS System

7. Ensure RACF administration is
complete.

Client Security Administrator

Host MVS System

8. Start ICSF

Client Operations or System
Programmer

Host MVS System
Console

9. Customize the TKE
cryptographic adapter card

TKE Administrator

TKE workstation

10. TKE Application Customization

TKE Administrator

TKE workstation

For more information on tasks 1 and 2, see Support Element Operations Guide.

For more information on tasks 3 and 4, see:

» Support Element Operations Guide

* PR/SM Planning Guide

+ ['TKE Enablement for 7990, z890, z9-109, z9 EC and z9 BC Systems” on page]

2]

+ |Appendix G, “LPAR Considerations,” on page 311

For more information on tasks 5, 6 and 7, see|Appendix B, “TKE TCP/IP and Host]
[Considerations,” on page 225/ TKE uses TCP/IP for communication between the
TKE workstation and the MVS operating system.

For more information on tasks 9 and 10, see|Appendix A, “TKE Workstation Setup|
fand Customization,” on page 205.|
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Note: If using smart cards, refer to(Table 1 on page 39|

Workstation Logon: Passphrase or Smart card

If you have installed TKE V5.0, you must decide if you will logon with a passphrase
or with a smart card. You must decide if you will use group logon. Once these
decisions are made, go to the appropriate section:

+ Passphrase - see [Initializing TKE for passphrase” on page 210
+ Smart card - see [Initializing TKE for smart cards” on page 217

From the Framework tree on the left hand side of the page, click on Trusted key
Entry, then click on Applications, and then click on Trusted Key Entry 5.0.

The Crypto Adapter Logon window displays the profile IDs you can logon with;
these are the single and group profiles previously created.

This is your starting point.

Passphrase and passphrase group logon
Depending on how you have initialized your environment, the Crypto Adapter Logon
window will be displayed with Profile IDs that represent single and/or group
passphrase logon.

Crypto Adapter Logon EQK
Profiles suitable for logon
Prafile ID Prafile type Role |
ITKELSER Passphrase TEEUSEE -
PPCROUP Passphrase Croup TEEUSEE
1| [
Ok Cancel Help |

Figure 11. Crypto Adapter logon window with passphrase profiles

Steps for logging on are:

1. Select the Profile ID that you would like to use to logon to the TKE
cryptographic adapter.

2. Select OK

If you selected a single passphrase profile ID
1. The Passphrase Logon window will be displayed.

&4 Passphrase Logon

User ID : TKEUSER

Passphrase : | |
Ok Cancel

Figure 12. Enter passphrase for logon

2. Enter the passphrase for this profile ID and select OK.

Note: The passphrase is case sensitive.

42 2/0S V1R8.0 ICSF TKE PCIX Workstation User's Guide



If you selected a group passphrase profile ID
1. The Crypto Adapter Group Logon window will be displayed. This window
displays the number of members required for logon and the profile IDs available

for logon.

rdapter Group Logen

"PPGROLP

Group profile ID :

Il
UL L

Group members required for logon: \2

0

Group members ready for logon :

Group members :
Frofile ID Status
PPGEPM 1 =
PPGEPMZ2
il I
Cancel Help

Figure 13. Crypto Adapter group logon window with passphrase profiles

Select the member profile ID that you would like to use to logon to the TKE
cryptographic adapter.

3. Select OK
4. Enter the passphrase for this profile ID and select OK.

2.

Note: The passphrase is case sensitive.

B4 Passphrase Logon

UserID: |PPGRPHM1

Figure 14. Enter passphrase for logon

Information in the Crypto Adapter Group Logon window is updated to reflect that

Passphrase : |

the selected profile ID is now ready for logon
adapter Group Logon x|
Group profile 1D |PPCROUP ]
Group members required for logon : |2 |
Group members ready for logon : |1 |
Group members :
Profile ID Status
ready for logan -

PPGRPM 1
PPGRPM2

(0|
Ok Cancel Help
Figure 15. Crypto Adapter Group logon window with passphrase profile ready

6. Repeat steps 2-4 until the number of group members required for logon is met
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Note: If the group logon should fail, the Group members ready for logon is
reset to zero and group logon must start over.

Once the single or group passphrase logon is successful, the TKE application will
be opened for use.

You may use the predefined user profile, TKEUSER, for single passphrase logon or
another user profile with an equivalent role. If you choose to use passphrase group
logon, the TKE Administrator must create a passphrase group profile and add the
single user passphrase profiles to the group profile. The passphrase group profile
should be mapped to the TKEUSER role or an equivalent role. The single user
profiles that will be added to the group profile should be mapped to the DEFAULT
role. This is done to limit the services permitted to the single users outside of the

group. For details on creating single and group passphrase profiles see
[‘Cryptographic Node Management Utility (CNM),” on page 233

Smart card and smart card group logon

Depending on how you have initialized your environment, the Crypto Adapter Logon
window will be displayed with Profile IDs that represent single and/or group smart
card logon.

Crypto Adapter Logon
Profiles suitable for logon

Frafile ID Frofile type Rale
GCTKEL Smart Card SCTKEUSR =
SCTREGRP Smart Card Group SCTKEUSRE

[4]

Ok Cancel Help
Figure 16. Crypto Adapter Logon Window with smart card profiles

Steps for logging on are:

1. Select the Profile ID that you would like to use to logon to the TKE
cryptographic adapter.

2. Select OK.

If you selected a single smart card profile ID
1. The Smart Card Logon window will be displayed.

2. Insert the TKE smart card that contains the TKE crypto adapter logon key for
the selected profile ID and select OK
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Smart card logon
Insert TEE smart card for the profile SCTEEL in the smart

card reader 2.

Ok Cancel

Figure 17. Insert the TKE smart card

3. Enter PIN for the TKE smart card

B4 Smart card logon
Enter your PIN on the Smart Card Reader.

Figure 18. Enter smart card PIN

If you selected a group smart card profile ID

1. The Crypto Adapter Group Logon window will be displayed. This window
displays the number of members required for logon and the profile IDs available

for logon.

Crypto Adapter Group Logon [ =l

Group profile ID © SCTKEGRP \

Group members required for logon : \2 \ ‘

Group members ready for logon: 10

Group members :

Profile 1D ‘ Status

GCTKEL
GCTKEZ

[4]

1D

i- Ok Cancel Help
Figure 19. Crypto Adapter Group logon window with smart card profiles

2. Select the member profile ID that you would like to use to logon to the TKE
cryptographic adapter.
3. Select OK

4. Insert the TKE smart card that contains the TKE crypto adapter logon key for
the selected profile ID and select OK
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Smart card logon
Insert TKE smart card for the profile SCTEEL in the smart

card reader 2.

Ok Cancel

Figure 20. Insert the TKE smart card

5. Information in the Crypto Adapter Group Logon window is updated to reflect that
the selected profile ID is now ready for logon

=/

Crypto Adapter Group Logon

Group profile ID : SCTKECEP
Group members required for logon: 2
Group members ready for logon : 1

Group members :

Frofile ID ‘ Status
SCTREL ‘ready for logan -
GCTKEZ

Ok Cancel Help
Figure 21. Crypto Adapter Group logon window with smart card profile ready

6. Repeat steps 2-4 until the number of group members required for logon is met

Note: If the group logon should fail, the Group members ready for logon is
reset to zero and group logon must start over.

Once the single or group smart card logon is successful, the TKE application will be
opened for use.

You may use the predefined group smart card profile, SCTKEUSR, or another user
profile with an equivalent role. If you choose to use single smart card logon, the
TKE Administrator must create a single smart card user profile and map it to the
SCTKEUSR role or an equivalent role. If a smart card group profile is used, the
TKE Administrator must define single smart card user profiles to be added to the
group. The single user profiles that will be added to the group profile should be
mapped to the DEFAULT role. This is done to limit the services permitted to the
single users outside of the group. For details on creating single and group smart
card profiles see |Appendix C, “Cryptographic Node Management Utility (CNM),” on|

|page 233.|

With either passphrase or smart card logon, if you cancel the logon, TKE operates
under the DEFAULT role. Use of the DEFAULT role does not require a user profile.
Any user can use the services permitted by the DEFAULT role without logging onto
or being authenticated by the TKE cryptographic coprocessor. However, the
DEFAULT role is limited in the operations it is allowed to perform.
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Automated Crypto Module Recognition

For each host, the TKE workstation maintains a list of the installed crypto modules
(CCF and PCICC or PCIXCC/CEX2C). The list contains all the information required
to protect communication between the workstation and the crypto modules.

Whenever the user of the workstation connects to a host, TKE queries the host to
determine the installed cryptographic hardware. The resulting list is compared to the
contents of the crypto module file.

The user is notified if any of the following events occur:
* A new crypto module has been installed

» A crypto module has been removed

* A crypto module has been replaced

* A crypto module had its signature key pair regenerated (PCICC/PCIXCC/CEX2C
only)

* A crypto module has been moved from one slot to another (PCICC/PCIXCC/
CEX2C only)

Authenticating the CMID and CMPM

CCF

The crypto module ID (CMID) and the Crypto Module Public Modulus (CMPM) are
used by the TKE workstation for verification of the messages from the crypto
module.

At the very first communication between a crypto module and the TKE workstation,
the CMID and CMPM from the crypto module are displayed at the workstation. You
are to verify the CMID against the CMID on the enablement diskette and verify that
the enablement diskette was successfully loaded.

Press the Yes button if the CMID values are equal. The values are saved at the
TKE workstation for further communication with the crypto module. The crypto
module is marked as Authenticated.

Press the No button if the values differ. The crypto module is marked as Rejected
by user. You will not be able to work with the crypto module but you are able to
authenticate the module at a later time. To re-authenticate the module, select the
module. The CMID/CMPM window is displayed for you to accept or reject the
values.

The confirmation process is only performed once, at the initial logon. In the event
you replace your crypto chip, the confirmation process will have to be repeated.

PCICC/PCIXCC/CEX2C

For PCICC/PCIXCC/CEX2C crypto modules, the CMID and the type of the crypto
module is displayed.

To verify the CMID, you need to logon to your host TSO id. From the ICSF main
panel, choose option 1, Coprocessor Management. This panel will list all the
PCICCs or PCIXCCs/CEX2Cs available to this host. Verify the coprocessor index
and serial number with the information on the 'Authenticate crypto module' window
on TKE.
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Press Yes if the coprocessor index and serial number on the host match the index
and CMID on the window. The CMID value is saved at the TKE workstation for
further communication with the crypto module. The crypto module is marked as
Authenticated.

Press No if they do not match. The crypto module is marked as Rejected by user.
You will not be able to work with the crypto module but you are able to authenticate
the module at a later time. You select the crypto module and the CMID/type window
is displayed for you to accept or reject the values.

#4 Authenticate crypto module

g A new crypto module has been installed in index E34
Before accepting this Crypto Coprocessor crypto module you

should verify that the Crypto module ID is identical to the
value supplied to you by IBM.

Crypto module type :
Crypto Coprocessor

Crypto module ID :
Q306007

Crypto module Part Number :

Description :
IBM 4758-XXX Test module

Do you accept the crypto module?

[Fodl [ w |

Figure 22. Authenticate Crypto Module for PCIXCC/CEX2C

Attention! The crypto module type for the PCIXCC and CEX2C on the TKE panels
will be Crypto Coprocessor.

It is not necessary to authenticate the Crypto Module Public Modulus. The CMPM is
authenticated by a chain of certificates. The public key of the root certificate is
hardcoded into the TKE workstation code. The user is informed of the result of the
verification process.

The IBM CE may need to reload code in the PCICC or PCIXCC/CEX2C card on the
host for maintenance. If this is done, at the first communication with the PCICC or
PCIXCC/CEX2C, it is sometimes necessary to reauthenticate the crypto module
because the signature key has been regenerated.

Initial Authorities

All commands from the workstation are signed. An initial signature key relationship
must be established between the workstation and the crypto modules before the
first command is issued. The Default Signature Key is used for this task.

For CCF, the initialization process loads the public part of the authority default
signature key to authority registers 00—13.
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Attention: Authorities 14 and 15 cannot be used for signing commands until their
default signature keys have been changed. Either these authority signature keys
must be changed or they should not be defined in the Signature Requirements
Array as authorized or required to sign commands.

For PCICC/PCIXCC/CEX2C, the initialization process creates the authority 00 and
assigns the authority default signature key to this authority.

Backing Up Files

Starting with TKE 5.0, the Backup Utility supported on previous versions of TKE
(which backed up host.dat, group.dat, 4758 pre-defined roles and profiles, 4758 key
storages, TCP/IP information, and emulator session configurations) is no longer
available. If you want to have specific files saved to diskette or DVD-RAM for
backup purposes other than install/recovery (Backup Critical Console Data), files
can be manually backed up using the TKE File Management Utility. This is an
activity that should be performed when you have completed your initialization tasks
and any time you make changes to TKE-related information. Files that should be
backed up are listed below. In addition, any user defined roles and profiles,
authority signature keys saved to binary files, and master and Operational key parts
saved to binary files should also be backed up. A diskette is shipped with your TKE
workstation for this purpose (TKEWS Binary Keys) or a customer supplied
DVD-RAM may be used. If using a DVD-RAM, it must be formatted with a volid of
TKEDATA. See [‘Backup Critical Console Data” on page 373 and ['TKE File]
[Management Utility” on page 355 for more information.

Workstation Files
This is a list of the TKE application specific files.

+ HOST.DAT — contains definitions for the host sessions and related host data. It
also contains the CMID for each crypto module and public modulus.

* GROUP.DAT — contains definitions for groups.

These files should be backed up whenever definitions for any of the above are
changed.

The supplied roles and profiles for the TKE crypto adapter are:
— Passphrase
- TKEUSR42.ROL
- TKEADM50.ROL
- KEYMAN1.ROL
- KEYMAN2.ROL
- TKEUSER.PRO
- TKEADM.PRO
- KEYMAN1.PRO
- KEYMAN2.PRO
— Smart card
- SCTKEUSR.ROL
- SCTKEADM50.ROL
- MIGUSER.ROL
- SCTKEUSR.PRO
- SCTKEADM.PRO
- MIGUSER.PRO
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Host Files

Any user defined roles and profiles for the TKE crypto adapter should be backed
up.

desstore.dat and desstore.NDX — DES Key Storage used to hold IMP-PKA keys
for encrypting RSA keys, IMPORTER keys, and EXPORTER keys used by the
4753 Migration Utility.

pkastore.dat and pkastore.NDX — PKA Key Storage used to hold one authority
signature key.

One file on the MVS Host system should be saved. The name of the crypto
module dataset is defined in the JCL used to start the TKE Host Transaction
program.

crypto module dataset — contains definitions for the Crypto Modules, Domains,
and Authorities

This file is updated any time the user makes changes in the TKE application
windows and crypto module notebooks for the above. It contains crypto module
descriptions, domain descriptions and authority information (name, address,
phone, e-mail, et cetera).

This file will be backed up on whatever schedule your installation uses to dump
user data. Depending on this schedule, you may want to back the file up more
frequently if many changes are being made.

There are other host installation files that contain the TKE programs that execute on
the host. Once these files have been installed, no updates to them are required.
The weekly system dumps should be sufficient for backup of these files. These are
the files documented in|Appendix B, “TKE TCP/IP and Host Considerations,” on|
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Chapter 4. Main Window

Trus

The main purpose of this window is to select a crypto module or a group of crypto
modules. From the main window, you also create host definitions and group
definitions.

Note: Many screen captures now show smart card as an option. If you are not

using smart card support, smart card will not be an option for selection on
the applicable windows.

ted Key Entry P o

Function Litilities

Preferences | Help

Hosts

Host ID

¥ Blind Key Entry
[ Floppy Drive Only
[J Enable Tracing

¥ Enable Smart Card Readers

[0 Show ZKA ECM bits

Modules
st 10 M index Status Description |

A7 T

Groups

Group ID

Cescription ‘

A7 T

L

Signature key NOT loaded \

Figure 23. TKE Preferences

Update TKE Preferences using the Preferences menu in TKE. By default only Blind
Key Entry is enabled. To customize the TKE workstation update the TKE
Preferences using the Preferences menu in TKE. Click on Preferences on the
toolbar. Enable/Disable Blind Key Entry, Floppy Drive Only, Enable Tracing, Enable
Smart Card Readers, and Show ZKA ECM bits as appropriate. Preferences are
enabled or disabled by clicking on the check box. A check indicates that the
preference is enabled. For details on each of the TKE Preferences, see
[Customization” on page 67}

The main window has three containers labeled Hosts, Groups and Crypto Modules.
All containers are blank until you create a host.

Once you have created a host, decide if you will be working with a single crypto
module or a group of crypto modules. If you are working with a single crypto
module, you will need to open the host defined in the Hosts container. If you are
working with a group, disregard the host container and double-click or open one of
the groups defined in the group container.

Note the message in the lower right corner that the signature key is not loaded. See
[‘Load Authority Signature Key” on page 60|

Host Logon

To logon, double-click on the host entry. If working with a crypto module group,
double click on the group. When you open a group in the TKE main window, you
must logon to all hosts that are to be accessed within that group.
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The Logon panel is displayed for the host logon.

HostID G118
Host description Test system

Hostuser ID |
Password

[T] Enable Mixed Case Passwords

Figure 24. Host Logon Window

Enter your RACF-defined TSO host userlD and password. This is the userID of the
TKE administrator.

Beginning with z/OS V1 R7, mixed case passwords are supported by RACF. If the
Enable Mixed Case Passwords check box is enabled on the Log on to Host panel,
passwords will be used as entered and will not automatically be folded to upper
case. You must enter your password as it was defined in the RACF database. If
your system does not support mixed case passwords and you check the Enable
Mixed Case Passwords check box, you must enter your password in upper case or
you will get "'The password is incorrect’ error.

Note: If your TSO password has expired, the message 'The password has
expired. Change password from TSO' is displayed. Change your password
and perform the logon again.

Working with Hosts

The Hosts container lists the host IDs currently defined to the workstation. You can
add, change, delete or open host definitions from this container. When you select
your host (by double-clicking or selecting open), the host logon window appears if
you have not yet logged on. The crypto modules available for that specific host
appear in the crypto module container.

Creating a Host

The TKE workstation keeps a host definition for every host it can connect to. By
clicking the right mouse button in the Hosts container, a popup menu is displayed
allowing you to choose Create Host.

g8 Create Hew Host

Host ID |
Host description |
IP Address |

Port number

| 0K H Cancel H Help ‘

| |Trusted Kew Entry

Figure 25. Create Host

The host definition contains the following information:
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* Host ID — Mandatory free format text used for referencing the host within TKE.
* Host Description — Free-format text for your own use

* |P address — Address in decimal-dot notation of the host where the TKE Host
Transaction Program server is running.

* Port Number — Application port number reserved in your host TCP/IP profile for
the TKE Host Transaction Program server. See|Appendix B, “TKE TCP/IP and|
[Host Considerations,” on page 225

LPAR Mode Considerations for CCF Systems

It is not necessary to define each logical partition to TKE. During the setup of the
PR/SM environment, one partition will have Enable modify authority activated. It will
most likely be the first partition you define, and this is the partition you must identify
to TKE. The control domain for this partition will contain its own domain as well as
any other domain where you want to load keys. The controlling partition will be able
to load DES and PKA master keys for itself as well as for the other domains in its
control.

For additional details on LPAR setup, refer to|Appendix G, “LPAR Considerations,’|

on page 311.

LPAR Mode Considerations for PCIXCC/CEX2C Systems

It is not necessary to define each logical partition to TKE. One partition will have its
control domain contain its own domain as well as any other domain where you want
to load keys. This domain must be unique and must have access to all
PCIXCC/CEX2C cards that it is to control.

For additional details on LPAR setup, refer to[Appendix G, “LPAR Considerations,’|

Changing Host Entries

Highlight the host definition in the hosts container that you want to change and click
the right mouse button. A pop-up menu is displayed. Select Change Host.

You can change the host description, IP address and port number. You cannot
change the host ID. If you want to change the host ID, you must delete the host
definition. You then create a new host ID.

Deleting Host Entries

To delete a host definition, highlight the host you want to delete from the hosts
container and right mouse click. A pop-up menu is displayed. Select Delete Host. A
confirmation message is displayed. Select Yes to confirm the delete request. Select
No to cancel the delete.

Working with Crypto Modules

The crypto module container displays the crypto modules that are available for use
with the host or group you have selected. The container lists the hostID that the
crypto module belongs to, the crypto module index, the status of the crypto module
and the description of the crypto module. You are not able to change any of these
fields from this container.

[Figure 26 on page 54| and [Figure 27 on page 54]illustrate the main window after
logging onto a host. Note that in this screen capture, the signature key has not
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been loaded. To load a signature key, refer to[‘Load Authority Signature Key” on|

(J] Trusted Key Entry 7 o O
Function Utilities Help
Hosts Crypto Modules
Haost 1D Description HaostID Ch index Status Descriptian
ESS5T1 Wicom POKMMTLA WATERPT |00 Authenticated  [%M16FP1 CO0 on native machine
ESSST3  |Wicom POKWMTLA WMIERT |C01 Authenticated  |VM16P1 CO1 on native machine
YM16F1 GE native machine WIMIERT P04 Authenticated  |VM16FP1 P04 on native machine
Groups
Group ID Description
ESSSTI ..

Cland C1 on ESS5T1 Yicom
FCICCs on native machine

Systest P

Function Utilities Preferences Help

Hosts

Crypto Modules
Huost D | Description Hast 1D CM inclex Status Description |
G118 |Tes| system G118 EOS Authenticated |
G118 E0& Authenticated
G118 X04 Authenticated
Groups
Group 1D Description
Help
| I Signature key NOT loaded ‘

Figure 27. Main Window with Crypto Modules - PCIXCC/CEX2C

As discussed in [‘Automated Crypto Module Recognition” on page 47 |the Crypto
Module container is filled in automatically once you have logged onto the host or
hosts.

If you have selected a host to work with, you will be able to choose the crypto
module you would like to open by highlighting it.
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If you have chosen a group, when you highlight a crypto module all of the crypto
modules will be highlighted.

Double-clicking on a crypto module opens the crypto module notebook.

Working with Groups

You manage groups in the TKE main window. You can add, change or delete group
definitions from this container.

The group concept allows you to perform operations on a set of crypto modules as
you would on a single crypto module. A group can include crypto modules from
different hosts. All modules within a group must be of the same type: either all CCF
crypto modules, all PCICC crypto modules or a combination of PCIXCC and
CEX2C crypto modules.

Attention! The representation for the PCIXCC and CEX2C crypto modules on the
TKE panels is Crypto Coprocessor.

It is highly recommended that you create groups for easier management of your
cryptographic coprocessors.

In general, you work with the group as if it is a single crypto module. For example,
you will see only one New Master Key register. The values displayed for a group
are the values of the master crypto module. You select the master crypto module
when you create the group.

It is important that the crypto modules within a group are in the same state (for
example, identical signature requirements and authority signature keys for CCF
crypto modules and identical roles for PCICC or PCIXCC/CEX2C crypto modules).
This is achieved by always working on the crypto modules through the group
interface. When doing access control administration or loading master keys, you
should always work with groups to ensure that the values are the same across all
crypto modules.

For several CCF and PCIXCC/CEX2C tasks, you must create a group where only
one CCF or PCIXCC/CEX2C crypto module for a host is present. This group will be
used for loading operational key parts to the key part queue (CCF only), loading
RSA keys to the PKDS and loading RSA keys to a host data set.

PCIXCC/CEX2C only: If a group is selected when loading operational key parts to
key part registers, only the master PCIXCC/CEX2C will be loaded, even if the group
contains other PCIXCCs/CEX2Cs.

When TKE performs a group operation and it is not successful, two new groups are
created. One group contains the updated crypto modules and one group contains
the crypto modules where the update failed. This allows you to operate on the
crypto modules of the failed group until the update is successful. You may then
delete the two new groups as you wish.

When you work with a group, you disregard the host container and double-click or
open one of the groups defined in the group container. You will be prompted to
logon to the hosts associated with the crypto module members of the group.

When you open the crypto modules of a group, a crypto module notebook is
displayed.
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Creating a Group

To create a new group, right-click the mouse button in the Groups container. Select
New and the Create Group window opens.

Attention! The representation for the PCIXCC and CEX2C crypto modules on the
TKE panels is Crypto Coprocessor.

B4 Create Mew Group
Group ID

Group Description | |

Type
@ CCF
) PCICC
" Crypto Coprocessor
Host Crypto Modules In Group
- | Hast ID [ CM index [ Master Module |
Crypto Modules Available On Host
CM index [ Description [
-
Add >>
<< Remove
4 |
| Close | | Cancel | | Help |

Trusted Key Entry

Figure 28. Create Group

Enter your information in the entry fields:

1.

Group ID - Name of the group (mandatory)
Description - Optional free text description

2.
3. Type of crypto modules to be in the group - CCF, PCICC or Crypto Coprocessor
4

Select the crypto modules to be in the group:

a. In the Host drop down list, select the host that has the crypto modules you
want to include in the group.

You will be prompted to logon to the selected host if you are not currently
logged on.

b. In the Crypto Modules Available on Host container, select the crypto
modules you want in the group.

c. Press Add, and the crypto modules selected now appear in the container:
Crypto Modules in Group

d. Repeat the prior three steps as required.

5. Select the crypto module to be the Master Module by right-clicking on the

module in the Crypto Modules in Group container. Set as Master Module
appears and sets the Master Module of the group. Unless you change it, the
first crypto module added to the group becomes the master module.

6. When finished, press Close.
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Changing a Group

To change a group, highlight the group you want to work with in the Groups
container and then right-click the mouse button. Select Change and the Change
Group window opens.

Attention! The representation for the PCIXCC and CEX2C crypto modules on the
TKE panels is Crypto Coprocessor.

B4 Change Group
Group ID Cryptos
Group Description |Crypt0 Coprocessar Group| |
Type
) CCF
) PCICC
% Crypto Coprocessor
Host Crypto Modules In Group
- | Host D CM index Master Module
G11 H00 Yes -
Crypto Modules Svailable On Host G #05 Mo
- — G11 0B Na
CM index [ Description [
- G11 HOT Mo
Add >>
<< Remove
4 D] |
| Close | | Cancel | | Help |
| Trusted Key Entry

Figure 29. Change Group - Crypto Coprocessor (PCIXCC/CEX2C)

To change the description, edit the field:
» Description - Optional free text description

To add more crypto modules to the group:

1. In the Host drop down list, select the host that has the crypto modules you want
to add to the group.

You will be prompted to logon to the selected host if you are not currently
logged on.

2. In the Crypto Modules Available on Host container, select the crypto modules
you want in the group.

3. Press Add, and the crypto modules selected now appear in the container:
Crypto Modules in Group.

4. Repeat steps 1-3 as required.

To remove crypto modules from the group, select the modules in the container
(Crypto Modules in Group) and press Remove. If you remove the master module,
you are prompted to set another master module.

When finished, press Close.

Changing the Master Crypto Module
The Change Group window displays all the crypto modules in the group and
indicates which crypto module is the master.
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To change the master crypto module for a group, highlight the crypto module you
want to set as the master module and right mouse click. Select Set as Master
Module. The master module is changed.

Comparing Groups
Comparing groups is not done from the main window. It does not compare groups
but compares the crypto modules within a group. To compare the crypto modules,
highlight and click on a specific group in the Groups container from the main

window. The crypto module group notebook opens. Click on Functions and select
Compare Group.

TKE reads and compares information from all the crypto modules in the group. The
process can be cancelled at any time from the progress window display.

All crypto module data is compared, with the exception of the descriptive
information for crypto modules, domains, roles and authorities. Transport key hash
patterns and information unique by nature (for example, crypto module ID) are also
not compared.

&4 Group Compare

Group name Systest CCFs
Status Crypto Module Mismatch

T Mismatches
@ [ Access control
@ [ Signature requirements array
[y LkP
[ ZD
[y LoS/LCR
[} Domain Change Enakle mask
O [ Authorities
© [ Damain 00
© [ Damain 03
© [ Damain 06
© [ Damain 11
© O Damain 13
© O Damain 15

| Close H Help ‘

| Trusted Key Entry

Figure 30. Compare Group - CCF
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B4 Group Compare

Group name G11-PCIX
Status Cnypto Module Mismatch

[ Mismatches
@ ] Domain 00
@ [ Keys
D Mew symmetric master key, status
D Old symmetric master key, hash pattern

Trusted Key Entry

Figure 31. Compare Group - PCIXCC/CEX2X

The Group Compare window displays the results:

* Group Name — Name of the group that has been compared
» Status — Overall result of the compare operation

* Mismatches — A list of properties that do not match

If you select a property, a list of all crypto modules in the group with the actual
values for that property is displayed.

TKE Functions Supporting Groups

Attention! The representation for the PCIXCC and CEX2C crypto modules on the
TKE panels is Crypto Coprocessor.

All displayed values in a notebook for a group are retrieved from the master
module. You can perform the following crypto module functions from a group
notebook:

» Access Control maintenance (CCF group)
» Change authority
» Create and delete authority (PCICC or Crypto Coprocessor group)
» Create, change and delete role (PCICC or Crypto Coprocessor group)
» Zeroize domain
* Domain Controls
» Enable/disable crypto (PCICC or Crypto Coprocessor)
* Domain keys:
— Load key part to new master key register
— Load key part to key-part queue (CCF - single group)
— Clear key register
— Clear key-part queue (CCF - single group)
— Set master key
— Load RSA key to PKDS (CCF and Crypto Coprocessor - single group)
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— Load RSA key to dataset (CCF and Crypto Coprocessor - single group)
— Load operational key part to key part queue (CCF - single group)
— Load operational key part to key part register ( Crypto Coprocessor)
— View operational key part registers (Crypto Coprocessor)
— Clear operational key part registers (Crypto Coprocessor)
* Co-sign
» Change signature index for notebook
* Release crypto modules

Function

The following selections are available from the Function pull-down:
* Load Signature Key...

» Define Transport Key Policy...

» Exit

Load Authority Signature Key

This function is used to load the authority signature key. This signature key is active
for all operations until explicitly changed by clicking on this option again to load a
different authority signature key. The TKE main window displays messages in the
lower right hand corner of the screen. Either SIGNATURE KEY NOT LOADED or
SIGNATURE KEY LOADED is displayed.

A dialog box is displayed for the user to select the source of the signature key:

g4 Seled Source

® Smart card
() Binary file

i) Key storage
() Default key

| Continue || Cancel || Help |

| | Trusted Key Entry |

Figure 32. Select Signature Key Source

Attention: Authorities 14 and 15 cannot be used for signing commands until their
default signature keys have been changed. Either these authority signature keys
must be changed or they should not be defined in the Signature Requirements
Array as authorized or required to sign commands.

If you specify Key storage or Default key, you then specify the authority index to
be used.
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4 Spedify authority index

An authority index is going to be used with the key.

Leawve the field below unchanged to use the index specified
in the key file, or enter a new index.

Authority index to be used | 1

| Continue H Cancel H Help ‘

| Trusted Key Entry

Figure 33. Specify Authority Index
Press Continue.

If you select Binary file, you must either select a file from the container or enter a
file name. Additionally, you must enter a password. This assumes the signature key
was previously generated and saved to a binary file.

To create a signature key, see [‘Generating Authority Signature Keys” on page 85

Load Signaturs Key ]

Password |*=rem=rees |

T () Floppy Drive

® TKE Data Directory

Files
hostdat =
'John_Doe_Authority
[trace.txt

File Name : |Juhn,Dae,Au(harw

| Trusted Key Entry

Figure 34. Load Signature Key

You then select the authority index .

If you select Smart card, you will be prompted to insert your TKE smart card into
smart card reader 2.

B4 Load Signature Key

Insert TKE smart card with a signature key in smart card reader

Figure 35. Load signature key from TKE smart card
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You will be prompted to enter the PIN.

4 Load Signature Key

Enter 4 digit PIN on smart card reader 2 PIN pad.

Figure 36. Enter PIN for TKE smart card

You then select the authority index (Figure 33 on page 61).

Define Transport Key Policy

The master key and operational keys are protected by encryption during the
transfer between the workstation and the crypto modules. The transport encryption
keys (key-encrypting keys) are established by means of a Diffie-Hellman key
agreement mechanism.

This selection lets you choose the transport key policy to follow.

&4 Seled Transport Key Policy

® Always use current transport key.

) Always establish new transport key based on
current values of Diffie-Hellman modulus and
generator polynomium.

) Always generate new values of Diffie-Hellman
modulus and generator polynomium and establish
new transport key.

‘ OK H Generate new DH values. .. H Cancel H Help |

Figure 37. Define Transport Policy

The default is to use the current transport key. This choice is recommended for
performance reasons. If a valid transport key is in place, the key can be reused,
thus avoiding the key agreement protocol actions.

If a valid Diffie-Hellman modulus (p) and generator (g) public values exist in the
workstation and you want to establish a new transport key, you can choose to reuse
the existing p and g values. This avoids the time-consuming generation of these
values. There are no security exposures to reusing the Diffie-Hellman modulus and
generator values.

Lastly, you can choose to generate a new pair of Diffie-Hellman modulus and
generator values, which in turn will be used for establishing a new transport key.
Generation of a new pair of modulus and generator values is very time-consuming if
the modulus size is large.

Select the required option by pressing the radio button and then press OK.

Anytime you wish to create new transport keys, press Generate new DH values.
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Exit

Selecting Exit closes the TKE application.

Utilities
The following selections are available from the Utilities pull-down:
* Manage Workstation DES keys...
* Manage Workstation PKA keys...
* Manage smart card contents...
* Copy smart card contents...
These utilities are used for managing the keys in the two workstation key storage
areas, managing smart cards and copying smart cards. When managing DES or

PKA keys is selected, a window opens displaying the keys stored in the key storage
as labels and their attributes.

Manage Workstation DES Keys

TKE uses the TKE workstation DES key storage for holding the RSA key-encrypting
keys (IMP-PKAs) and other key-encrypting keys used by the 4753 Migration Utility.

¥4 TKE Workstation DES Key Storage

Keyw Label Key Tvpe Key Attributes
IMPPEA RSAKEYGEN KNOWMN KEY WALUE  |[EXPORTER | IMEX OPEx EXEX EXFORT. NO-*FORT ANY,DOLUEBLE
IMPFEA RSARETENCENOWNEEYYALUE  |[EXFORTER  |IMEX OFEX EXEXEXAPORT AFORT-0OK.ANY, DOUBLE

Al

| Close H Help ‘

| Trusted Key Entry |

Figure 38. TKE Workstation DES Key Storage Window

The TKE Workstation DES key storage displays:

* Key label

* Key type
Key-encrypting keys written to key storage will have the key type EXPORTER.
Keys with key type No_Key are empty and can be deleted. There may be other

key types if the TKE cryptographic adapter card is used for purposes other than
TKE.

* Key Attributes
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Here is a list of some of the key words used by the TKE Crypto Adapter card for
defining the control vector.

— KEY-PART - The initial key part has been loaded but the last key part has not
been loaded.

— NO-XPORT - The key cannot be exported. IMP-PKAs used to protect
generated RSA keys have this attribute.

— XPORT-OK - The key is exportable. IMP-PKAs used to protect entered RSA
keys have this attribute.

e Control vector - The CCA control vector.
e Created date and time
» Updated date and time

Deleting an Entry
If you select an entry, and right-click, a popup menu is displayed. The only selection
is Delete key. This allows you to permanently delete a key from key storage.

Manage Workstation PKA Keys
TKE uses the TKE workstation PKA key storage for holding one signature key.

g TKE Workstation PKA Key Storage

ey Label key Type Key Token Type | Creation Date/Time | Update Date/Ti
TKEAUTHORIT.SIGHNATURKEY.D0000  |RSA_PRINY  |[INTERMNAL 2000-03-28 16:26:43  |2000-03-28 16:26:43

E [»

| Close H Help ‘

| Trusted Key Entry|

Figure 39. TKE Workstation PKA Key Storage Window

The TKE Workstation PKA key storage displays:
* Key label
* Key type

The type of key is one of the following:

— RSA-PRIV - A token holding the private and public key part of a PKA key pair.
This is the key type for a signature key.

— RSA-PUB - A token holding the public part of a PKA key pair.
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Manage smart

— RSA-OPT - A token holding the private and public part of a PKA key part in
optimized form.

* Key Token Type
The type of token is one of the following:

— Internal - The key token is internal and the key value is enciphered under the
TKE Crypto Adapter master key.

— External - The key token is external and the key value is either enciphered or
unenciphered by a key-encrypting key.

— No_Key - The key token is empty.
» Created date and time
* Updated date and time

Deleting an Entry

If you select an entry, and right-click, a popup menu is displayed. The only selection
is Delete key. This allows you to permanently delete a key from key storage.

cards

This function allows you to view or delete keys from your TKE smart card.
1. At the prompt, insert your TKE smart card into smart card reader 2.

2. The utility reads the TKE smart card contents. This may take some time. The
card ID is displayed followed by the card description. Verify that this is the TKE
smart card you want to work with.

Manage TEE smart card contents

I
[

Card ID 1EF574DAS
Zone description TKESO UT
Card description

Card contents

Key type Description Origin MDC4

Crypto adapter Logon key SCTKEL Smart card

TKE Authority key 1, SCTKE1 Smart card

ICSF symmetric master key part Key part 1 Crypto adapter |90SOAE7SEEE89ES461EDACDEADOSAERD
ICSF symmetric master key part Key part 2 Crypto adapter [B62D02900A53230B3F7FF181E9BE76061
ICSF symmetric master key part Key part 3 Crypto adapter |[19EQ0ASTOFEASFOCDAFESFS9418D099E
ICSF symmetric master key part Key part 9 Crypto adapter |[7ESOFBE4S5AFEAS0441444B099DECODCE
ICSF symmetric master key part Key part 4 Crypto adapter AFO776FEDEAFE18F35EES7ODAMATITID
ICSF symmetric master key part Key part S Crypto adapter (OALIFDESOY2AD0OTEAC1SCAFZ5806B0132
ICSF symmetric master key part Key part 6 Crypto adapter |BEFGB2C11E71726BC48FS2CEFAFD7ERS
ICSF symmetric master key part Key part 7 Crypto adapter |S9793C428209C4AFEFE38733782606339
Operational key part, DATAM Operational Key -... Crypto adapter |SA3EAZ73CF4ES2B7ACESSA1DZAE5BA42
4 [»

Close Help
Trusted Key Entry

Figure 40. TKE smart card contents

The information displayed for a TKE smart card is:

Card ID
Identification of TKE smart card

Card description
Description of the TKE smart card; entered when the smart card was
personalized

Card contents

Key type, Description, Origin, MDC4, SHA-1, ENC-ZERO, Control
Vector (for operational keys only), and Length

3. Highlight the keys you want to delete. By holding down the control button you

can select specific entries on the list with your mouse. By holding down the shift
button you can select a specific range of entries on the list with your mouse.
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N o ok

Right click and select Delete.

Confirm the delete.

Enter the 4-digit PIN.

You will get a message that the command was executed successfully.

Copy smart cards

This function allows you to copy keys and key parts from one TKE smart card to
another TKE smart card. You can copy the following types of keys:

Crypto adapter logon key

TKE authority key

ICSF operational key parts
ICSF master key parts

Crypto adapter master key parts

Note: The two TKE smart cards must be enrolled in the same zone; otherwise the

1.

copy will fail. To display the zone of a TKE smart card, exit from TKE and
use either the Cryptographic Node Management Utility 3.10 SC or the Smart
Card Utility Program 1.20 under Trusted Key Entry Applications on the
Framework. See [‘Crypto Node Management Batch Initialization 3.10SC” on|
[page 343| or[Appendix D, “Smart Card Utility Program (SCUP),” on page 277|

Insert the source and target TKE Smart Cards into the appropriate smart card
readers.

B4 Copy smart card contents

Insert source TKE smart card in smart card reader 1.

Figure 41. Enter source TKE smart card for copy

B4 Copy smart card contents

Insert target TKE smart card in smart card reader 2.

Figure 42. Enter target TKE smart card for copy

2.

The utility reads the TKE smart card contents. This may take some time. The
card ID is displayed followed by the card description. Verify that these are the
TKE smart cards you want to work with.

The following lists the information displayed for a TKE smart card:

Card ID
Identification of TKE smart card

Card description
Description of the TKE smart card; entered when the smart card was
personalized

Card contents
'Key type, Description, Origin, MDC4, SHA-1, ENC-ZERO, Control
Vector (for operational keys only), and Length
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3. Highlight the keys that you want to copy. By holding down the control button you
can select specific entries on the list with your mouse. By holding down the shift
button you can select a specific range of entries on the list with your mouse.
Click on the Copy button or right click and select Copy.

Note: Smart card copy does not overwrite the target TKE smart card. If there is
not enough room on the target TKE smart card, you will get an error
message. You can either delete some of the keys on the target TKE
smart card (see [‘Manage smart cards” on page 65) or use a different

TKE smart card.

Copy smart card contents X

Card ID B2A4B2E1S Card ID 0OBF5EC315
Zone description TKESO UT Zone description TKES0 UT
: Card description TKE2 Card description TKE3
Card contents Card contents
Key type 8 Key type Cescription origin MDC4
rypto adapter Logon key CTKEZ
THE Authority key __ [7, SCTKE2 |

Jperational key part, DAT
Jperational key part, |

Gy =3
| ATAMY 21
perational key part, IKEVALAT |Operational Wil copy >o
p | Cony >> |
iy

_|Operational key part,

perational keai C
Inerational key COPY e
goperational key part, =L

{EIEIFEEL
Jperat

~|operational

Trusted Key Entry |

Figure 43. Select keys to copy

4. At the prompts, enter the PINs for the TKE smart cards on the smart card
reader PIN pads. The keys will then be copied to the target TKE smart card.
The target TKE smart card contents window is refreshed.

TKE Customization
After installation of the TKE workstation a number of parameters can be customized
by using the TKE Preferences menu.

Blind Key Entry
Controls if key values entered at the TKE keyboard are displayed or hidden.
With hidden entry, a * character is displayed for each entered hexadecimal
character.

Ensure the menu item is checked if you want hidden entry; otherwise uncheck
the menu item.

Enable Tracing
Activates the trace facility in TKE. The output can be used to help debug
problems with TKE. Do not check this menu item unless an IBM service
representative instructs you to do so.

When checked, TKE produces a trace file named trace.txt in the TKE Data
Directory. Every time TKE is restarted, the trace.txt file is overwritten and a new
file is created.

Enable Smart Card Readers
Enables the smart card option for TKE.

If the menu item is unchecked, TKE will hide all smart card options from the
user.
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Note: The TKE application must be closed and reopened for this change to
become effective.

ZKA Compliance
ZKA compliance requires specific TKE behavior.

Floppy Drive Only
Specifies where files can be retrieved and stored.

Ensure the menu item is checked if you want to restrict access to the floppy
drive only; otherwise uncheck the menu item.

For ZKA compliance, this check box must be checked.

Show ZKA ECM Bits

Controls whether or not to display two additional CCF ECM (Environment
Control Mask) bits when working with the CCF Domain Controls task:

* Reset Domain
* Load Clear Master Key
For ZKA compliance, this check box must be selected. Further, for the CCF

Domain Controls, the only ECM bit that should remain enabled is Cryptographic
functions. All other ECM selections must be disabled.
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Chapter 5. Crypto Module Notebook

Once you select a crypto module or group of crypto modules, the crypto module
notebook opens on the General tabular page.

The notebook is the central point for displaying and changing all information related
to a crypto module. It is used for single crypto modules as well as groups of
modules. The contents of some of the pages vary slightly depending on this. The
information on the page also varies depending on the type of the modules: CCF,
PCICC or PCIXCC/CEX2C.

Note: Many screen captures now show smart card as an option. If you are not

using smart card support, smart card will not be an option for selection on
the applicable windows.

(J] CCF Crypto Module Administration : YM16P1 / C01 7 =

C01, CCF crypto module

Figure 44. CCF Crypto Module Administration Notebook - General Page

General

The contents of this page are:
» Description

An optional free text description displayed in the crypto module container at the
main window. This description is saved in the crypto module data set specified in
the TKE host transaction program started procedure on the host. In order to
change the description, edit the field contents and press Send updates.
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* Host or Group ID

* Host or Group Description

* Crypto Module Index
Together with the crypto module type, the index uniquely identifies the crypto
module within a host. For CCF crypto modules, the index value is 00 or 01. For

PCICC/PCIXCC/CEX2C crypto modules, the index value is 00 through 63. There
is no crypto module index for a group.

* Crypto Module Type

+ Status (PCICC and PCIXCC/CEX2C )
A PCICC or PCIXCC/CEX2C crypto module is either enabled or disabled. When
a PCICC or PCIXCC/CEX2C crypto module is enabled, it is available for
processing. From this page you change the status of the module, by pressing the
appropriate button. Enable is a dual-signature command and another authority
may need to co-sign. Disable is a single signature command.
Disabling a PCICC or PCIXCC/CEX2C crypto module disables all the
cryptographic functions for a single PCICC or PCIXCC/CEX2C crypto module (or
group of PCICC or PCIXCC/CEX2C crypto modules). This disables the crypto
module for the entire system, not just the LPAR that issued the disable.

(J] PCICC Crypto Module Administration : YM16P1 / P02 i

e

PCICC POZ on V1B

Figure 45. PCICC Crypto Module Administration Notebook - General Page
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. Crypto Coprocessor Crypto Module Administration : G11 / X07 = o [

Function

General

General Crypto Module Information

Description [FCI %07

Host ID G11
Host description Trex test floor
Crypto module index X07
Crypto module type Crypto Coprocessor

Status Crypto module enabled

| Send updates || Disable Crypto Module || Help |

| [ UPDATE MODE

Figure 46. Crypto Coprocessor (PCIXCC/CEX2C) Crypto Module Administration Notebook - General Page

If you press Disable Crypto Module, a series of windows open. You are asked if
you are sure you want to disable the module and then notified if the command
executes successfully. The button on the screen becomes Enable Crypto Module.

Intrusion Latch on the PCICC and PCIXCC/CEX2C

Under normal operation, the intrusion latch on a PCICC or PCIXCC/CEX2C is
tripped when the card is removed. This causes all installation data, master keys,
retained keys, roles and authorities to be zeroized in the card when it is reinstalled.
Any new roles and authorities are deleted and the defaults are recreated. The
setting for TKE Enablement is also returned to the default value of Denied when the
intrusion latch is tripped.

If a situation arises where a PCIXCC/CEX2C needs to be removed, for example,
you need to remove your card for service, and you do not want the installation data
to be cleared, perform the following procedure to disable the PCIXCC/CEX2C .

There is no similar procedure for the PCICC.

This process will require you to switch between the TKE application, the ICSF
Coprocessor Management panel, and the Support Element.

1. Open an Emulator Session on the TKE workstation and logon to your TSO
user ID on the Host System where the PCIXCC/CEX2C will be removed.

2. From the ICSF Primary Option Menu on TSO, select Option 1 for Coprocessor
Management.
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3. Leave the Coprocessor Management panel displayed during the rest of this
procedure. You will be required to hit ENTER on the Coprocessor Management
panel at different times. DO NOT EXIT this panel.

4. Open the TKE Host where the PCIXCC/CEX2C will be removed. Open the
PCIXCC/CEX2C . Click on Disable Crypto Module.

5. After the PCIXCC/CEX2C has been disabled from TKE, hit ENTER on the
Coprocessor Management panel. The status should change to DISABLED.

Note: You do not need to deactivate a disabled card before configuring it
OFFLINE.

6. Configure Off the PCIXCC/CEX2C from the Support Element.

7. After the card has been taken Offline, hit ENTER on the Coprocessor
Management panel. The status should change to OFFLINE.

8. Remove the PCIXCC/CEX2C. Perform whatever operation needs to be done.
Replace the PCIXCC/CEX2C.

9. Configure On the PCIXCC/CEX2C from the Support Element.

10. When the initialization process is complete, hit ENTER on the Coprocessor
Management panel. The status should change to DISABLED.

11. From the TKE Workstation Crypto Module General page, click on Enable
Crypto Module.

12. After the PCIXCC/CEX2C has been enabled from TKE, hit ENTER on the
Coprocessor Management panel. The Status should return to its original state.
If the Status was ACTIVE in step 2, when the PCIXCC/CEX2C is enabled it
should return to ACTIVE.

All installation data; master keys, retained keys, roles, and authorities should still be
available. The PCIXCC/CEX2C data was not cleared with the card removal
because it was DISABLED first via the TKE workstation.

Notebook Functions

The selections under the Function pull-down are:

* Refresh Notebook - The content of the notebook is refreshed by reading
information from the host. Performing a refresh may change the mode of the
notebook.

+ Change Signature Index - The authority signature index for the currently loaded
signature key can be changed. An authority may use the same signature key on
different hosts but be known by a different authority index on each host. Since
the authority signature key is active until another signature key is loaded, the
authority can change his/her signature index to administer different hosts.

* Release Crypto Module - A window displays the user ID that currently has this
crypto module open. This selection releases the crypto module from the update
lock. This selection is only active if the notebook is in read-only mode.

g Yarning!

The crypto module is currently reserved by user : [essst] ]
Do you want to force release of the crypto module?

[Yes || No |

Figure 47. Window to Release Crypto Module
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You can confirm release of the crypto module by pressing Yes.

Note: Releasing a crypto module can damage an on-going operation initiated by
another authority. Use this option only if you are certain that the crypto
module must be released.

» Compare Group - This selection is only displayed if working with a group of

modules. For more information, see [‘Comparing Groups” on page 58]

» Close - This selection closes the Crypto Module Notebook.

Notebook Mode

The notebook is opened in one of four possible modes:
* UPDATE MODE

* READ-ONLY MODE

* PENDING COMMAND MODE

* LOCKED READ-ONLY MODE - group notebooks only

The mode is displayed in the lower right hand corner on all the crypto module
notebook pages.

In UPDATE MODE, you are able to display crypto module information and to perform
updates to the crypto module.

In READ-ONLY MODE, you are able to display crypto module information but not update
it. The notebook is currently opened by another TKE workstation.

In PENDING COMMAND MODE, a command is waiting to be co-signed. A multi-signature
command issued by an authority, but not yet executed, is called a pending
command. You must perform the co-sign. You cannot issue other commands in this
mode.

In LOCKED READ-ONLY MODE, you are able to display crypto module information for the
master module and to compare the reduced group of crypto modules. You are not
allowed to do updates. TKE could not access one or more crypto modules of the

group.

Tabular Pages

For the Cryptographic Coprocessor Feature (CCF), the other tabular pages
available are:

+ Details: see [‘Details” on page 74.

+ Access Control: see [‘Access Control (CCF only)” on page 75.

+ Authorities: see [‘Authorities” on page 83|

+ Domains: see [‘Domain Keys Page - CCF” on page 94|

+ Co-sign: see [‘Co-Sign” on page 146

For the PCICC and PCIXCC/CEX2C, the other tabular pages available are:
+ Details: see [‘Details” on page 74|

* Roles: see[‘Roles (PCICC/PCIXCC/CEX2C)” on page 78.

+ Authorities: see [‘Authorities” on page 83/

+ Domains: see [‘Domains Keys Page (PCICC and PCIXCC/CEX2C)” on page 110
+ Co-sign: see [‘Co-Sign” on page 146
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As discussed previously, the notebook opens on the General page.

Details

The Details page has five pages of information for CCF crypto modules and two
pages for PCICC and PCIXCC/CEX2C crypto modules. No changes to the
information are allowed from these pages.

For CCF, the pages and their contents are:
* Crypto module:

— Crypto Module ID - Unique identifier burnt into the crypto module during the
manufacturing process.

— Public Modulus - Used by TKE to verify signed replies from the crypto module

— Signature Sequence Number - Sequence number of crypto module signed
reply

— Hash pattern of Basic Transport Key - MDC-4 value of the current
Diffie-Hellman DES transport key for this crypto module

— Hash pattern of PKA Transport key - MDC-4 value of the current
Diffie-Hellman PKA transport key for this crypto module

— Crypto Module Test Mode - Indicates if the crypto module is in test mode

— Initial PM loaded - Indicates if a manufacturing initialization public modulus is
loaded or not loaded for each authority

» TKE Services: displays the list for TKE services, checking those that were
enabled during crypto module initialization.

* ICRF Services: displays the list for ICRF services, checking those that were
enabled during crypto module initialization.

* PKA Services: displays the list for PKA services, checking those that were
enabled during crypto module initialization.

* Key Sizes: displays the maximum length of keys allowed. All key sizes are in
bits. For DES keys, parity bits are not included. For Diffie-Hellman keys, the size
applies to the largest modulus involved in the establishment of DH transport
keys. The settings were loaded during crypto module initialization.

For PCICC and PCIXCC/CEX2C, the pages and their contents are:
* Crypto module:

— Crypto Module ID - Unique identifier burnt into the crypto module during the
manufacturing process.

— Public Modulus - Used by TKE to verify signed replies from the crypto module

— Signature Sequence Number - Current value of sequence number from
signed, crypto module, replies

— Hash pattern of transport key - MDC-4 value of the current Diffie-Hellman
DES and PKA transport key for this crypto module

* FCV (referred to as Crypto Services on the Details page):
— Maximum length of RSA keys used to encipher DES keys
— Base CCA services availability
— CDMF availability
— 56-bit DES availability
— Triple DES availability
— SET services
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The settings were loaded during crypto module initialization.

Access Control (CCF only)

The access control page displays the signature requirements, the authority masks
and the domain masks. You define the authorities that can sign each of the
multiple-signature commands as well as the number of signatures required.

Here you update which authorities can issue signed commands and which
authorities can generate authority signature keys.

Attention: Authorities 14 and 15 cannot be used for signing commands until their
default signature keys have been changed. Either these authority signature keys
must be changed or they should not be defined in the Signature Requirements
Array as authorized or required to sign commands.

If an authority is disabled in the authority signature mask, the authority cannot issue
any signed commands. If an authority is signature enabled but is not change
enabled, the authority can issue signed commands but a new signature key cannot
be loaded for that authority.

By defining authorities to sign commands and by requiring more than one authority
signature, unauthorized users are prevented from issuing commands that could
change system data. Also, changes that are in error are prevented from occurring
since co-signing authorities can validate if the command is required and valid.

Signature Requirements Container

The access control page lists the current signature requirements for each
multiple-signature command. Signature requirements are specified as three
conditions that have to be fulfilled. Each condition is a list of authorities allowed to
sign the command and a count specifying the number of signatures required.
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(J] CCF Crypto Module Administration : YM16P1 / C01 = o £
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Figure 48. CCF Access Control Page

Specifying a required number of signatures equal to zero for all three conditions
means that the command does not have any requirements. However, the command
must be issued by an authority which can be used to issue signed commands.

The command will not be able to be executed if the required number of signatures
is greater than the number of authorities allowed to sign the command.

There is one entry on the page for each of the ten multi-signature commands. The
command is identified by its two or three letter acronym. The commands are:

* LAP (Load Authorization Public Modulus)

This command is issued from the Change Authority window, when sending a
signature key to the crypto module.

* LCB (Load PKSC Control Block)
This command is issued from the Access Control page.
» ZD (Zeroize Domain)

This command is issued from the Domain General page when requesting the
domain to be zeroized.

* LEC (Load Environment-Control Mask)

This command is issued from the Domain Controls page when updating
cryptographic capabilities.

* LKP (Load Key Part)
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This command is issued from the Load and Load to Queue functions (for loading
a new master key or operational keys) of the Domains Keys page.

* LCS/LCR (Load and Combine PKA Master Keys)

This command is issued from the Domain window by the Load function and the
reset function for loading and resetting the PKA Signature Master Key and the
PKA Key Management Master Key.

* XEM (Extract and Encrypt Master Key)
Not supported by TKE.

* XES/XER (Extract and Encrypt PKA Master Keys)
Not supported by TKE.

* RTS/RTR (Reencipher to PKA Master Keys)
Not supported by TKE.

* RFS/RFR (Reencipher from PKA Master Keys)
Not supported by TKE.

Following the command acronym there are three sets of counts and masks.

The counts define the required number of signatures from the mask that follows. In
the mask a check mark indicates an authority that can be used to satisfy a
signature requirement.

Changing Signature Requirements
Double-clicking on one of the signature requirement entries brings up a dialog box
allowing changes to the signature requirements for that command.

4 Change Signature Requirements

Signature requirements for command : Load Authorization Public Modulus
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Figure 49. Change Signature Requirements Window

The window displays the full name of the command in question (in this case, Load
Authorization Public Modulus). Below are the settings of the Authority Signature
Mask. This is for reference only as the mask cannot be changed in this box.

The user can change the signature requirements by altering the counts and/or by
selecting or unselecting authorities in the masks.

When OK is pressed in the dialog box, it is checked whether the number in front of

each of the three rows is larger than the number of check boxes ticked in the row
and enabled in the Authority Signature Mask.
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If so, an error message informing the user of the problem is displayed and the
change is rejected.

4 Change Signature Requirements

Signature requirements for command : Load Authorization Public Modulus
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Figure 50. Change Signature Requirements Example

Using the signature requirements defined for the Load Authorization Public Modulus
command in Fiéure 50|, the following authority signatures would be necessary
before the LAP command would complete execution:

Two signatures from authorities 0, 2, 3 or 5

One signature from authorities 1 or 4

Authority 6 MUST sign the command

Authority Masks Container

The authority mask labeled Authority Enable displays the authority indices that the
crypto module will accept in signed commands.

The authority mask labeled Signature Key Change Enable displays the authorities
that can have their signature key changed.

To change the mask, click on the relevant check boxes. When all changes have
been made, press Send updates.

Domain Masks Container
The domain mask labeled Change Enable displays the change enable status of
individual domains: whether or not it is allowed to enter keys and change enabled
cryptographic functions.

The domain mask labeled Extraction Enable indicates if keys can be extracted
from the domain. This mask should be cleared.

To change the mask, click on the relevant check boxes. When all changes have
been made, press Send updates.

Roles (PCICC/PCIXCC/CEX2C)

The PCICC and PCIXCC/CEX2C crypto modules use role-based access control. In
a role-based system, the administrator defines a set of roles, which correspond to
the classes of coprocessor users. Each authority is mapped to one role. In the
container, currently defined roles are displayed by their ROLE IDs and Descriptions.
You can create, change or delete a role.
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A role-based system is more efficient than one in which the authority is assigned
individually for each user. In general, the users can be separated into just a few
different categories of access rights. You can separate access to domains. You can
also control the loading of a two-part key, requiring two different authorities to
complete that task.

INITADM is a predefined role available on your system, assigned to authority 00. It
was created with both an issue access control point and a co-sign access control
point. This way, you can create the necessary roles and profiles for the PCICC or
PCIXCC/CEX2C without needing someone to co-sign. This role allows you to create
other roles and authorities for the PCICC and PCIXCC/CEX2C without requiring
another authority to co-sign.

Once other roles and authorities are defined, you may choose to assign a different
role to authority 00.

(J] PCICC Crypto Module Administration : YM16P1 / POD =l o O
Functions

Roles

Rale 1D Description

INITADM ADM default role

keyralel load first key part

keyrole? load middlefinal

mr. Zerg zernize domain

Help
UPDATE MODE

Figure 51. PCICC Roles Page

Multi-Signature Commands

Multi-signature commands for PCICC and PCIXCC/CEX2C modules always require
two signatures. The authority authorized to issue the command automatically signs.
A signature from the authority authorized to co-sign the command is also required.

If a role has both issue and co-sign authority for a multi-signature command, then
the authority assigned to the role automatically co-signs the command after issuing
it. (A role is assigned issue or co-sign authority or both when the role is created or
changed.)

There are four dual-signature commands:
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Enable crypto card - This command is issued from the General page when
changing the crypto module state.

Access Control - This command is issued from:

— Create/Change Role windows - when creating or changing a role

— Role page - when deleting a role

— Create/Change Authority windows - when creating or changing an authority

— Authorities page - when deleting an authority

Zeroize domain - This command is issued from the Domain General page when
zeroizing a domain.

Domain controls - This command is issued from the Domain Controls page when
updating control settings.

Single Signature Commands
The following commands require only one signature:

—_

1.

©C©X®NOORAOOD

Disable crypto card

Load first key part - SYM-MK and ASYM-MK

Combine middle key parts - SYM-MK and ASYM-MK

Combine final key part - SYM-MK and ASYM-MK

Clear new master key register - SYM-MK and ASYM-MK

Set asymmetric master key - ASYM-MK

Load first key part - PCIXCC/CEX2C only (Operational Keys)

Load additional key part - PCIXCC/CEX2C only (Operational Keys)
Complete key - PCIXCC/CEX2C only (Operational Keys)

Clear operational key register - PCIXCC/CEX2C only (Operational Keys)

Creating or Changing a Role

When you right click in the container, a pop-up window appears and you can select
Create, Change or Delete:
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Figure 52. PCICC Roles Page - Create, Change or Delete a Role

Role ID

¥4 Create Mew Role

Description |

r Crypto Module Enable

[_] Disable crypto card

[_] Enable crypto card. issue
[J Enable crypto card. co-sign

rAccess Control

[J] Access control, issue

[ Access control. co-sign

-New Symmetric Master Key
[[] Load first key part

[l Combine middle key parts
[[] Combine final key part

[ Clear new master key register

- New Asymmetric Master Key

[J] Load first key part

[J] Combine middle key paris

[J] Combine final key part

[J Clear new master key register

[ Set asymmetric master key

-Domain Zeroize
[l Zeroize domain, issue

[CJ] Zeroize domain, co-sign

Domain Controls
] Domain controls change. issue

] Domain controls change. co-sign

rDomain Access

Oe
E‘—l
O
O w
O
O o
Cl
Ll

O =
Ow
ds
o=
O
O
0=
O

| Send updates || Cancel || Help |

Trusted Key Entry

Figure 53. PCICC Create New Role Page
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Figure 54. PCIXCC/CEX2C Create New Role Page

* Role ID — Enter the Role ID. If you are creating a new role you must fill in a
name for that role. If you are changing a role, you cannot change this field.

» Description — Optional free text description.

* Check Boxes — Mark the boxes you require for the role. Choices must be made
in the following categories:

Crypto Module Enable

Choose if the role can disable the crypto card, issue the enable crypto card
command, or co-sign the enable crypto card command.

Access Control

Choose if the role can issue the access control command or co-sign the
access control command (needed for creating roles and profiles).

New Symmetric Master Key

Choose if the role can load the first key part, combine middle key parts,
combine final key part and/or clear new master key registers.

New Asymmetric Master Key

Choose if the role can load the first key part, combine middle key parts,
combine final key part, clear new master key registers and/or set the
asymmetric master key.

Domain Zeroize

Choose if the role can issue a zeroize domain command or co-sign a zeroize
domain command.

Domain Controls
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Choose if the role can issue a domain controls change or co-sign a domain
controls change (needed for administering access to ICSF panel services,
access control points for ICSF callable services, and access to User Defined
Extensions (UDX).

— Operational Key (PCIXCC/CEX2C only)

Choose if the role can load First and Additional key parts to key part registers,
complete key part registers and clear key part registers.

— Domain Access
Choose the domains this role can access.

Press Send Updates. This is a dual-signature command and another authority may
need to co-sign.

Deleting a Role

You can choose a crypto module and delete a role. TKE ensures that access to the
crypto module is not lost when the role is deleted.

You must delete or reassign the user profile associated with a role before you
delete the role.

Authorities

An authority is a person who is able to issue sighed commands to the crypto
module. For each of the currently defined authorities, this container lists the name,
index and other authority information.

TKE operates in exactly the same way with respect to authorities for CCF, PCICC
and PCIXCC/CEX2C. However, CCF implements exactly sixteen predefined
authorities while PCICC and PCIXCC/CEX2C allow a variable number of
authorities.

Attention: Authorities 14 and 15 on CCF cannot be used for signing commands
until their default signature keys have been changed. Either these authority
signature keys must be changed or they should not be defined in the Signature
Requirements Array as authorized or required to sign commands.

The purpose is to allow the user to:

* Generate a signature key for an authority and save it on a selected medium
together with authority related information (name, telephone number etc).

» Upload the public part of the signature key and the authority information to the
selected crypto module.

» Display and edit the authority-related information for the selected crypto module.

When you right-click in the Authorities container, you are given the opportunity to
create, change or delete an authority, as well as generate a signature key. Creating
and deleting authorities is only available for PCICC and PCIXCC/CEX2C crypto
modules.
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Figure 55. PCICC Authorities Page
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Figure 56. PCIXCC/CEX2C Authorities Page

Beginning with TKE 4.2, the representation for the PCIXCC and CEX2C crypto

modules on the TKE panels will be Crypto Coprocessor.

Generating Authority Signature Keys

You generate and save a signature key by right-clicking in the Authorities container

and selecting the Generate signature key action.

Follow this procedure:

Enter authority index - This is a mandatory field with the index of the authority.
Valid range is 00 through 99. The authority index will be saved with the key and
is called the default authority index.

1.

Note: You can only load the signature key to a CCF module if the index is in

Enter name, phone, e-mail, address and description to identify the authority.

the range 00—15. It is recommended that you use the same index across

platforms and use only the first 16 indices for PCICC and

PCIXCC/CEX2C.

These are optional free text fields. The information that you enter here is saved

with the key. It will be filled in automatically when the key is selected for

creating a new authority. Press the Continue push button.
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Authority index | 12

B4 Generate Signature Key

Name |R Smith

Phone [555-5555

E-mail |rsmith@email.com

Address |PDughkeepsie, M

Description |R Smith's signature ke |

| Continue H Cancel H Help ‘

Trusted Key Entry

Figure 57. Filled In Generate Signature Key Window

3. When the key is generated, select the target destination. Signature keys can be
saved to a binary file, key storage, or TKE smart card.

Generate Authority

Password |

Confirm passw... |

(I J Floppy Drive
(% TKE Data Directory

Files

host.dat
trace.txt

File Name :  [John_Doe_autharitg

Figure 58. Save Signature Key

4. If the keys are to be saved as a

|Trusted Key Emry\

binary file on the hard drive, a password and

file name are required to encrypt and save the key file. After saving the authority
signature key and information to a binary file or key storage, you are prompted
to save the key again. It is not recommended that you save it again.

Only one signature key can be stored in PKA key storage.

Warning: If the file is saved to floppy you must deactivate the floppy drive
before removing the diskette. If the diskette is removed prior to deactivating the

drive data could be lost or corru

pted. For details on deactivating media see

[‘Managing Media” on page 393.

5. If the keys are to be saved to a

TKE smart card:

a. Select Target window is displayed after Generate Signature key window.
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Bd Seled Target

@ Smart card
) Binary file
) Key storage

| Continue || Cancel || Help |

| | Trusted Key Entry

Figure 59. Select target window

b. Insert the TKE smart card into smart card reader 2. Press OK.

#4 Generate Signature Key

Insert TKE smart card in smart card reader 2.

Figure 60. Insert TKE smart card

c. The user enters the PIN. When the authority signature key is saved to a
TKE smart card it is protected by the PIN of the TKE smart card.

B4 Generate Signature Key

Enter 4 digit PIN on smart card reader 2 PIN pad.

Figure 61. Enter PIN

d. The Authority Signature Key is generated on the TKE smart card and a
successful message is displayed.

B4 Generate Signature Key

Signature key and info stored successfully on the TKE smart

card.
0 You can use the 'Copy Smart Card' function in the "Litilities"
menu to create a hack-up.

Figure 62. Generate signature key

6. When saving an Authority Signature Key on a TKE smart card, the user is not
given the option to save it again. The user should use the copy smart card

contents utility to save the TKE authority key again. See [‘Copy smart cards” on|

Each TKE smart card can hold only one authority signature key.

Create Authority (PCICC/PCIXCC/CEX2C)

This selection allows you to create an authority at the host and load the authority

signature key public modulus. Before you can create a new authority, you need to
generate a signature key (see [‘Generating Authority Signature Keys” on page 85) .
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To create an authority, click with the right mouse button in the container on the

Authorities page.

Select the Create Authority action.

A series of windows open for you to specify the signature key source.

() Binary file

g4 Seled Source

(@ Smart card in reader 1

) Smart card in reader 2

) Key storage
() Default key

| Continue || Cancel || Help |

ITrusted Key Entr\y|

Figure 63. Select source of signature key

If you select key storage, the key and accompanying information you previously
entered appears in the window.

B4 Create Hew Authority

Role
Authority index | 12
MName |R Smith | [ERERE M|
Phone [555-5555 |
E-mail [rsmith@email.com |
Address |P0ughkeepsie. Y |
Description |R8mith's sighature ke |
Signﬂture kEy B1l45C7054876EQN013C1E71BAEEBG SDIEE106FDI 942 F3CESBATCD061663B0774ER
32 3 460672036 TECFEICIANCDFCS 6 SEBAEEE T305E09F 23E26 9884599902 42CATEES
64,95 £456450401655E01FSTIAFEDIETEE00 TEADCE 00003 1E13FIEDEOGABI D EALDEFT
96127 13C43FE3C1968AICCEEEDIEAFSIEEC) SFIDBDAGFY 22 EFA6 353 CERBCRIFOCLEY
| Send updates || Cancel || Help |
| |Trusted Keyw Entry |

Figure 64. Create New Authority

If you select Smart card in reader 1 or Smart card in reader 2, you are prompted
to insert the TKE smart card into the appropriate reader.

2

&4 Load Signature Key

Insert TKE smart card with a signature key in smart card reader

Figure 65. Insert TKE smart card
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Then you are prompted to enter the TKE smart card PIN.

B4 Load Signature Key

Enter 4 digit PIN on smart card reader 1 PIN pad.

Figure 66. Enter PIN

Once the PIN has been verified, the Create New Authority window appears.

B Create Hew asuthority

Authority index | 10

|niTapm |

Name |R Jones

Phone [5-6398

|
|
E-mail |rj0nes@us.ibm.com |
|

Address |P0ughkeepsie

Description |Sign key on TKE smart card \

Signature key 0..31 C15753F776BEDRIEEEFTOFFES51D251EC437DFF35A4514605T9EES62D36RA30
32.63 eDCOF92C2ASSERE4D1IDZ224291FOE1DIE496D630710AS 3603 TADCI 1FOE T3 FCODS
64.95 ScFsF0425a9570415028F794EB96D3E03AR080800702D533166D39009D76B3730
96..127 2B372873128B9E37653928300F2CFE1D0FZAE S S8 EFSB04051 3696655 FI8FASAF

‘ Send updates || Cancel || Help |

| Trusted Key Entry

Figure 67. Create new authority

If you select binary, you are prompted for the signature key file to load and
password before the Create New Authority window appears.

Warning: If the file is loaded from a floppy you must deactivate the floppy drive
before removing the diskette. If the diskette is removed prior to deactivating the
drive data could be lost or corrupted. For details on deactivating media see
[‘Managing Media” on page 393
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Load Signature Key

Password |

(e ) Floppy Drive

(@ TKE Data Directory

Files
host.dat =
John_Doe_Authority
trace.txt

File Name : \Juhn_Due_Aumurltv

‘T_rusled K-Ev Entry

Figure 68. Load Signature Key from binary file

If you select default, there is no information in the Create New Authority window.
Also, there will not be any information if you did not provide any when you
generated the key.

g4 Create Mew Authority

Authority index ,E Role
[INITADM ~|
Name |Default |
Phone | | CoEnable =
i Domain
= matl | | CoDomain
Address | | symiirst
Description | | symclear
asymlst
asymmid n

Signﬁture key"_ FFFFFFFFFFFFFFFEFFFFFFFFFFEFFFFFFFFFFEFFFFFFFFFFFEFFFFFFFFFFFFFEFEE
32. 63 FFFFEFFFFFFFFFFEFFFFFFFFFFEFFFFFFFFFFEFFFFFFFFFFEFFFFEFFFFEFEFES 2

G495 0000000000000000000000000000000000000000000000000000000000000000

gg._127 0000000000000000000000000000000000000000000000000000000000057¢0L

| Send updates || Cancel || Help |

| Trusted Key En

Figure 69. Create New Authority with Role Container

The Create New Authority window is opened with the authority information read
from the signature key source:

* Authority index - This is a mandatory field with the index of the authority. Valid
range is 00 through 99.

If the authorization public modulus is going to be loaded into several crypto
modules, it simplifies matters to use the same authority index for all crypto
modules.

* Name - Name of the authority. Optional free text entry field.

* Phone - Phone number of the authority. Optional free text entry field.
* E-mail - E-mail address for the authority. Optional free text entry field.
* Address - Address of the authority. Optional free text entry field.
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» Description - Description of the authority. Optional free text entry field.
» Signature key - Public modulus of the signature key.

You can edit all of the entry fields.

In the Role container there is a drop-down list. Select one of the previously defined
roles. The authority is mapped to the access rights of that role. This is available
only when creating or changing a PCICC/PCIXCC/CEX2C authority.

Press Send updates. This is a dual signature command and will require another
authority to co-sign.

The authority information (name, phone, e-mail and address) is saved in the crypto
module dataset specified in the TKE host transaction program started procedure on
the host.

Change Authority

Activating this selection allows the user to change authority information and to
replace the authority public modulus in the crypto module. All information except the
authority index and authority TSN can be changed.

Attention: Authorities 14 and 15 on the CCF cannot be used for signing
commands until their default signature keys have been changed. Either these
authority signature keys must be changed or they should not be defined in the
Signature Requirements Array as authorized or required to sign commands.

Name
Phone
E-mail

Address

Authority TSN

Signature key._
32..63

64..95

96..127

£4 Change Authority
Authority index

Role

[Autharity 7

|D|:|mﬂin v|

55555

Description |This is John Srmith. |

3AS26231CEFTR0410C4TAG 021D 000000100504

ADE400RIERY 2T EEAFOYES ABAEEESAEAYEONVD AL 6 CEEEECEDBAFDAIS 516552 740
ETRISIDEFBECDEFLED L 1CIFFFE AEF3 26 DEFRI6 S46 9 T2 E2DESLI0C2Fe ASODZERED
AMEZVODEE G E0ERSCAZAA0IEE VALCER 3G VA ADADCE S EDIDEOCAZCA TR ED AT AT
T4p0Te 2 0EBYENRCECD 2 09 FASDOLIEDELSAFEFAS 23 TEEVESCAEZABASEE 1 T43C1E

| Send updates H |Get Signature Key H Cancel H Help ‘

Trusted Key Entry

Figure 70. Change Authority (PCICC/PCIXCC/CEX2C)

When an authority is selected, you will be able to update the Name, Phone, E-mail
and Address fields and the Authority Public Modulus. You can also change the Role
definition by clicking on the pull-down menu and selecting a different role.
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The Get signature key button opens a select source window and load signature
window. The contents of the selected key file replace the contents of the Change
Authority window except for the index.

The Send updates button uploads the information displayed at the window to the
crypto module. The authority information (name, phone, e-mail and address) is
updated in the crypto module dataset specified in the TKE host transaction program
started procedure on the host.

Delete Authority (PCICC and PCIXCC/CEX2C )

PCICC and PCIXCC/CEX2C operates with a variable number of TKE authorities
(TKEAUTxx profiles). TKE allows a user to delete an authority from a PCICC or
PCIXCC/CEX2C. TKE performs a consistency check of the resulting TKE roles and
profiles to ensure that access to the crypto module is not lost when the profile is
deleted.

Domains

The Domains page defines the domains that can have DES and PKA master keys
and operational keys loaded and changed, as well as providing domains controls.

The Domains page holds general information about each domain. There are 16
tabs on the right hand side, one for each domain.

(J] CCF Crypto Module Administration : VM16P1 / C00

Functions
Domains Index
Domain Index Description

0 C0 on Dormain 0, System Testfloor
1 C0 on Domain 1. System Testfloor
2 C0 on Domain 2. System Testfloor
3 C0 on Domain 3. System Testfloor
4 C0 on Domain 4, Systern Testfloor
5
B
7
i

C0 on Dormain 5, System Testfloor
C0 on Domain B, System Testfloor
C0 on Domain 7. System Testfloor
C0 on Domain 8. System Testfloor

9 C0 on Domain 9, System Testfloor

10 C0 on Domain 10, System Test floor

1 C0 on Damain 11, System Test floor

12 C0 on Domain 12, System Test floor

13 0 on Damain 13, System Test floor

14 C0 on Dornain 14, System Test floor

15 C0 on Damain 15, System Test floor (Group tested)

READ-OMNLY MODE

Figure 71. CCF Domains Page

Domains General Page

The Domains General page appears when you select a domain. Each domain has
three associated pages: the General page, the Keys page and the Controls page.
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. CCF Crypto Module Administration : F21 / 00 Z| el

Function

fGeneraI rDetaiIs r.m:l:ess Control r.nuthorities rDomains rCu-Sign |

=
=
@
x

Domain General

Domain Index 2

Description [Domain 2 an CCF 0

=
=

-
=

-
(X

|
(L =y )

| Zeroize domain... || Send updates || Discard changes || Help |

General |Keys | Controls

UFDATE MODE

Figure 72. CCF Domains General Page

From this page, you can update the description and zeroize the domain.

To change the description, edit the entry field and press Send updates. The
description is saved in the crypto module data set specified in the TKE host
transaction program started procedure on the host.

Zeroize Domain
Zeroizing a domain erases its configuration data and clears all cryptographic keys
and registers for the current domain.

Selecting Zeroize domain... results in the display of an action (warning) message
informing the user that the initiated process is a destructive and irreversible
process. Accepting this, the domain is zeroized. That is, all registers and keys
related to this domain are set to zero or set invalid.

If you are reassigning a domain for another use, it is a good security practice to
zeroize that domain before proceeding.

For CCF, once a domain has been zeroized, the cryptographic functions must be
enabled from the Domains Controls page. After this has been done, DES master
and PKA master keys can be loaded.

For a PCICC or PCIXCC/CEX2C, when a domain is zeroized, the domains controls
are reset to their initial state whereby all services are enabled.

Note: Unlike the Global Zeroize issued from the Support Element, zeroize domain
does not affect the enablement of TKE Commands on the PCIXCC/CEX2C.
Refer to ['TKE Enablement for 2990, z890, z9-109, z9 EC and z9 BC|
[Systems” on page 26
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Domain Keys Page - CCF

This page displays master key status information and allows you to generate, load
and clear domain key registers.

The upper part of the window displays the status and hash patterns for the DES
master key registers and for the PKA master key registers. The status and hash
patterns of the entries in the key-part queue are displayed as well.

Select the key type you will be working with from the Key Type container.

The following actions are available:

Generate: Generate a key or key part and save it to a file or TKE smart card
Clear. Clear (reset) the key register

Load: Load a key or key part directly to the relevant key register

Load to Queue: Load a key or key part to the key part queue

Load to Key Storage: Load a key part to the TKE workstation DES key storage
Encipher RSA Key: Encipher an unencrypted RSA key under an IMP-PKA key

Generate RSA Key: Generate an RSA Key and encrypt it under an IMP-PKA
key.

Load RSA Key to PKDS: Load an RSA key to the PKDS active in the logical
partition where the Host Transaction Program is started

Load RSA Key to Host Dataset. Load an RSA key to a host data set

Secure key part entry: Enter known key part values to a TKE smart card.

After you select a Key Type and right-click, a pop-up window appears with the
available actions.

Note: The two TKE smart cards must be enrolled in the same zone; otherwise the

copy will fail. To display the zone of a TKE smart card, exit from TKE and
use either the Cryptographic Node Management Utility 3.10SC or the Smart
Card Utility Program 1.20 under the Trusted Key Entry Applications on the
Framework. See [‘Crypto Node Management Batch Initialization 3.10SC” on|
[page 343| or[Appendix D, “Smart Card Utility Program (SCUP),” on page 277l
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Functions

[J] CCF Crypto Module Administration : YM16P1 / C01 = o [

Domain Keys

New Master Key
0Old Master Key
Master Key

Key Management Master Key
Signature Master Key

Key Part Queue, Part 1

Select key to work with

Domains

Status

Empty

Empty
valid

Full or Part full
Full or Part full

Empty

Hash pattern

00000000000000000000000000000000
00000000000000000000000000000000
DF3A50AE3546612396EFSL7EGBDOZAC

EFACE5754B5088C22D034806C7695282
E83F158521FEEAZ23986CC9463DAFD Y11

00000000000000000000000000000000

Key Type

Mew Master Ke

Key Management Master Ke

Signature Master Ke

Operational key:

Operational Ke

- EXFPORTER

Operational Ke

- IMFORTER

Operational Ke

- IFINEME

Operational Ke

- OFINEMC

Operational Ke

- FINGEM

Operational Ke

- FINVER

Operational Ke

- IMP-PKA

Bt Koy

| Clear Key Part Queue H Help |

[Keys |

UFPDATE MODE

Figure 73. CCF Domains Keys Page

The key part queue permits new master key parts and operational key parts to be
entered. To load keys from the key part queue and import them into the CCF crypto
modules, ICSF panels must be used. See [Chapter 6, “Managing Keys: TKE and|

[[CSF with CCF,” on page 149.|After each import from the ICSF panels, if you return

to this page be sure to refresh the notebook. This will update the status of the key
part queue, before you load another key part. Refresh is available from the
Function drop-down menu.

To delete all entries in the key-part queue, press Clear Key Part Queue.

Not all actions are available for all key types. [Table 3 on page 96|illustrates the
possibilities:
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Table 3. Key Types and Actions for CCF Crypto Modules

CCF

Key Type

Popup

Sub-popup

Special Considerations

New Master
Key

Generate

Load

First
Intermediate
Last
Complete

Load is disabled if the New Master
Key register is full. Load First and
Load Complete require the register
to be empty. Load Intermediate and
Load Last require the register to be
part full. Use Load Complete if
loading only one key part.

Load to queue

First
Intermediate
Last
Complete

Load to queue is disabled if the
queue is full. If loading just one key
part, use load to queue complete.
However, you must import two key
parts from the key part queue from
ICSF. The last key part is
automatically set to zeros in the key
part queue register.

Secure key part
entry

Enter known key part values to a

TKE smart card; see|Kppendix E,

‘Secure Key Part Entry,” on page

po7]

Signature
Master Key

Generate

Load

First
Intermediate
Last
Complete

Load First and Load Complete
require the Signature Master Key
register to be empty. Load
Intermediate and Load Last require
the register to be part full. Use Load
Complete if you are loading only one
key part.

Clear

Secure key part
entry

Enter known key part values to a
TKE smart card; see|Appendix E,

“Secure Key Part Entry,” on page

po7]

Key
Management
Master Key

Generate

Load

First
Intermediate
Last
Complete

Load First and Load Complete
require the Key Management Master
Key register to be empty. Load
Intermediate and Load Last require
the register to be part full. Use Load
Complete if you are loading only one
key part.

Clear

Secure key part
entry

Enter known key part values to a
TKE smart card; see|Kppendix E,

‘Secure Key Part Entry,” on page|

po7]
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Table 3. Key Types and Actions for CCF Crypto Modules (continued)

CCF
Key Type Popup Sub-popup Special Considerations
Operational Generate
Keys Load to queue First Load to queue is disabled if the
Intermediate queue is full.
Last
Load to key First This function is only performed for
storage Intermediate Operational Key types IMPORTER
Last or IMP-PKA.
Secure key part Enter known key part values to a
entry TKE smart card; see|ﬂppendix E,
‘Secure Key Part Entry,” on page
297
RSA Key Generate
Encipher
Load to PKDS Loads RSA key to TKE host LPAR
only.
Load to data set The host dataset must be
preallocated.

Note: The LOAD, LOAD TO QUEUE, and CLEAR are not possible if domain
change is disabled.

Operational keys are keys that are loaded to a CCF crypto module and then
encrypted with the master key. The TKE workstation can be used for entry of the
following operational key types:

« EXPORTER
* IMPORTER
* IPINENC

+ OPINENC

* PINGEN

* PINVER

* IMP-PKA

The operational keys are always loaded as key parts through the key-part queue.
After each key part is loaded to queue, the key part must be imported to the CKDS
using host ICSF panels. See [‘Loading and Importing Operational Keys” on page|
i

Generate - CCF
When you select Generate, a window opens whereby you specify the target.
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4 Seled Target
® Smart card
(_» Binary file
Z Print file
| Continue | | Cancel | | Help |
™
| n ITrusted Key Entr\y|

Figure 74. Select Target
Next, save the key part.

Note: If the key part is saved to a TKE smart card it cannot be saved to any other
medium such as binary file or print file. If saving the key part to a binary or
print file, specify either Floppy Drive or TKE Data Directory and the file
name. With either the binary or print file option, you can save the key part to
another medium, except a TKE smart card.

Note: The TKE cryptographic adapter generates the key part and securely
transfers the key to the TKE smart card. You must insert a TKE smart card
that is enrolled in the same zone as the TKE cryptographic adapter;
otherwise the Generate will fail. To display the zone of a TKE smart card,
exit from TKE and use either the Cryptographic Node Management Utility
3.10SC or the Smart Card Utility Program 1.20 under Trusted Key Entry
IAEL)lIications on the Framework. See [‘Display smart card details” on page]
2

68| or [‘Display smart card information” on page 283

If you are saving to a TKE smart card, the following screens appear:

B ooy por ]

Insert TKE smart card in smart card reader 2.

Figure 75. Save key part to TKE smart card

B4 Save key part

Enter 4 digit PIN on smart card reader 2 PIN pad.

Figure 76. Enter PIN
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8 Enfer key part description

Description [New Master Key - TKE Smart Gard |

| Continue || Cancel || Help |

| | Trusted Key Entry

Figure 77. Enter key part description

B oo

Key part and info stored successfully on the card. You can use
0 the 'Copy Smart Card' function in the "tilities' menu to create

a back-up.

Figure 78. Key part saved successfully

The save key part successful message appears. If you want to create a backup,
see [‘Copy smart cards” on page 66

Clear - CCF

Clear is only available for the SMK and KMMK. If a register is not empty or if you
make a mistake during key entry, you can select Clear, and the following window
opens:

B o

E Are you sure you want to clear the Key Register
[ o |

Figure 79. Clear Key Warning Message

If you press Yes, the command executes successfully message appears.

Load and Load to Queue - CCF

Load is available for all master keys. Load directly loads the key part to the key
register. It can be used when loading DES master keys the first time (see
[‘First-Time Startup” on page 150), but is not recommended subsequent times.

Load to Queue is only available for loading New Master Key parts or operational
key parts. After successfully loading a key part to the key part queue, you must go
to your TSO session and use the ICSF panels to import the key part from the key
part queue to the New Master Key register or the operational key part into the
CKDS. This must be done for each key part loaded to the queue from TKE. See
[Chapter 6, “Managing Keys: TKE and ICSF with CCF,” on page 149)
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— Warning
When entering a DES master key part, Load should only be selected if ICSF
is NOT active in the selected domain. If ICSF is active in the target domain,
Load to Queue should be used to prevent possible corruption of the CKDS or
overlay of the key in the auxiliary master key register in the current domain or
another domain.

Having selected Load or Load to Queue, a new menu pops up giving the user the
ability to select the key part to load:

* First

* Intermediate

* Last

* Complete

You can input domain keys from the keyboard, a binary file or a TKE smart card..
Input from Keyboard:

A dialog box is displayed for selecting the input source.

g4 Seled Source

) Smart card in reader 1
) Smart card in reader 2
) Binary file

© Keyhoard

| Continue || Cancel || Help |

| | Trusted Key Entry |

Figure 80. Select CCF key source - keyboard

If keyboard is selected as the input source an input dialog box is displayed with
input fields for either a 16-byte key or a 24-byte key depending on the key type.
The dialog box displayed for entering the key values depends on the installation’s
Blind Key Entry selection. Blind Key Entry masks the key values being entered. If
your installation is using Blind Key Entry, the following dialog box is displayed for
entering the key values:

&4 Enter key value

By-les I] ? |**************** | Reenter l:l:lpﬁl:lnﬂ') |**************** |
ﬁ 15 |1’rﬁ1’rﬁ1’rﬁ1’rﬁ1’rﬁ1’rﬁ1’rﬁ1’rﬁ | REEntEr (Dptiﬂnﬁl) |1’rﬁ1’rﬁ1’rﬁ1’rﬁ1’rﬁ1’rﬁ1’rﬁ1’rﬁ |
| Continue ‘ | Cancel ‘ | Help ‘

| Trusted Key Entry

Figure 81. Enter Key Value - Blind Key Entry

An optional confirmation field can be used to confirm the key value entered.
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For information on how to change the Blind Key Entry option, see
[Customization” on page 67|

If Blind Key Entry is not being used, the following dialog box is displayed:

&4 Enter key value

Bytes 0.7 [0123-4567-80a5-coEF |

§.15 |0123-4567-agas-c9551 |

| Continue H Cancel H Help ‘

| |Trusted Kew Entry |

Figure 82. Enter Key Value

When the user presses Continue, the MDC-4 and ENC-ZERO is calculated and
displayed, providing the user with the opportunity to visually verify the values. When
Load Key is pressed, the user is asked if they would like to save the key part. If
yes, a file chooser window is opened for the user to select either Floppy drive or
TKE Data Directory and enter a File Name for saving the key part. The key part is
then loaded. If no, the key part is not saved and the key is loaded.

Warning: If saving a key part to diskette, the floppy drive must be deactivated via
the TKE Media Manager before the diskette is removed from the floppy drive or
data could be lost or corrupted.

£4 Key part information

Description

ENC-ZFERDO BIE13665
MDC-4 3DDAEGZ29901A0CSICABESETCB505400

Key type New Master Key.

| Load key H Cancel H Help ‘

| |Trusted Key Entry

Figure 83. Key Part Information Window

If loading to queue, the key part is loaded to the key part queue on the CCF crypto
module. You must go to your TSO session and import the key part from the key
part queue to the New Master Key register or the CKDS. To import an NMK key

art to the New Master Key register, see [lmporting Key Parts from the Queue” on|
page 153.| To import an operational key part to the CKDS, see |“Loading and|
Importing Operational Keys” on page 174.|

If loading directly and if you have not loaded the entire key, return to the Domains
Keys page, refresh the notebook, and continue.

Input from Binary File:

A dialog box is displayed for selecting the input source.
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g4 Seled Source

) Smart card in reader 1
) Smart card in reader 2

®
) Keyhoard

| Continue u Cancel || Help |

| | Trusted Key Entry |

Figure 84. Select CCF key source - binary file

File

 Floppy Drive
@ TKE Data Directory

Files

current_nmk_key
host.dat
trace.txt

1]

File Mame : |currem_nmk_kev

| |Trusted ety Entry

Figure 85. Specify Key File

Specify the file location (Floppy Drive or TKE Data Directory) and file name. Select
Open.

Warning: If the file is loaded from a floppy you must deactivate the floppy drive
before removing the diskette. If the diskette is removed prior to deactivating the
drive data could be lost or corrupted. For details on deactivating media see
[‘Managing Media” on page 393
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The MDC-4 is calculated and displayed, providing the user with the opportunity to
visually verify the MDC-4 value.The Encipher Zero VP (ENC-ZERO) is also
displayed for verification (DES master key parts and operational key parts).

&4 Key parf information

Description POK test key

ENC-ZERD DED4AFET
MD(C-4 DF3AS0RE3S46612396EFSSTEREDNTACL

Key type New Master Key.

| Load key H Cancel H Help ‘

| |Trusted Key Entry

Figure 86. Key Part Information Window

Press Load key.

If loading directly and if you have not loaded the entire key, return to the Domains
Keys page, refresh the notebook, and continue.

Input from Smart Card:
1. A dialog box is displayed for selecting the input source.

g4 Select Source

(@) Smart card in reader 1
) Smart card in reader 2
() Binary file
) Keyhoard

| Continue || Cancel || Helk |

| | Trusted Key Entry |

Figure 87. Select CCF key source - smart card

2. Insert the TKE smart card into the reader, highlight a key part, right click and
choose select, or highlight and press OK.

Se t key part from TKE smart card |
Card ID 1EF574DAS

Zone description TKES0 UT
Card description

Card contents

Key type Description arigin MDC4
CSF symmetric master key part ey part 1 Crypto adapter |J050AETSES820E2451EDACDE4B0S4EE
CSF symmetric master key part ey part 2 Crypto adapter B86202000433230B3F7FF181EDBETACH
CSF symmetric master key part ey part 3 Crypto adapter 18ES0ASTOFEESFOCDAFESFI84180D0!
CSF symmetric master key part ey part 8 Crypto adapter 7EBOFBE4834F6AZ0441444B330ECOS
CSF symmetric master key part ey part 4 Crypto adapter AFOTTEFEDE4FG1SF3SEEQTOOALATIT
CSF symmetric master key part ey part 5 Crypto adapter OALFDES90924D0T7EEC15C4F258CAR0L
CSF symmetric master key part ey part 6 Crypto adapter BEFGB2C11ET1726BC4BFS2ZCEFAFSTE
CSF symmetric master key part ey part 7 Crypto adapter S8793C42820C4AFEFS38733782B063
perational key part, DATAM Operational Key - DATAM [Crypto adapter BAIEA273CF4ES2BT4CESOE1D2A55BA4
[ [ [»

Trusted Key Entry \

Figure 88. Select a key part

Chapter 5. Crypto Module Notebook 103



104

3. Enter PIN.

g Seled key part

Enter 4 digit PIN on smart card reader 1 PIN pad.

Figure 89. Enter PIN

4. The key part is read from the TKE smart card. Press Load Key.

4 Key part information

Description Operational Key - EXPORTER
ENC-FERQO 4FSsEEEL
MDC-4 79132653FBA14F230E26AC00ECASER
Keytype Operational Key - EXPORTER

| Load key || Cancel || Help |

| |Trusted Key Entry

Figure 90. Load key
5. You will get a message that the command was executed successfully.

Load or Load to Queue Complete - CCF

Use Load Complete or Load to Queue Complete if you have only one master key
part. Load complete loads a complete key to the new master key register in a single
load operation. The register status is full after a load complete.

Load to queue complete is only valid for loading a new DES master key to the CCF.
Load to queue complete loads a key part to the key part queue. After you import
the first key part, the key part on the key part queue is automatically set to zeros.
You must import the final key part of zeros to the new master key register. The
process is:

» Select Complete from Load to Queue pop-up menu (TKE workstation)

* Import first key part from the key part queue to the NMK register (ICSF panels)

* Import final key part from the key part queue to the NMK register (ICSF panels)

Load to Key Storage - CCF

This selection is only possible for operational IMP-PKA or IMPORTER keys. The
IMP-PKA key-encrypting keys are used to protect RSA keys during transport from
the workstation to ICSF whereas the IMPORTER keys are used to protect DES
keys during transport from the workstation to ICSF. Having selected Load to Key
Storage, the user selects which key part to load to the workstation key storage:

* First...

* Intermediate...

e Last...
The contents of the container depend upon the user’s selection.
If the user selected First, the container shows all keys in the workstation key

storage usable as IMP-PKA key encrypting keys. The user can use these as
skeletons for composing the new key label.
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If the user selected Intermediate or Last, the container shows all keys in the
workstation key storage that have been installed with the first key part. It also
shows any optional, intermediate key parts that have been installed. The user must
select one of these as the key label.

g Install IMPORTER key part in TKE workstation key storage

A host IMPORTER key is installed in the TKE workstation key storage as an EXPORTER key.

EXPORTER keys in TKE workstation key storage.
Key label

IMPPEA RSA KEYGEMN KNOWMN.KEY WALLIE

IMPPEA RSA KEYERC KNOWN KEY WaLUE
MIGRATE.IMPORTER KEY

Workstation key label | |

‘ Continue || Cancel H Help |

| Trusted Key Entry|

Figure 91. Install Importer Key Part in Key Storage

For IMP-PKA keys, you must specify additional information.
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g4 Install IMP-PKA key part in TKE workstation key storage

A host IMP-PKA key is installed in the TKE workstation key storage as an EXPORTER key.

EXPORTER keys in TKE workstation key storage.
Keyusage Key label
MPPEARSA KEYGEMN.KENOWN.KEY VALLE
IMPPRARSA KEYENC KNOWN. KEY WALLUE

® for RSA key generation

i for RSA key enciphering

Workstation key label | |

‘ Continue || Cancel H Help |

| Trusted Key Entry |

Figure 92. Install IMP-PKA Key Part in Key Storage

A window is displayed for the user to specify the workstation key label and whether
this IMP-PKA KEK will be used for protecting an RSA key to be generated at the
workstation or a clear RSA key to be enciphered at the workstation.

Note: For the RSA key to be loaded into the PKDS, the same IMP-PKA key value
must be stored in the CKDS. If a non-odd parity key is generated, when it is
loaded to key storage its parity is adjusted. However, that same non-odd
parity key is sent to the MVS host system (using Load to Queue) without the
parity adjusted.

Secure Key Part Entry

To save known key part values to a TKE Smart Card use secure key part entry.
Refer to|Appendix E, “Secure Key Part Entry,” on page 297|for details on using this
function.

Generate RSA Key - CCF
This selection initiates RSA key generation at the workstation. The key is protected
with a previously generated IMP-PKA key encrypting key and saved in a file.

From the Domains Keys page, right-click on RSA key in the Key Types container
and select Generate. The Generate RSA Key window is displayed.
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B4 Generate RS54 key
-RSA key usage control -Key length— Public exponent
® Signature w512 w3
) Key management & signature | | 768 i 65537
1024  Random
o
PKDS key label | |
Private key name | |
Description | |
¥Workstation IMP-FPKA label Key label
Host IMP-PKA key label | |
| Generate ‘ | Cancel ‘ | Help ‘
Trusted Key Entry|

Figure 93. Generate RSA Key

Specify the following information:

RSA key usage control — Specifies whether or not the RSA key can be used for
key management purposes (encryption of DES keys). All RSA keys can be used
for signature generation and verification.

Key length — Length of the modulus of the RSA key in bits. All values from 512
to 1024 are valid. If the entered value exceeds the maximum value set by the
selected crypto module an error Invalid key length specified. It must be
between 512 and 1024 is displayed. You are allowed to continue but the
generated RSA key cannot be loaded to this crypto module.

Public exponent — Value of the public exponent of the RSA key.

PKDS key label — Label to be given the imported RSA key at the host. The
information provided in this field can be changed when you load the RSA key to
the host.

Private key name — Text string that is included in the RSA key token and
cryptographically related to the key. The private key name can be used for
access control for the key. The information you entered in the PKDS key label
field is copied to this field and can be edited.

Description — Optional free text that is saved with the RSA key and displayed
when you retrieve the key.

Workstation IMP-PKA label — The container displays the labels of the
key-encrypting keys currently in the TKE workstation key storage available for
protecting RSA keys generated at a TKE workstation. Select one by clicking on it.
Host IMP-PKA key label — The label of the host used to import the RSA key.
The selected Workstation IMP-PKA label is copied to this field and can be edited.
This information can be changed when you load the RSA key to the host.
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When the key is generated, a file chooser window is displayed for the user to
specify the file location (Floppy Drive or TKE Data Directory) and file name for
saving the generated RSA key.

Warning: If saving the RSA key to diskette, the floppy drive must be deactivated via
the TKE Media Manager before removing the diskette or data could be lost or
corrupted.

Encipher RSA Key - CCF

This selection allows an RSA key to be read from a clear key file, encrypted with a
previously generated IMP-PKA key encrypting key and saved in a file. The format of
the clear key file is described in|Appendix |, “Clear RSA Key Format,” on page 317

Having selected the Encipher action, the Encipher RSA Key window is displayed:

g4 Encipher RSA key

-RSA key usage control—— Key length - Public exponent——
® Signature 3612 3
r Key management & signature O 768 ® B5537

1024 2 Random

@) 799

PKDS key label [R54739 ke |

Private key name |[B54739 ke |

Description [R5A 799 kvs |

Workstation EXPORTER key label Kevlahel
IMPPEARSA KEYEMCKNOWN KEY WALUE

Host IMP-PKA key label \ii16P1 IMPPKARSA KEYENC KNOWN.KEY WVALUE |

| Encipher H Cancel H Help ‘

| Trusted Key Entry |

Figure 94. Encipher RSA Key

Specify the following information:

* RSA key usage control — Specifies whether the RSA key can be used for key
management purposes (encryption of DES keys). All RSA keys can be used for
signature generation and verification.

* PKDS key label — Label to be given the imported RSA key at the host. The
information provided in this field can be changed when you load the RSA key to
the host.

* Private key name — Text string that is included in the RSA key token and
cryptographically related to the key. The private key name can be used for
access control for the key. The information you entered in the PKDS key label
field is copied to this field and can be edited.
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» Description — Optional free text that is saved with the RSA key and displayed
when you retrieve the key.

* Workstation EXPORTER key label — The container displays the labels of the
key-encrypting keys currently in the TKE workstation key storage available for
protecting RSA keys entered from a clear key file. Select one by clicking on it.

* Host IMP-PKA key label — The label of the host used to import the RSA key.
The selected Workstation IMP-PKA label is copied to this field and can be edited.
This information can be changed when you load the RSA key to the host.

When the user presses Encipher, a file chooser window is displayed for the user to
specify the file location (Floppy Drive or TKE Data Directory) and file name for
saving the encrypted RSA key.

Warning: If saving the RSA key to diskette, the floppy drive must be deactivated via
the TKE Media Manager before removing the diskette or data could be lost or
corrupted.

Load RSA Key to PKDS - CCF

This selection allows the user to load an RSA key to the host and install it in the
PKDS. Using this function, it is only possible to load the RSA key to the PKDS in
the TKE Host LPAR. For loading RSA keys to TKE target LPARs, see
[Key to Host Dataset - CCF” on page 110}

Having selected Load to PKDS, a dialog box is displayed for selecting the input file
holding the encrypted RSA key. When completed, the Load RSA key to PKDS
window is displayed.

g Load RSA key to PKDS

PKDS key label [RSA512 KEY1 |
Private key name RSA512 KEY1
Description [TKE generated BSA 512 key |
Workstation EXPORTER key label IMPPKA RSA KEYGEN KNOWN KEY VALUE
Host IMP-PKA key label IMPPKARSAKEYGEN.KNOWN.KEY WALUE |

| Send H Cancel H Help ‘

| Trusted Key Entry

Figure 95. Load RSA Key to PKDS

Specify the following information:

* PKDS key label — Label to be given the imported RSA key at the host. Change
this field as needed.

* Private key name — Text string that is included in the RSA key token and
cryptographically related to the key. The private key name can be used for
access control for the key. The information you entered in the PKDS key label
field is copied to this field and can be edited.

» Description — Optional free text that was saved with the RSA key.

* Workstation EXPORTER key label — Label of the workstation IMP-PKA that is
used for protecting the RSA key.
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Domains Keys

* Host IMP-PKA key label — Label of the IMP-PKA key stored in the host CKDS
that will be used to import the RSA key. Change this field as needed.

Load RSA Key to Host Dataset - CCF

This selection allows the user to load an RSA key to a host data set as an external
key token. From this dataset it is possible to install the key in the PKDS by means
of TSO ICSF panels.

The host dataset must be defined in advance with the following attributes: recfm
fixed, Irecl=1500, partitioned. Using this installation method, it is possible to load
RSA keys into any PKDS in any LPAR. For information on the TSO ICSF interface,
see ['Installing RSA Keys in the PKDS from a Dataset” on page 183

The steps are the same as for loading an RSA key to the PKDS (see
[Key to PKDS - CCF” on page 109), except that the user has to specify the full
dataset and member name. If you don’t specify the dataset and member name in
quotes, the high level qualifier for the dataset is the TSO logon of the
administrator/host user ID.

g4 Load RSA key to dataset

PKDS key label [RSAG12KEY1 |
Private key name R5A512 KEY1
Description | TKE generated RSA 512 hit ke |
Workstation EXPORTER key label IMPPKA RSA KEYGEN KNOWN KEY.VALUE
Host IMP-PKA key label IMPPKA RSAKEYGEN KNOWNKEY WALUE |

Host dataset and member name ['cryntor? tkev3.keys(rsas12k1)] |

| Send H Cancel H Help ‘

| |Trusted Kew Entry |

Figure 96. Load RSA Key to Dataset

Page (PCICC and PCIXCC/CEX2C)

This page displays master key status information and allows you to generate, load,
set and clear domain key registers.

The upper part of the window displays the status and hash patterns for the new
symmetric master key registers and for the new asymmetric master key registers.

If you have implemented smart card support, make sure that the cryptographic
adapter in the TKE workstation and the TKE smart cards are in the same zone. To
display the zone of a TKE smart card, exit fom TKE and use either the
Cryptographic Node Management Utility 3.10SC or the Smart Card Utility Program
1.20 under Trusted Key Entry Applications in the Framework. See |“Disp|ay smarﬂ
card details” on page 268| or|Appendix D, “Smart Card Utility Program (SCUP),” on|

page 277|

Select the key type you will be working with from the Key Type container. The
following actions are available:

* Generate: Generate a key part and save to a file or TKE smart card
* Clear. Clear (reset) the key register or key part register
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* Load: Load a key part directly to the relevant new master key register

» Set. Sets the new asymmetric master key. That is, the current ASYM-MK is
transferred to the old ASYM-MK register, and the new ASYM-MK register is
transferred to the current ASYM-MK register. The new ASYM-MK register is reset
to zeros.

* Generate RSA Key. Generate an RSA Key and encrypt it under an IMP-PKA
key.

* Encipher RSA Key: Encipher an unencrypted RSA key under an IMP-PKA key

* Load RSA Key to PKDS: Load an RSA key to the PKDS active in the logical
partition where the Host Transaction Program is started

* Load RSA Key to Host Dataset. Load an RSA key to a host data set
* Load to Key Storage: Load a key part to the TKE workstation DES key storage

* Load to Key Part Register. Load/accumulate operational key parts in a key part
register

» View: View key part register information
» Secure key part entry. Enter known key part values to a TKE smart card.

(J] PCICC Crypto Module Administration : VM16P1 / P01
Functions
General rDetaiIs rRuIes rAuthurities rDumains rCu—Sign |
. Index
Domain Keys B
Status Hash pattern 1
New Symmetric Master Key Empty 00000000000000000000000000000000 2
Old Symmetric Master Key Empty 00000000000000000000000000000000 3
Symmetric Master Key Invalid 00000000000000000000000000000000
4
New Asymmetric Master Key Empty 00000000000000000000000000000000
Old Asymmetric Master Key Empty 00000000000000000000000000000000 a3
Asymmetric Master Key Invalid 00000000000000000000000000000000 [
7
Select key to work with Key Type 3
Mew Symrmetric Master Ke 9
MNew Asymmetric Master Ke
10
11
12
13
14
15
Help
LGeneraI |LKeys LCDntmIs |
UFPDATE MODE

Figure 97. PCICC Domains Keys Page

Not all actions are available for all key types. [Table 4 on page 112|illustrates the
possibilities for the PCICC and [Table 5 on page 113]illustrates the possibilities for
the PCIXCC/CEX2C:

Chapter 5. Crypto Module Notebook 111



Table 4. Key Types and Actions for PCICC Crypto Modules

PCICC
Key Type Popup Sub-popup Special Considerations
New symmetric | Generate
MK Load First Load First requires the register to be
Intermediate empty. Load Intermediate and Last
Last require the register to be part full.
Clear
Secure key part Enter known key part values to a
entry TKE smart card; see |Kppendix E,
“Secure Key Part Entry,” on page]
297 |
New Generate
,&s}gmmetnc Load First Load First requires the register to be
Intermediate empty. Load Intermediate and Last
Last require the register to be part full.
Set
Clear
Secure key part Enter known key part values to a
entry TKE smart card; see |Kppendix E,
“Secure Key Part Entry,” on page
297 |

. Crypto Coprocessor Crypfo Module Administration : G11 / X00 7 o [

Function
Domain Keys
Status Hash pattern
Hew Symmetric Master Key Empty
Old Symmetric Master Key Valid 2BOCT23D1ABICI48EICIEIZEFFFIB7F4
Symmetric Master Key \falid DF3A5DAE3546612396EFA57EBBDOTAC
New Asymmetric Master Key Empty
Old Asymmetric Master Key Valid EF4C65754B5088C22D03480BC7B952B2
Asymmetric Master Key Valid E83F158521FEEAZ23986CCI9483DAFDT 11
Select key to work with Key Type

MNew Symmetric Master kKey

MNew Asymmetric Master Key

Operational key:
Operational Key - IMPO
Operational Key - IPINE  Load to key part register »
Operational Key - OPIN View
Operational Key - PING
Operational Key - PIRY
Operational Key - IMP-F  Secure Key part entry
Operational Key - DATA —

Clear

TGenora | eye Gairts]

| | UPDATE MODE

Figure 98. PCIXCC/CEX2C Domains Keys Page
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Table 5. Key Types and Actions for PCIXCC/CEX2C Crypto Modules

PCIXCC
Key Type Popup Sub-popup Special Considerations
New symmetric | Generate
MK Load First Load First requires the register to be
Intermediate empty. Load Intermediate and Last
Last require the register to be part full.
Clear

Secure key part
entry

Enter known key part values to a
TKE smart card; see |Appendix E,

“Secure Key Part Entry,” on page

po7]

Operational Generate
Keys Load to Key First This function is only performed for
Storage Intermediate operational key types IMPORTER or
Last IMP-PKA.
Load to Key Part | First Load First requires the key part
register Add part register label to be unique. Load
Complete Add part requires a First key part
loaded for the key type selected.
Load Complete requires the key part
register to be in the intermediate
state for the key type selected.
View
Clear
Secure key part Enter known key part values to a
entry TKE smart card; see |Appendix E,
“Secure Key Part Entry,” on page
297 |
RSA Keys Generate...
Encipher
Load to PKDS...
Load to dataset
New Generate
,:As}é/mmetrlc Load First Load First requires the register to be
Intermediate empty. Load Intermediate and Last
Last require the register to be part full.
Set
Clear

Secure key part
entry

Enter known key part values to a
TKE smart card; see |Appendix E,

“Secure Key Part Entry,” on page

po7]

Generate New Symmetric Master Key and New Asymmetric

Master Key for PCICC/PCIXCC/CEX2C

When you select Generate, a window opens whereby you specify the target.
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4 Seled Target
® Smart card
(_» Binary file
Z Print file
| Continue | | Cancel | | Help |
™
| n ITrusted Key Entr\y|

Figure 99. Select Target

Select the target: TKE smart card, binary or print file. Save the key part. If saving
the key part to a binary or print file, specify the file path. to If saving the key part to
a binary or print file, specify either Floppy Drive or TKE Data Directory and the file
name.

If you are saving to a TKE smart card, the following screens appear:

Note: If you have implemented smart card support, make sure that the TKE
cryptographic adapter in the TKE workstation and the TKE smart cards are in
the same zone. To display the zone of a TKE smart card, exit TKE and use
either the Cryptographic Node Management Utility 3.10SC or the Smart Card
Utility Program 1.20 under Trusted Key Entry Applications on the Framework.
See [‘Display smart card details” on page 268| or [‘Display smart card|
information” on page 283

If saving the key part to a TKE smart card, it can not be saved to any other
medium such as a binary or print file.

B ooy por ]

Insert TKE smart card in smart card reader 2.

Figure 100. Save key part to smart card

After you insert the TKE smart card - press OK. Then enter the PIN onto the smart
card reader PIN pad.

R4 Enter key part description

Description |New Symmetric Master Key |

| || Cancel || Help |

| | Trusted key Entry

Figure 101. Enter key part description

Enter a description for the key part.

114 20S V1R8.0 ICSF TKE PCIX Workstation User's Guide



B ovekepoi

Storing key part on the TKE smart card.

Figure 102. Save key part

B sovciopor

Key part and info stored successfully on the card. You can use
0 the 'Copy Smart Card' function in the "Liilities' menu to create

a hack-up.
Figure 103. Save key part success message

Load - PCICC/PCIXCC/CEX2C

Having selected Load, a new menu pops up giving the user the possibility to select
which key part to load:

* First

* Intermediate

* Last

Input from Keyboard:

A dialog box is displayed for selecting the input source.

g4 Select Source

() Smart card in reader 1

() Smart card in reader 2

() Binary file
® Keyboard
g
| Continue || Cancel || Help |

| | Trusted Key Entry |

Figure 104. Select PCICC/PCIXCC/CEX2C key source - keyboard

If keyboard is selected as the input source an input dialog box is displayed with
input fields for either a 16-byte key or a 24-byte key depending on the key type.
The dialog box displayed for entering the key values depends on the installation’s
Blind Key Entry selection. Blind Key Entry masks the key values being entered. If
your installation is using Blind Key Entry, the following dialog box is displayed for
entering the key values:
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&4 Enter key value

By‘es I] ? |1'rﬁ1'rﬁ1'rﬁ1'rﬁ1’rﬁ1’rﬁ1’rﬁ1’rﬁ | REEntEr (Dptiﬂnﬁl) |1'rﬁ1'rﬁ1'rﬁ1'rﬁ1’rﬁ1’rﬁ1’rﬁ1’rﬁ |
ﬂ 15 |**************** | REEntEr (Dptiﬂnﬂl) |**************** |
| Continue ‘ | Cancel ‘ | Help ‘

| Trusted Key Entry

Figure 105. Enter Key Value - Blind Key Entry

An optional confirmation field can be used to confirm the key value entered.

For more information on how to change the Blind Key Entry option, see
[Customization” on page 67|

If Blind Key Entry is not being used, the following dialog box is used:

&4 Enter key value

Bytes 0.7 [0123-4567-80a5-coEF |

§.15 |0123-4567-agas-c9551 |

| Continue H Cancel H Help ‘

| |Trusted Kew Entry |

Figure 106. Enter Key

When the user presses Continue, the MDC-4 and the Encipher Zero VP
(ENC-ZERO) are calculated and displayed, providing the user with the opportunity
to visually verify the MDC-4 and ENC-ZERO values. When Load key is pressed the
user is asked if they would like to save the key part. If yes, a file chooser window is
opened for the use to specify the file location (Floppy drive or TKE Data Directory)
and file name for saving the key part. Then the key part is Loaded. If no, the key
part is not saved and the key part is loaded.

&4 Key parf information

Description

ENC-ZERQ #2ch&4DEd
MD(C-4 279ER3DCF46158TLIFOR01TEIS303967

Key type New Symmetric Master Key,

| Load key H Cancel H Help ‘

| |Trusted Key Entry

Figure 107. Key Part Information Window
Press Load key.
Input from Binary File:

A dialog box is displayed for selecting the input source.
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g4 Select Source

) Smart card in reader 1
) Smart card in reader 2
@) Binary fi

) Keyhoard

| Continue || Cancel || Help |

| | Trusted Key Entry |

Figure 108. Select PCICC/PCIXCC/CEX2C key source - binary file

File

* Floppy Drive
@ TKE Data Directory

Files

current_nmk_Kkey
host.dat
trace.txt

1]

File Mame : |current_nmk_kev

| Trusted Key Entry

Figure 109. Specify Key File

Specify the drive and file name. Select Open to Select Floppy Drive or TKE Data
Directory and the file name. Select Open.

The MDC-4 is calculated and displayed, providing the user with the opportunity to
visually verify the MDC-4 value.

Warning: If the file is loaded from a floppy you must deactivate the floppy drive
before removing the diskette. If the diskette is removed prior to deactivating the
drive data could be lost or corrupted. For details on deactivating media see
[‘Managing Media” on page 393
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£4 Key part information

Description POK test key

ENC-ZFERDO TELIERED
MDC-4 #BO0CTZ3D1ABICH4BEICIES EETFFIETRA

Key type New Symmetric Master Key,

| Load key H Cancel H Help ‘

| |Trusted Key Entry

Figure 110. Key Part Information Window
Press Load key.

Input from TKE Smart Card:

Follow these steps:
1. A dialog box is displayed for selecting the input source.

g4 Seled Source

® Smart card in reader 1
) Smart card in reader 2
) Binary file
) Keyhoard

| Continue || Cancel || Helk |

| ITrusted Key Entr\y|

Figure 111. Select PCICC/PCIXCC/CEX2C key source - smart card

Press Continue.

2. Insert the TKE smart card into the appropriate reader. Ensure the TKE smart
card is enrolled in the same zone as the TKE crypto adaptor; otherwise, the

Load will fail.

Note: To display the zone of a TKE smart card, exit from TKE and use either
the Cryptographic Node Management Utility 3.10SC or the Smart Card
Utility Program 1.20 under Trusted Key Entry Applications on the
Framework. See [‘Display smart card details” on page 268| or [‘Display]
fsmart card information” on page 283.|

3. The smart card contents are read and the following window appears:
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ct key part from TKE smart card X

Card ID 1EFS74DAS
Zone description TKESO UT
| Card description

| Card contents

I Key type Cescription origin | MDC4

| [ICSF symmetric master key part ey part 1 Crypto adapter |9059AE7888889E8461EDACDE49

| |ICSF synmetric master key part ey part 2 Crypto adapter 86202000A53230B3F7FF181ESE

1 |ICSF synmetric master key part ey part 3 Crypto adapter |19E90ASTOFEGSFSCDAFESFS041|
C5F symmetric master key part ey part 8 Crypto adapter |FESOFBE485AFGAE0441444B20D)

. |ICSF synmetric master key part ey part 4 Crypto adapter AFOT7GFGDE4FE18F3SEESTOOAL
C5F symmetric master key part ey part 3 Crypto adapter OALFDEI9S82AD0TEAC1SCAF258
CSF symmetric master key part ey part 6 Crypto adapter |BEFGS2C11ET1726BC48F52CEFN
C5F symmetric master key part ey part 7 Crypto adapter |S9793C42820C4AFEFE3IBT33TEY
perational key part, DATAM Operational Key - DATAM Crypto adapter |6A3EA273CF4E92E74CE59 1024
perational key part, EXPORTER |Operational Key - EXPORTER  Crypto adapter |235576201371513080C11 DACY

N | D
OK Cancel Help
[

I Trusted Key Entry |

Figure 112. Select key part from TKE smart card

4. Highlight key part to load.

5. Click OK.

6. Enter the PIN on the smart card reader PIN pad when prompted.
7

The MDC-4 is calculated and displayed, providing the user with the opportunity
to visually verify the MDC-4 value. The Encipher Zero VP (ENC-ZERO) of the
new symmetric or asymmetric master key part is also displayed for verification.

8. Press Load key.
9. You will get a message that the command was executed successfully.

Clear - PCICC/PCIXCC/CEX2C
If a register is not empty or if you make a mistake during key entry, you can select
Clear, and the following window opens:

B o

E Are you sure you want to clear the Key Register
No

Figure 113. Clear Key Validation Message

If you press Yes and the command executes successfully, you will get the following
message:

4 Clear Key Register

Command was executed successfully

A lg'”ﬁ

Figure 114. Clear Key Successful Message
Set (ASYM-MK only) - PCICC/PCIXCC/CEX2C

If you select SET for an asymmetric-keys master key, a message is issued warning
that PKA services must be disabled before the SET is done. If you respond to
continue then you get a message indicating successful execution.
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SET will activate the new ASYM-MK. That is, the current ASYM-MK is transferred to
the old ASYM-MK register and the new ASYM-MK register is transferred to the
current ASYM-MK register. The new ASYM-MK register is reset to zeros.

Domain Keys Page - PCIXCC/CEX2C

120

Operational Keys (PCIXCC/CEX2C)

Beginning with TKE V4.1, operational keys can be loaded on a Crypto Coprocessor.
Operational key part registers allow operational keys to be loaded and accumulated
on a Crypto Coprocessor.

Note: To use TKE V4.1 or higher to load operational keys, you must be running
HCR770B or higher for ICSF.

Once all the key parts have been loaded and the key is Complete, you are required

to remove the key from the key part register and load it into the CKDS. This is

accomplished either through ICSF panels (see [‘Loading Operational Keys to the

CKDS” on page 199) or using an option on KGUP JCL (see |z/OS Cryptographi

Services ICSF Administrator’s Guide).

Each PCIXCC/CEX2C can have a maximum of 100 key part registers distributed
across all domains. A key part register can be in one of the following states:

» First part entered — Load to key part register (First has completed successfully)

* Intermediate part entered — Load to key part register (Add part has completed
successfully)

* Complete — Load to key part register (Complete has completed successfully)

At least two key parts must be entered and there is no maximum number of key
parts.

Available tasks for Operational key part registers are:

» Load to key part register

* View

e Clear

Tasks for Load to key part register are:

* First

* Add part

» Complete

A key part register is freed when a Complete key is loaded to the CKDS from ICSF
(either through the ICSF panels or KGUP JCL), when the key part register is

Cleared from TKE, or a zeroize domain is issued from TKE. View of a key part
register displays key part register information.

Use of the operational key part registers on the PCIXCC/CEX2C is controlled by
access control points in the role definition. The access control points are:

* Load First Key Part

* Load Additional Key Part

* Complete Key

* Clear Operational Key Part Register

The Crypto Coprocessor supports all ICSF operational keys, not just Transport and
PIN key types. A USER DEFINED key type is also available that allows the user to
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specify their own control vector. This USER DEFINED control vector must still conform
to the rules of a valid control vector. For more details on control vectors, see
Ai i endix C in the [z/0S Cryptographic Services ICSF Application Programmer’s

Generate Operational Key Parts: When Generate is selected for a Default
Operational Key, the Generate Operational Key window is displayed showing the
key type, key length, description and control vector. Only the description field may
be updated. The key length and control vector fields reflect the default length and
control vector for the key type selected. If the key type supports different lengths
(MAC, MACVER and DATA) then the key length field can also be updated.

4 Generate Operational Key

ey length

Keytype EXPORTER 16

Description |Operati0na| Key - EXFORTER

Bytes 0.7 8.15
Control vector

| Continue " Cancel " Help |

Figure 115. Generate Operational Key - Default ICSF Key Type

When Generate is selected for a USER DEFINED key, the Generate Operational Key
window is displayed showing the key type, key length, description, and blank control
vector fields. All but the key type can be updated. The control vector entered must
conform to the rules for a valid control vector.

4 Generate Operational Key

Keytype USER DEFINED

Description |0perati0na| Key- USER DEFINED

Bytes 0.7 8..15
Control vector
| Continue " Cancel " Help |

Figure 116. Generate Operational Key - USER DEFINED

In both cases, after selecting Continue on the Generate window, the user is
presented with a choice of targets: Binary File, Print File or Smart Card.
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4 Seled Target

® Smart card
(_» Binary file
Z Print file
| Continue | | Cancel | | Help |

| ITrusted Key Entr\y|

Figure 117. Select Target

For either the binary file or print file option, the user must specify where the key is
to be saved on the Save key part window.

I
P

Description \Operatmnal Key - EXPORTER |

(e 2 Floppy Drive

(@ TKE Data Directory

Files
current_nmk_key 1|
hostdat
trace.txt

File Name: [OPKEY_EXPORTER]

‘ Trusted Key Entrny

Figure 118. Save key part

After the key is saved, the user can save the same key value again in another
location on the Save key again window.

4 Save key again

Key and info saved successfully
Would you like to save the key elsewhere?

= [ [ ]

Figure 119. Save key again

Warning: If a binary key is saved to floppy you must deactivate the floppy drive
before removing the diskette. If the diskette is removed prior to deactivating the
drive data could be lost or corrupted. For details on deactivating media see

[‘Managing Media” on page 393.

Save key to Smart Card

Note: The TKE cryptographic adapter generates the key part and securely
transfers the key to the TKE smart card. You must insert a TKE smart card
that is enrolled in the same zone as the TKE cryptographic adapter;
otherwise the Generate will fail. To display the zone of a TKE smart card,
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exit from TKE and use either the Cryptographic Node Management Utility
3.10SC or the Smart Card Utility Program 1.20 under Trusted Key Entry
Applications on the Framework. See [‘Display smart card details” on page]
268 )|‘Display smart card information” on page 283 or [‘View current zone” on|

page 295

Steps for saving a key to a TKE smart card are:

1.

2.
3.
4

When prompted, insert TKE smart card into smart card reader 2
Press OK
Enter the PIN on the smart card reader PIN pad

A pop up message will indicate that the key part was successfully stored on the
TKE smart card.

Note: The user can use the Copy smart card contents utility to copy key parts from

one TKE smart card to another. See [‘Copy smart cards” on page 66

Load to Key Part Register - First: When Load to Key Part Register First is
selected, the user must select the source of the key part on the Select source
window.

¥4 Select Source

(®) Smart card in reader 1
) Smart card in reader 2
) Binary file
) Keyhoard

| Continue || Cancel || Helk |

| Trusted Key Entry

Figure 120. Select Source

If binary file is selected, the user chooses the file to load on the Specify key file
window.
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I
<

) Floppy Drive
| s TKE Data Directory

Files

current_nmk_key
hostdat
OPKEY_EXPORTER
trace.txt

| »

1]

File Name : |OPKEY_E}(PORTER

uew |

| |Trusted Fey Entry

Figure 121. Specify key file for binary file source

If the binary file contains a key type that does not match the key type selected for
loading, a warning is displayed asking for confirmation to continue. If continue is
chosen, TKE will load the key part as the key type defined in the binary file and not
the key type selected originally by the user.

Warning: If the file is loaded from a floppy you must deactivate the floppy drive
before removing the diskette. If the diskette is removed prior to deactivating the
drive data could be lost or corrupted. For details on deactivating media see
[‘Managing Media” on page 393|

If keyboard is selected, the Enter key value window is displayed. When the key type
is a default operational key with a fixed length (single length or double length only),
the fields on the window that can be updated are the description and the key value.
If the default operational key supports different lengths (DATA, MAC and MACVER),
then the key length field can be updated. When the user presses Continue, the
MDC-4 and ENC-ZERO is calculated and displayed, providing the user with the
opportunity to visually verify the values. When Load key is pressed, the user is
asked if they would like to save the key part. If yes, a file chooser window is
opened for the user to select either the Floppy drive or the TKE Data Directory and
enter a File Name for saving the key part. The key part is then loaded. If no, the
key part is not saved and the key is loaded.
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&4 Enter key value

ey length
8
Keytype EXPORTER 16
24
Description |Operati0na| Key- EXFORTER |
Bytes 0..7 8.15 16..23

Control vector

Keywalue | |

Continue || Cancel || Help |

Trusted Key Entry

Figure 122. Enter key value - keyboard source for ICSF default key type

When the key type is USER DEFINED, all the fields on the Enter Key Value window
can be updated, including the control vector. The control vector entered must
conform to the rules for a valid control vector. See|z/OS Cryptographic Serviced
[ICSF Application Programmer’s Guided

&4 Enfer key value

Keytype USER DEFINED

Description |Operati0na| Key- USER DEFIMNED |

Bytes 0.7 8..15 16..23

Control vector
Key value

Continue || Cancel || Help |

Trusted Key Entry

Figure 123. Enter key value - keyboard source for USER DEFINED key type

1. If TKE smart card is selected, the user is prompted to insert a TKE card into the
appropriate reader and select OK.
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g4 Seled Source

(@ Smart card in reader 1
) Smart card in reader 2
) Binary file
) Keyhoard

| Continue || cancel || Helk |

| | Trusted Key Entry

Figure 124. Select Source

2. Highlight the key part, right click and choose select; or highlight and press OK.

If the smart card contains a key type that does not match the key type selected
for loading, a warning is displayed asking for confirmation to continue. If
continue is chosen, TKE will load the key part as the key type defined in the
smart card and not the key type selected originally by the user.

cey part from TKE smart card ]
Card ID 1EF574DAS
Zone description TKES0 UT
| Card description
| Card contents
[ Key type Description Qarigin MDC4
| |TCSF symmetric master key part |Key part 1 Crypto adapter DOSSAETEES830ES461EDACDE4S
| [IC5F symmetric master key part |Key part 2 Crypto adapter B862028D0433230B3F7FF181ESE
| |1ICSF symmetric master key part |Key part 3 Crypto adapter [18ES0ASTOFEGSFOCDAFESFIS41
ICSF symmetric master key part Key part 9 Crypto adapter 7ESBOFBE4839AF6AZ0441444B300
|ICSF symmetric master key part  |Key part 4 Crypto adapter AFOTTEFEDE4FG1SF3SEEITOOAS
ICSF symmetric master key part Key part 5 Crypto adapter DALFDESS924D076EEC15C4F258C
ICSF symmetric master key part Key part Crypto adapter |BEFGB2C11ET1T26BC4BFS2CEFA
ICSF symmetric master key part Key part 7 Crypto adapter |S8783C42820C4AFEF8387337582
Operational key part, DATAM Operational Key - DATAKM Crypto adapter BAIEAZTICF4EOZBT4CESOS1D24/
Operational key part, EXPORTER  Operational Key - EXPORTER Crypto adapter 235576201371B13080C11EDACL
4 [»
OK Cancel Help

Trusted Key Entrny

Figure 125. Select key part from TKE smart card
3. Enter PIN on PIN pad

After the binary file or TKE smart card is read or the key part is entered, the
ENC-ZERO and MDC-4 values for the key part are calculated and displayed along
with the description, key type, and control vector on the Key part information
window. (ENC-ZERO is not displayed for 24 byte key parts.) The user must enter a
key label for the key part to be loaded. When loading additional key parts, the key
part register will be selected by the key label entered. The key label entered must
not already exist. If it does, an error will occur. The key label must conform to valid
key label names in the CKDS. It must be no more than 64 bytes with the first
character alphabetic or a national (#, %, @). The remaining characters can be
alphanumeric, a national character, or a period(.). When the key part is processed,
the label will be converted to uppercase.
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4 Key part information

Description Operational Key - EXPORTER
ENC-ZERQ CF35DF3E
MDC-4 F75B19275213A03DA3AETSD23CTSFCSC
Keytype Operational Key - EXPORTER
Controlvector 00417D0003410000 00417D0003210000

Key label

| Load key || Cancel || Help |

Trusted Key Entry

Figure 126. Key part information - first key part

If the information presented on the Key part information panel is correct, the key
part is loaded to the key part register by selecting Load Key. After the key part is
successfully processed, the Key part register information window is displayed. It
displays information about the Key Part Register, including the key type, SHA-1
hash of the first key part, the Control Vector and the key label. If necessary, the
parity of the key part was adjusted to odd.

&4 Key part register information

0 Keytype Cperational Key- EXPORTER
SHA1 96D8511F54BFBDFGO1EA226FEFBOCT SEAS1878F1
Control vector |00417D0003410000 0041700003210000
Keylabel EXPORTER.TKE41.BINARY

Figure 127. Key part register information

After OK is selected on the Key part register information window, the Load
Operational Key window is displayed, indicating that the load was processed
successfully.

Load to Key Part Register - Add Part: Load to key part register Add part can be
performed multiple times, but must be performed at least once. The process for
loading additional parts is similar to loading the first key part.

If binary file is selected, the user chooses the file to load. If smart card in reader 1
or smart card in reader 2 is selected, the user chooses the key part to load. If
keyboard is selected and the key type is a default operational key, the Enter Key
Value window is displayed. If the key type is USER DEFINED then the Load
Operational Key Part Register window is displayed with a drop down menu of
available control vectors.

®4 Load Operational Key Part Register

g Control vector |l]l]4142l]l]l]348l]l]l]l] 0041420003280000 |

Figure 128. Load Operational Key Part Register - add part, keyboard source for USER
DEFINED
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The user selects the control vector for the key part to be loaded. Note that in this
display of the available control vectors, the key part bit (bit 44) is turned on
indicating that the key in the key part register is a partial key and is not yet
complete. This bit will be turned on automatically when the first key part is loaded
regardless if the user turned it on when the control vector was defined.

B4 Load Operational Key Part Register

g Control vector | 0041420003480000 0041420003280000 ~ |
0041420003480000 0041420003280000 -
00054D0003480000 00054D0003280000
00413C0003480000 00413C0003280000

Figure 129. Drop down of control vectors - add part, keyboard source for USER DEFINED

After the control vector is selected, the Enter Key Value window is displayed. Once
the binary file or key part from the TKE smart card is read or the key part is
entered, the Key part information window is displayed. This window differs from the
window displayed for the Load first key part in two ways: key label and key label’s
SHA-1.

B4 Key part information

Description Operational Key - EXPORTER
ENC-ZERQ ascoasses
MDC-4 37Fde3E9ACESSESAEFDSCOSARNZ933FE
Keytype Operational Key - EXPORTER
Control vector 00417D0003410000 00417D00032 10000

Key label | EXPORTER.TKE41.KEYBOARD -

Key label's SHA1 7z26F4A032E9F40ERSS1 4E925E49 COE37E 264B7E4

Load key || Cancel || Help |

Trusted Key Entry

Figure 130. Key part information - add part

The key label field is now a drop down menu for all the labels that have the same
control vector and are not in a Complete state. The user selects the appropriate key
label to load the key part. The key label's SHA-1 reflects the SHA-1 hash of the key
parts currently loaded in the selected key part register. Load Key is selected and
the key part register information window is displayed. The SHA-1 hash value
displayed now represents the accumulated key parts, including the key part just
loaded. If necessary, the parity of the key part just loaded was adjusted to even.

4 Key part register information

0 Keytype Operational Key- EXPORTER
SHA1 9164326B19241AEB33AB5117096F544CC06C18ER
Control vector |0041700003410000 0041700003210000
Keylabel EXPORTER.TKE#1 BINARY

Figure 131. Key part information - add part with SHA-1 for combined key

When the add part is successfully processed, the Load Operational Key window is
displayed.

z/OS V1R8.0 ICSF TKE PCIX Workstation User's Guide



Load to Key Part Register - Complete: When all the key parts have been
loaded, the key part register needs to be placed in the Complete state. When load
key part register complete is selected for a default operational key, the Complete
Operational Key Part Register window is displayed. Only key part register labels in
the intermediate state that contain keys of the same operational key type are
displayed for selection. If the key type supports different key lengths (8, 16 or 24),
then all key part registers of the key type selected will be displayed regardless of
key length.

B4 Complefe Operational Key Part Register

ﬂ EXPORTER.TKE41.BINARY
EXPORTER.TKE41 KEYBOARD

Key labels

SHA1 916432681924 1AEB33AB5117096F544CCO6C18EB

| 0K || Cancel || Help |

Figure 132. Complete Operational Key Part Register - ICSF default key type

To select one key label, select the label with the left mouse button. To select more
than one key label, select the label with the left mouse button, then hold down the
Control key and select additional key labels with the button. To select a range of
key labels, select the first key label with the left mouse button, then hold down the
Shift key and select the last key label. All key labels in between the two selected
labels will be selected. To select all the key labels, hold down the Control key and
type an 'a’. When only one key label is selected, the SHA-1 hash of the
accumulated key in the key part register is displayed. If more than one key label is
selected then the SHA-1 field on the window contains a '-'.

When load key part register complete is selected for USER DEFINED key type, the
complete operational key part register window is displayed with all the domains’ key
part registers that are in the intermediate state.

B4 Complefe Operational Key Part Register
g LD TKE41 BINARY
UD TKE41 KEYBOARD

Key labels

SHA1 345C0E97987B 1F4E1BE3SBEE1678ASF1061C2C301

| 0K || Cancel || Help |

Figure 133. Complete Operational Key Part Register - USER DEFINED

After the key labels have been selected, the key part register information window is
displayed for each label that was selected. The ENC-ZERO value is shown for the

Chapter 5. Crypto Module Notebook 129



130

completed key and the state is complete. ENC-ZERO is only shown for key parts
that are not 24 bytes long.

4 Key part register information

0 Keytype Operational Key- EXPORTER
ENC-ZERQO  445C3F2C
Control vector |00417D0003410000 0041700003210000
Keylabel EXPORTER.TKE#1 BINARY
State |Complete

Figure 134. Key part register information - complete

After all the key labels that were selected are processed, the load operational key
window is displayed indicating that the command was executed successfully.

View: Operational Key View is used to display key part register information. When
View is selected for a default operational key, the View Operational Key Part
Register window is displayed. Only key part register labels that contain keys of the
same operational key type are displayed for selection.

4 View Operational Key Part Register

ﬂ EXPORTER.TKE41 BINARY
EXPORTER.TKE41 KEYBOARD

Key labels

SHA1 916432681924 1AEB33AB5117096F544CCO6C18EB

| 0K || Cancel || Help |

Figure 135. View Operational Key Part Register - ICSF default key type, one key label
selected

To select one key label, select the label with the left mouse button. To select more
than one key label, select the label with the left mouse button, then hold down the
Control key and select additional key labels with the button. To select a range of
key labels, select the first key label with the left mouse button, then hold down the
Shift key and select the last key label. All key labels in between the two selected
labels will be selected. To select all the key labels, hold down the Control key and
type an 'a'. When only one key label is selected, the SHA-1 hash of the
accumulated key in the key part register is displayed. If more than one key label is
selected then the SHA-1 field on the window contains a '-'.
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4 View Operational Key Part Register

g EXPORTER.TKE41.BINARY
EXPORTER.TKE41 KEYBOARD

Key labels

SHA1

| 0K || Cancel || Help |

Figure 136. View Operational Key Part Register - ICSF default key type, all key labels
selected

When View is selected for USER DEFINED key type, the view operational key part
register is displayed with all the domains’ key part registers.

4 View Operational Key Part Register

ﬂ EXPORTER.TKE41.BINARY
EXPORTER.TKE41 KEYBOARD

UD.TKE41 BINARY

UD. TKE41 KEYBOARD

UD.TKE41 KEYBOARD KEY2

HKey labels

SHA1 9164326B19241AEB33AB5117096F544CCO6C18EB

| 0K || Cancel || Help |

Figure 137. View Operational Key Part Register - USER DEFINED

After the key labels have been selected, the key part register information window is
displayed for each label that was selected. For keys that are in the First part
entered or Intermediate part entered state, the SHA-1 value is displayed for the
accumulated partial key value. Since the key contained in the key part register is a
partial key, the key part bit (bit 44) of the control vector will be turned on. This is
true for default and USER DEFINED key types.

4 Key part register information

0 Keytype Operational Key- USER DEFINED
SHA&1 172D8670CB4B47DEFCB5EGC1609AFB0BDF1983B1
Control vector |(0413C0003480000 00413C0003250000
Keylabel D TKE41 KEYBOARD KEY2
State First part entered

Figure 138. View key part register information - key part bit on in CV

If the key is in the Complete state, the ENC-ZERO value of the completed key is
displayed. If the key is 24 bytes, the ENC-ZERO value will be a dash (’-’) rather
than the actual hex number. The control vector for the completed key will have the
key part bit turned off.
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4 Key part register information

o Keytype |operational Key- EXPORTER
ENC-ZERO 445C3F2C
Control vector |00417D0002410000 004170000321 0000
Keylabel EXPORTER TKE# BINARY
State |Complete

Figure 139. View key part register information - complete key

After all the key labels that were selected are processed, the view key register
window is displayed indicating that the command was executed successfully.

B4 View Key Register

0 Command was executed successfully
Close

Figure 140. View key register successful message

Clear: Operational Key Clear is used to clear the contents of key part registers.
When Clear is selected, a Warning! window is displayed, prompting the user to
confirm that they want to clear the key part registers.

B ooy |

ﬂ Are you sure you want to clear the Key Register

= N =

Figure 141. Warning! message for clear operational key part register

When clear is selected for a default operational key, the clear operational key part
register window is displayed. Only key part register labels that contain keys of the
same operational key type are displayed for selection. If the key type supports
different key lengths (8, 16 or 24), then all key part registers of the key type
selected will be displayed regardless of key length.
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4 Clear Operational Key Part Register

ﬂ EXPORTER.TKE41.BINARY
EXPORTER.TKE41 KEYBOARD
EXPORTER.TKE41. KEYBOARD .KEY2

Key labels

SHA1 726F4A032B9F40EE6D14E929B49CCE37B264B7B4

| 0K || Cancel || Help |

Figure 142. Clear Operational Key Part Register - ICSF default key type, one key label
selected

To select one key label, select the label with the left mouse button. To select more
than one key label, select the label with the left mouse button, then hold down the
Control key and select additional key labels with the button. To select a range of
key labels, select the first key label with the left mouse button, then hold down the
Shift key and select the last key label. All key labels in between the two selected
labels will be selected. To select all the key labels, hold down the Control key and
type an 'a’. When only one key label is selected, the SHA-1 hash of the
accumulated key in the key part register is displayed. If more than one key label is
selected then the SHA-1 field on the window contains a '-'.

4 Clear Operaftional Key Part Register

g EXPORTER.TKE41.BINARY
EXPORTER.TKE41 KEYBOARD
EXPORTER.TKE41 KEYBOARD KEY2

Key labels

SHA1

| 0K || Cancel || Help |

Figure 143. Clear Operational Key Part Register - ICSF default key type, all key labels
selected

When Clear is selected for USER DEFINED key type, the clear operational key part
register is displayed with all the domains’ key part registers.
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4 Clear Operafional Key Part Register

ﬂ EXPORTER.TKE41.BINARY
EXPORTER.TKE41 KEYBOARD

UD.TKE41 BINARY

UD. TKE41 KEYBOARD

UD.TKE41 KEYBOARD KEY2

Key labels

SHA1 916432681924 1AEB33AB5117096F544CC06C18EB

| 0K || Cancel || Help |

Figure 144. Clear Operational Key Part Register - USER DEFINED, one key label selected

After OK is selected, the key labels selected are processed, and the Clear Key
Register window is displayed indicating that the command was executed
successfully.

4 Clear Key Register

0 Command was executed successfully
Close

Figure 145. Clear Key Register successful message

Load to Key Storage - PCIXCC/CEX2C

This selection is only possible for operational IMP-PKA or IMPORTER keys. The
IMP-PKA key-encrypting keys are used to protect RSA keys during transport from
the workstation to ICSF whereas the IMPORTER keys are used to protect DES
keys during transport from the workstation to ICSF. Having selected Load to Key
Storage, the user selects which key part to load to the workstation key storage:

* First...

* Intermediate...

e Last...

The contents of the container depend upon the user’s selection.

If the user selected First, the container shows all keys in the workstation key
storage usable as IMP-PKA key encrypting keys. The user can use these as
skeletons for composing the new key label.

If the user selected Intermediate or Last, the container shows all keys in the
workstation key storage that have been installed with the first key part. It also
shows any optional, intermediate key parts that have been installed. The user must
select one of these as the key label.

z/OS V1R8.0 ICSF TKE PCIX Workstation User's Guide



#4 Install IMPORTER key part in TKE workstation key storage

A host IMPORTER key is installed in the TKE workstation key storage as an EXPORTER key.
EXPORTER keys in TKE workstation key storage.

Key label

IMFPEA RSAKEYGEMN KNOWMN.KEY VALUE

IMPPRARSAKEYENCENOWN.KEY WALUE

MIGEATE.IMPORTER.EEY

Workstation key label |

‘ Continue || Cancel H Help |

Trusted Key E

try |

Figure 146. Install Importer Key Part in Key Storage

For IMP-PKA keys, you must specify additional information.

g4 Install IMP-PKA key part in TKE workstation key storage

A host IMP-PKA key is installed in the TKE workstation key storage as an EXPORTER key.

Key usage
) for RSA key generation
_1 for RSA key enciphering

EXPORTER keys in TKE workstation key storage.

Key label

IMPPEA RSARKEYGEMN.KNOWMN.KEY VALLIE

IMPPKARSAKEYENC KNOWNKEY WALUE

Workstation key label |

‘ Continue || Cancel H Help |

Trusted Key E

try |

Figure 147. Install IMP-PKA Key Part in Key Storage
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A window is displayed for the user to specify the workstation key label and whether
this IMP-PKA key will be used for protecting an RSA key to be generated at the
workstation or a clear RSA key to be enciphered at the workstation.

Note: For the RSA key to be loaded into the PKDS, the same IMP-PKA key value
must be stored in the CKDS. See [‘Load to Key Part Register - First” on page)

Secure Key Part Entry

To save known key part values to a TKE Smart Card use secure key part entry.
Refer to|Appendix E, “Secure Key Part Entry,” on page 297] for details on using this
function.

Generate RSA Key - PCIXCC/CEX2C

Note: On z990, z890, or z9-109 it is strongly recommended that customers use the
PKA key generate (CSNDPKG) API to generate RSA keys.

To write RSA keys to the PKDS, use PKA key record create (CSNDKRC or
CSNDKRW).

For more information, see |z/OS Cryptographic Services ICSF Application]
[Programmer’s Guidel

This selection initiates RSA key generation at the workstation. The key is protected
with a previously generated IMP-PKA key encrypting key and saved in a file.

From the Domains Keys page, right-click on RSA key in the Key Types container
and select Generate. The Generate RSA Key window is displayed.
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B4 Generate RS54 key

-RSA key usage control——— Key length— [ Public exponent
® Signature w512 w3
) Key management & signature | | 768 i 65537
1024 ) Random
ol ]

PKDS key label | |

Private key name | |

Description | |

Workstation IMP-PKA label key label

Host IMP-PKA key label | |

| Generate H Cancel H Help ‘

Trusted Key Entry |

Figure 148. Generate RSA Key

Specify the following information:

RSA key usage control — Specifies whether or not the RSA key can be used for
key management purposes (encryption of DES keys). All RSA keys can be used
for signature generation and verification.

Key length — Length of the modulus of the RSA key in bits. All values from 512
to 1024 are valid. If the entered value exceeds the maximum value set by the
selected crypto module an error Invalid key length specified. It must be
between 512 and 1024 is displayed. You are allowed to continue but the
generated RSA key cannot be loaded to this crypto module.

Public exponent — Value of the public exponent of the RSA key.

PKDS key label — Label to be given the imported RSA key at the host. The
information provided in this field can be changed when you load the RSA key to
the host.

Private key name — Text string that is included in the RSA key token and
cryptographically related to the key. The private key name can be used for
access control for the key. The information you entered in the PKDS key label
field is copied to this field and can be edited.

Description — Optional free text that is saved with the RSA key and displayed
when you retrieve the key.

Workstation IMP-PKA label — The container displays the labels of the
key-encrypting keys currently in the TKE workstation key storage available for
protecting RSA keys generated at a TKE workstation. Select one by clicking on it.
Host IMP-PKA key label — The CKDS key label at the host used to import the
RSA key. The selected Workstation IMP-PKA label is copied to this field and can
be edited. This information can be changed when you load the RSA key to the
host.
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When the key is generated, a file chooser window is displayed for the user to
specify the file location (Floppy Drive or TKE Data Directory) and file name for
saving the generated RSA key.

Warning: If saving the RSA key to diskette, the floppy drive must be deactivated via
the TKE Media Manager before removing the diskette or data could be lost or
corrupted.

Encipher RSA Key - PCIXCC/CEX2C

This selection allows an RSA key to be read from a clear key file, encrypted with a
previously generated IMP-PKA key encrypting key and saved in a file. The format of
the clear key file is described in|Appendix |, “Clear RSA Key Format,” on page 317

Having selected the Encipher action, the Encipher RSA Key window is displayed:

g4 Encipher RSA key

-RSA key usage control—— Key length - Public exponent——
® Signature 3612 3
r Key management & signature O 768 ® B5537

1024 2 Random

@) 799

PKDS key label [R54739 ke |

Private key name |[B54739 ke |

Description [R5A 799 kvs |

Workstation EXPORTER key label Kevlahel
IMPPEARSA KEYEMCKNOWN KEY WALUE

Host IMP-PKA key label \ii16P1 IMPPKARSA KEYENC KNOWN.KEY WVALUE |

| Encipher H Cancel H Help ‘

| Trusted Key Entry |

Figure 149. Encipher RSA Key

Specify the following information:

* RSA key usage control — Specifies whether the RSA key can be used for key
management purposes (encryption of DES keys). All RSA keys can be used for
signature generation and verification.

* PKDS key label — Label to be given the imported RSA key at the host. The
information provided in this field can be changed when you load the RSA key to
the host.

* Private key name — Text string that is included in the RSA key token and
cryptographically related to the key. The private key name can be used for
access control for the key. The information you entered in the PKDS key label
field is copied to this field and can be edited.
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» Description — Optional free text that is saved with the RSA key and displayed
when you retrieve the key.

* Workstation EXPORTER key label — The container displays the labels of the
key-encrypting keys currently in the TKE workstation key storage available for
protecting RSA keys entered from a clear key file. Select one by clicking on it.

* Host IMP-PKA key label — The CKDS key label at the host used to import the
RSA key. The selected Workstation IMP-PKA label is copied to this field and can
be edited. This information can be changed when you load the RSA key to the
host.

When the key is enciphered, a file chooser window is displayed for the user to
specify the file location (Floppy Drive or TKE Data Directory) and file name for
saving the encrypted RSA key.

Warning: If saving the RSA key to diskette, the floppy drive must be deactivated via
the TKE Media Manager before removing the diskette or data could be lost or
corrupted.

Load RSA Key to PKDS - PCIXCC/CEX2C

This selection allows the user to load an RSA key to the host and install it in the
PKDS. Using this function, it is only possible to load the RSA key to the PKDS in
the TKE Host LPAR. For loading RSA keys to TKE target LPARs, see
[Key to Host Dataset - PCIXCC/CEX2C” on page 140}

Having selected Load to PKDS, a dialog box is displayed for selecting the input file
holding the encrypted RSA key. When completed, the Load RSA key to PKDS
window is displayed.

g Load RSA key to PKDS

PKDS key label [RSA512 KEY1 |
Private key name RSA512 KEY1
Description [TKE generated BSA 512 key |
Workstation EXPORTER key label IMPPKA RSA KEYGEN KNOWN KEY VALUE
Host IMP-PKA key label IMPPKARSAKEYGEN.KNOWN.KEY WALUE |

| Send H Cancel H Help ‘

| Trusted Key Entry

Figure 150. Load RSA Key to PKDS

Specify the following information:
* PKDS key label — Label to be given the imported RSA key at the host. Change
this field as needed.

* Private key name — Text string that is included in the RSA key token and
cryptographically related to the key. The private key name can be used for
access control for the key. The information you entered in the PKDS key label
field is copied to this field and can be edited.

» Description — Optional free text that was saved with the RSA key.

» Workstation EXPORTER key label — Label of the workstation IMP-PKA that is
used for protecting the RSA key.
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* Host IMP-PKA key label — Label of the IMP-PKA key stored in the host CKDS
that will be used to import the RSA key. Change this field as needed.

Load RSA Key to Host Dataset - PCIXCC/CEX2C

This selection allows the user to load an RSA key to a host data set as an external
key token. From this dataset it is possible to install the key in the PKDS by means
of TSO ICSF panels.

The host dataset must be defined in advance with the following attributes: recfm
fixed, Irecl=1500, partitioned. Using this installation method, it is possible to load
RSA keys into any PKDS in any LPAR. For information on the TSO ICSF interface,
see [Installing RSA Keys in the PKDS from a Data Set” on page 203

The steps are the same as for loading an RSA key to PKDS (see [‘Load RSA Key to|
[PKDS - PCIXCC/CEX2C” on page 139), except that the user has to specify the full
dataset and member name. If you don’t specify the dataset and member name in
quotes, the high level qualifier for the dataset is the TSO logon of the
administrator/host user ID.

g4 Load RSA key to dataset

PKDS key label [RSAG12KEY1 |
Private key name R5A512 KEY1
Description | TKE generated RSA 512 hit ke |
Workstation EXPORTER key label IMPPKA RSA KEYGEN KNOWN KEY.VALUE
Host IMP-PKA key label IMPPKA RSAKEYGEN KNOWNKEY WALUE |

Host dataset and member name ['cryntor? tkev3.keys(rsas12k1)] |

| Send H Cancel H Help ‘

| |Trusted Kew Entry |

Figure 151. Load RSA Key to Dataset

Domains Controls Page

140

The Domain Controls page displays the cryptographic functions that are in effect for
the domain and allows you to make changes to them. There are different pages for
the CCF crypto modules and the PCICC/PCIXCC/CEX2C crypto modules.

* To change a setting, click on it
» To upload the controls settings to the crypto module, press Send updates

» To leave the controls settings unaltered after you have made changes to the
page, press Discard changes

Working with Domain Controls Settings (CCF)

You can enable or disable the following functions from the TKE workstation:
* Cryptographic functions

* Special Secure mode

* Load clear new master key

» Load clear Signature master key

* Load clear Key Management master key
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(J] CCF Crypto Module Administration : VM16P1 / C00

Function

General rDelaiIs rAccess Control rAuthurities rDumains rCo—Sign|

Domain Cryptographic Services

rEnvironmental control mask

1
|2
|3
4
5
B

[vl Cryptographic functions 7
[ Special Secure mode 8
[l Load clear new master key 9

[ Load clear Signature master key

[ Load clear Key Management master key

| Send updates || || Discard changes || Help |

LGeneraI LKeys LCD ntrols |

| UPDATE MODE

Figure 152. CCF Domain Controls Page - Default Setting

The Cryptographic functions box should always be checked. If it is not, basic
cryptography is unavailable. If for some reason you must disable cryptographic
functions, you must first disable PKA services from the ICSF panels (see
[PKA Services” on page 170). PKA Services should not be enabled on the target
system until ALL crypto modules are back online (see [‘Enabling PKA Services” on|
_pae 171

The Special Secure mode box, when enabled, allows you to input clear keys and
generate clear PINs. SSM must be enabled for the KGUP utility to permit
generation or input of clear keys and to enable the secure key import or clear pin
generate callable services. If you want to control the setting of SSM through the
TKE workstation, SSM must be enabled in the Installation Options dataset and on
the LPAR Cryptographic Control panel.

The Load Clear New Master Key, the Load Clear PKA Signature Master Key and
the Load Clear PKA Key Management Master Key boxes, if checked, allow Clear
Key Entry to be performed with the ICSF panels. These Load clear functions do not
need to be enabled for TKE usage. Installations must decide if these functions
should remain disabled.

If you disable the Load Clear functions from TKE, you will not be able to change the
DES and PKA Master Keys if there is a hardware failure on the workstation.

To set the typical controls setting for CCF, press Set default values. The default
setting enables cryptographic functions.
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Working with Domains Controls Settings (PCICC/PCIXCC/CEX2C)
With TKE 3.1 and higher, you are able to administer access control points to ISPF
Services, API Cryptographic Services and User Defined Extensions for the PCICC
and PCIXCC/CEX2C from this page.

There are expandable folders for the Domain Cryptographic services. Within the
folders are the services you can enable or disable:

* ISPF Services

* API Cryptographic Services

* UDXs (appears only if you have created UDXs on your system)

Note: Some services cannot be disabled because they are ‘required’. This is
indicated on the panel.

Whether the various services are enabled or disabled on your system is dependent
upon TKE workstation installation. Prior to TKE Version 3.1, only ISPF services
could be updated. With TKE Version 3.1 and later, access control points for API and
UDX services can be updated.

If you have never installed a TKE workstation on your system, all services (ISPF
and API) will be enabled when you first logon to the workstation. (For UDXs with
access control points, enablement requires a TKE workstation.)

If, however, you have previously installed a TKE Version 3 workstation, your service
settings will be the same as those for your existing system. The API settings will
also be the same as those for the existing system, except for new access control
points (which are disabled). The UDX access control points would all be disabled
for the PCICC.

As new access control points are added, they are enabled for new, first-time, TKE
installations. For existing TKE installations, API services will reflect what had been
enabled/disabled in Version 3.1 and new access control points will be disabled.
UDX support is implemented likewise. If your installation wants to use the new
callable services, the corresponding access control point must be enabled.

PCIXCC/CEX2C have some additional access control points that are not available
on the PCICC. For new TKE V5.0 users, all access control points enabled in the
Default Role will be enabled on the PCIXCC/CEX2C. If migrating from TKE V4.0,
TKE V4.1, or TKE V4.2 to TKE 5.0 on a z990, z890, or z9-109, API services will
reflect what had been enabled/disabled in V4.0, V4.1, or V4.2. Access control points
may need to be enabled depending on the ICSF FMID installed on the z990, z890
or z9-109.

ISPF Services: Under the ISPF Services folder, there are check boxes for the
services you can enable or disable. These services are for loading and setting the
Symmetric and Asymmetric Master Keys on the PCICC/PCIXCC/CEX2C through
the ICSF panel interface.
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[J] PCICC Crypto Module Administration : ESSST2 / P32 =z e

Function

Domains

Domain Cryptographic Services

| »

®  [JISPF Services

[ Clear Mew ASYh Master Key Register
[ Clear Mew Svh Master Key Register
[} Combine AS'YM Master Key Parts

[} Combine Sk Master Key Parts

[ Load First ASh Master Key Part

[y Load First 5vhd bMaster Key Part

[y SetASYM Master Key

[y Set SvM Master Key *=* Reguired *==*
[ AFI Cryptographic Services

1 UDXs

E & & E & E E E

[4]

4] [¥]

| Send updates || Discard changes H Help |

| UPDATE MODE

Figure 153. PCICC Domain Controls Page with Expanded ISPF Services

If you are using a TKE workstation for the first time, your settings under ISPF
Services will indicate that all services are enabled.

If you previously used a TKE V3.1 workstation, your settings under ISPF Services
will indicate the settings that were being used in TKE V3.1 for the PCICC.

For the Crypto Coprocessor, your settings under ISPF Services will indicate that all
services are enabled. If you previously used TKE, your settings under ISPF
Services will indicate the settings that were being used in TKE for the Crypto
Coprocessor.
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. Crypto Coprocessor Crypto Module Administration : Tool 1 { E35 Z| e

Function

Domains

Domain Cryptographic Senvices

| »

@ 1 ISPF Services
[w] D Clear Mew ASYM Master Key Register
[w] D Clear Mew 50 Master Key Register
[¥ [j Combine ASYM Master Key Parts
[v [[j Combine SYM Master Key Parts
[ [ Load First ASYM Master Key Part
[V [y Load First SYM Master Key Part
[ [} SetASTM Master Key
[¥] D Set 5 Master Key = Required =
- 3 AP Cryptographic Services k

[4]

| »

|

| Send updates || Discard changes || Help ‘

| UPDATE MODE

|
Figure 154. PCIXCC/CEX2C Domain Controls Page with Expanded ISPF Services

API Cryptographic Services: Under the API Cryptographic Services folder are all
the ICSF services that can be enabled or disabled from the TKE workstation. See
[Appendix F, “Access Control Points and Callable Services,” on page 303|for the
correlation between the access control point and the ICSF callable service.
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[J] PCICC Crypto Module Administration : ESSST2 / P32 =z e

Domains

Domain Cryptographic Services

CIISPF Services

1 4P| Cryptographic Services

[} Access Control Manager-Read role = Required *=
[ Clear PIN Encrypt

[ Clear PIN Generate Altermate-3624 Offset
[ Clear PIN Generate Altermate-yISA Py
[ Clear PIN Generate-3624

[y Clear PIN Generate-GEP

[y Clear PIN Generate-Interhank

[y Clear PIN Generate-v134 Py

[y Contral Wector Translate

[y Cryptographic Variakle Encipher

[y DES Key Token Change *** Requited ==
[y Data Key Expart

[y Data Key Import

=l

E B B E & E EEEEEE

[4]

4]

| Send updates || Discard changes H Help |

| UPDATE MODE

Figure 155. PCICC Domain Controls Page with Expanded API Cryptographic Services

UDXs: The UDX folder appears only if there are User Defined Extensions on your
system. The UDXs folder lists your extensions and allows you to enable or disable

them.
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(J)] PCICC Crypto Module Administration : ESSST2 / P32 =z e

Function

Domains

Domain Cryptographic Services

| »

C]ISFF Services

1 APl Cryptographic Services
C1UDKs

[ D Fegs User Defined Extension
vi D Fegs User Defined Extension2

[4]

4] | ¥

| Send updates || Discard changes || Help |

| UPDATE MODE

Figure 156. PCICC Domain Controls Page with Expanded UDXs

Co-Sign

For co-signing a pending command in a crypto module, open the notebook for that
crypto module and select the Co-sign page. This page displays information on the
command to co-sign:

Pending command — Name of the pending command

Pending command reference — Unique hexadecimal number returned to the
issuer of the command

Loading Authority — Issuer of the command

Pending command details container — Important parts of the pending command
Signature requirements container — Current status for the fulfillment of the
signature requirements

For CCF crypto modules, the number of required signatures is displayed for each
of the three conditions together with the authority index and name of each
authority allowed to sign the pending command.

For PCICC and PCIXCC/CEX2C crypto modules, exactly two signatures are
required for a multi-signature command. The authority index and name of each
authority allowed to sign the pending command are displayed.

Authorities who have already signed the command are indicated by a yes in the
column labeled Signed.
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()] PCICC Crypto Module Administration : VM16P1 / P04

Function

Co-sign pending command

2 =

Pending command Load authority
Pending command reference 20A0832852D531FESDCBAONDD1BD6000020700808
Loading authority 2. J Roberts

Pending command details

Field Yalue
huthor. .. |7

Fale: acEess

Public. . .

Signature requirements

Reqg Authority Signed
1 of oa,

01, R Sreene

02, J Eoherts res

and
1 af oo,
01, R Sreene

053, H Ford

| Co-Sign || Delete || Help |

PENDING COMMAND MODE

Figure 157. PCICC Co-Sign Page

Pressing the Co-sign button initiates the signing of the pending command. It opens
windows where you can choose the source of the signature and then choose the
authority index associated with that key.

» Current key - Uses the currently loaded signature key

* Smart card - Reads a signature key from a TKE smart card

* Binary file - Reads a signature key from a hard disk or diskette

» Key storage - Reads the signature key from PKA key storage

» Default key - Uses the default signature key hardcoded into TKE

Press Delete if you want to delete the pending command.
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Chapter 6. Managing Keys: TKE and ICSF with CCF

Master keys are used to protect all cryptographic keys that are active on your
system. The number and types of master keys you need to enter depends on your
hardware configuration.

* On the zSeries Model 900 eServers, on the S/390 Enterprise Servers and on
S/390 Multiprise with Cryptographic Coprocessor Features, a DES master key
protects DES keys and PKA master keys protect DSS and RSA keys.

» On the optional PCI Cryptographic Coprocessor, the symmetric-keys master key
(SYM-MK) protects symmetric keys such as DES keys and the asymmetric-keys
master key protects RSA keys. These are discussed in this chapter.

Because master key protection is essential to the security of the other keys, ICSF
stores the master keys within the secure hardware of the cryptographic feature.
This nonvolatile key storage area is unaffected by system power outages, because
it has a battery backup. The values of the master keys never appear in the clear
outside the cryptographic feature.

ICSF is required to complete some operations initiated from TKE. These
operations include importing a DES key part from the key part queue to the
DES master key register and importing operational key parts from the key
part queue to the CKDS. ICSF is required for setting the master key,
initializing/refreshing the CKDS, and installing RSA keys to the PKDS. ICSF is
also required for disabling and enabling PKA services, PKDS Initialization,
PKDS Reencipher and PKDS Activate.

Be prepared to switch between your TKE workstation and your ICSF host
session.

This chapter discusses the procedures needed for:

» Loading the master keys the first time you start ICSF ( page
* Importing Master Keys from the Queue (page

* Changing the DES and SYM-MK master keys periodically (page
* Restarting Key Entry (page

* Reentering the master keys (page

* Adding Additional Coprocessors (page

» Changing the PKA master keys (page

* Loading and Importing Operational Keys (page

* Refreshing the CKDS (page

* Install RSA Keys (page

The types of master keys you can enter and the steps you take to enter master
keys depends on your system processor and hardware features.

Synchronizing Keys

If your installation is using both CCF crypto modules and PCICC crypto modules,
you must keep specific keys the same. The DES Master Key in your CCF crypto
modules must be the same as the Symmetric Master Key in your PCICC crypto
modules. The PKA Signature Master Key (SMK) in your CCF crypto modules must
be the same as the Asymmetric Master Key in your PCICC crypto modules.
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Before you set (activate) your master key, you must be sure that all your crypto
modules (CCF and PCICC) have loaded the same key. If you change the DES new
master key in your CCF crypto modules, you must then make the same change to
the New Symmetric Master Key in your PCICC crypto modules. This also holds true
for the PKA SMK key and the New Asymmetric Master Key.

Master Key Parts

Master key parts are loaded using binary files, the keyboard, or TKE smart cards. If
loading key parts with the keyboard, record the key parts and the associated hash
patterns.

The key parts are generated from the Domain Keys page. For more information,
see ['‘Domain Keys Page - CCF” on page 94| and ['‘Domains Keys Page (PCICC and|
[PCIXCC/CEX2C)” on page 110,

Note: If you are reentering master keys after they have been cleared, use the
same master key part values as when you originally entered the keys. You
should have saved the key part values in a secure place after you entered
the master keys previously.

To enter a DES master key, you can either enter a complete key, a first key part
and a final key part or a first key part, one or more intermediate key part and a final
key part.

First-Time Startup

150

The first time you start ICSF, you must load a DES master key and initialize the
CKDS. For information on creating an empty CKDS, see |z/OS Cryptographid
[Services ICSF System Programmer’s Guide, When you initialize the CKDS, ICSF
creates a header record for the CKDS, installs the required system keys in the
CKDS, and sets the master key. Keys stored in the CKDS are enciphered under the
DES master key. After the master key has been set, you can generate or enter any
keys you need to perform cryptographic functions.

To define a DES master key, you must load the key parts to the DES new master
key register on CCF, and if running with PCICCs, you must also load the key parts
to the new SYM-MK register. Since this is the first time you are starting ICSF, you
may use Load to load directly to the register. If you use Load to Queue, you must
additionally import the key (see [‘Importing Key Parts from the Queue” on page 153
for instructions).

Load and Load to Queue are discussed in ['‘Domain Keys Page - CCF” on page]

There are four different types of system keys you can install in the CKDS:

* Required SYSTEM keys are automatically generated when you first initialize the
CKDS. These include the MAC and MACVER keys that ICSF uses to generate
and validate the MAC code in each CKDS record.

* NOCV-enablement keys are required for NOCV IMPORTERs and EXPORTERSs.
The NOCV-enablement system keys are used to twist on and twist off the CVs
on external tokens during key import and key export. This allows ICSF to
communicate with systems that do not use control vectors.

* ANSI system keys are required for almost all ANSI services to perform the
notarization and offset that are required by ANSI X9.17.

z/OS V1R8.0 ICSF TKE PCIX Workstation User's Guide



* ESYS, or enhanced system keys, are used only in Symmetric Key Export
(CSNDSYX) callable service.

You have to initialize a CKDS only the first time you start ICSF on a system. After
you initialize a CKDS, you can copy the disk copy of the CKDS to create other
CKDSs for use on the system. You can also share a CKDS with another ICSF
system if the system has the same master key value.

If sharing a CKDS between a z990 or z9-109 system and a legacy system, the
CKDS must be initialized on a legacy system.

At any time, you can read a different disk copy into storage. For information about
how to read a disk copy into storage, see [‘Refreshing the CKDS” on page 182

Initialize the CKDS

At this point, the DES new master key register on each CCF in this domain is full. If
you have PCICC crypto modules, the new SYM-MK register on each PCICC is also
full. The hash pattern of the new SYM-MK should match the hash pattern of the
DES master key. If it does not, clear the register and reload the keys.

You must now initialize the CKDS (which also activates the DES master key).

From the ICSF Primary Menu on TSO:
1. Select Option 2, MASTER KEY, as shown in [Figure 158

~
CSFEPRIM ----=--emmmm- Integrated Cryptographic Service Facility ---------
OPTION ===> 2
Enter the number of the desired option.
1 COPROCESSOR MGMT - Management of Cryptographic Coprocessors
2 MASTER KEY - Master key set or change, CKDS/PKDS processing
3 OPSTAT - Installation options
4 ADMINCNTL - Administrative Control Functions
5 UTILITY - ICSF Utilities
6 PPINIT - Pass Phrase Master Key/CKDS Initialization
7 TKE - TKE Master and Operational key processing
8 KGUP - Key Generator Utility processes
9 UDX MGMT - Management of User Defined Extensions
Licensed Materials - Property of IBM
This product contains "Restricted Materials of IBM"
5694-A01 (C) Copyright IBM Corp. 2004. A1l rights reserved.
US Government Users Restricted Rights - Use, duplication or
disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
Press ENTER to go to the selected option.
\?ress END to exit to the previous menu. )

Figure 158. ICSF Selecting the Master Key Option on the Primary Menu Panel

2. The Master Key Management panel appears. Select Option 1, INIT/REFRESH
CKDS, as shown in [Figure 159 on page 152
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~
CSFMKMOO -----==-==mmmmmm ICSF - Master Key Management -------------
OPTION ===> 1

Enter the number of the desired option above.

1 INIT/REFRESH CKDS - Initialize a Cryptographic Key Data Set or
activate an updated Cryptographic Key Data Set

2 SET MK - Set a DES/Symmetric-Keys master key

3 REENCIPHER CKDS - Reencipher the CKDS prior to changing the DES
/Symmetric Keys master key

4 CHANGE MK - Change the DES/Symmetric-Keys master key and
activate the reenciphered CKDS

5 INITIALIZE PKDS - Initialize or update a PKDS Cryptographic
Key Data Set header record
6 REENCIPHER PKDS - Reencipher the PKA Cryptographic Key Data Set
7 ACTIVATE PKDS - Activate the PKDS after it has been reenciphered

9 8 REFRESH CACHE - Refresh the PKDS cache if enabled )

Figure 159. Selecting the Initialize a CKDS Option on the ICSF Master Key Management
Panel

3. The Initialize a CKDS panel now appears.

4 N
CSFCKDOO --------=--=----- ICSF - Initialize a CKDS -------=mmommum-
COMMAND ===> 1
Enter the number of the desired option.
1 Initialize an empty CKDS (creates the header and system keys)
2 NOCVKEYS - Create NOCV-Enablement keys (for keys without CVs)
3 ANSI - Create ANSI system keys (for ANSI X9.17 services)
4 ESYS - Create enhanced system keys (for Symmetric services)
5 REFRESH - Activate an updated CKDS
Enter the name of the CKDS below.
CKDS ===> 'FIRST.EMPTY.CKDS' )

Figure 160. ICSF Initialize a CKDS Panel

4. In the CKDS field at the bottom of the panel, enter the name of the empty
VSAM data set that was created to use as the disk copy of the CKDS.

The name you enter should be the same name that is specified in the CKDSN
installation option in the installation options data set. For information about
creating a CKDS and specifying the CKDS name in the installation options data
set, see |z/OS Cryptographic Services ICSF System Programmer’s Guide,

5. Choose option 1, Initialize an empty CKDS, and press ENTER.

ICSF creates the header record in the disk copy of the CKDS. Next, ICSF sets
the DES master key. ICSF then adds the required system keys to the CKDS
and refreshes the CKDS. When ICSF completes all these steps the message
INITIALIZATION COMPLETE appears. If you did not enter a master key into the
new master key register previously, the message NMK REGISTER NOT FULL
appears and the initialization process ends. You must enter a master key into
the new master key register before you can initialize the CKDS.
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Note: If any part of the option 1 fails, you must delete the CKDS and start over.
If the failure occurs after the master key is set and before the system
keys have been created, you will need to start over: initialize an empty
CKDS, load a new master key and initialize the CKDS.

If you want ICSF to create NOCV-enablement keys after the initialization
process has been completed, select option 2, NOCVKEYS, and press ENTER.

The creation of NOCV-enablement keys is optional. It allows you to create
NOCYV keys using the key generator utility program or the Key Token Build
callable service. NOCV keys allow you to send and receive keys from systems
that do not use control vectors. For a description of NOCV keys, see the
description of the key generator utility program NOCV keyword in
[Cryptographic Services ICSF Administrator's Guidel

Note: If you want to run the ICSF conversion program to convert a CUSP/PCF
CKDS into ICSF format, the CKDS you start with must contain
NOCV-enablement keys. For more information about the conversion
program, see |z/OS Cryptographic Services ICSF System Programmer’s

To create ANSI system keys used for the ANSI X9.17 services, choose option 3,
ANSI.

The creation of ANSI system keys is optional. ANSI system keys are required if
you intend to also create enhanced system keys.

The message ANSI KEYS ADDED appears on the top right of the panel, if the
process succeeds.

To create enhanced system keys, choose option 4, ESYS.

The creation of enhanced system keys is optional. To create enhanced system
keys, you must have previously installed the ANSI system keys in the CKDS.
The message ESYS KEYS ADDED appears on the top right of the panel, if the
process succeeds.

After you complete the entire process, a master key and CKDS exist on your
system. If you want to enter keys other than PIN or transport (for example, keys
using the key generate callable service, the key generator utility program, or convert
CUSP/PCF keys to ICSF keys using the conversion program), see

[Cryptographic Services ICSF Administrator's Guide,

Note: Special secure mode is required to initialize ICSF for the first time. After you

perform the initialization process, you may choose to disable special secure
mode.

Importing Key

Parts from the Queue

This is the suggested method whereby you load the master key parts to a key part
queue. You then import the keys to the new master register from the queue.

Note: Depending on your machine type, the key part queue will have room for

either one or multiple entries (up to three). If your machine can only handle
one entry on the key part queue, you must load and then import each key

part individually. If your machine handles multiple entries, you load the key
parts and then import them all.

This task is performed from your TSO logon id using the ICSF panels.
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Importing Key Parts Individually

This procedure is for machines that can only handle one entry on the key part
queue. Follow these steps to load and import two or more key parts into the DES
new master key register:

1.
2.

9.

Loading the first DES new master key part (TKE workstation)

Importing the first DES new master key part into the DES new master key
register (ICSF panels)

Refresh the crypto notebook (TKE workstation)
Loading the intermediate DES new master key part (TKE workstation)*

Importing the intermediate DES new master key part into the DES new master
key register (ICSF panels)*

Refresh the crypto notebook (TKE workstation)*
Loading the final DES new master key part (TKE workstation)

Importing the final DES new master key part into the DES new master key
register (ICSF panels)

Refresh the crypto notebook (TKE workstation)

Note: * You may have one or more intermediate key parts, so these steps (4, 5

and 6) can be repeated.

Importing Multiple Key Parts

This procedure is for machines that can handle multiple entries (up to three) on the
key part queue. Follow these steps to load and import two or more key parts into
the DES new master key register:

1.

2.
3.
4

7.

Loading the first DES new master key part (TKE workstation)
Loading the intermediate DES new master key part (TKE workstation)
Loading the final DES new master key part (TKE workstation)

Importing the first DES new master key part into the DES new master key
register (ICSF panels)

Importing the intermediate DES new master key part into the DES new master
key register (ICSF panels)

Importing the final DES new master key part into the DES new master key
register (ICSF panels)

Refresh the crypto notebook (TKE workstation)

Importing the First Master Key Part into the DES New Master Key
Register

154

To begin importing the first master key part, start at the ICSF panels and follow the
instructions below:

1. Select oition 7, TKE, on the primary menu panel, as shown in|Figure 161 on

page 155
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CSFEPRIM ------oemem Integrated Cryptographic Service Facility ---------
OPTION ===> 7
Enter the number of the desired option.
1 COPROCESSOR MGMT - Management of Cryptographic Coprocessors
2 MASTER KEY - Master key set or change, CKDS/PKDS processing
3  OPSTAT - Installation options
4 ADMINCNTL - Administrative Control Functions
5 UTILITY - ICSF Utilities
6 PPINIT - Pass Phrase Master Key/CKDS Initialization
7 TKE - TKE Master and Operational key processing
8 KGUP - Key Generator Utility processes
9 9 UDX MGMT - Management of User Defined Extensions )

Figure 161. Selecting the TKE Option on the ICSF Primary Menu Panel

2. Select option 1, DES Master Key entry, on the TKE Processing Selection panel,

as shown in |Figure 162

7 N\
CSFOPKOO ---------=------ ICSF - TKE Processing Selection -------------
OPTION ===> 1
Enter the number of the desired option.
1 DES Master key entry
2 DES Operational key entry
3 PKA key entry
- J

Figure 162. Selecting the DES Master Key entry on the TKE Processing Selection Panel

3. The TKE Coprocessor Selection panel, similar to the one in[Figure 163 on page]
156| appears. Select the coprocessor for master key entry by typing the
coprocessor number on the OPTION line and pressing ENTER.

Note: If you have only one coprocessor installed, or if there is only one
coprocessor defined to this partition, this panel will only show one
Coprocessor.
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CSFCMP20 -----=--=mmmmmmmm oo ICSF - TKE Coprocessor Selection -------------
OPTION ===> 0

CRYPTO DOMAIN:
Enter the number of the coprocessor to be used for key entry.
REGISTER STATUS

0. COPROCESSOR CO 1. COPROCESSOR C1

Crypto Module ID : E589C39694407A60 : C39997A396F1407A
: 5D40C39997A396F0 : 605D40E589C39694

New Master Key register : EMPTY : EMPTY

NMK verification pattern 3

01d Master Key register : VALID : VALID

OMK verification pattern : 0212570BB5E544C1 : 0212570BB5E544C1

01d/New Master Key register: 3DDAE6229901A0C5 : 5B82229C87F044C3
hash pattern : 3C8BE367(85054C0 : DA6544F00CC43D46

Master Key register : VALID : VALID

MK verification pattern : CA6B408A02371B1D : CA6B408A02371B1D

Master Key register : DF3A50AE5466123A : DF3A50AE5466123A
hash pattern : 96EF57E8BDO74557 : 96EF57E8BDO74557

Special Secure Mode : ENABLED : ENABLED

Environment Control Mask : F3FEFCFO : F3FEFCFO

Press ENTER to select coprocessor and proceed to new master key part entry.
Press END to exit to the previous menu.

Figure 163. Selecting a Coprocessor for Master Key Entry

4. The Enter New Master Key panel appears. See |Figure 164 Select option 1,
ENTER A KEY PART, to begin the key part entry steps.

Coprocessor selected for new master key : CO
New master key register status : EMPTY

Enter the number of the desired option.
1 ENTER A KEY PART - Enter a key part into NMK register

2 ENTER A FINAL KEY PART - Enter a final key part into NMK register
3 RESTART KEY ENTRY PROCESS - Clear the NMK register

Figure 164. Selecting the Enter Key Part Option on the Enter New Master Key Panel

5. The Enter First Master Key Part panel appears. See [Figure 165 on page 157}
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CSFEKP10--=---==-----=--- ICSF - TKE - Enter First Master Key Part ---------
COMMAND ===>

Coprocessor selected for new master key : CO
New master key register status : EMPTY
Press ENTER to Toad the key part.
Press END to exit to the previous menu. )

Figure 165. Enter First Master Key Part Panel with Key Part Register Status Enabled

6. Press ENTER. The panel should now appear similar to |Figure 166} If

successful, the message KEY PART LOADED appears in the right hand corner.

4 .

CSFEKP20-------- ICSF - TKE - Enter First  —--------ooooomn KEY PART LOADED
COMMAND ===>
Coprocessor selected for new master key : CO
New master key register status : PARTFULL
Verification pattern for the entered key part is:
02010E4AG4E0212A (Record and secure this pattern)
Press END  to exit to the previous menu. )

Figure 166. First Panel

Press PF3 to exit to the previous menu.

If your machine can only enter one key part at a time, return to the TKE
workstation, refresh the crypto notebook, and then load the next key part to the
queue.

Otherwise, import the key part to the DES new master key register.

Importing the Intermediate Master Key Part into the DES New Master

Key Register

To import the intermediate master key part, follow the instructions:

The Enter New Master Key panel appears. See [Figure 167 on page 158|
1. Select option 1, ENTER A KEY PART, to begin the key part entry steps.
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Coprocessor selected for new master key : CO
New master key register status : PARTFULL

Enter the number of the desired option above.
1 ENTER A KEY PART - Enter a key part into NMK register

2 ENTER A FINAL KEY PART - Enter a final key part into NMK register
3 RESTART KEY ENTRY PROCESS - Clear the NMK register

Figure 167. Selecting the Enter Key Part Option on the Enter New Master Key Panel

2. The Enter Master Key Part panel appears. See |Figure 168

-
CSFEKP10-------------- ICSF - TKE - Enter Master Key Part ---------
COMMAND ===>

Coprocessor selected for new master key : CO
New master key register status : PARTFULL

Press ENTER to Toad the key part.
Press END to exit to the previous menu.

Figure 168. Enter Intermediate Master Key Part

3. Press ENTER and the Enter Master panel appears. See |Figure 169|.

-
CSFEKP20--------- ICSF - TKE - Enter Master ----------- KEY PART LOADED
COMMAND ===>

Coprocessor selected for new master key : CO
New master key register status : PARTFULL

Verification pattern for the entered key part is:

12B42031145E212B (Record and secure this pattern)

Press END to exit to the previous menu.

-

Figure 169. Middle Panel

Press PF3 to exit to the previous menu.

If your machine can only enter one key part at a time, return to the TKE
workstation, refresh the crypto notebook and then load the next key part to the
queue. Otherwise, import the next key part to the DES new master key register.

Importing the Final Key Part into the DES New Master Key Register

The Enter Final Master Key Part panel appears. After you enter the first key part,
and any intermediate key parts, you then enter the final master key part as
explained here:
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1. Select option 2, Enter a Final Key Part on the Enter New Master Key panel, as
shown in|Figure 170}, and press ENTER.

~
CSFEKMOO=======mmmmm e ICSF - TKE - Enter New Master Key -----------
OPTION ===> 2
Coprocessor selected for new master key : CO
New master key register status : PARTFULL
Enter the number of the desired option above.
1 ENTER A KEY PART - Enter a key part into NMK register
2 ENTER A FINAL KEY PART - Enter a final key part into NMK register
3 RESTART KEY ENTRY PROCESS - Clear the NMK register
N J
Figure 170. Selecting to Enter a Final Key Part on the Enter New Master Key Panel
2. The Enter Final Master Key Part panel appears. See |Figure 171
/’ . N\
CSFEKP10-----=-=--=---- ICSF - TKE - Enter Final Master Key Part ---------
COMMAND ===>
Coprocessor selected for new master key : Co
New master key register status : PARTFULL
Press ENTER to Toad the key part.
Press END to exit to the previous menu. )
Figure 171. Enter Final Master Key Part
3. Press ENTER.
The Enter Final panel appears. See |[Figure 172
/’ . N
CSFEKP20---- ICSF - TKE - Enter Final Master Key Part -- KEY PART LOADED
COMMAND ===>
Coprocessor selected for new master key : CO
New master key register status : FULL
Verification pattern for the entered key part is:
02010E4AG64E0212A (Record and secure this pattern)
Verification pattern for the new master key is:
AB864EC4210811AA2 (Record and secure this pattern)
Press END to exit to the previous menu. )

Figure 172. Final Panel

Press PF3 to exit to the previous menu. Remember to refresh the crypto notebook.
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Changing Master Keys

For security reasons your installation should change the master keys periodically. In
addition, if the master keys have been cleared, you may also want to change the
master keys after you reenter the cleared master keys.

Tasks necessary for changing the master key are:
1. Load to Queue the DES new master key (first, middle, last)

* Load to Queue requires you to import the key part(s) after loading. Whether
you do it after each time a key part is loaded or load multiple key parts
deiends on your machine. (See ['Importing Key Parts from the Queue” on|

page 153)

2. Load new SYM-MK (first, middle, last), if running PCICC

e The new SYM-MK (on PCICC) must equal the DES new master key (on
CCF)

3. Re-encipher CKDS
4. Change master key

The step-by-step procedure for changing the DES master key, reenciphering the
CKDS, and activating the new DES master key is presented in[‘Changing the
[Master Key Using the Master Key Panels.”| For information on the contents of the

master key registers during the key change process, and some compatibility mode
considerations, see [z/0S Cryptographic Services ICSF Administrator’s Guide,

A DES master key and a CKDS containing keys enciphered under that DES master
key already exist. Before you replace this existing DES master key with the new
DES master key, you must reencipher the CKDS under the new DES master key.

If you are working with the CCF and changed the DES master key before, the
previous DES master key was stored in the auxiliary (or new/old) master key
register. The currently active DES master key exists in the master key register.
When you enter the key parts of a new DES master key, they displace the previous
DES master key in the auxiliary master key register. Therefore, the previous DES
master key is lost.

When the DES master key is changed, the current active DES master key is moved
to the auxiliary master key register and the new DES master key is moved to the
master key register. In this way, the new DES master key you have just entered
becomes the current DES master key, and the previous DES master key is stored
in the auxiliary master key register.

Before the new DES master key is placed into the master key register, you must
reencipher all disk copies of the CKDS under the new DES master key. Then you
are ready to activate the master key. When you change the master key, you have
ICSF replace the in-storage copy of the CKDS with the reenciphered disk copy and
make the new master key active on the system.

Changing the Master Key Using the Master Key Panels

Load the key parts of the new master key that you want to replace the current
master key. The new master key parts must be loaded from TKE. When changing
the DES Master Key, Load to Queue should be used as ICSF is active in the
selected domain. For information to do this procedure, see [‘Load and Load to|
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[Queue - CCF” on page 99 You must also import each key part after loading to
queue (see ['Importing the First Master Key Part into the DES New Master Keyl
[Register” on page 154

If you have PCICC crypto modules, you also need to load the same key parts to the
new SYM-MK register. Make sure the hash pattern of the register matches the DES
new master key register. See ['Load - PCICC/PCIXCC/CEX2C” on page 115)

Note: The steps for this task are performed from your TSO logon id using the ICSF
panels.

The new master key register on all crypto modules (CCF and PCICC) must be full
before you change the master key.

1. Select option 2, MASTER KEY, on the ICSF Primary Menu.

/'CSF@PRIM ------------- Integrated Cryptographic Service Facility --------- h
OPTION ===> 2
Enter the number of the desired option.
1 COPROCESSOR MGMT - Management of Cryptographic Coprocessors
2 MASTER KEY - Master key set or change, CKDS/PKDS processing
3 OPSTAT - Installation options
4 ADMINCNTL - Administrative Control Functions
5 UTILITY - ICSF Utilities
6 PPINIT - Pass Phrase Master Key/CKDS Initialization
7 TKE - TKE Master and Operational key processing
8 KGUP - Key Generator Utility processes
9 9 UDX MGMT - Management of User Defined Extensions )

Figure 173. Selecting the Master Key Option on the ICSF Primary Menu Panel

2. Before you change the master key, you must first reencipher the disk copy of
the CKDS under the new master key. Select option 3, REENCIPHER CKDS,
on the Master Key Management panel, as shown in |Figure 174} and press

ENTER.
~
CSFMKMOO ------=-===-=-=~ ICSF - Master Key Management -------------
OPTION ===> 3
Enter the number of the desired option above.
1 INIT/REFRESH CKDS - Initialize a Cryptographic Key Data Set or
activate an updated Cryptographic Key Data Set
2 SET MK - Set a DES/Symmetric-Keys master key
3 REENCIPHER CKDS - Reencipher the CKDS prior to changing the DES
/Symmetric Keys master key
4 CHANGE MK - Change the DES/Symmetric-Keys master key and
activate the reenciphered CKDS
5 INITIALIZE PKDS - Initialize or update a PKDS Cryptographic
Key Data Set header record
6 REENCIPHER PKDS - Reencipher the PKA Cryptographic Key Data Set
7 ACTIVATE PKDS - Activate the PKDS after it has been reenciphered
9 8 REFRESH CACHE - Refresh the PKDS cache if enabled )

Figure 174. Selecting the Change Master Key Option on the ICSF Master Key Management
Panel
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3. The Reencipher CKDS panel appears. See |Figure 175

4 . N\
CSFCMK10 ----=-==-=-=mom- ICSF - Reencipher CKDS -------=-c-mumunm-
COMMAND ===>
To reencipher all CKDS entries from encryption under the current DES/
Symmetric-Keys master key to encryption under the new master key enter
the CKDS names below.
Input CKDS ===> CKDS.CURRENT.MASTER
Qutput CKDS ===> CKDS.NEW.MASTER
o J

Figure 175. Reencipher CKDS

4. In the Input CKDS field, enter the name of the CKDS that you want to
reencipher. In the Output CKDS field, enter the name of the data set in which
you want to place the reenciphered keys.

Note: The output data set should already exist although it must be empty. For
more information about defining a CKDS, see |z/0S Cryptographid
[Services ICSF System Programmer’s Guide,

Reenciphering the disk copy of the CKDS does not affect the in-storage copy
of the CKDS. On this panel, you are working with only a disk copy of the
CKDS.

5. Press ENTER to reencipher the input CKDS entries and place them into the
output CKDS.

The message REENCIPHER SUCCESSFUL appears on the top right of the
panel if the reencipher succeeds.

6. If you have more than one CKDS on disk, specify the information and press
ENTER as many times as you need to reencipher all of them. Reencipher all
your disk copies at this time. When you have reenciphered all the disk copies
of the CKDS, you are ready to change the master key.

7. Press END to return to the Master Key Management panel.

a. Changing the master key involves refreshing the in-storage copy of the
CKDS with a disk copy and activating the new master key.

b. If you are running in compatibility or co-existence mode, do not select
option 4, the Change option. To activate the changed master key when
running in compatibility or co-existence mode, you need to re-IPL MVS and
start ICSF. When you re-IPL MVS and start ICSF, you activate the changed
master key and refresh the in-storage CKDS. To do this, you must exit the
panels at this time.

c. If you are running in noncompatibility mode, to change the master key
select option 4 on the Master Key Management panel, as shown in
[Figure 176 on page 163|
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e
CSFMKMOO -----==--=mmmm-m ICSF - Master Key Management -------------
OPTION ===> 4

Enter the number of the desired option above.

1 INIT/REFRESH CKDS - Initialize a Cryptographic Key Data Set or
activate an updated Cryptographic Key Data Set
SET MK - Set a DES/Symmetric-Keys master key
3 REENCIPHER CKDS - Reencipher the CKDS prior to changing the DES
/Symmetric Keys master key
4 CHANGE MK - Change the DES/Symmetric-Keys master key and
activate the reenciphered CKDS

nN

5 INITIALIZE PKDS - Initialize or update a PKDS Cryptographic
Key Data Set header record

6 REENCIPHER PKDS - Reencipher the PKA Cryptographic Key Data Set

7 ACTIVATE PKDS - Activate the PKDS after it has been reenciphered

8 REFRESH CACHE - Refresh the PKDS cache if enabled
N J
Figure 176. Selecting the Change Master Key Option on the ICSF Master Key Management
Panel

8. When iou press the ENTER key, the Change Master Key panel appears. See

Figure 177
e N
CSFCMK20 -=--=--=--=mmmmmmmm o ICSF - Change Master Key --------------
COMMAND ===>
Enter the name of the new CKDS below:
New CKDS ===> CKDS.NEW.MASTER
When the master key is changed, the new CKDS will become active.
- J

Figure 177. Change Master Key Panel

9. In the New CKDS field, enter the name of the disk copy of the CKDS that you
want in storage.

You should have already reenciphered the disk copy of the CKDS under the
new master key. The last CKDS name that you specified in the Output CKDS
field on the Reencipher CKDS panel, which is shown in [Figure 175 on pagel
162} automatically appears in this field.

10. Press ENTER.

ICSF loads the data set into storage where it becomes operational on the
system. ICSF also places the new master key into the master key register so it
becomes active.

After you press ENTER, ICSF attempts to change the master key. It displays a
message on the top right of the panel. The message indicates either that the
master key was changed successfully or that an error occurred that did not
permit the change process to be completed. For example, if you indicate a
data set that is not reenciphered under the new master key, an error message
displays and the master key is not changed.
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Restarting the DES Key Entry Process

If you realize you made an error when loading a key part, you can restart the
process of loading the new master key. Restarting the key entry process causes the
new master key register to be cleared, which means all the new master key parts
you entered previously are erased.

PCICC registers can be cleared from the TKE workstation. See
[PCICC/PCIXCC/CEX2C” on page 119.|

The following describes the procedure for clearing the DES new master key register
in the CCF.

Note: When you enter the first key part, your old master key is lost, even if you
restart the process.

To restart the key entry process, follow the steps below using ICSF from your TSO
logon id:
1. Select option 7, TKE, on the ICSF Primary Option Menu.

CSFEPRIM -=---mmmmmmm- Integrated Cryptographic Service Facility --------- A
OPTION ===> 7
Enter the number of the desired option.
1 COPROCESSOR MGMT - Management of Cryptographic Coprocessors
2 MASTER KEY - Master key set or change, CKDS/PKDS processing
3 OPSTAT - Installation options
4 ADMINCNTL - Administrative Control Functions
5 UTILITY - ICSF Utilities
6 PPINIT - Pass Phrase Master Key/CKDS Initialization
7 TKE - TKE Master and Operational key processing
8 KGUP - Key Generator Utility processes
9 9 UDX MGMT - Management of User Defined Extensions )

Figure 178. Selecting the TKE Option on the ICSF Primary Menu Panel

2. The TKE Processing Selection panel appears. Select option 1, DES master key
entry.

-
CSFOPKOO ---------------- ICSF - TKE Processing Selection -------------
OPTION ===> 1

Enter the number of the desired option.
1 DES Master key entry

2 DES Operational key entry
3 PKA key entry

- v
Figure 179. Selecting the DES Master Key entry on the TKE Processing Selection Panel

3. The Coprocessor Selection panel, which may be similar to the one in
on page 165} appears. Select the coprocessor for master key entry by typing

the coprocessor number on the OPTION line and pressing ENTER.
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Note: If you have only one coprocessor installed, or if there is only one
coprocessor defined to this partition, this panel will only show one

coprocessor.

/,
CSFCMP20 ===----mmmmmcmeeeeee
OPTION ===> 0

CRYPTO DOMAIN: O

Enter the number of the coprocessor to be used for key entry.

REGISTER STATUS 0. COPROCESSOR CO 1. COPROCESSOR C1
Crypto Module ID : E589C39694407A60 : C39997A396F1407A
: 5D40C39997A396F0 : 605D40E589C39694

New Master Key register : FULL : FULL

NMK verification pattern : 0212570BB5E544C1 : 0212570BB5E544C1

01d Master Key register : EMPTY : EMPTY

OMK verification pattern g

01d/New Master Key register: 3DDAE6229901A0C5 : 5B82229C87F044C3
hash pattern : 3C8BE367(C85054C0 : DA6544F00CC43D46

Master Key register . VALID : VALID

MK verification pattern : CA6B408A02371B1D : CA6B408A02371B1D

Master Key register : DF3A50AE5466123A : DF3A50AE5466123A
hash pattern : 96EF57E8BDO74557 : 96EF57E8BD0O74557

Special Secure Mode : ENABLED : ENABLED

Environment Control Mask : F3FEFCFO : F3FEFCFO

Press ENTER to select coprocessor and proceed to new master key part entry.
\‘Press END to exit to the previous menu.

Figure 180. Selecting a Coprocessor for Master Key Entry

4. Choose option 3, the RESTART KEY ENTRY PROCESS option, on the Enter
New Master Key panel, as shown in|Figure 181

Coprocessor selected for new master key : Co
New master key register status ¢ FULL

Enter the number of the desired option above.
1 ENTER A KEY PART - Enter a key part into NMK register

2 ENTER A FINAL KEY PART - Enter a final key part into NMK register
3 RESTART KEY ENTRY PROCESS - Clear the NMK register

v

Figure 181. Selecting the Restart Key Entry Process Option on the Enter New Master Key
Panel

When you choose option 3, the Confirm Restart Request panel appears. See
[Figure 182 on page 166]
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~
CSFEKM30---------=---- ICSF - Confirm Restart Request -------------

COMMAND ===>

ARE YOU SURE YOU WISH TO RESTART THE KEY ENTRY PROCESS?

Restarting the process will clear the new master key register.

Press ENTER to confirm restart request
Press END  to cancel restart request

Figure 182. Confirm Restart Request Panel

This panel confirms your request to restart the key entry process.
If you want to restart the key entry process, press ENTER.

The restart request automatically empties the key part register and new master
key register.

If you do not want to restart, press END.
After you make a choice, you return to [Figure 181 on page 165}

Either begin the key entry process again or exit that panel to return to the ICSF
primary menu panel.

Re-entering Master Keys After They have been Cleared

In certain situations, the Cryptographic Coprocessor Feature clears the master key
registers so that the master key values are not disclosed. Master keys are cleared
in the following situations:

166

If the Cryptographic Coprocessor Feature detects tampering
If you issue a command from the TKE workstation to zeroize a domain
If you issue a command from the Support Element to zeroize a domain

In the following situations, the PCI Cryptographic Coprocessor Feature (PCICC)
clears the master key registers so that the master key values are not disclosed:

If the PCI Cryptographic Coprocessor Feature detects tampering (the intrusion
latch is tripped), ALL installation data is cleared: master keys, retained keys for
all domains, as well as roles and profiles.

If the PCI Cryptographic Coprocessor Feature detects tampering (the secure
boundary of the card is compromised), it self-destructs and can no longer be
used.

If you issue a command from the TKE workstation to zeroize a domain

This command zeroizes the data specific to a domain: master keys and retained
keys.

If you issue a command from the Support Element panels to zeroize all domains.

This command zeroizes ALL installation data: master keys, retained keys and
access control roles and profiles.

Although the values of the master keys are cleared, the keys in the CKDS are still
enciphered under the cleared DES master key. The RSA and DSS private key are
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also each enciphered under one of the cleared PKA master keys. Therefore, to
recover the keys in the CKDS, and the PKA private keys in the PKDS, you must
reenter the same master keys and activate the DES master key. For security
reasons, you may then want to change all the master keys.

PR/SM Considerations

If you are running in PR/SM logical partition (LPAR) mode, the Cryptographic
Coprocessor Feature causes all logical partitions (LPs) to lose their master keys
only for a tamper situation. In this case, you must ensure that key entry is enabled
for each LP on the Change LPAR Crypto page on the support element Hardware
Master Console and then reenter the master keys in each LP. If you have a PCICC,
you also need to regenerate any retained keys. If you zeroize a domain using the
TKE workstation, however, the master keys are cleared only in that domain. Master
keys in other domains are not affected and do not need to be reentered. For more
information about reentering master keys in LPAR mode, see [z/0S Cryptographid
[Services ICSF Administrator’s Guide,

Setting the Master Key

After the master keys have been cleared, reenter the same master keys by
following these steps:

1. Load new master key parts. For details on loading the keys, see
[Load to Queue - CCF” on page 99.|
These values should be stored in a secure place as specified in your enterprise
security process.

2. Retrieve the key parts, checksums, verification patterns, and hash patterns you
used when you loaded the master keys originally. These values should have
been stored in a secure place.

3. To activate the DES master key you just entered, you need to set it. On the
ICSF Primary Menu panel in TSO, select option 2.

/’CSF@PRIM ------------- Integrated Cryptographic Service Facility --------- A
OPTION ===> 2
Enter the number of the desired option.
1 COPROCESSOR MGMT - Management of Cryptographic Coprocessors
2 MASTER KEY - Master key set or change, CKDS/PKDS processing
3 OPSTAT - Installation options
4 ADMINCNTL - Administrative Control Functions
5 UTILITY - ICSF Utilities
6 PPINIT - Pass Phrase Master Key/CKDS Initialization
7 TKE - TKE Master and Operational key processing
8 KGUP - Key Generator Utility processes
9 9 UDX MGMT - Management of User Defined Extensions )

Figure 183. ICSF Selecting the Master Key Option on the Primary Menu Panel

4. To set the DES master key, choose option 2 on the panel and press ENTER.
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CSFMKMOO --------==--=-~ ICSF - Master Key Management -------------
OPTION ===> 2

Enter the number of the desired option above.

1 INIT/REFRESH CKDS - Initialize a Cryptographic Key Data Set or
activate an updated Cryptographic Key Data Set

2 SET MK - Set a DES/Symmetric-Keys master key

3 REENCIPHER CKDS - Reencipher the CKDS prior to changing the DES
/Symmetric Keys master key

4 CHANGE MK - Change the DES/Symmetric-Keys master key and
activate the reenciphered CKDS

5 INITIALIZE PKDS - Initialize or update a PKDS Cryptographic

Key Data Set header record
6 REENCIPHER PKDS - Reencipher the PKA Cryptographic Key Data Set
ACTIVATE PKDS - Activate the PKDS after it has been reenciphered

9 8 REFRESH CACHE - Refresh the PKDS cache if enabled )

Figure 184. Selecting the Set Host Master Key Option on the ICSF Master Key Management
Panel

~

After you select option 2, ICSF checks that the states of the registers are
correct. ICSF then transfers the DES master key from the new master key
register to the master key register. This process sets the DES master key.

When ICSF attempts to set the DES master key, it displays a message on the
top right of the Master Key Management panel. The message indicates either
that the master key was successfully set, or that an error prevented the
completion of the set process.

5. If your system is using two Cryptographic Coprocessor Features, ICSF sets the
DES master key for each Cryptographic Coprocessor Feature whose new DES
master key enciphers the in-storage CKDS. You should reenter the DES master
key into the new master key register for each of the Cryptographic Coprocessor
Features.

When you set the reentered DES master key, the DES master key that
enciphers the existing CKDS now exists.

6. You can now change the DES master key, if you choose to, for security
reasons. Continue with [‘Changing Master Keys” on page 160

Adding Cryptographic Coprocessors After ICSF Initialization

CCF

168

There may come a time when you wish to add additional PCI Cryptographic
Coprocessors (PCICC) to your system or may have one Cryptographic Coprocessor
feature (CCF) and wish to add the second. After the new crypto modules have been
installed and configured by the appropriate hardware personnel, make them known
to the TKE workstation by following the appropriate procedure.

Note: With TKE V4.0 or later, it is no longer necessary to exit the application to
add new crypto modules.

1. Open the Host where the crypto module was added. You will be prompted to
authenticate the crypto module.

2. Open the new crypto module.
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PCICC

Use the default signature key to administer access control and load authority
signature keys to match the other crypto module.

Load the keys. Use Load to Queue. (You must import each key part from the
key part queue from ICSF.)

Note: The keys should be the same keys that you loaded to the other crypto
module.

If loading PKA master keys, disable PKA services (see [‘Disabling PKA Services’|
on page 170).

Set the master keys as outlined in [‘Setting the Master Key” on page 167

Enable PKA Callable Services if you had previously disabled the services. Also
enable PKDS Reads and Writes.

If desired, add the new crypto module to the group by doing a group change.

Note: With TKE V4.0 or later, it is no longer necessary to exit the application to

1.

®© N

add new crypto modules.

Open the Host where the crypto module(s) were added. You will be prompted to
authenticate the crypto module.

Open the new crypto module(s).

Use the authority 0 default signature key to administer access control (create
the same roles and authorities for the new PCICC to match the PCICC currently
on the host). Load the authority signature keys to match the other crypto
modules.

Load a new signature for an authority that can load master keys. If one authority
does not have the ability to load all the master key parts for each master key,
you may need to load additional signature keys.

Load the keys. The new symmetric master key must match the DES new
master key value on the CCF. The new asymmetric master key must match the
SMK value on the CCF.

Note: The keys should be the same keys that you loaded to the other crypto
modules. If you are adding more than one crypto module, load the keys
in all crypto modules before setting the master key.

Set the new symmetric master key on the PCICC from ICSF (see [‘Setting the
[Master Key” on page 167) when everything is the same (roles, authorities,
controls, master keys).

Set the new asymmetric master key from TKE.
If desired, add the new PCICC(s) to the group by doing a group change.

PKA Master Key Parts

When you enter the PKA master keys the first time, the PKA callable services are
initially disabled. Once you have entered the PKA master keys, you must enable the
PKA callable services for these services to work. Before you change the PKA
master keys, you need to disable the PKA callable services. To enable and disable
the PKA callable services refer to ['Disabling PKA Services” on page 170

To enter a PKA master key, you can either enter a complete key, a first key part and
a final key part or a first key part, an intermediate key part and a final key part.
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After you enter a key part for a DES or PKA master key the Cryptographic
Coprocessor Feature calculates a sixteen-byte hash pattern. The hash patterns are
displayed in a pop-up window for the administrator to verify. You can use the hash
pattern to verify that the key parts were entered correctly.

Tasks necessary for changing the PKA master keys are listed below. Note that
steps 2 through 8 are done at the TKE workstation.

Note: You must have at least one PCICC on the system to change your PKA
Master Keys. The PCICC is required to perform the PKDS Reencipher.

1. Disable PKA Services

2. Clear SMK (if not empty)

3. Clear KMMK (if not empty)

4. Load SMK — first, middle, last

5. Load KMMK — first, middle, last

6. Clear New ASYM-MK (if not empty)

7. Load New ASYM-MK — first, middle, last

8. Set ASYM-MK

9. PKDS Reencipher under the new PKA Master Key

10. PKDS Activate
11. Enable PKA Services
12. Enable PKDS Reads/Writes

We highly recommend that you set SMK=KMMK to maximize routing. The
ASYM-MK on the PCICC must equal the SMK on the CCF.

Disabling PKA Services

When you enter or change the PKA master keys, the PKA services should first be
disabled. To disable PKA services:

1. From TSO, access the user control functions by choosing option 4,
ADMINCNTL, on the Primary Menu panel of ICSF, as shown in |Figure 185

/'CSF@PRIM ------------- Integrated Cryptographic Service Facility ---------
OPTION ===> 4
Enter the number of the desired option.
1 COPROCESSOR MGMT - Management of Cryptographic Coprocessors
2 MASTER KEY - Master key set or change, CKDS/PKDS processing
3 OPSTAT - Installation options
4 ADMINCNTL - Administrative Control Functions
5 UTILITY - ICSF Utilities
6 PPINIT - Pass Phrase Master Key/CKDS Initialization
7 TKE - TKE Master and Operational key processing
8 KGUP - Key Generator Utility processes
9 9 UDX MGMT - Management of User Defined Extensions )

Figure 185. Selecting the Administrative Control Option on the ICSF Primary Menu Panel

2. The Administrative Control Function panel appears. See [Figure 186 on page|
-171
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/>CSFACF00 ------------- ICSF Administrative Control Functions
COMMAND ===>

Active CKDS: CSF.CKDS

Active PKDS: CSF.PKDS

To change the status of a control, enter the appropriate character
(E - ENABLE, D - DISABLE) and press ENTER.

Function STATUS
. Dynamic CKDS Access ENABLED
D PKA Callable Services ENABLED
PKDS Read Access ENABLED
9 PKDS Write, Create, and Delete Access ENABLED )

Figure 186. Disabling the PKA Callable Services

3. Type a 'D' to the left of the functions you want disabled and press ENTER.

Note: Disabling PKA Callable Services automatically disables PKDS
Read/Write/Create/Delete access as well.

Enabling PKA Services

After you enter or change the PKA master keys, the PKA services should be
enabled. To enable PKA services:

1. From TSO, access the user control functions by choosing option 4,
ADMINCNTL, on the Primary Menu panel of ICSF, as shown in

CSFEPRIM -=--cmmmmmme- Integrated Cryptographic Service Facility --------- A
OPTION ===> 4
Enter the number of the desired option.
1 COPROCESSOR MGMT - Management of Cryptographic Coprocessors
2 MASTER KEY - Master key set or change, CKDS/PKDS processing
3 OPSTAT - Installation options
4 ADMINCNTL - Administrative Control Functions
5 UTILITY - ICSF Utilities
6 PPINIT - Pass Phrase Master Key/CKDS Initialization
7 TKE - TKE Master and Operational key processing
8 KGUP - Key Generator Utility processes
9 9 UDX MGMT - Management of User Defined Extensions )

Figure 187. Selecting the Administrative Control Option on the ICSF Primary Menu Panel

2. The Administrative Control Function panel appears. See [Figure 188 on page|
-1 72

Chapter 6. Managing Keys: TKE and ICSF with CCF 171



CSFACFOO ------------- ICSF Administrative Control Functions
COMMAND ===>

Active CKDS: CSF.CKDS

Active PKDS: CSF.PKDS

To change the status of a control, enter the appropriate character (E - ENABLE,
D - DISABLE) and press ENTER.

Function STATUS
. Dynamic CKDS Access ENABLED
E PKA Callable Services DISABLED
E PKDS Read Access DISABLED
\\E PKDS Write, Create, and Delete Access DISABLED )

Figure 188. Enabling and Disabling the PKA Callable Services

3. Enter the option and press ENTER.

» To enable the PKA callable services, type an 'E' before the function. Press
ENTER.

* To enable PKDS Read Access, type an 'E' before the function. Press ENTER.
* To enable PKDS Write Access, type an 'E' before the function. Press ENTER.

Resetting PKA Master Keys

Reenciphering

If you realize that you have made a mistake entering key parts to either PKA master
key register, you are able to reset the value in the register to zero. From the TKE
workstation, access the domain window (see [‘Domain Keys Page - CCF” on page]
[04] and ['Domains Keys Page (PCICC and PCIXCC/CEX2C)” on page 110]). Select
the appropriate PKA master key and then select Clear.

If changing the PKA master keys, you should clear out the current PKA key values
by resetting the values to zero.

Notes:

1. Once the PKA master keys have been changed, internal tokens in the PKDS
are unusable. You will need to reencipher and activate the PKDS in order to use
them with the changed master key. This requires a PCICC on your system. See
[‘Reenciphering and Activating the PKDS.”|

2. For RSA keys loaded into the PKDS from the TKE workstation, the process can

be repeated to load the keys under the changed PKA master keys. See |“Load

RSA Key to PKDS - CCF” on page 109|and [Installing RSA Keys in the PKDS

from a Dataset” on page 183]for details.

and Activating the PKDS

For security reasons, your installation should periodically change the PKA master
keys and reencipher the private keys. Reenciphering and activating the PKDS
automatically refreshes the PKDS cache, as does starting ICSF.

You must have a PCICC to perform the reencipher. PKA keys should NOT be
changed if a PCICC is not available.

To reencipher the PKDS after the PKA SMK and ASYM-MK have been changed, go
to the Master Key Management panel and select option 6.
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Note: Only keys enciphered under the SMK and the ASYM-MK are reenciphered.
PKDS reencipher will not be able to reencipher private keys encrypted under
the CCF key management master key (KMMK) if the KMMK does not equal

the SMK.
4 N
CSFMKMOO ---------=-=---- ICSF - Master Key Management -------------
OPTION ===> 6
Enter the number of the desired option.
1 INIT/REFRESH CKDS - Initialize a Cryptographic Key Data Set or
activate an updated Cryptographic Key Data Set
2 SET MK - Set a DES/Symmetric-Keys master key
3 REENCIPHER CKDS - Reencipher the CKDS prior to changing the DES
/Symmetric Keys master key
4 CHANGE MK - Change the DES/Symmetric-Keys master key and
activate the reenciphered CKDS
5 INITIALIZE PKDS - Initialize or update a PKDS Cryptographic
Key Data Set header record
6 REENCIPHER PKDS - Reencipher the PKA Cryptographic Key Data Set
7 ACTIVATE PKDS - Activate the PKDS after it has been reenciphered
9 8 REFRESH CACHE - Refresh the PKDS cache if enabled )

Figure 189. Selecting the Reencipher PKDS Option on the Master Key Management Panel

The Reencipher PKDS panel appears. In the Input PKDS field, specify the name of
the PKDS that you want ICSF to reencipher under the current SMK and ASYM-MK.

In the Output PKDS field, specify the name of an empty VSAM data set. ICSF
writes the reenciphered keys to this data set.

/’ . N\
CSFCMK11 -=---=mmmmmm e - ICSF - Reencipher PKDS -------------
COMMAND ===>
To reencipher all PKDS entries from encryption under the old signature/
asymmetric-keys master key to encryption under the current master key,
enter the PKDS names below.
Input PKDS ===>
Qutput PKDS ===>
Press ENTER to reencipher the PKDS.
Press END to exit to the previous menu )

Figure 190. Reencipher PKDS

Press enter to reencipher the PKDS. Reenciphering automatically refreshes the
PKDS cache. Once successful, you will then want to activate the PKDS. Return to
the Master Key Management panel and select option 7.
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CSFMKMOO -----==-==mmmmmm ICSF - Master Key Management -------------
OPTION ===>7

Enter the number of the desired option.

1 INIT/REFRESH CKDS - Initialize a Cryptographic Key Data Set or
activate an updated Cryptographic Key Data Set

2 SET MK - Set a DES/Symmetric-Keys master key

3 REENCIPHER CKDS - Reencipher the CKDS prior to changing the DES
/Symmetric Keys master key

4 CHANGE MK - Change the DES/Symmetric-Keys master key and
activate the reenciphered CKDS

5 INITIALIZE PKDS - Initialize or update a PKDS Cryptographic
Key Data Set header record

6 REENCIPHER PKDS - Reencipher the PKA Cryptographic Key Data Set
7 ACTIVATE PKDS - Activate the PKDS after it has been reenciphered
9 8 REFRESH CACHE - Refresh the PKDS cache if enabled )

Figure 191. Selecting the Activate PKDS Option on the Master Key Management Panel

The Activate PKDS panel appears. Enter the name of the PKDS that you want
ICSF to use. The PKDS must have already been reenciphered under the current
Signature/Asymmetric-keys master key.

s
CSFCMK21 ------- ICSF - Activate PKA Cryptographic Key Data Set ---------
COMMAND ===>
Enter the name of the new PKDS below.

New PKDS ===>

Press ENTER to activate the PKDS.
\Fress END to exit to the previous menu

Figure 192. Activate PKDS

After you press ENTER, the PKDS becomes active. Activation automatically
refreshes the PKDS cache.

Loading and Importing Operational Keys

174

From the TKE workstation, you can load key parts for operational (PIN and
transport) keys into a key part queue. To import these key parts into the CKDS, you
must also use the ICSF Operational Key panel and perform a CKDS refresh.

Note: Depending on your machine type, the key part queue may only have room
for one entry. You must import the key part using the ICSF panels.

When loading and importing an operational key part, a first and final key part are
required. One or more intermediate key parts are optional. See [‘lmporting the First]

Operational Key Part” on page 175 [‘lmporting Intermediate Operational Key Parts’|

on page 179 and [‘Importing the Final Operational Key Part’ on page 180
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Importing Key Parts Individually

This procedure involves loading and importing two or more key parts individually

and is divided into these tasks:

1. Loading the first operational key part (TKE workstation)
Importing the first operational key part (ICSF panels)
Refresh the crypto notebook (TKE workstation)

Loading intermediate operational key part (TKE workstation)*
Importing intermediate operational key part (ICSF panels)*
Refresh the crypto notebook (TKE workstation)*

Loading the final operational key part (TKE workstation)
Importing the final operational key part (ICSF panels)
Refresh the crypto notebook (TKE workstation)

Refresh the CKDS (ICSF panels)

COXNOORWN

—_

Note: * If you are loading more than one intermediate key part, steps 4, 5 and 6

can be repeated.

Importing Multiple Key Parts

This procedure involves loading and importing multiple key parts and is divided into

these tasks:

Loading the first operational key part (TKE workstation)
Loading intermediate operational key part (TKE workstation)
Loading the final operational key part (TKE workstation)
Importing the first operational key part (ICSF panels)
Importing intermediate operational key part (ICSF panels)
Importing the final operational key part (ICSF panels)
Refresh the crypto notebook (TKE workstation)

Refresh the CKDS (ICSF panels)

NGO A~D =

Importing the First Operational Key Part

Note: The process of importing operational key parts from the key part queue is

performed from your TSO logon id using the ICSF panels.

To begin importing the first operational key part, start at the ICSF main menu and

follow the instructions below:
1. Select option 7, TKE, on the primary menu panel, as shown in [Figure 193

~
CSFEPRIM ----=--ommmm- Integrated Cryptographic Service Facility ---------
OPTION ===> 7
Enter the number of the desired option.
1 COPROCESSOR MGMT - Management of Cryptographic Coprocessors
2 MASTER KEY - Master key set or change, CKDS/PKDS processing
3 OPSTAT - Installation options
4 ADMINCNTL - Administrative Control Functions
5 UTILITY - ICSF Utilities
6 PPINIT - Pass Phrase Master Key/CKDS Initialization
7 TKE - TKE Master and Operational key processing
8 KGUP - Key Generator Utility processes
9 UDX MGMT - Management of User Defined Extensions
N J
Figure 193. Selecting the TKE Option on the ICSF Primary Menu Panel
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2. The TKE Processing Selection panel appears. Select option 2, DES Operational

key entry.

Note: You must have read access to the resource CSFMVR otherwise the

operation will fail.

OPTION ===> 2

1 DES Master key entry

3 PKA key entry

-

Enter the number of the desired option.

2 DES Operational key entry

-
CSFOPKOO ---------=--=--- ICSF - TKE Processing Selection -------------

v

Figure 194. Selecting the DES Operational Key entry on the TKE Processing Selection Panel

3. The Coprocessor Selection panel appears:

T
OPTION ===> 0

REGISTER STATUS
Crypto Module ID

New Master Key register
NMK verification pattern
01d Master Key register
OMK verification pattern
01d/New Master Key register
hash pattern
Master Key register
MK verification pattern
Master Key register
hash pattern
Special Secure Mode
Environment Control Mask

Press END
o

0. COPROCESSOR CO

: E589C39694407A60
: 5D40C39997A396F0
: EMPTY

¢ VALID
: 0212570BB5E544C1

3DDAE6229901A0C5

: 3C8BE367C85054C0

¢ VALID

: CA6B408A02371B1D
: DF3A50AE5466123A
: 96EF57E8BDO74557
: ENABLED

: F3FEFCFO

CRYPTO DOMAIN: 0O
Enter the number of the coprocessor to be used for key entry.
1. COPROCESSOR C1

: €39997A396F1407A
: 605D40E589(C39694
: EMPTY

: VALID

: 0212570BB5E544C1
: 5B82229C87F044C3
: DA6544F00CC43D46
: VALID

: CA6B408A02371B1D
: DF3A50AE5466123A
: 96EF57E8BD0O74557
: ENABLED

: F3FEFCFO

Press ENTER to select coprocessor and proceed to new master key part entry.
to exit to the previous menu.

Figure 195. Selecting a Coprocessor for Operational Key Entry

4. Select a coprocessor. The Operational Key Input panel appears (Figure 196 on|

page 177).
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CSFSCK10 -----==--=--=-- ICSF - TKE - Operational Key Input ---------------
COMMAND ===>

Coprocessor selected for new key : CO

Enter the dataset name and the key specifications.

CKDS name ==> 'S09.CKDS'

Key label ==> S09.EXPORTER.KEY1

Key type ==> Selection panel displayed if blank
Key part ==> FIRST FIRST, MIDDLE or FINAL

For FINAL key part enter the following information.

Adjust parity ===> YES or NO
Control Vector ===> YES or NO
Installation data ===

Press ENTER to select the dataset and the key.
Press END to exit to the previous menu.

Figure 196. Operational Key Input Panel - First Key Part

All the panels for entering key parts show status information at the top. The
coprocessor you selected before entering key parts, either 0 or 1, is displayed.

a. In the CKDS name field, enter the name of the disk copy of the CKDS in
which you want the key parts and, eventually, the entire key to be stored.

This CKDS name field defaults to the name of the disk copy of the CKDS
last used to refresh the in-storage CKDS.

b. In the Key label field, specify the label of the entry on the CKDS in which
the key parts and, eventually, the entire key will be stored.

c. Inthe Key type field, enter the type of key you want to enter.

You can enter any of the following types of keys:
EXPORTER  Exporter key-encrypting key

IMP-PKA Limited Authority Importer Key
IMPORTER Importer key-encrypting key
PINGEN PIN generation key

PINVER PIN verification key

IPINENC Input PIN-encrypting key

OPINENC Output PIN-encrypting key

If you leave the field blank and press ENTER, the Key Type Selection panel
appears. See [Figure 197 on page 178

d. Type s to the left of the key type you want to specify from the displayed list
of key types and press ENTER.

In [Figure 197 on page 178} the EXPORTER key is selected.
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~
CSFCSE12 ---------- ICSF - Key Type Selection Panel ---------- ROW 1 OF 7
COMMAND ===> SCROLL ===> PAGE

Select one key type only
KEY TYPE DESCRIPTION

s EXPORTER  Export key encrypting key
IMP-PKA Limited Authority importer key
IMPORTER  Import key encrypting key
IPINENC Input PIN encrypting key
OPINENC Qutput PIN encrypting key
PINGEN PIN generation key
PINVER PIN verification key

kkkkkkkkkkkkkkkrkrkxxxxxxxkxxx BOTTOM OF DATA #*kkkkkkhkhkhkhkhkhhkhkhkhkhkhkhkh®

- J
Figure 197. Selecting a Key Type on the Key Type Selection Panel

e. In the Key part field, enter FIRST for the first key part.

Figure 198 shows an example of the Operational Key Input panel filled in for
a first key part.

The Operational Key Input panel appears. See |Figure 198

-
CSFSCK30-------- ICSF - TKE - Operational Key Input ------=----cmemmmonm-
COMMAND ===>

Coprocessor selected for new key : CO

Enter a verification pattern. (optional)
VP ===> 0000000000000000

Press ENTER after the key has been entered.
Press END to exit to the previous menu.

- J
Figure 198. Operational Key Input Panel - Key Part Register Status for First Part

5. Enter the verification pattern if desired, and press ENTER.

Pressing ENTER on the Operational Key Input panel reads the key part from
the key part queue and loads the key part into the CKDS.

Since you are entering the first key part, the key label on the CKDS should not
already exist. ICSF will create an entry with the key label you specify.

However, if you specified a key label that already exists, the Operational Key
Input panel appears. See [Figure 199 on page 179|

Note: This panel will only appear if the key represented by the existing label is
a null key or a partial key (the final key has not been entered). If the
label represents a complete key then an error message NOT A PARTIAL
KEY will appear in the upper right corner of the panel.
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CSFSCK40 ------------- ICSF - TKE - Operational Key Input -------------cu---
COMMAND ===>

A record with the following specifications has been found in the selected CKDS:

Key Tabel : S09.EXPORTER.KEY1
Key type : EXPORTER

Press ENTER to replace the existing record.
Press END to exit to the previous menu.

- J
Figure 199. Operational Key Input Panel

This panel alerts you that even though you are entering the first key part, an
entry in the CKDS under the label you specified already exists. The panel
displays the key label and key type for the entry.

6. If you want to replace the existing key with the new key you are about to enter,
press ENTER.

The new key value will replace the existing key under that label in the CKDS.

You have completed the process of importing the first key part. Therefore, the first
key part has been transferred from the key part queue to the key label you
specified on the CKDS. When you load and import the next key part, it will be
combined with the first key part in the CKDS.

You are now ready to load and import a middle or final key part. A first and final key
part are required for an operational key. Any intermediate key parts are optional.

If your machine can only handle one key part on the queue, return to the TKE
workstation, refresh the crypto notebook, and load the next key part. Otherwise,
import the next key part using the appropriate ICSF panels.

Importing Intermediate Operational Key Parts

If you have loaded an intermediate key part from TKE, follow this procedure to
import the intermediate key part to the CKDS.

1. In the key part field on the Operational Key Input panel, specify MIDDLE, as
shown in [Figure 200 on page 180} and press ENTER.
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CSFSCK10 ------=--mmmm- ICSF - TKE - Operational Key Input -----------=--o----
COMMAND ===>

Coprocessor selected for new key : CO

Enter the dataset name and the key specifications.

CKDS name ==> 'S09.CKDS'

Key label ==> S09.EXPORTER.KEY1

Key type ==> EXPORTER Selection panel displayed if blank
Key part ==> MIDDLE FIRST, MIDDLE or FINAL

Press ENTER to select the dataset and the key.
Press END to exit to the previous menu.

Figure 200. Operational Key Input Panel - Middle Key Part

Figure 201| appears.

~
CSFSCK30-------- ICSF - TKE - Operational Key Input ----=-=--c-cmemaeanm-
COMMAND ===>

Coprocessor selected for new key : Co

Enter a verification pattern. (optional)
VP ===> 0000000000000000

Press ENTER after the key has been entered.
Press END to exit to the previous menu.

-

Figure 201. Operational Key Input Panel - Key Part Register Status for Middle Part

2. Press enter.

If your machine can only handle one key part on the queue, return to the TKE
workstation, refresh the crypto notebook, and load the next key part to the queue.
Import the key part using the appropriate ICSF panels.

Importing the Final Operational Key Part
To import a final operational key part, follow these steps:
1. In the Key part field on the Operational Key Input panel, specify FINAL.
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e
CSFSCK10 -----==--=--=-- ICSF - Operational Key Input ----------mmmmmmmmmom
COMMAND ===>

Coprocessor selected for new key : CO

Enter the dataset name and the key specifications.

CKDS name ==> 'S09.CKDS'

Key label ==> S09.EXPORTER.KEY1

Key type ==> EXPORTER Selection panel displayed if blank
Key part ==> FINAL FIRST, MIDDLE or FINAL

For FINAL key part enter the following information.

> YES YES or NO
> YES YES or NO
> EXPORTER A TO B INSTALLED 03/01/99

Adjust parity
Control Vector
Installation data

Press ENTER to select the dataset and the key.
Press END to exit to the previous menu.

Figure 202. Operational Key Input Panel - Final Key Part

2. In the Adjust parity field, specify YES if you want ICSF to adjust the parity to
odd.
Any key generated on ICSF has odd parity. However, ICSF allows you to enter
a key with odd or non-odd parity. A key with non-odd parity will function on ICSF
but ICSF will return an even parity reason code for many functions in which the
key is used. Although ICSF runs with odd or non-odd parity, your installation
may choose to run with just odd parity keys.

3. In the Control Vector field, specify YES or NO.
For all types of keys except transport keys, specify YES. If you want to enter a
transport key, you can specify either YES or NO. If you specify NO, the
transport key is flagged for use in NOCV processing. In NOCV processing,
ICSF uses the transport key itself rather than a transport key variant to encrypt
keys. NOCV processing is used to exchange keys with products that do not use
control vectors.

4. In the Installation data field, enter any information your installation wants to
specify about the key.

This information is stored in the installation data field of the CKDS.
Figure 202| shows this panel filled in for the final key part.
5. Press ENTER. |Figure 203 on page 182|appears.
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~
CSFSCK30--------- ICSF - TKE - Operational Key Input -----------mmemmemnm-
COMMAND ===>

Coprocessor selected for new key : CO

Enter a verification pattern. (optional)
VP ===> 0000000000000000

Press ENTER after the key has been entered.
Press END to exit to the previous menu.

- %
Figure 203. Operational Key Input Panel - Key Part Register Status for Final Part

6. Press enter.

Refreshing the CKDS

At any time without disrupting cryptographic functions, you can refresh the

in-storage CKDS with an updated or different disk copy of the CKDS by following

the steps below.

1. Enter option 2, Master Key, on the ICSF Primary Menu to access the Master
Key Process panel. Enter option 1, INIT/REFRESH CKDS to access the
Initialize CKDS panel which is shown in

4 N
CSFCKDOO -----==-==mmmmmm ICSF - Initialize a CKDS ---------mmmmom-
COMMAND ===> 5§
Enter the number of the desired option.
1 Initialize an empty CKDS (creates the header and system keys)
2 NOCVKEYS - Create NOCV-Enablement keys (for keys without CVs)
3 ANSI - Create ANSI system keys (for ANSI X9.17 services)
4 ESYS - Create enhanced system keys (for Symmetric services)
5 REFRESH - Activate an updated CKDS
Enter the name of the CKDS below.
CKDS ===> 'FIRST.EMPTY.CKDS' )

Figure 204. ICSF Initialize a CKDS Panel

2. In the CKDS field, specify the name of the disk copy of the CKDS that you want
ICSF to read into storage.

3. Choose option 5, REFRESH, and press ENTER.

ICSF reads the disk copy of the specified CKDS into storage. Partial keys that
may exist when you enter keys manually are not loaded into storage during a

REFRESH. Applications running on ICSF are not disrupted. A message stating
that the CKDS was refreshed appears on the right of the top line on the panel.
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After the CKDS is read into storage, ICSF performs a MAC verification on each
record in the CKDS. If a record fails the MAC verification, a message giving the
key label and type for that record is sent to the MVS security console. You can
then delete the record from the CKDS using KGUP or the dynamic CKDS
update services. Any other attempts to access a record that has failed MAC
verification results in an invalid MAC return code and reason code.

4. Press END to return to the Primary Menu panel.

Installing RSA Keys in the PKDS from a Dataset

If you used TKE to load an RSA key into a host dataset member on MVS, you load
it from the dataset to the PKDS by this method.

1. Select Option 7, TKE, on the ICSF Primary Option Menu.

7 N\
CSFEPRIM ==--mmemmmemm Integrated Cryptographic Service Facility ---------
OPTION ===> 7
Enter the number of the desired option.

1 COPROCESSOR MGMT - Management of Cryptographic Coprocessors

2 MASTER KEY - Master key set or change, CKDS/PKDS processing
3  OPSTAT - Installation options

4 ADMINCNTL - Administrative Control Functions

5 UTILITY - ICSF Utilities

6 PPINIT - Pass Phrase Master Key/CKDS Initialization

7 TKE - TKE Master and Operational key processing

8 KGUP - Key Generator Utility processes

S 9 UDX MGMT - Management of User Defined Extensions )

Figure 205. Selecting the TKE Option on the ICSF Primary Menu Panel

2. The TKE Processing Selection panel appears. Select option 3.

4 . . N
CSFOPKOO ------=--=-ommmm- ICSF - TKE Processing Selection -------------

OPTION ===> 3

Enter the number of the desired option.

1 DES Master key entry
2 DES Operational key entry
3 PKA key entry

- J
Figure 206. Selecting PKA Key entry on the TKE Processing Selection Panel

3. On the ICSF PKA Direct Key Load panel, enter the name of the pre-allocated
partitioned dataset and the member name of the RSA key to be loaded into the
PKDS.
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/'CSFTPLOO -------------- ICSF - PKA Direct Key Load ~ =---------------
Enter the data set name and the key specifications.
Key Data Set
Name ====> 's09.pkds(rsakeyl)"'

Press ENTER to select the data set and the key.
Press END to exit to the previous menu.

Figure 207. PKA Direct Key Load

If the RSA key is loaded successfully into the PKDS, a LOAD COMPLETED
message is displayed in the upper right corner. If an error occurs during the load
process, an applicable error message is displayed in the upper right corner with
detailed error information displayed in the middle of the display for selected errors.
You may also press the PF1 key for more information.
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Chapter 7. Managing Keys: TKE and ICSF with
PCIXCC/CEX2C

Master keys are used to protect all cryptographic keys that are active on your
system.

Because master key protection is essential to the security of the other keys, ICSF
stores the master keys within the secure hardware of the cryptographic feature.
This nonvolatile key storage area is unaffected by system power outages, because
it has a battery backup. The values of the master keys never appear in the clear
outside the cryptographic feature.

On a z990, z890 or z9-109 with a PCI X Cryptographic Coprocessor/Crypto
Express2 Coprocessor, the Symmetric-Keys Master Key (SYM-MK) protects
symmetric keys such as DES keys and the Asymmetric-Keys Master Key protects
RSA keys.

ICSF is required to complete some operations initiated from TKE. These
operations include setting the master key, initializing/refreshing the CKDS,
loading operational keys into the CKDS, and installing RSA keys to the PKDS.
ICSF is also required for disabling and enabling PKA services, PKDS
Initialization, PKDS Reencipher and PKDS Activate.

Be prepared to switch between your TKE workstation and your ICSF host
session.

This chapter discusses the procedures needed for:

» Loading the master keys the first time you start ICSF ( page
* Changing the SYM-MK master keys periodically (page

« Reentering the master keys (page [192)

» Adding Additional Coprocessors (page

* Changing the ASYM-MK master keys (page

» Loading Operational Keys to the CKDS (page

* Refreshing the CKDS (page

* Install RSA Keys (page

Master Key Parts

Master key parts are loaded using binary files, the keyboard, or secure key part
entry. If loading key parts with the keyboard, record the key parts and the
associated hash patterns.

The key parts are generated from the Domain Keys page. For more information,
see ['Domains Keys Page (PCICC and PCIXCC/CEX2C)” on page 110/

Note: If you are reentering master keys after they have been cleared, use the
same master key part values as when you originally entered the keys. You
should have saved the key part values in a secure place after you entered
the master keys previously.
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To enter a Symmetric-keys master key, you can either enter a first key part and a
final key part or a first key part, one or more intermediate key part and a final key
part.

First-Time Startup

The first time you start ICSF, you must load a Symmetric-Keys master key and
initialize the CKDS. For information on creating an empty CKDS, see
[Cryptographic Services ICSF System Programmer’s Guidel When you initialize the
CKDS, ICSF creates a header record for the CKDS, installs the required system
key in the CKDS, and sets the master key. Keys stored in the CKDS are
enciphered under the Symmetric-Keys master key. After the master key has been
set, you can generate or enter any keys you need to perform cryptographic
functions.

To define a Symmetric-Keys master key, you must load the key parts to the
Symmetric-Keys new master key register.

You have to initialize a CKDS only the first time you start ICSF on a system. After
you initialize a CKDS, you can copy the disk copy of the CKDS to create other
CKDSs for use on the system. You can also share a CKDS with another ICSF
system if the system has the same master key value. If sharing a CKDS between a
2990, 2890 or z9-109 and a legacy system, the CKDS must be initialized on the
legacy system. At any time, you can read a different disk copy into storage. For
information about how to read a disk copy into storage, see [‘Refreshing the CKDS']

Initialize the CKDS

186

At this point, the new symmetric-keys master key register on each PCIXCC/CEX2C
in this domain is full.

You must now initialize the CKDS (which also activates the symmetric-keys master
key).

From the ICSF Primary Menu on TSO:
1. Select Option 2, MASTER KEY, as shown inFigure 208 on page 187}
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CSFEPRIM ------oemem Integrated Cryptographic Service Facility ---------
OPTION ===> 2

Enter the number of the desired option.

1 COPROCESSOR MGMT - Management of Cryptographic Coprocessors

2 MASTER KEY - Master key set or change, CKDS/PKDS processing
3  OPSTAT - Installation options

4 ADMINCNTL - Administrative Control Functions

5 UTILITY - ICSF Utilities

6 PPINIT - Pass Phrase Master Key/CKDS Initialization

7 TKE - TKE Master and Operational key processing

8 KGUP - Key Generator Utility processes

9 UDX MGMT - Management of User Defined Extensions

Licensed Materials - Property of IBM

This product contains "Restricted Materials of IBM"

5694-A01 (C) Copyright IBM Corp. 2004. A1l rights reserved.

US Government Users Restricted Rights - Use, duplication or
disclosure restricted by GSA ADP Schedule Contract with IBM Corp.

Press ENTER to go to the selected option.
\Press END to exit to the previous menu.

Figure 208. ICSF Selecting the Master Key Option on the Primary Menu Panel

2. The Master Key Management panel appears. Select Option 1, INIT/REFRESH
CKDS, as shown in|Figure 209

/>CSFMKM00 ———————————————— ICSF - Master Key Management ------------- A
OPTION ===> 1
Enter the number of the desired option above.
1 INIT/REFRESH CKDS - Initialize a Cryptographic Key Data Set or
activate an updated Cryptographic Key Data Set
2 SET MK - Set a DES/Symmetric-Keys master key
3 REENCIPHER CKDS - Reencipher the CKDS prior to changing the DES
/Symmetric Keys master key
4 CHANGE MK - Changing the DES/Symmetric-Keys master key and
activate the reenciphered CKDS
5 INITIALIZE PKDS - Initialize or update a PKDS Cryptographic
Key Data Set header record
6 REENCIPHER PKDS - Reencipher the PKA Cryptographic Key Data Set
7 ACTIVATE PKDS - Activate the PKDS after it has been reenciphered
9 8 REFRESH CACHE - Refresh the PKDS cache if enabled )

Figure 209. Selecting the Initialize a CKDS Option on the ICSF Master Key Management
Panel

3. The Initialize a CKDS panel now appears.
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4 s N
CSFCKD10 -----==-=mmmmmmm ICSF - Initialize a CKDS ---------mmmmmm-
COMMAND ===> 1
Enter the number of the desired option.
1 Initialize an empty CKDS (creates the header and system keys)
2 REFRESH - Activate an updated CKDS
Enter the name of the CKDS below.
CKDS ===> 'FIRST.EMPTY.CKDS' )

Figure 210. ICSF Initialize a CKDS Panel

4. In the CKDS field at the bottom of the panel, enter the name of the empty
VSAM data set that was created to use as the disk copy of the CKDS.

The name you enter should be the same name that is specified in the CKDSN
installation option in the installation options data set. For information about
creating a CKDS and specifying the CKDS name in the installation options data
set, see |z/OS Cryptographic Services ICSF System Programmer’s Guide,

5. Choose option 1, Initialize an empty CKDS, and press ENTER.

ICSF creates the header record in the disk copy of the CKDS. Next, ICSF sets
the symmetric-keys master key. ICSF then adds the required system key to the
CKDS and refreshes the CKDS. When ICSF completes all these steps the
message INITIALIZATION COMPLETE appears. If you did not enter a master key
into the new master key register previously, the message NMK REGISTER NOT
FULL appears and the initialization process ends. You must enter a master key
into the new master key register before you can initialize the CKDS.

Note: If any part of the option 1 fails, you must delete the CKDS and start over.
If the failure occurs after the master key is set and before the system key
has been created, you will need to reload the new master key register,
delete the CKDS and start over.

After you complete the entire process, a master key and CKDS exist on your
system. If you want to enter keys (for example, keys using the key generate
callable service, the key generator utility program, or convert CUSP/PCF keys to
ICSF keys using the conversion program), see |z/0S Cryptographic Services ICSH
[Administrator’'s Guidel

Changing Master Keys

188

For security reasons your installation should change the master keys periodically. In
addition, if the master keys have been cleared, you may also want to change the
master keys after you reenter the cleared master keys.

Tasks necessary for changing the master key are:
1. Load new SYM-MK (first, middle, last)

2. Re-encipher CKDS

3. Change master key

The step-by-step procedure for changing the symmetric-keys master key,
reenciphering the CKDS, and activating the new master key is presented in
[‘Changing the Master Key Using the Master Key Panels” on page 189 For
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information on the contents of the master key registers during the key change
process, and some compatibility mode considerations, see |z/0S Cryptographid
[Services ICSF Administrator’'s Guide,

A symmetric-keys master key and a CKDS containing keys enciphered under that
master key already exist. Before you replace this existing master key with the new
master key, you must reencipher the CKDS under the new master key.

When the DES master key is changed, the current active DES master key is moved
to the auxiliary master key register and the new DES master key is moved to the
master key register. In this way, the new master key you have just entered
becomes the current master key, and the previous master key is stored in the old
master key register.

Before the new symmetric-keys master key is placed into the master key register,
you must reencipher all disk copies of the CKDS under the new master key. Then
you are ready to activate the master key. When you change the master key, you
have ICSF replace the in-storage copy of the CKDS with the reenciphered disk
copy and make the new master key active on the system.

Changing the Master Key Using the Master Key Panels

Load the key parts of the new master key that you want to replace the current
master key. The new master key parts must be loaded from TKE.

Note: The steps for this task are performed from your TSO logon id using the ICSF
panels.

The new symmetric-keys master key register on all PCIXCCs/CEX2Cs must be full
before you change the master key.

1. Select option 2, MASTER KEY, on the ICSF Primary Menu.

CSFEPRIM ------oomem Integrated Cryptographic Service Facility --------- h
OPTION ===> 2
Enter the number of the desired option.
1 COPROCESSOR MGMT - Management of Cryptographic Coprocessors
2 MASTER KEY - Master key set or change, CKDS/PKDS processing
3 OPSTAT - Installation options
4 ADMINCNTL - Administrative Control Functions
5 UTILITY - ICSF Utilities
6 PPINIT - Pass Phrase Master Key/CKDS Initialization
7 TKE - TKE Master and Operational key processing
8 KGUP - Key Generator Utility processes
9 9 UDX MGMT - Management of User Defined Extensions )

Figure 211. Selecting the Master Key Option on the ICSF Primary Menu Panel

2. Before you change the master key, you must first reencipher the disk copy of
the CKDS under the new master key. Select option 3, REENCIPHER CKDS,
on the Master Key Management panel, as shown in |Figure 212 on page 190}
and press ENTER.
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~
CSFMKMOO --------==--=-~ ICSF - Master Key Management -------------
OPTION ===> 3

Enter the number of the desired option above.

1 INIT/REFRESH CKDS - Initialize a Cryptographic Key Data Set or activate
an updated Cryptographic Key Data Set

2 SET MK - Set a DES/Symmetric-Keys master key

3 REENCIPHER CKDS - Reencipher the CKDS prior to changing the DES
/Symmetric Keys master key

4 CHANGE MK - Change the DES/Symmetric-Keys master key and
activate the reenciphered CKDS

5 INITIALIZE PKDS - Initialize or update a PKDS Cryptographic
Key Data Set header record

6 REENCIPHER PKDS - Reencipher the PKA Cryptographic Key Data Set
7 ACTIVATE PKDS - Activate the PKDS after it has been reenciphered
9 8 REFRESH CACHE - Refresh the PKDS cache if enabled )

Figure 212. Selecting the Reencipher CKDS Option on the ICSF Master Key Management
Panel

3. The Reencipher CKDS panel appears. See [Figure 213

- . N\
CSFCMK10 --------=mmmmmm ICSF - Reencipher CKDS -------=---=mncu-u-
COMMAND ===>
To reencipher all CKDS entries from encryption under the current DES/
Symmetric-Keys master key to encryption under the new master key enter
the CKDS names below.
Input CKDS ===> CKDS.CURRENT.MASTER
Qutput CKDS ===> CKDS.NEW.MASTER
o J

Figure 213. Reencipher CKDS

4. In the Input CKDS field, enter the name of the CKDS that you want to
reencipher. In the Output CKDS field, enter the name of the data set in which
the reenciphered keys are written.

Note: The output data set should already exist although it must be empty. For
more information about defining a CKDS, see |z/0S Cryptographid
[Services ICSF System Programmer’s Guide,

Reenciphering the disk copy of the CKDS does not affect the in-storage copy
of the CKDS. On this panel, you are working with only a disk copy of the
CKDS.

5. Press ENTER to reencipher the input CKDS entries and write them into the
output CKDS.
The message REENCIPHER SUCCESSFUL appears on the top right of the
panel if the reencipher succeeds.
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6. If you have more than one CKDS on disk, specify the information and press
ENTER as many times as you need to reencipher all of them. Reencipher all
your disk copies at this time. When you have reenciphered all the disk copies
of the CKDS, you are ready to change the master key.

7. Press END to return to the Master Key Management panel.

a. Changing the master key involves refreshing the in-storage copy of the
CKDS with a disk copy and activating the new master key.

b. If you are running in compatibility or co-existence mode, do not select
option 4, the Change option. To activate the changed master key when
running in compatibility or co-existence mode, you need to re-IPL MVS and
start ICSF. When you re-IPL MVS and start ICSF, you activate the changed
master key and refresh the in-storage CKDS. To do this, you must exit the
panels at this time.

c. If you are running in noncompatibility mode, to change the master key
select option 4 on the Master Key Management panel, as shown in
Figure 214

/>CSFMKM00 ---------------- ICSF - Master Key Management ------------- h
OPTION ===> 4
Enter the number of the desired option above.
1 INIT/REFRESH CKDS - Initialize a Cryptographic Key Data Set or activate
an updated Cryptographic Key Data Set
2 SET MK - Set a DES/Symmetric-Keys master key
3 REENCIPHER CKDS - Reencipher the CKDS prior to changing the DES
/Symmetric Keys master key
4 CHANGE MK - Change the DES/Symmetric-Keys master key and
activate the reenciphered CKDS
5 INITIALIZE PKDS - Initialize or update a PKDS Cryptographic
Key Data Set header record
6 REENCIPHER PKDS - Reencipher the PKA Cryptographic Key Data Set
7 ACTIVATE PKDS - Activate the PKDS after it has been reenciphered
9 8 REFRESH CACHE - Refresh the PKDS cache if enabled )

Figure 214. Selecting the Change Master Key Option on the ICSF Master Key Management
Panel

8. When iou press the ENTER key, the Change Master Key panel appears. See

Figure 215
e N
CSFCMK20 --=-==-m=mmmmmmmm e ICSF Change Master Key --------------
COMMAND ===>
Enter the name of the new CKDS below:
New CKDS ===> CKDS.NEW.MASTER
When the master key is changed, the new CKDS will become active.
- J

Figure 215. Change Master Key Panel
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9. In the New CKDS field, enter the name of the disk copy of the CKDS that you
want in storage.

You should have already reenciphered the disk copy of the CKDS under the
new master key. The last CKDS name that you specified in the Output CKDS
field on the Reencipher CKDS panel, which is shown in [Figure 213 on page]
automatically appears in this field.

10. Press ENTER.

ICSF loads the data set into storage where it becomes operational on the
system. ICSF also places the new master key into the master key register so it
becomes active.

After you press ENTER, ICSF attempts to change the master key. It displays a
message on the top right of the panel. The message indicates either that the
master key was changed successfully or that an error occurred that did not
permit the change process to be completed. For example, if you indicate a
data set that is not reenciphered under the new master key, an error message
displays and the master key is not changed.

Re-entering Master Keys After They have been Cleared

192

In the following situations, the PCI X Cryptographic Coprocessor (PCIXCC)/Crypto
Express2 Coprocessor (CEX2C) clears the master key registers so that the master
key values are not disclosed:

» If the PCIXCC/CEX2C detects tampering (the intrusion latch is tripped), ALL
installation data is cleared: master keys, retained keys for all domains,
operational key part registers, as well as roles and authorities.

+ If the PCIXCC/CEX2C detects tampering (the secure boundary of the card is
compromised), it self-destructs and can no longer be used.

* If you issue a command from the TKE workstation to zeroize a domain

This command zeroizes the data specific to a domain: master keys, retained
keys and operational key part registers.

* If you issue a command from the Support Element panel to zeroize all domains.

This command zeroizes ALL installation data: master keys, retained keys,
operational key part registers, and access control roles and profiles. Also, the
default setting of Denied for all PCIXCCs/CEX2Cs set for TKE Enablement.

Although the values of the master keys are cleared, the keys in the CKDS are still
enciphered under the cleared symmetric-keys master key. The RSA and DSS
private key are also each enciphered under the cleared asymmetric-keys master
keys. Therefore, to recover the keys in the CKDS, and the PKA private keys in the
PKDS, you must reenter the same master keys and activate the symmetric-keys
master key. For security reasons, you may then want to change all the master keys.

PR/SM Considerations

When running in PR/SM logical partition (LPAR) mode with PCIXCC/CEX2C, a
tamper situation causes all installation data; master keys, retained keys, operational
key part registers, roles and authorities to be cleared. All installation data will need
to be reloaded and recreated. If you zeroize a domain using the TKE workstation,
however, the master keys are cleared only in that domain. Master keys in other
domains are not affected and do not need to be reentered. For more information
about reentering master keys in LPAR mode, see |z/OS Cryptographic Serviced
[ICSF Administrator’'s Guide,
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Setting the Master Key

After the master keys have been cleared, reenter the same master keys by
following these steps:

1. Load new master key parts. For details on loading the keys, see

[PCICC/PCIXCC/CEX2C” on page 115.|

These values should be stored in a secure place as specified in your
enterprises security process.

2. Retrieve the key parts, checksums, verification patterns, and hash patterns you

used when you loaded the master keys originally. These values should have

been stored in a secure place.

3. To activate the symmetric-keys master key you just entered, you need to set it.
On the ICSF Primary Menu panel in TSO, select option 2.

OO NOOOT P WN

.

/,
CSFOPRIM =--mmmmm e
OPTION ===> 2

COPROCESSOR MGMT
MASTER KEY
OPSTAT

ADMINCNTL
UTILITY

PPINIT

TKE

KGUP

UDX MGMT

Enter the number of the desired option.

Management of Cryptographic Coprocessors

- Master key set or change, CKDS/PKDS processing
- Installation options

- Administrative Control Functions

- ICSF Utilities

- Pass Phrase Master Key/CKDS Initialization

- TKE Master and Operational key processing

- Key Generator Utility processes

- Management of User Defined Extensions

Figure 216. ICSF Selecting the Master Key Option on the Primary Menu Panel

4. To set the Symmetric-Keys master key, choose option 2 on the panel and press
ENTER.

1

-

~
CSFMKMOO
OPTION ===> 2

INIT/REFRESH CKDS

SET MK
REENCIPHER CKDS

CHANGE MK

INITIALIZE PKDS

REENCIPHER PKDS
ACTIVATE PKDS
REFRESH CACHE

Enter the number of the

desired option above.

Initialize a Cryptographic Key Data Set or activate
an updated Cryptographic Key Data Set

Set a DES/Symmetric-Keys master key

Reencipher the CKDS prior to changing the DES
/Symmetric Keys master key

Change the DES/Symmetric-Keys master key and
activate the reenciphered CKDS

Initialize or update a PKDS Cryptographic

Key Data Set header record

Reencipher the PKA Cryptographic Key Data Set
Activate the PKDS after it has been reenciphered
Refresh the PKDS cache if enabled

J

Figure 217. Selecting the Set Host Master Key Option on the ICSF Master Key Management

Panel
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After you select option 2, ICSF checks that the states of the registers are
correct. ICSF then transfers the symmetric-keys master key from the new
master key register to the master key register. This process sets the master key.

When ICSF attempts to set the master key, it displays a message on the top
right of the Master Key Management panel. The message indicates either that
the master key was successfully set, or that an error prevented the completion
of the set process.

5. You can now change the symmetric-keys master key, if you choose to, for
security reasons. Continue with [‘Changing Master Keys” on page 188 |

Adding Cryptographic Coprocessors After ICSF Initialization

There may come a time when you wish to add additional PCI X Cryptographic
Coprocessor (PCIXCC)/Crypto Express2 Coprocessor(CEX2C) to your system. After
the new crypto modules have been installed and configured by the appropriate
hardware personnel, make them known to the TKE workstation by following the
appropriate procedure.

PCIXCC/CEX2C

Note: With TKE Version 4.0 and later, it is no longer necessary to exit the
application to add new crypto module(s).

1. Open the Host where the crypto module(s) were added. You will be prompted to
authenticate the crypto module.

2. Open the new crypto module(s).

3. Use the authority 0 default signature key to administer access control (create
the same roles and authorities for the new PCIXCC/CEX2C to match the
PCIXCC/CEX2C currently on the host). Load the authority signature keys to
match the other crypto modules.

4. Load a new signature for an authority that can load master keys. If one authority
does not have the ability to load all the master key parts for each master key,
you may need to load additional signature keys.

5. Load the keys.

Note: The keys should be the same keys that you loaded to the other crypto
modules. If you are adding more than one crypto module, load the keys
in all crypto modules before setting the master key.

6. Set the asymmetric master key from TKE.

7. Set the symmetric master key on the PCIXCC/CEX2C from ICSF (see [‘Setting
fthe Master Key” on page 193) when everything is the same (roles, authorities,
controls, master keys).

8. If desired, add the new PCIXCC(s)/CEX2C(s) to the group by doing a group
change.

Asymmetric-keys Master Key Parts

194

When you enter the asymmetric-keys master key the first time, the PKA callable
services are initially disabled. Once you have entered the master key, you must
enable the PKA callable services for these services to work. Before you change the
asymmetric-keys master keys, you need to disable the PKA callable services. To
enable and disable the PKA callable services refer to [‘Disabling PKA Services” on|
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To enter a asymmetric-keys master key, you can either enter a first key part and a
final key part or a first key part, an intermediate key part and a final key part.

After you enter a key part for a symmetric-keys or asymmetric-keys master key the
PCIXCC calculates a sixteen-byte hash pattern. The hash patterns are displayed in
a pop-up window for the administrator to verify. The hash patterns check whether
you entered the key part correctly.

Tasks necessary for changing the asymmetric-keys master keys are listed below.
Note that steps 2 through 4 are done at the TKE workstation.

1. Disable PKA Services

Clear New ASYM-MK (if not empty)

Load New ASYM-MK — first, middle, last

Set ASYM-MK

PKDS Reencipher under the new PKA Master Key
PKDS Activate

Enable PKA Services

Enable PKDS Reads/Writes

© N o oA~ DN

Disabling PKA Services

When you enter or change the asymmetric-keys master keys, the PKA services
should first be disabled. To disable PKA services:

1. From TSO, access the user control functions by choosing option 4,
ADMINCNTL, on the Primary Menu panel of ICSF, as shown in

/’CSF@PRIM ------------- Integrated Cryptographic Service Facility --------- A
OPTION ===> 4
Enter the number of the desired option.
1 COPROCESSOR MGMT - Management of Cryptographic Coprocessors
2 MASTER KEY - Master key set or change, CKDS/PKDS processing
3 OPSTAT - Installation options
4 ADMINCNTL - Administrative Control Functions
5 UTILITY - ICSF Utilities
6 PPINIT - Pass Phrase Master Key/CKDS Initialization
7 TKE - TKE Master and Operational key processing
8 KGUP - Key Generator Utility processes
9 9 UDX MGMT - Management of User Defined Extensions )

Figure 218. Selecting the Administrative Control Option on the ICSF Primary Menu Panel

2. The Administrative Control Function panel appears. See [Figure 219 on page|
-1 96

Chapter 7. Managing Keys: TKE and ICSF with PCIXCC/CEX2C 195



CSFACFOO ------------- ICSF Administrative Control Functions
COMMAND ===>

Active CKDS: CSF.CKDS

Active PKDS: CSF.PKDS

To change the status of a control, enter the appropriate character
(E - ENABLE, D - DISABLE) and press ENTER.

Function STATUS
. Dynamic CKDS Access ENABLED
D PKA Callable Services ENABLED
PKDS Read Access ENABLED
L PKDS Write, Create, and Delete Access ENABLED )

Figure 219. Disabling the PKA Callable Services

3. Type a 'D' to the left of the functions you want disabled and press ENTER.

Note: Disabling PKA Callable Services automatically disables PKDS
Read/Write/Create/Delete access as well.

Enabling PKA Services

After you enter or change the asymmetric-keys master keys, the PKA services
should be enabled. To enable PKA services:

1. From TSO, access the user control functions by choosing option 4,
ADMINCNTL, on the Primary Menu panel of ICSF, as shown in |Figure 220

CSFEPRIM -=--ommmmmm- Integrated Cryptographic Service Facility --------- A
OPTION ===> 4
Enter the number of the desired option.
1 COPROCESSOR MGMT - Management of Cryptographic Coprocessors
2 MASTER KEY - Master key set or change, CKDS/PKDS processing
3 OPSTAT - Installation options
4 ADMINCNTL - Administrative Control Functions
5 UTILITY - ICSF Utilities
6 PPINIT - Pass Phrase Master Key/CKDS Initialization
7 TKE - TKE Master and Operational key processing
8 KGUP - Key Generator Utility processes
9 9 UDX MGMT - Management of User Defined Extensions )

Figure 220. Selecting the Administrative Control Option on the ICSF Primary Menu Panel

2. The Administrative Control Function panel appears. See [Figure 221 on page|
-1 97
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/>CSFACF00 ------------- ICSF Administrative Control Functions
COMMAND ===>
Active CKDS: CSF.CKDS
Active PKDS: CSF.PKDS

To change the status of a control, enter the appropriate character (E - ENABLE,
D - DISABLE) and press ENTER.

Function STATUS
. Dynamic CKDS Access ENABLED
E PKA Callable Services DISABLED
E PKDS Read Access DISABLED
\‘E PKDS Write, Create, and Delete Access DISABLED )

Figure 221. Enabling and Disabling the PKA Callable Services

3. Enter the option and press ENTER.

* To enable the PKA callable services, type an 'E' before the function. Press
ENTER.

* To enable PKDS Read Access, type an 'E' before the function. Press ENTER.
* To enable PKDS Write Access, type an 'E' before the function. Press ENTER.

Resetting Asymmetric-Keys Master Keys

Reenciphering

If you realize that you have made a mistake entering key parts to the

asymmetric-keys master key register, you are able to reset the value in the register
to zero. From the TKE workstation, access the domain window (see |“Domains Keys|

Page (PCICC and PCIXCC/CEX2C)” on page 110|and [‘Domain Keys Page -

PCIXCC/CEX2C” on page 120). Select the asymmetric-keys master key and then

select Clear.

Notes:

1. Once the asymmetric-keys master key has been changed, internal tokens in the
PKDS are unusable. You will need to reencipher and activate the PKDS in order
to use them with the changed master key. See [‘Reenciphering and Activating|

2. For RSA keys loaded into the PKDS from the TKE workstation, the process can
be repeated to load the keys under the changed asymmetric-keys master keys.
See [‘Load RSA Key to PKDS - PCIXCC/CEX2C” on page 139 and [‘Installing|
[RSA Keys in the PKDS from a Data Set” on page 203|for details.

and Activating the PKDS

For security reasons, your installation should periodically change the
asymmetric-keys master key and reencipher the private keys. Reenciphering and
activating the PKDS automatically refreshes the PKDS cache, as does starting
ICSF.

To reencipher the PKDS after the ASYM-MK has been changed, go to the Master
Key Management panel and select option 6.

Note: If sharing a PKDS, only keys enciphered under the ASYM-MK are
reenciphered. PKDS reencipher will not be able to reencipher private keys
encrypted under the CCF key management key (KMMK) if the KMMK does
not equal the SMK.
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~
CSFMKMOO -----==-==mmmmmm ICSF - Master Key Management -------------
OPTION ===> 6

Enter the number of the desired option.

1 INIT/REFRESH CKDS - Initialize a Cryptographic Key Data Set or activate
an updated Cryptographic Key Data Set

2 SET MK - Set a DES/Symmetric-Keys master key

3 REENCIPHER CKDS - Reencipher the CKDS prior to changing the DES
/Symmetric Keys master key

4 CHANGE MK - Change the DES/Symmetric-Keys master key and
activate the reenciphered CKDS

5 INITIALIZE PKDS - Initialize or update a PKDS Cryptographic

Key Data Set header record
6 REENCIPHER PKDS - Reencipher the PKA Cryptographic Key Data Set
ACTIVATE PKDS - Activate the PKDS after it has been reenciphered

9 REFRESH CACHE - Refresh the PKDS cache if enabled )

Figure 222. Selecting the Reencipher PKDS Option on the Master Key Management Panel

(o1

The Reencipher PKDS panel appears. In the Input PKDS field, specify the name of
the PKDS that you want ICSF to reencipher under the current ASYM-MK.

In the Output PKDS field, specify the name of an empty VSAM data set. ICSF
writes the reenciphered keys in this data set.

- . N\
CSFCMK11 ------mmmmmmmm - ICSF - Reencipher PKDS -------------
COMMAND ===>
To reencipher all PKDS entries from encryption under the old signature/
asymmetric-keys master key to encryption under the current master key, enter
the PKDS names below.
Input PKDS ===>
Qutput PKDS ===>
Press ENTER to reencipher the PKDS.
\Fress END to exit to the previous menu )

Figure 223. Reencipher PKDS

Press enter to reencipher the PKDS. Reenciphering automatically refreshes the
PKDS cache. Once successful, you will then want to activate the PKDS. Return to
the Master Key Management panel and select option 7.
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e
CSFMKMOO -----==--=mmmm-m ICSF - Master Key Management -------------
OPTION ===>7

Enter the number of the desired option.

1 INIT/REFRESH CKDS - Initialize a Cryptographic Key Data Set or activate
an updated Cryptographic Key Data Set
SET MK - Set a DES/Symmetric-Keys master key
3 REENCIPHER CKDS - Reencipher the CKDS prior to changing the DES
/Symmetric Keys master key
4 CHANGE MK - Change the DES/Symmetric-Keys master key and
activate the reenciphered CKDS

nN

5 INITIALIZE PKDS - Initialize or update a PKDS Cryptographic
Key Data Set header record
6 REENCIPHER PKDS - Reencipher the PKA Cryptographic Key Data Set
7 ACTIVATE PKDS - Activate the PKDS after it has been reenciphered

9 8 REFRESH CACHE - Refresh the PKDS cache if enabled )

Figure 224. Selecting the Activate PKDS Option on the Master Key Management Panel

The Activate PKDS panel appears. Enter the name of the PKDS that you want
ICSF to use. The PKDS must have already been reenciphered under the current
Signature/Asymmetric-keys master key.

e
CSFCMK21 --------- ICSF - Activate PKA Cryptographic Key Data Set --------
COMMAND ===>
Enter the name of the new PKDS below.
New PKDS ===>

Press ENTER to activate the PKDS.
Press END to exit to the previous menu

Figure 225. Activate PKDS

After you press ENTER, the PKDS becomes active. Activation automatically
refreshes the PKDS cache.

Loading Operational Keys to the CKDS

Beginning with TKE V4.1, you can load operational key parts into key part registers
on the PCIXCC/CEX2C. To load these keys into the CKDS you need to use the
ICSF DES Operational Key Load panel or KGUP. For KGUP details, refer to[z/09
[Cryptographic Services ICSF Administrator’s Guide,

Unlike the key part queue on the CCF, each key part register on the
PCIXCC/CEX2C holds an accumulated key. Multiple key loads are not required for
each key part. Therefore, when a key is loaded into the CKDS from a key part
register, it is done in a single step.

Before a key can be loaded into the CKDS from a key part register, it must be in
the Complete State. If the key part register is not in the complete state, the error
message KEY NOT COMPLETE will result. Access control point, Key Part Import -
RETRKPR, must be enabled on the selected PCIXCC/CEX2C or error message
ACCESS CONTROL FAILED will result.
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To load operational keys into the CKDS, start at the ICSF main menu and follow
these instructions:

1. Select option 1, COPROCESSOR MGMT, on the primary menu panel

/'CSF@PRIM ------------- Integrated Cryptographic Service Facility --------- A
OPTION ===> 1
Enter the number of the desired option.
1 COPROCESSOR MGMT - Management of Cryptographic Coprocessors
2 MASTER KEY - Master key set or change, CKDS/PKDS processing
3 OPSTAT - Installation options
4 ADMINCNTL - Administrative Control Functions
5 UTILITY - ICSF Utilities
6 PPINIT - Pass Phrase Master Key/CKDS Initialization
7 TKE - TKE Master and Operational key processing
8 KGUP - Key Generator Utility processes
9 9 UDX MGMT - Management of User Defined Extensions )

Figure 226. ICSF Primary Menu Panel

2. The Coprocessor Management panel appears. Put a ’K’ by the PCIXCC/CEX2C
that contains the key part register to load.

~
CSFGCMPO -=-==-==-==m=mmm - ICSF Coprocessor Management -------------
COMMAND ===>
Select the coprocessors to be processed and press ENTER.
Action characters are: A, D, E, K, R, and S. See the help panel for details.
COPROCESSOR  SERIAL NUMBER STATUS
_ AO6 ACTIVE
_ A07 DEACTIVATED
_ X00 42-K0001 ONLINE
K X04 42-K0043 ACTIVE
_ X05 42-K0058 DISABLED
_ X06 42-K0055 DEACTIVATED
\C J

Figure 227. Coprocessor Management Panel

3. The DES Operational Key Load panel appears. The PCIXCC/CEX2C previously
selected and the active CKDS are displayed at the top of the panel.
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e
CSFCMP50 ------------ ICSF DES Operational Key Load -----
COMMAND ===>

Coprocessor selected for new key: X04
CKDS name: 'CSFLPAR1.SYSPLEX.CKDS'

Enter the key label

Key label
==> FREDS.MAC.KEY

Control Vector ===> YES YES or NO

. %
Figure 228. DES Operational Key Load Panel

a. In the key label field, enter the CKDS entry label for the key. The label must
match the key label specified on the key part information window on TKE
when the First key part was loaded to the key part register. Otherwise, a KEY
NOT FOUND message is displayed. See [‘Load to Key Part Register - First” on|

b. In the control vector field enter YES or NO. This field only applies if the key
being loaded is a standard CV importer or exporter key. If it is and you
specify NO, ICSF will not exclusive-or a control vector with the key before
using it. Select NO for keys that will be exchanged with a system that does
not use control vectors. The default is YES.

If a record already exists in the CKDS with a label that matches the key label
specified, the DES Operational Key Load panel appears alerting you that CKDS
RECORD EXISTS. If you want to replace the existing key with the new key you are
trying to load, press ENTER. Unlike the CCF, partial and complete keys can be
replaced on the PCIXCC/CEX2C.

/’ N\
CSFCMP51 -----o-ommo o ICSF DES Operational Key Load -------------
COMMAND ===>
A record with the following specifications has been found in the CKDS:
Key Tabel : MY.EXISTING.LABEL.EXPORTER
Key type : EXPORTER
- J

Figure 229. DES Operational Key Load Panel

When the key has been successfully loaded the ENC-ZERO value of the key and
the control vector are displayed for the user.
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s
CSFCMP50 ------------ ICSF DES Operational Key Load ----- KEY LOAD COMPLETE
COMMAND ===>

Coprocessor selected for new key: X04
CKDS name: 'CSFLPAR1.SYSPLEX.CKDS'

Enter the key label

Key Tlabel
==> FREDS.MAC.KEY

Control Vector ===> YES YES or NO
ENC-ZERO VP: 01234567

Control vector: 00054D0003410000 00054D0003210000

- J
Figure 230. DES Operational Key Load Panel - ENC-ZERO and CV values displayed

Refreshing the CKDS

At any time without disrupting cryptographic functions, you can refresh the

in-storage CKDS with an updated or different disk copy of the CKDS by following

the steps below.

1. Enter option 2, Master Key, on the ICSF Primary Menu to access the Master
Key process panel. Enter option 1, INIT/REFRESH CKDS to access the

Initialize a CKDS panel, which is shown in |Figure 231

4 N
CSFCKD10 --------=mmmmm - ICSF - Initialize a CKDS ----=---=-mmumu-
COMMAND ===> 2
Enter the number of the desired option.
1 Initialize an empty CKDS (creates the header and system keys)
2 REFRESH - Activate an updated CKDS
Enter the name of the CKDS below.
CKDS ===> 'FIRST.EMPTY.CKDS' )

Figure 231. ICSF Initialize a CKDS Panel

2. In the CKDS field, specify the name of the disk copy of the CKDS that you want
ICSF to read into storage.

3. Choose option 2, REFRESH, and press ENTER.
ICSF places the disk copy of the specified CKDS into storage. Partial keys that
may exist when you enter keys manually are not loaded into storage during a

REFRESH. Applications running on ICSF are not disrupted. A message stating
that the CKDS was refreshed appears on the right of the top line on the panel.

After the CKDS is read into storage, ICSF performs a MAC verification on each
record in the CKDS. If a record fails the MAC verification, a message giving the
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key label and type for that record is sent to the MVS security console. You can
then delete the record from the CKDS using KGUP or the dynamic CKDS
update services. Any other attempts to access a record that has failed MAC
verification results in an invalid MAC return code and reason code.

4. Press END to return to the Primary Menu panel.

Installing RSA Keys in the PKDS from a Data Set

If you used TKE to load an RSA key into a host data set member on MVS (see
[‘Loading Operational Keys to the CKDS” on page 199), you load it from the data
set to the PKDS by this method.

1. Select Option 7, TKE, on the ICSF Primary Option Menu.

/' N\
CSFEPRIM ----=--ommemm- Integrated Cryptographic Service Facility ---------
OPTION ===> 7
Enter the number of the desired option.

1 COPROCESSOR MGMT - Management of Cryptographic Coprocessors

2 MASTER KEY - Master key set or change, CKDS/PKDS processing
3 OPSTAT - Installation options

4 ADMINCNTL - Administrative Control Functions

5 UTILITY - ICSF Utilities

6 PPINIT - Pass Phrase Master Key/CKDS Initialization

7 TKE - TKE Master and Operational key processing

8 KGUP - Key Generator Utility processes

9 9 UDX MGMT - Management of User Defined Extensions )

Figure 232. Selecting the TKE Option on the ICSF Primary Menu Panel

2. The TKE Processing Selection panel appears. Select option 3.

e . . N
CSFOPKOO ==-=====--eemenaa ICSF - TKE Processing Selection -------------

OPTION ===> 3
Enter the number of the desired option.
1 DES Master key entry
2 DES Operational key entry
3 PKA key entry
- J

Figure 233. Selecting PKA Key entry on the TKE Processing Selection Panel

3. On the ICSF PKA Direct Key Load panel, enter the name of the pre-allocated
partitioned data set and the member name of the RSA key to be loaded into the
PKDS.
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/'CSFTPLOO -------------- ICSF - PKA Direct Key Load ~ =---------------
Enter the data set name and the key specifications.
Key Data Set
Name ====> 's09.pkds(rsakeyl)"'

Press ENTER to select the data set and the key.
Press END to exit to the previous menu.

Figure 234. PKA Direct Key Load

If the RSA key is loaded successfully into the PKDS, a LOAD COMPLETED
message is displayed in the upper right corner. If an error occurs during the load
process, an applicable error message is displayed in the upper right corner with
detailed error information displayed in the middle of the display for selected errors.
You may also press the PF1 key for more information.
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Appendix A. TKE Workstation Setup and Customization

This appendix describes several tasks that are necessary preparation for operating
your TKE workstation.

Installation

The IBM CE will install the TKE cryptographic adapter into your TKE workstation
and then power it up.

IMPORTANT: For reliable TKE operation, the customer needs to ensure an
installation area ambient temperature in the range of 10 degrees Celsius to 40
degrees Celsius, plus or minus 5 degrees Celsius.

For TKE storage, the customer needs to ensure an installation area ambient
temperature in the range of 1 degree Celsius to 60 degrees Celsius, plus or minus
5 degrees Celsius. In addition, the ambient relative humidity must not exceed 80
percent.

Configuring TCP/IP

The TKE Administrator must configure the TKE workstation for TCP/IP. TCP/IP is
configured through the Customize Network Settings task.

Customize Network Settings
In the left frame of the Trusted Key Entry Console, click on System Management,

and then Configuration. In the right frame of the Trusted Key Entry Console, click
on Customize Network Settings.

TEE: Customlze MNaetworlk

gf Customize Metwork Settings

Identification LAH Adapters Hame Semvices Rovting

IUse the following information to identify your console on the
=1 network. Specify host name, domain name, and a short
description of this computer.

Console name: TKE

Domain narme: Inok.ibm.com
Console description: [TKE 5.0 Workstation

2k | Cancel | Help |

Figure 235. Customize Network Settings - Identification Tab

By Default, the Console name is TKE. It is displayed in the title bar of all the
window displays. Enter the domain name for your network and a brief description
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for the workstation. If you do not have any further updates to make, click OK. To
continue with updates to your network settings, click on the Lan Adapters Tab.

Identificakion LAH Rdapters Hame Senites

Ethernet ethD 00:00:60:84:9F ;32 |!

Details... |

I, | Cancel | Help |

Figure 236. Customize Network Settings Lan Adapters Tab

With the Ethernet LAN adapter highlighted, click on Details.
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g:f LAN Adapter Details

LAH Adapter

Local Area Network frforrafion

LAMN interface address: 00:0D:E0:E4:9F 32 ethO

Media Speed (ethernet)

| Autodetection R

DHCP Client P Adklress

& Obtain an IP address automatically
" Specify an |P address

TCP/AP interface address: |9.56.53.194
TCP/IP interface network mask: |755,255,255.0

oK || cancel || Help |

Figure 237. Local Area Network

Specify Local Area Network Information and DHCP Client/IP address information for
your network. Press the OK button. If you do not have any further updates to make,
click OK on the Customize Network Settings Window. To continue with updates to

your network settings, click on the Name Services tab.
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TEER:

E;f Customize Network Settings

LAN Adapters Hame Sewices

ONE Cornenalion
¥ DM enabled
ONE Server Searclr (rder

ﬁdd|
Hemnue|

fxnpair Soffix Searclr hrfer

ﬁdd|
Hemnue|

K, Cancel | Help |

Figure 238. Customize Network Settings - Name Services Tab

Select whether DNS is enabled or disabled. Configure the DNS Server Search
Order and the Domain Suffix Search Order for your network. If you do not have any
further updates to make, click OK. If Routing information is required for your
network, click on the Routing tab and configure as appropriate. When complete,
click OK to save all updates to your network settings.

Problems associated with networking can be diagnosed with the Network Diagnostic

Information task. To open this task select System Management, Service
Applications, Network Diagnostic Information.
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If you are having problems connecting to a host system, test the TCP/IP connection
by pinging the address. Enter the host address in the TCP/IP Address to Ping field
and click on Ping.

J(T  Interfaces | Address | Rowtes | ARP | Sockets | TCP | UDP n

TCPAP Address o Fing

*19.56.53.167

'}

Ping

" Cancel | Help |

Figure 239. Network Diagnostic Information Task

Initializing the TKE cryptographic adapter

The cryptographic adapter in the TKE workstation needs to be initialized before it
can be used for cryptographic functions.

You need to decide whether to use passphrase or smart card authentication. For
simplicity, we recommend that you do not use a mix of authentication methods.

First, set the clock on your TKE workstation. See [‘Setting the Clock.’|

Next, initialize the TKE cryptographic adapter using TKE’s IBM Crypto Adapter
Initialization and Cryptographic Node Management Utility 3.10SC.

« If you are initializing using passphrase, see [‘Initializing TKE for passphrase” on|
o If iou are initializing using smart cards, see [Initializing TKE for smart cards” on|

Setting the Clock

To set the system clock on your workstation, open the Customize Console
Date/Time task under System Management, Configuration.

Changing the clock to Local or UTC

Local
Sets the time to the current time of the time zone that you selected.

uTC
Sets the time to the Greenwich Mean Time (GMT) regardless of what time zone
you have chosen.
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A time is required for your local system operation. Enter in either the local time or
the UTC time.

Setting the assigned time for your system

Specify the new time using the same format as shown in the Time field. For
example,

09:35:00 AM
Setting the assigned date for your system

Specify the new date using the same format as shown in the Date field. For
example,

September 10, 2005

If you have chosen the Local clock choose a city from the list that has the same
time as the one you need. Press the Customize button when finished.

TEE: Customize Console Dat T

. Customize Console Date and Time

Battery operated Trusted Key Entry clock

Clock: I | acal j

Time: *1 3508 PM
Date: *May b, 2005
Time zone: | <notintialized> -

Customize | Refresh | Cancel | Help |

Figure 240. Customize Console Date and Time Window

Initializing TKE for passphrase

210

To initialize the TKE crypto adapter, click on Trusted Key Entry and then
Applications. Under Applications, click on TKE’s IBM Crypto Adapter Initialization.
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czuloni.ah | = Q KI

Warniing! The following task will intialize your cryptographic coprocessor,
All modifications to the cryptographic coprocessor will be lost,
Would you like to continue? (/M) [default=N]

Figure 241. Crypto Adapter Initialization 1 Window

A warning will remind you that this operation will initialize your Cryptographic
Coprocessor and all modifications will be lost. Select Y if you would like to continue

Select P for Passphrase.

czulenl.sh bl
Warniing! The following task will intialize your cryptographic coprocesszor,
All modifications to the cryptographic coproceszor will be lost,
Mould you like to continue? (Y/M) [default=NM]
Y
Would you like to prepare your cryptographic coprocessor for Smart Card or Paszs
F'}ir*ase uze? (5/F) [default=F]
Fl

Figure 242. Crypto Adapter Initialization 2 Window
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The TKE Crypto adapter is initialized with the roles and profiles required for the
passphrase environment. The time on the workstation and crypto adapter are
synchronized. The crypto adapter master key is set and DES and PKA key storages
are initialized.

cguleni . sh — | =

— ]

Would you like to prepare your cryptographic coprocessor for Smart Card or Pass
Phraze usze? (5/P) [default=F]
F

The cryptographic coprocessor will be prepared for Pasz Phrasze usze,

Initialization Output

Cryptographic facility initialized.

Time suynchronized with host

Created user role DEFAULT

Created user role TKEADM

Created user role EEYHANL

Created user role EEYHANZ

Created user role TREUSER

Created user profile TEEADM

Created user profile KEYMANL

Created user profile KEYMANZ

Created user profile TKEUSER

Master key set,

DIES key Storage initialized uzing desstore.dat
PEA key Storage initialized uzing pkastore.dat
Created user role DEFAULT

Press <Enter® to exit.

Figure 243. Crypto Adapter Initialization 3 Window
When complete, press Enter to exit the task.

Access Control Administration
Open the CNM Utility. You can find this task under Trusted Key Entry, Applications.
Click Cryptographic Node Management Utility 3.10SC to open the task.

The Cryptographic Node Management Utility is opened. The CNM utility provides a
graphical user interface to use in administering access control and managing CCA
master keys on the cryptographic adapter in the TKE workstation.
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I o Lty =X
M Crypto Node Master Key Keys Key Storage Access Control Smart Card  Help
" Passphrase Legon..
Smart Card Logon...
Group Logon...
Logoff
CHMI Editar
© Enable Smart Card Readers
Exit

Figure 244. Cryptographic Node Management Utility

The TKE administrator must logon to the crypto node. Click on File and then
choose Passphrase Logon... from the drop down menu.

&4 Passphrase Logon
User ID ITKEADM

Imm

Passphrase

| Legen I| Cancell | Help I

Figure 245. Passphrase logon

The Passphrase Logon window is opened. The user ID (TKEADM) and Pass
phrase (TKEADM) are set up for the TKE administrator. They are case sensitive
(and must be entered in upper case). Select Logon.

Once successfully logged on, change the passphrase for the TKEADM profile. You
may also change the Passphrase Expiration Date and the profile’s Activation and
Expiration dates. Refer to [‘Edit a User Profile loaded in the TKE Crypto Adapter” on|
for instructions on editing a coprocessor-stored user profile. The
passphrase is case sensitive. If you save this profile to disk, remember to back up
the file to diskette.

Warning: If the file is saved to floppy you must deactivate the floppy drive before
removing the diskette. If the diskette is removed prior to deactivating the drive data
could be lost or corrupted. For details on deactivating media see [‘Managing Media’]

on page 393.

At this time, you should also change the passphrase for the other predefined
profiles. You may want to define other profiles for the predefined roles. The access
control points for each of the predefined roles are listed in [‘Access Control Points|
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ffor Roles” on page 215 Refer to[‘Define a User Profile” on page 247| for
instructions on defining a user profile. Backup your profiles to diskette.

Warning: If saving files to diskette, deactivate the floppy drive before removing the
diskette or data could be lost or corrupted. See [‘Managing Media” on page 393| for
details.

Group Logon: Group Logon is supported with TKE V4.2 and higher. Group logon
allows multiple users to co-sign a logon to the TKE cryptographic adapter. If you
decide to use group logon, you need to define additional user profiles at this time.
See [‘Define a User Profile” on page 247 You then need to define a group profile
and assign the user profiles to the group profile (see [‘Define a Group Profile” on|
|§a§e 252

Note: The group role overrides the role assigned to the individual profiles. When
defining profiles, we recommend that the DEFAULT role be mapped to each
of the user profiles to limit the functions that the user can perform outside of
the group. The group profile should be mapped to role TKEADM or
TKEUSER.

The TKEADM user ID can now logoff the crypto node. Click on File and then
choose Logoff from the drop down menu.

Load First Key Part
If using passphrase logon, see [‘Passphrase Logon” on page 234 If using group
logon, see [‘Group Logon” on page 235 |

Logon to the crypto node as KEYMAN1.The master keys should be changed.
Follow the directions in[‘Loading a new master key from clear key parts” on page]
for instructions on how to load a new master key from parts. After the first key
part is successfully loaded, this user must logoff the crypto node. Backup any key
files to a diskette.

Warning: If the file is saved to floppy you must deactivate the floppy drive before
removing the diskette. If the diskette is removed prior to deactivating the drive data
could be lost or corrupted. For details on deactivating media see [‘Managing Media’|

on page 393.

Load Last Key Part
If using passphrase logon, see [‘Passphrase Logon” on page 234 If using group
logon, see [‘Group Logon” on page 235

Next, logon to the crypto node as KEYMAN2. Enter a middle key part (optional) and
a last key part. Backup as necessary. You may want to verify the master key

verification pattern before setting the master key. See [‘Verifying Master Key Parts’|
for instructions on the verification procedure.
Warning: If the file is saved to floppy you must deactivate the floppy drive before

removing the diskette. If the diskette is removed prior to deactivating the drive data
could be lost or corrupted. For details on deactivating media see [‘Managing Media’]

on page 393.

KEYMAN?2 sets the Master Key.

KEYMAN2 now re-enciphers DES and PKA key storage.
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KEYMAN2 can now logoff the crypto node.

Access Control Points for Roles
The following tables provide the access control points and related functions for the
predefined roles.

Profiles using the TKEUSER Role are for TKE authorities and 4753 Migration Utility
users.

Table 6. TKEUSER Role

Function Access Control Point
Clear Diffie-Hellman Key values X'0252'
Combine Diffie-Hellman Key part X'0251"
Combine Key Part X'001C'
Compute Verification Pattern X'001D'
Decipher X'000F'
Digital Signature Generate X'0100'
Digital Signature Verify X'0101"
Encipher X'000E!
Export Card Device Certificate X'02A9'
Generate Key X'008E!
Generate Key Set X'008C'
Load Diffie-Hellman Key mod/gen X'0250'
Load First Key Part X'001B'
Load Roles and Profiles X'0116'
PKA Clear Key Generate X'0205'
PKA Clone Key Generate X'0204'
PKA Key Generate X'0103'
PKA Key Import X'0104
Process cleartext ICSF key parts X'02A0'
Process enciphered ICSF key parts X'02A1"
RNX access control point X'02A2'
Reencipher from Master Key X'0013'
Reencipher to Master Key X'0012'
Session Key Master X'02A3'
Session Key Slave X'02A4'
TKE USER X'8002'
Unrestrict Combine Key Parts X'027A'

Profiles using the TKE Administration role allow the user to perform security
administration for the TKE workstation. They are able to create, change and delete
roles and profiles.

Table 7. TKEADM Role
Function Access Control Point
Change Authentication Data X'0114
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Table 7. TKEADM Role (continued)

Function Access Control Point
Change Profile Expiration Date X'0113'
Clear FCV X'011A
Compute Verification Pattern X'001D'
Delete Role X'0118'
Delete User Profile X'0117'
Initialize Access Control X'0112'
Load FCV X'0119'
Load Roles and Profiles X'0116'
One-Way Hash SHA-1 X'0107'
Reinitialize Device X'0111'
Reset Battery Low Indicator X'030B"
Reset Intrusion Latch X'010F'
Reset Logon Failure Count X'0115'
Set clock X'0110'

Profiles using the TKE Key Manager 1 role allow the user to clear the TKE Crypto
Adapter new master key register and load first master key parts.

Table 8. KEYMANT Role

Function Access Control Point
Clear New Master Key Register X'0032'
Compute Verification Pattern X'001D'
Generate Key X'008E!
Load Roles and Profiles X'0116'
Load first Master Key Part X'0018'

Profiles using the TKE Key Manager 2 role allow the user to load middle and last
master key parts, to set the master key, and to re-encipher workstation key storage.

Table 9. KEYMANZ2 Role

Function Access Control Point
Combine Master Key Parts X'0019'
Compute Verification Pattern X'001D'
Generate Key X'008E!
Load Roles and Profiles X'0116'
PKA Key Token Change X'0102'
Reencipher to Current Master Key X'0090'
Set Master Key X'001A'

The DEFAULT role allows any user to view public role and profile information. It
also allows re-initialization of the TKE Crypto Adapter.
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Table 10. DEFAULT Role

Function Access Control Point
Compute Verification Pattern X'001D'
Export Card Device Certificate X'02A9'
Load Roles and Profiles X'0116'
Reinitialize Device X'0111'

Initializing TKE for smart cards

Enable Smart Card Readers in CNM

Click on Trusted Key Entry, Applications, and click on Cryptographic Node
Management Utility 3.10SC. When the application is opened, click on the File
dropdown, and click on Enable Smart Card Readers. Close the application.

Steps to initialize the TKE Crypto Adapter for smart card support

1. To initialize the TKE crypto adapter, click on Trusted Key Entry and then
Applications. Under Applications, click on TKE’s IBM Crypto Adapter
Initialization.

| ceulenien [N

Warning! The following taszk will initialize your cryptographic coprocessor,
All modifications to the cryptographic coprocessor will be lost,
%n:luld you like to continue? (Y¥/N) [default=N]

Figure 246. Crypto Adapter Initialization Confirmation Window

A warning will remind you that this operation will initialize your Cryptographic
Coprocessor and all modifications will be lost. Select Y if you would like to
continue.
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| csuleni.sh

Warning! The following task will initialize your cryptographic coprocessor,
All modifications to the cryptographic coprocessor will be lost,

Would you like to comtinue? CYAN) [default=N]

Y

Would you like to prepare your cryptographic coprocezzor for Smart Card or Pazs
ihrase use? (S5/P) [default=P]

Figure 247. Crypto Adapter Initialization - Smart Card or Passphrase

Select S for Smart Card.

The TKE Crypto adapter is initialized with the roles and profiles required for the
smart card environment. The time on the workstation and crypto adapter are
synchronized. The crypto adapter master key is set and DES and PKA key
storages are initialized.

218 z/0S V1R8.0 ICSF TKE PCIX Workstation User's Guide




| csulenisn  [HENY

Warning! The following taszk will initialize your cruptographic coprocessor,
All modifications to the cryptographic coprocessor will be lost,
Would you like to continwe? (YAN) [default=N]

=
Would you like to prepare your cryptographic coprocezsor for Smart Card or Paszs
Phraze use? (5/P) [default=F]

=
The cruptographic coprocessor will be prepared for Smart Card use,

Initialization Output

Cryptographic facility initialized,

Time synchronized with host

Created uzer role DEFALLT

Created uzer role SCTKEADM

Created uzer role SCTKELSE

Created uzer role MIGUSER

Created uzer profile MIGUSER

Haster key set,

DES Key Storage initialized uzing desstore,dat
PKA key Storage initialized using pkastore,dat
Fresz <Enter> to exit,

Figure 248. Crypto Adapter Initialization for smart card complete

When complete, press Enter to exit the task.
2. SCUP initialization tasks
a. Initialize and personalize a CA smart card.
(see [Initialize and personalize the CA smart card” on page 279)
b. Backup CA smart card.
(see [‘Backup a CA smart card” on page 281)

c. Enroll local TKE cryptographic adapter. Enroll remote TKE cryptographic
adapter if applicable.

(see [‘Enroll a TKE cryptographic adapter” on page 287)
d. Initialize and enroll TKE smart cards.
(see [Initialize and enroll a TKE smart card” on page 284)
e. Personalize TKE smart cards.
(see [‘Personalize a TKE smart card” on page 285)
Close the SCUP application.
3. CNM initialization tasks (Appendix C)

a. Generate Crypto Adapter logon keys to TKE smart cards that will be used to
logon to the TKE cryptographic adapter.

(see [‘Generate TKE Crypto Adapter logon key” on page 267.)

b. Define user profiles for the TKE smart cards which have a Crypto Adapter
logon key.

(see [‘Define a User Profile” on page 247.)

c. Define a group profile (optional). Empty group profiles SCTKEADM and
SCTKEUSR are provided. A group may contain 1 to 10 members.

(see [‘Define a Group Profile” on page 252.)
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d.

-

k.

Reset the DEFAULT role. Your TKE workstation is not secure until you
replace the TEMPDEFAULT role with the regular DEFAULT role. See
for edit a disk-stored role” on page 242

Logon to the TKE Crypto Adapter using a TKE smart card profile or a smart
card group profile.

(see[‘Smart Card Logon” on page 234| or[*Smart Card Group Logon” on|

|page 237.|D

Generate a TKE Crypto Adapter first key part to a TKE smart card.
(see [‘Generating master key parts to a TKE smart card” on page 259.)
Load the first key part to the new master key register.

(see ['Loading master key parts from a TKE smart card” on page 260.)

Generating and loading the first and last key parts should be performed by
two individuals to set up a dual control security policy. Remove the TKE
smart card of individual A and insert a TKE smart card from individual B. We
recommend a dual control security policy for key parts. Generate a TKE
Crypto Adapter last key part to the TKE smart card.

Load the last key part to the new master key register. Verify the verification
pattern and save it to disk for future reference.

(see [‘Verifying Master Key Parts” on page 262.)
Set the master key.

Reencipher DES/PKA key storage.

(see ['‘Reenciphering key storage” on page 264.)

Access Control Points for Roles
The following tables provide the access control points and related functions for the
predefined roles.

Profiles using the SCTKEUSR Role are for TKE authorities.
Table 11. SCTKEUSR Role

Function Access Control Point
Clear Diffie-Hellman Key values X'0252'
Combine Diffie-Hellman Key part X'0251"
Combine Key Part X'001C'
Compute Verification Pattern X'001D'
Decipher X'000F'
Digital Signature Generate X'0100'
Digital Signature Verify X'0101"
Encipher X'000E'
Export Card Device Certificate X'02A9'
Generate Key X'008E!
Generate Key Set X'008C'
Load Diffie-Hellman Key mod/gen X'0250'
Load First Key Part X'001B"
Load Roles and Profiles X'0116'
One-Way Hash SHA-1 X'0107'
PKA Clear Key Generate X'0205'
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Table 11. SCTKEUSR Role (continued)

Function

Access Control Point

PKA Clone Key Generate X'0204"
PKA Key Generate X'0103'
PKA Key Import X'0104'
Process cleartext ICSF key parts X'02A0'
Process enciphered ICSF key parts X'02A1"
RNX access control point X'02A2'
Reencipher from Master Key X'0013'
Reencipher to Master Key X'0012'
Session Key Master X'02A3'
Session Key Slave X'02A4
Unrestrict Combine Key Parts X'027A'
TKE USER X'8002'

Profiles using the TKE Administration role allow the user to perform security
administration for the TKE workstation. They are able to create, change and delete

roles and profiles.

Table 12. SCTKEADM Role

Function Access Control Point
Change Authentication Data X'0114'
Change Profile Expiration Date X'0113'
Clear FCV X'011A'
Clear New Master Key Register X'0032'
Combine Master Key Parts X'0019'
Compute Verification Pattern X'001D'
Delete Role X'0118'
Delete User Profile X'0117'
Initialize Access Control X'0112'
Load FCV X'0119'
Load Roles and Profiles X'0116'
Load first Master Key Part X'0018'
Master Key Extended X'02A7
One-Way Hash SHA-1 X'0107'
PKA Key Token Change X'0102'
RNX access control point X'02A2'
Reencipher to Current Master Key X'0090
Reinitialize Device X'0111'
Reset Battery Low Indicator X'030B"
Reset Intrusion Latch X'010F'
Reset Logon Failure Count X'0115'
Session Key Master X'02A3'

Appendix A.

TKE Workstation Setup and Customization

221




Table 12. SCTKEADM Role (continued)

Function

Access Control Point

Session Key Slave

X'02A4'

Set Master Key X'001A'
Set clock X'0110'
Unrestrict Combine Key Parts X'027A'

The DEFAULT role allows any user to view public role and profile information. It

also allows re-initialization of the TKE Crypto Adapter.

Table 13. DEFAULT Role

Function

Access Control Point

Compute Verification Pattern

X'001D'

Export Card Device Certificate X'02A9'
Load Roles and Profiles X'0116'
Reinitialize Device X'0111"

Profiles using the MIGUSER Role are for 4753 Migration Utility users.

Table 14. MIGUSER Role

Function

Access Control Point

Clear Diffie-Hellman Key values

X'0252'

Combine Diffie-Hellman Key part X'0251"
Combine Key Part X'001C'
Compute Verification Pattern X'001D'
Decipher X'000F'
Digital Signature Generate X'0100'
Digital Signature Verify X'0101"
Encipher X'000E!
Export Card Device Certificate X'02A9'
Generate Key X'008E!
Generate Key Set X'008C'
Load Diffie-Hellman Key mod/gen X'0250'
Load First Key Part X'001B'
Load Roles and Profiles X'0116'
PKA Clear Key Generate X'0205'
PKA Clone Key Generate X'0204"'
PKA Key Generate X'0103'
PKA Key Import X'0104'
Process cleartext ICSF key parts X'02A0'
Process enciphered ICSF key parts X'02A1"
RNX access control point X'02A2'
Reencipher from Master Key X'0013'
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Table 14. MIGUSER Role (continued)

Function

Access Control Point

Reencipher to Master Key

X'0012'

Session Key Master X'02A3'
Session Key Slave X'02A4'
Unrestrict Combine Key Parts X'027A

Customize the TKE Application

1. Open the TKE Application by clicking on Trusted Key Entry, Applications and

then clicking on Trusted Key Entry 5.0.

2. Logon to the TKE Crypto Adapter. See Workstation Logon: Passphrase or Smart

Card on ['Workstation Logon: Passphrase or Smart card” on page 42| for details.

3. Click on Preferences on the task bar.

Enable/Disable the Preferences as appropriate. See [‘TKE Customization” on|

for details.
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Appendix B. TKE TCP/IP and Host Considerations

This chapter discusses TKE TCP/IP setup and customization, host transaction
program setup, and configuring 3270 emulator sessions.

TKE TCP/IP Setup and Customization

TKE uses TCP/IP for communication between the TKE workstation and the MVS
operating system. We are assuming that you have TCP/IP already installed and
configured. Proceed with the following:

1. Update the Hosts file with your IP address.

(HOST : 9.117.59.140 : )

Figure 249. Entry Example

TKE refers to the host by IP address, not by the host name.

Note: If a domain name server (DNS) is running, then this update is
unnecessary as all hosts will be identified to the DNS.

2. Save your Hosts file and test it. If TCP/IP is started, you can test changes by
opening a command window and issuing the ping command with the name you
just added or go to the TKE 5.0 workstation and use the Ping option under the
Network Diagnostic Information task.

TCP/IP Address to Ping

*lose 53 167

Total: 0 Displayed: 0 |
Fing

Cancel | Help |

Figure 250. Example of Ping Command

You know you have a connection when you get a response from the ping
command.

3. Update your TCPIP profile to reserve a port for the TKE application.
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PORT
50003 TCP CSFTTCP s ICSF TKE Server

Figure 251. Example of Reserving a Port

The example allows use of the port by the server named CSFTTCP. The port
number must not start in column 1. TCP is the port type. CSFTTCP is the name
of the started procedure. The 50003 is added to the port section and can be
changed by the installation. The port number here has to be specified on the
workstation when connecting to the host.

Any job with jobname CSFTTCP can connect to this port.

TKE Host Transaction Program Setup

The TKE Host Transaction Program (TKE HTP) is the host-based part of Trusted
Key Entry. It forms the interface between the TKE workstation and the crypto
modules.

The TKE HTP (server) needs to be started before a TKE workstation (client) can
communicate with the host crypto modules. The TKE HTP consists of a started
procedure (CSFTTCP) which passes some start-up parameters to a REXX clist
(CSFTHTP3). The clist then calls a module (CSFTTKE) that does RACF
authorization checking to make sure that no unauthorized clients get to the TKE
HTP server.

In order to run the new TKE Host Transaction program, the CSFTTKE module must
be added to the authorized command list in IKUITSOxx on the system where the
TKE HTP server will be started.

Perform the following steps to install the server:

1. Update the authorized commands list in the TSO commands and programs
member, IKITSOxx, in the SYS1.PARMLIB data set.

4 N\
AUTHCMD NAMES ( /* AUTHORIZED COMMANDS =/ +
COMMAND1 /* */ +
COMMAND2 /* */ +
COMMAND3 /* */ +
. +
+
. +
CSFTTKE /* AUTHORIZE TKE */ +
. +
+
. +

- J

Figure 252. Format of AUTHCMD

2. Set up system security

To protect module CSFTTKE from unauthorized users, you must protect it using
RACF. For more information, refer to [z/0S Security Server RACF Security|
Administrator’s Guidd and [z/0S Security Server RACF System Programmer’s,

Guidglr
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See |z/0S Security Server RACF Command Language Reference for the correct
command syntax. You may need to work with your system programmer, since
these RACF commands are not available to the general user.

The following example permits the userid or group assigned to the CSFTTCP
started task to the CSFTTKE profile in the FACILITY class:

SETR CLASSACT (FACILITY)

SETR RACLIST(FACILITY)

RDEFINE FACILITY CSFTTKE UACC(NONE)

PERMIT CSFTTKE CLASS(FACILITY) ID(userid or group) ACCESS(READ)
SETROPTS RACLIST(FACILITY) REFRESH

Figure 253. Assign a Userid to CSFTTKE in FACILITY Class

The module (CSFTTKE) must also be protected, using the APPL class to control
which users can use the application when they enter the system.

The following example assigns a userid or group to the CSFTTKE profile in the
APPL class:

SETR CLASSACT (APPL)

SETR RACLIST(APPL)

RDEFINE APPL CSFTTKE UACC(NONE)

PERMIT CSFTTKE CLASS(APPL) ID(userid or group) ACCESS(READ)
SETROPTS RACLIST(APPL) REFRESH

Figure 254. Assign a Userid to CSFTTKE in APPL Class

Note: The userids or groups of userids must be permitted to use the TKE
workstation.

If you do not have a generic userid associated to all started procedures, you
can associate a userid to the CSFTTCP proc by issuing a RACF RDEFINE
command. For more information, see [z/0S Security Server RACF Security|
[Administrator’'s Guidd

Note: The RACF userid associated with the CSFTTCP proc must have a valid
OMVS segment.

The following example assigns a userid or group to the started task CSFTTCP:

SETR CLASSACT (STARTED)

SETR RACLIST(STARTED)

RDEFINE STARTED CSFTTCP.CSFTTCP STDATA(USER(userid))
SETROPTS RACLIST(STARTED) REFRESH

Figure 255. Assign a Userid to a Started Task

3. The TKE Host Transaction program must be started before you can logon to the
host from TKE. A sample startup procedure is shipped in
CSF.SAMPLIB(CSFTTCP) and included here. Copy this procedure to your
proclib data set and customize it for your installation.
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/}/CSFTTCP PROC LEVEL=CSF,MEMBER=CSFTHTP3, A
// CPARM="PORT;1000;SET DISPLAY LEVEL;TRACE ALL'
//CLIST EXEC PGM= IKJEFTO1,
// PARM="EX ''&LEVEL..SCSFCLIO(&MEMBER)'' ''&CPARM'' EXEC'
//STEPLIB DD DSN=EZA.SEZALINK,DISP=SHR
//SYSABEND DD SYSOUT=*
//SYSPRINT DD SYSOUT=+
//SYSEXEC DD DSN=&LEVEL..SCSFCLIO,DISP=SHR
//SYSPROC ~ DD DSN=&LEVEL..SCSFCLIO,DISP=SHR
//SYSTSPRT DD SYSQUT=*
//SYSTSIN DD DUMMY
//TKEPARMS DD DSN=&LEVEL..SAMPLIB(CSFTPRM),DISP=SHR
//*
//* customize the DSN to be the TCP/IP data set on your system
/1%
//*SYSTCPD DD DSN=TCPIP.SEZAINST(TCPDATA),DISP=SHR
// PEND CSFTTCP
R e e e e o o o = ===
o %

Figure 256. Sample Startup Procedure

TKE Startup Parameters

Note: If upgrading from a legacy machine to a z990, z890, or z9-109 and
upgrading to TKE 5.0, you must either delete or rename the existing
TKECM dataset. The current TKE V3.0, V3.1, V4.0, V4.1, and V4.2
TKECM dataset is not compatible with a z990, z890, or z9-109 system
TKECM dataset.

Startup parameters may be passed to the TKE Host Transaction Program in a

JCL parm field (CPARM) or in a data set referenced in the TKEPARMS DD

statement. Parameters specified on the CPARM field override the parameters in

the TKEPARMS data set. A sample TKEPARMS data set is shipped in

CSF.SAMPLIB(CSFTPRM).

The following parameters are allowed:
« SET THE TKE DATA SETS;CM data set name

The CM data set will contain the crypto module descriptions, domain
descriptions, and authority information for a host. If the data set name does
not exist, TKE will automatically create it on the host the first time you send
updates to it. If you do not specify a CM data set name, TKE uses a default
data set name of 'smfid. TKECM'.

Note: A fully qualified data set name may not be specified on the CPARM
field. Use the TKEPARMS to set the fully qualified TKECM data set
name.

Here are some examples:
— Example 1: SET THE TKE DATA SETS;TKECM

TKE will use data set name 'generic_id. TKECM'. The generic_id is the
userid assigned to the STARTED class for this proc.

— Example 2: SET THE TKE DATA SETS; TKEV3.TKECM'
TKE will use data set name "TKEV3.TKECM'.
e SET DISPLAY LEVEL;trace level

This parameter sets the amount of trace information that is written to the job
log of the started proc. The valid options are:

— TRANSACTION TRACE - Logs HTP input and output transaction data
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— TRACE ALL - logs all HTP activities, including all TCP/IP verb return
codes and information, input and output transaction data, and ICSF input
and output data

— TRACE NON-ZERO - Logs TCP/IP verbs with non-zero return codes only
(this is the default if display level is not specified

* PORT;port number

This parameter defines the TCP/IP application port number that the started
proc will use. This port number should be reserved in your TCP/IP profile for
CSFTTCP to prevent other applications from using this port. This port number
must be specified at the TKE workstation when defining a host (see
[TCP/IP Setup and Customization” on page 225).

If a port number is not specified, a default port of 50003 will be used.
However, if port 50003 is not reserved in your TCP/IP profile, another
application may use it and the TKE HTP will fail.

For example: PORT;1000

SYSTCPD is optional but, depending on your TCP/IP installation, may be
needed.

In previous versions of TCP/IP, almost all configuration data sets were implicitly
allocated. Starting with TCP/IP Version 3 Release 2, you may choose between
implicit and explicit allocation.

* Implicit - The name of the configuration data set is constructed at run time,
based on rules implemented in the components of TCP/IP. Once a data set
name is constructed, TCP/IP uses the dynamic allocation services of MVS to
allocate the configuration data set.

« Explicit - TCP/IP searches for a specific DD name allocation for some
configuration data sets. If you allocated a DD name with a DD statement in
the JCL used to start a TCP/IP component, TCP/IP will read its configuration
data from that allocation. It will not construct a configuration data set name
for dynamic allocation.

4. Start the TKE server from the MVS System console:

CS CSFTTCP )

Figure 257. Start the TKE server

Cancel the TKE server
To cancel the TKE server:

(S CSFTCTCP )

Figure 258. Cancel the TKE server

A sample procedure CSFTCTCP is shipped in CSF.SAMPLIB(CSFTCTCP). You

must copy this procedure to your proclib data set and customize it with the port

number reserved for the TKE HTP server. If a port number is not specified, it will
default to 50003.

Note: Depending on your system setup, you may need to define the CSFTCTCP
task to the RACF STARTED class in the same manner you did for the TKE
started task CSFTTCP.

REDEFINE STARTED CSFTCTCP.CSFTCTCP STDATA(USER(userid))
SETROPTS RACLIST(STARTED) REFRESH
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Configure 3270 Emulator Sessions for TKE

An MVS session is required, on the host, for several tasks executed on TKE 5.0 to
complete. If you do not have access to the MVS system, outside of the TKE
Workstation, create access to the MVS system, on the TKE, by configuring a 3270
emulator session.

To configure a 3270 emulator session, click System Management, Configuration,
and then click Configure 3270 Emulators.

TEE: Configure 32%0 Emulators

‘ Configure 3270 Emulators

Configured 3270 Emulator Sessions
select Host Address  Start at Console Startup | Mew..

Delete

atart

d

[8].8 Cancel| Help|

Figure 259. Configure 3270 Emulators

Click on the new button to add a 3270 session.

The Add 3270 Emulator Session window is displayed.

Enter the Host Address you would like to connect to.

Select Enable or Disable from the Start at Console Startup drop down menu.

Enabled
When the console starts this session will also be started.

Disabled
When the console starts this session will not start.

PoODd
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Emulator Session

Add 3270 Emulator Session T

Specily Host Atklress aiud il Siale

Host Address Start at Console Startup
*la.56.52.125 i

[ oK || cancel | Help | :I

Figure 260. Add 3270 Emulator Session

5. To save the emulator session definition press OK.

6. On the Configure 3270 Emulators window press OK to save the session. Press
Cancel to end without saving the session.

7.0.0.1:8080 - TEEl: Configure 2270 Emula )ﬁ
Configure 3270 Emulators r
Configured 3270 Emulator Sessions
Select  Host Address Start at Console Startup
® [9.12.21.161 Enabled =
C g.12.21.162 Disabled
C 8.12.21.191 Enabled Mew..
C 8.12.21.185 Enabled Celete
o 9.1221.196 Enabled _Start |
[0]:8 | Cancel | Help |
/

Figure 261. Start or Delete a 3270 Emulator Session

7. To Start or Delete a Host Address select the Host Address from the list and
press Start or Delete.
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Appendix C. Cryptographic Node Management Utility (CNM)

The Cryptographic Node Management (CNM) utility is a Java application that
provides a graphical user interface to initialize and manage the TKE cryptographic
adapter. It is part of the IBM Cryptographic Coprocessor CCA Support Program.

This chapter describes the functions of CNM that are used for initializing and
managing the Crypto Adapter in the TKE workstation.

Note: Smart Card and Smart Card Group options within the CNM panels will onl
be available if CNM is updated to support Smart Cards. See [‘Initializing TKE|

[for smart cards” on page 217

To start CNM, go to Trusted Key Entry, Applications, and click on Cryptographic
Node Management Utility 3.10SC.

nent Utility

Figure 262. CNM main window

File Menu

From the File pull-down, you can choose to logon or logoff the TKE cryptographic
adapter.

Logon to the TKE cryptographic adapter: From the File pull-down menu, select
the type of logon:
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Figure 263. CNM main window - File pull down menu

Passphrase Logon

You will be prompted to enter a user ID and passphrase. They are both case
sensitive.

4 Passphrase Logon
TKEADM

| Loson [ Gancal | Helo

Figure 264. Passphrase logon prompt

Smart Card Logon

Follow the prompts to insert your TKE smart card into smart card reader 2 and to
enter your PIN.

Note: Smart card support must be activated in CNM before logon with a TKE smart
card is available. See step 1 in[‘Steps for smart card setup” on page 19|

&4 Ssmart Card Logon

[ [oend

Figure 265. TKE smart card prompt
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_/ Smart Card Logon

FPlease enter PIM on srmart card reader keyboard

Figure 266. PIN prompt

Group Logon
Group logon allows multiple users to cosign a logon to the TKE cryptographic
adapter. At the prompt, enter a group profile name for Group ID. Profile names are

case sensitive.

Sroup Logon

Group ID I PPCROUP

0OK| Cancel

Figure 267. Passphrase group logon - group member list

There are two types of group logon:
» Passphrase Group Logon
* Smart Card Group Logon

Passphrase Group Logon
The passphrase group logon window is displayed if a passphrase group profile
name is entered at the Group Logon prompt.
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(J] CCAHMode Management Utility - Passphrase Group Logon oz I |

File Cryptohlads Masterkey  Heys  Hey Storspe Access Contall SmertCard  Help

Group prefile PPGROUP
Authentication methed Passphrase
Group members required for logon 2
Group members ready for logon o

Group members

M
K1

TKEADH -]
ppt J
ppd
pp3
ppd

Select a group member and press the Enter Passphrase button. When the required number of users have entered their
passphrase a logonis performed.

Ll

| Enter Passphrasel | Cancell | Help |

Figure 268. Group logon prompt

» The group profile name is displayed. The authentication method is Passphrase.

Group members required for logon is the number of users that must sign the
logon before the logon is performed. To sign the logon, the selected group
member must enter his passphrase.

Group members ready for logon is the number of users that have entered their
passphrase. This counter is incremented each time a user signs the logon.

The group members are listed. Select a group member from the list and press
the Enter Passphrase button. The user is prompted for his passphrase.

&4 Enter Passphrase

User I pp2
FPassphrase ﬁ

Figure 269. Passphrase group logon - enter passphrase prompt

The list is updated indicating that the user is ready for logon. Group members

ready for logon is incremented.
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(J] CcAHMode Management Utility - Passphrase Group Logon oz I |

File Cryptalads WMasterkey  Heys Key Storege Access Coptoll Smart Card Help

Group prefile PPGROUP

Authenticatien method Fassphrase

Group members required for logon 2

Group mermbers ready for logon 1

Group members

[THEADNM ﬂ
pp1 -ready ferlegen

pp2

pp3

ppd
ET| =
Select a group member and press the Enter Passphrase button. YWhen the required number of users have entered their
passphrase alogon is perormed.

| Enter Passphrasel | Cancel I| HeIpI

Figure 270. Passphrase group logon - member is ready for logon

When Group members ready for logon equals Group members required for
logon, the logon is performed.

If the group logon is successful, Group Logon Completed will be displayed.

&4 FPassphrase Group Logon
Group Logon Completed

Figure 271. Passphrase group logon successful

If the group logon should fail (for example, a user profile has expired, an

incorrect passphrase was entered, etc.), Group members ready for logon is reset
to zero and group logon must start over.

Smart Card Group Logon

The smart card group logon window is displayed if a smart card group profile is
entered at the Group Logon prompt.
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(J] CCAHMode Management Utility - Smart Card Group Logon oz I |

File Cryptohlads Masterkey  Heys  Hey Storspe Access Contall SmertCard  Help

Group prefile SCTKEADM
Authentication methed Srart card
Group members required for logon 2

Group members ready for logon o

Group members

el ﬂ

sc2
sc3

| =
Insert a TKE smart card that helongs to a group membhber into Smart Card reader 2 and enter the PIMN at the smart card reader
keyboard. YWhen the required number of smart cards have been supplied a logon is performed.

| Read Smart Cardl | Gancel | | Help I

Figure 272. Smart card group logon window

The group profile name is displayed. The authentication method is Smart card.

Group members required for logon is the number of users that must sign the logon
before the logon is performed. To sign the logon, the group member must insert his
TKE smart card into smart card reader 2 and enter his correct PIN on the smart
card reader 2 PIN pad.

Group members ready for logon is the number of users that have signed the logon
with their TKE smart card and PIN. This counter is incremented each time a user
signs the logon.

The group members are listed. Insert the TKE smart card for a group member and
press the Read Smart Card button. The user is prompted for his PIN. If the PIN is
correct, the list is updated indicating that the user is ready for logon. Group
members ready for logon is incremented. If an incorrect PIN is entered, the user is
prompted to retry another PIN or cancel.

&4 Ssmart Card Group Logon

FIM notwalid. Do wou want to thy another PIMT

Figure 273. Smart card group logon — retry PIN prompt
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(J] CCANode Management Utility - Smart Card Group Logon oz I |

File Cryptalads WMasterkey  Heys Key Storege Access Coptoll Smart Card Help

Group prefile SCTKEADM
Authentication method Srnart card
Group members required for logon 2

Group mermbers ready for logon 1

Group members

sc1 -ready for legon ﬂ
sc2
sc3

<l e
Insert a TKE smart card that helongs to a group memhber into Smart Card reader 2 and enter the PIMN atthe smart card reader
keyboard. When the required number of smart cards have been supplied a logon is performed.

[reead simart Gard] | Gancel || Help |

Figure 274. Smart card group logon window - member is ready for logon

Note: A TKE smart card is blocked after three incorrect PIN attempts. To unblock a
PIN, you must exit from CNM and use SCUP. (Refer to [‘Unblock PIN on g
[TKE smart card” on page 286.)

When Group members ready for logon equals Group members required for logon,
the logon is performed. If the group logon is successful, Group Logon Completed
will be displayed.

&4 Ssmart Card Group Logon

Group Logon Completed

Figure 275. Smart card group logon successful

If the group logon should fail (for example, a user profile has expired), Group
members ready for logon is reset to zero and group logon must start over.

Logoff

Logoff of the TKE cryptographic adapter: From the File pull-down menu, select
Logoff.

Select Yes to confirm logoff. A successful message is displayed.

Crypto Node Menu
TKE Crypto Adapter Clock-Calendar

The TKE Crypto Adapter uses its clock-calendar to record time and date and to
prevent replay attacks in passphrase-based profile authentication.
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Note: If there is more than 5 minutes difference between the TKE crypto adapter
clock and the TKE workstation clock, the TKE crypto adapter cannot be used
by either CNM or TKE.

o CCA Mode Management Ufility = = =

Master Key  Keys Key Storage Access Contral  Smart Card  Help

Initialize. ..

Status

Authorization 5

Reset Intrusion Latch...
Reset Batteny Low Indicatar...

Set Envionmert |D
Select Adapter

Share Administration 3

Figure 276. CNM main window — Crypto Node Time sub-menu

Read Clock-Calendar
To read the TKE crypto adapter clock-calendar:

1. From the Crypto Node pull-down menu, select Time. A sub-menu is displayed.

2. From the sub-menu, select Read; the current date and time is displayed. The
time is displayed in Greenwich Mean Time (GMT).

4 Current Coprocessor Clock

Tuesday, August 17, 2004 2:40:39 P GMT

Figure 277. Current Coprocessor Clock
3. Finish the task by selecting OK.
Synchronize Clock-Calendar

To synchronize the TKE crypto adapter clock-calendar with the TKE workstation
clock:

Note: If not already logged on, logon to the crypto adapter using TKEADM or an
equivalent profile.

1. From the Crypto Node pull-down menu, select Time. A sub-menu is displayed.
2. From the sub-menu, select Set; a confirmation prompt is displayed.
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B4 Sync Time With Host

Are you sure that vou want to synchronize the real tirme clock with
the host PC%

Figure 278. Sync time with host window

3. Respond Yes to synchronize the clock-calendar with the host.
4. Finish the task by selecting OK.

Note: If the time is more than 5 minutes off, the clock on the TKE workstation
needs to be reset before the clock-calendar can be synchronized. See
Setting the Clock [‘Setting the Clock” on page 209| for details.

Access Control Menu

The access control system restricts or permits the use of commands based on roles
and user profiles. You create roles that correspond to the needs and privileges of
assigned users.

To access the privileges assigned to a role (those that are not authorized in the
default role), a user must logon to the TKE cryptographic adapter using a unique
user profile. Each user profile is associated with a role. Multiple profiles can use the
same role. The TKE Crypto Adapter authenticates logons using the passphrase or
TKE smart card and PIN associated with the profile that identifies the user.

The TKE cryptographic adapter always has at least one role, the DEFAULT role.
Use of the DEFAULT role does not require a user profile. Any user can use the
functions permitted by the DEFAULT role without logging onto or being
authenticated by the TKE Crypto Adapter.

A TKE administrator can manage roles and profiles from the CNM utility Access
Control pull-down menu.
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(J] CCAHMode Management Utility oz I |

File  Crypto Node  Master Key  Keys  Key Storage Smart Card  Hslp

Figure 279. CNM main window — Access Control menu

TKE predefined roles

A role defines permissions and other characteristics of the users assigned to that
role. The following lists are the predefined roles supplied with TKE.

For passphrase:
+ TKEUSER
+ TKEADM
+ KEYMAN1
+ KEYMAN2

For smart card:
+ SCTKEUSR
« SCTKEADM
« MIGUSER

These roles are in the CNM Data Directory. Multiple profiles can be associated with
the same role.

Additional roles are not needed for TKE.

Open or edit an existing role

242

Use the CNM uitility to:
* Open or edit a disk-stored role
» Edit a role loaded in the TKE Crypto Adapter

Open or edit a disk-stored role
Follow these steps for opening and editing a disk-stored role.
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Follow these steps when you need to reload the DEFAULT or the TEMPDEFAULT
role. The TEMPDEFAULT role has ACPs for all functions and is necessary for

enrolling TKE cryptographic adapters. It should then be reset to the DEFAULT role.
Note: You should not edit the DEFAULT or the TEMPDEFAULT role.

To open or edit a role stored on disk:

1. From the Access Control pull-down menu, select Roles; a list of currently

defined roles is displayed:

(J] CCAHode Management Utility - Role Management 7 = =
File  Cryptofads WMasterbey  Heys  KHeyStanaoe Access Contrall Smet Cand Help
Existing Reles
DEFAULT ﬂ
SCTKEADM
SCTKEUSR
MIGUSER
<1 =
| M ey I | Delete.. I| R efresh || Open. . I| Cancell | Help I

Figure 280. Role Management panel - list of roles loaded to the TKE crypto adapter for
Smart Card

2. Select Open; you are prompted to choose a file.
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Figure 281. Open a disk-stored role - choose a file

Note: All predefined roles and profiles will be in the CNM Data Directory.
3. Open a file; data is displayed in the Role Definition panel.
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I

File

+ Role ID DEF&LILT

Comment IETKE we default role

" Required authentication strength |E0
Yalid times in GMT (Start - End) IEOO:OO IEQS:SEI ]

Valid days [Fsun M Mon [ Tue Mwed [T Thu [T Fri [ 5at

Restricted Operations Permitted Qperations

000E Encipher = : 0010 Compute Yerification Pattern !
00OF Dacipher | - 0111 Reinitialize Device

0010 Generate MAC Permit All 0116 Read Public fccess-Contral Informaticl
0011 Verify MAC 0289 Export Card Device Certificate

0012 Reencipher to Master key
0013 Reencipher from Master key
0018 Load First Master Key Part
0013 Combine Master Key Parts
Q014 Set Master Key |
001B Lead First Key Part

001C Coembine Key Parts

001F Translate Key

0020 Generate Randorm Master Key

4 Restrict all
ODen...| Save...| Load| List Cancel| Help|

Figure 282. Role Definition panel - role is displayed

4. Select Load to save the new role to the TKE cryptographic adapter.
5. Role successfully loaded message appears.

Edit a role loaded in the TKE Crypto Adapter

To edit a role loaded in the TKE cryptographic adapter:

1. From the Access Control pull-down menu, select Roles; a list of currently
defined roles is displayed.

2. Highlight the role you want to edit.

3. Select Edit; data is displayed in the Role Definition panel.

4. Edit the role. The Restricted Operations column lists the access points that are
not allowed for this role. The Permitted Operations column lists the access
points that are allowed for this role. Select access point(s) from the Restricted
Operations column and press Permit to move it to the Permitted Operations
column.

We do not recommend deleting any access control points from the predefined
roles. If you do, CNM or TKE functions may fail with an access control error.

If you are migrating from previous releases of TKE to TKE V5.0, you may need
to add access control points to your roles. See [‘Migration” on page 9.
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File i iy § Help
y Role ID IITKEUSER
Comment IETKE authority

" Required authentication strength

|;50
Yalid times in GMT (Start - End) IEOO:OO |E23:SEI

Valid days [FSun FMon FTue Fwed FThu FFri [F5at

Restricted Operations Pertmitted Operaticns

0290 Generate Diversified Key (DALL with | Permit 0204 PEA Clone Key Generate k|
0291 Generate CSC-5, 4 and 2 VYalues - 0205 PKA Clear key Cenerate

0232 Werify CSC-3 Yalues Permit All 0250 Load Diffie-Hellman Key mod/gen
0293 Verify CSC-4 Yalues 0251 Combine Diffie-Hellman Key part
0294 Verify CSC-5 VYalues 0252 Clear Diffie-Hellman key values
0285 Import Card Device Certificate 0278 Unrestrict Cembine kKey Parts
0286 Import C& Public Certificate 0240 Process cleartext ICSF key parts
0ZAT Master Key Extended 0241 Process enciphered ICSF key parts
0248 Delete Device Retained Key 0242 RNX access control point

0288 Export CA& Public Certificate 0243 Session Key Master

030B Reset Battery Low Indicator 0244 Session Key Slave

030C Unrastrict Digital Signature Generat | | 0249 Export Card Device Certificate

5 Restrict All|

Open...| 5ave...| Load| List Cancel| Help|

Figure 283. Edit a role - highlight access point to permit

File B g Help
Rale ID ITKEUSER
Comment IETKE authority

Required authentication strength |E50
Valid times in GMT (Start - End) nmon |E23:59

Valid days [FSun M Mon [ Tue Fwed M Thu FFri [FSat

Restricted Operations Permitted Operations

027C Unrestrict Data kKey Import _: H 0204 PEA Clene key Gehnerate £
0290 Generate Diversified Key (DALL with 0205 PKA Clear Key Generate

0291 Generate C5C-5, 4 and 3 Yalues 0250 Load Diffie-Hellman Kay mod/gen
0292 Verify CSC-3 Yalues 0251 Cambine Diffie-Hellman Key part
0293 Verify CSC-4 Values 0252 Clear Diffie-Hellman Key values
0294 Verify CSC-5 Values 0278 Unrestrict Combine Key Parts
0285 Import Card Device Certificate 0280 Pracess cleartext ICSF key parts
0Z2AE Import CA Public Certificate 0241 Process enciphered ICSF key parts
0ZA7 Master Key Extended 0ZA2Z RNX access control paint

0288 Delete Device Retained Key 0243 Session Key Master

0ZAA Export CA Public Certificate 0244 Session Key Slave

030B Reset Battery Low Indicator - 02A9 Export Card Device Certificate
030C Unrestrict Digital Signature Cenerat J i 2002 TKE USER

] Restrict &l [=] ]

Open...| Save...| Load| List Cancel| Help|

Figure 284. Edit a role - access point is moved to Permitted Operations column

5. Select Save to save the role to disk; you will be prompted for a filename. You
may save the file to either the CNM data directory or the Floppy disk. Select
Load to load the role into the TKE cryptographic adapter.

246 z/0S V1R8.0 ICSF TKE PCIX Workstation User's Guide



Warning: If the file is saved to floppy you must deactivate the floppy drive
before removing the diskette. If the diskette is removed prior to deactivating the
drive data could be lost or corrupted. For details on deactivating media see

[‘Managing Media” on page 393.

Define a User Profile

A user profile identifies a specific user to the TKE cryptographic adapter. To define a

user profile:

1. From the Access Control pull-down menu, select Profiles. A list of existing
profiles is displayed.

File  Crypto hacle

(J] CCAHNode Management Utility - Profile Management 7 = =

Wastenbey Heys  FKey Storege Access Contrel Smant Card Help

Excisting Profiles

MIGUSER

el
sc2
SCTKEADM
SCTKEUSR

| Newl | Delete... I | R efresh I | Qpen... I | Reset FC I | Cancell | Help I

Figure 285. Profile management panel — profile list

Passphrase profiles
TKE supplies the following predefined profiles:

TKEUSER

TKEADM

KEYMAN1

KEYMAN2

associated with role TKEUSER,; use this profile for logging onto

the TKE application and performing TKE functions without smart
cards.

associated with role TKEADM; use this profile for managing the
TKE Crypto Adapter using CNM, including defining roles/profiles

associated with role KEYMANT1; use this profile to load the first
master key part to the TKE Crypto Adapter new master key
register

associated with role KEYMAN2; use this profile to load any
middle and last master key parts to the TKE Crypto Adapter

new master key register, set the master key and reencipher key
storage.

Smart card profiles
TKE supplies the following predefined profiles:

SCTKEADM

associated with role SCTKEADM. This is an empty group profile
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that can be updated to include the group members after the
group member user profiles are defined. This profile allows the
administration of the TKE Crypto Adapter using smart cards;
including generating/loading TKE Crypto Adapter master key
parts and loading roles/profiles.

SCTKEUSR  associated with role SCTKEUSR. This is an empty group profile
that can be updated to include the group members after the
group member user profiles are defined. This profile allows all
TKE application functions using smart cards.

MIGUSER associated with role MIGUSER; use this profile for logging onto
the TKE Crypto Adapter in the Migration Utility. This is a
passphrase profile required for the Migration Utility in a smart
card environment.

2. Select New to define a new user profile. A sub-menu is displayed. Select the
profile type - Passphrase, Smart Card or Group.

g4 Profile Management

Select profile type:

() Srmart card

() Group

Gentinue | | Gancel

Figure 286. Define a new profile — select profile type

Depending on your choice, see the following sections:
+ [‘Define a Passphrase Profile’|

+ [‘Define a Smart Card Profile” on page 250]

+ [‘Define a Group Profile” on page 252

Define a Passphrase Profile
1. If Passphrase is selected as the profile type, the following panel is displayed:
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(J] CCAHMode Management Utility - Profile Management oz I |

File Cryptalads WMasterkey  Heys Key Storege Access Coptoll Smart Card Help

User ID
CGomment
Activation Date

Ewxpiraticn Date

Rele

Fassphrase
Genfirm Passphrase

Fassphrase Expiraticn Date

[
IO?J’ ETIE004
IO?.‘" 2004

DEFAULT é
l— SCTKEADM
SGTKEUSR |

K1 5
|

|10f2?f2004

| Qpen. . | | Save... | | Load | | Change Passphrase | | Cancel | | Help |

Figure 287. Profile Management panel — Passphrase profile

2. Fill'in the fields on the panel:

User ID

Comment

The name of the profile. A maximum of 8 characters may be
specified. This field is case sensitive.

An optional character string. A maximum of 20 characters may
be specified.

Activation Date

Determines the first date when the user can logon. This field
defaults to the current date. Change this date as appropriate.

Expiration Date

Role

Passphrase

Determines the last date when the user can logon. This field
defaults to the current date. Change this date as appropriate.

The name of the role that defines the permissions granted to
the profile. Select a role from the list.

Note: If this user profile will be assigned to a group profile, we
recommend mapping the DEFAULT role to this user
profile. This limits the access this profile has outside of
the group.

The character string that the user must enter to logon to the
TKE cryptographic adapter. A maximum of 64 characters may
be specified. This field is case sensitive. The Passphrase and
Confirm Passphrase fields must match.

Confirm Passphrase

This field is identical to the Passphrase field above. It is case
sensitive. The Passphrase and Confirm Passphrase fields must
match.

Passphrase Expiration Date

The expiration date for the passphrase. This date will default to
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90 days from the current date. The expiration date can be
changed. Every passphrase contains an expiration date, which
defines the lifetime of that passphrase. This is different from the
expiration date of the profile itself.

[J] CCAHMode Management Utility - Profile Management 7 = =
File  Cryptoblade Masterley  Heys  Hey Stonsge Access Contrall SmertCad Help
User ID g
Corment Ipp group rmernber
Activation Date IW
Expiraticn Date IW
DEFAULT
Passphrase I*"'*
Cenfirm Passphrase I***

Passphrase Expiration Date I 10f27 2004

| Open.. I | Save. . I | Load I | Change Passphrase I | Cancel I | Help I

Figure 288. Profile Management panel — Passphrase profile fields filled in

3. Select Save to save the profile to disk.

Warning: If the file is saved to floppy you must deactivate the floppy drive
before removing the diskette. If the diskette is removed prior to deactivating the
drive data could be lost or corrupted. For details on deactivating media see
[‘Managing Media” on page 393.

4. Select Load to load the profile into the TKE Crypto Adapter.

Other actions and tasks available from this panel are:

« Select Open to work with a profile saved to disk. You will be prompted to select a
file.

» Select Change Passphrase to change the profile’s Passphrase and Passphrase
Expiration Date.

» Select List to return to the list of existing profiles.
e Select Cancel to return to the CNM main window.

Define a Smart Card Profile

1. If Smart card is selected as the profile type, you will be prompted to insert a
TKE smart card into smart card reader 2.
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&4 Profile Management

Please insett a TKE smartt card into Smart Card reader 2.

iKE | Gancel

Figure 289. Smart card profile — TKE smart card prompt

2. The TKE smart card is read and the information is displayed in the following

panel:
(J] CCAHode Management Utility - Profile Management = = =

File Cryptohads WMasterbey  Heys  HeyStonepe Access Contrall Smert Cad Help

User ID

CGomment I

Activation Date IO?.-"2?.-"2004
Expiration Date IO?.-’E?.-’2004

DEFAULT é
SCTKEADM
Rale I SGTKEUSR ~|
<1 i3

Publie modulus

EDCF933F4AN6a04De0409 289 5AZ0EREF1 7142 20F1 TEERDAFS 4ETAR 3 364824683
26189910ED20144C1196EASI89ECSEGAR 208 0CFSES6SAB0FT23FEL17 2829 EDAFE
ZFD3IE3FTIES0D74721036734R61A0S0SEIN14E0694B 03021 COBD3AREEECO042S
1ARDZOS 0D 2FESE633ES 735951562 CFe23D4R10356 2D3AN 02459202 CEDES 5471

| Open... I | Save. . I | Leoad I | Read Smart Cardl | Cancell | Help I

Figure 290. Profile management panel — smart card profile

3. Fill in the fields on the panel:

User ID The name of the profile. This field is read from the TKE smart

card and cannot be changed. The User ID is set when the

Crypto Adapter logon key is generated. (See Generate Crypto

Adapter logon key).

Comment An optional character string. A maximum of 20 characters may

be specified.

Activation Date

Determines the first date when the user can logon. This field
defaults to the current date. Change this date as appropriate.

Expiration Date

Determines the last date when the user can logon. This field

defaults to the current date. Change this date as appropriate.

Role The name of the role that defines the permissions granted to

the profile. Select a role from the list.
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Note: If this user profile will be assigned to a group profile, we
recommend mapping the DEFAULT role to this user
profile. This limits the access this profile has outside of
the group.

Public Modulus

This is the public modulus of the TKE Crypto Adapter logon key
read from the TKE smart card. This field cannot be changed.
See [‘Generate TKE Crypto Adapter logon key” on page 267 |

Filz  Crypto ade

(J] CCAHMode Management Utility - Profile Management Z el

Master ey Keys Koy Starage Access Contal Smat Card Help

Uszer ID

Gornment |Te5ter4 smart card

Activation Date IO?IE?J’2004
Expiration Date IO?I2?J"2005

DEFAULT -
SCTREADM

Rele [PEFAULT |2 iremusr =
¢ 2l

Public modulus

EDOFS 3EFAR0SE0405 04052 A0S AZ0EEFL 71 42 20F1 7 EEFDAFS AETAS 65364824683
26189910ED201 4401 196 ERI989ECSEEA32080CFSES 6SARNFT23FE1T252 9EDAFE
2FOSEZFTSEE00TAT210367 94AC1A0S0SE001 AR5 4B 020 21 OOED2ARSE S (D0 425
1AFDZ090032FES6693E5 735951562 CF923 (M4E10356 203 A002 49302 CEDE 5471

| Qpen. . I| Save... I | Lead I | Read Smart Cardl | Cancell | Help I

Figure 291. Profile Management panel — smart card profile fields filled in

4. Select Save to save the profile to disk.
Warning: If the file is saved to floppy you must deactivate the floppy drive

before removing the diskette. If the diskette is removed prior to deactivating the

drive data could be lost or corrupted. For details on deactivating media see
[‘Managing Media” on page 393.

5. Select Load to load the profile into the TKE Crypto Adapter.

Other actions and tasks available from this panel are:

» Select Open to work with a profile saved to disk. You will be prompted to select a

file.

» Select Read Smart Card to read the User ID and public modulus from the TKE

smart card inserted in smart card reader 2.
» Select List to return to the list of existing profiles.
* Select Cancel to return to the CNM main window.

Define a Group Profile
1. If Group is selected as the profile type, the following panel is displayed:
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File  Erypta fade

(J] CCAHMode Management Utility - Profile Management oz I |

Wasterbey  Keys

tey Storame Access Controll Smart Card Help

Group 1D
CGomment
Activation Date

Ewxpiraticn Date

Rele

@ Passphrase profiles

o Srnart card profiles

HAocailable profiles

|
IOE.Jr 022004
IOE.Jr 022004

DEFAULT é
I— SCTKEADN
SGTKEUSR M|

EX o

Group members reguired for log on |1_

Group members (mae 10}

KEYMAMN1 - Add a
KEYMANZ J\_I J
TKEUSER 5

TKEADM

ppl

pp2 - £
=1 LIJ Removeiil LIJ

| Qpen.. | | Save. .. | | Lead I | Cancell | Help |

Figure 292. Profile Management panel — Passphrase Group profile

2. Fill'in the fields on the panel:

Group ID

Comment

The name of the profile. A maximum of 8 characters may be
specified. This field is case sensitive.

An optional character string. A maximum of 20 characters may
be specified.

Activation Date

Determines the first date when the group can logon. This field
defaults to the current date. Change this date as appropriate.

Expiration Date

Role

Determines the last date when the group can logon. This field
defaults to the current date. Change this date as appropriate.

The name of the role that defines the permissions granted to
the profile. Select a role from the list.

Note: The role of the group overrides the roles of the individual
user profiles.

Passphrase profiles/Smart Card profiles

Select the profile type for this group profile. The profiles for the
selected profile type are listed in the Available profiles container.

Available profiles

This container lists all the profiles for the selected profile type.
Highlight the profiles and press the Add button to add them to
the Group members container

Group members

This container lists the profiles that are members of this group.
A group may have a maximum of 10 members. To remove
members from the group, highlight the profiles from the Group
members container and press the Remove button.
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Group members required for log on
This is the number of users that must sign the logon before the
logon is performed. The minimum is 1, the maximum is the
number of members in the group, which cannot exceed 10.

BT CCh ioie anagement Uiy Proie Momagement [N
File  Cryptoblade Masterley  Heys  Hey Stonsge Access Contrall SmertCad Help

Group 1D lm

Cormmant |TKE Srnart Card group

Activation Date [oarozrzood

Expiration Date [osrozrzo0s

DEFAULT

Rals ISCTKEUSF i

o Fassphrase profiles

(@) Srrart card profiles

Group members required for log on I‘I_

Available prefiles Greup members (s 10}
THKESCG4 ) Ldd sc1 .
J se2 J
I
= il EEE e ol

| Open... I | Save. . I | Load I | Cancell | Help I

Figure 293. Profile Management panel — Smart Card Group profile filled in

3. Select Save to save the profile to disk.

Warning: If the file is saved to floppy you must deactivate the floppy drive
before removing the diskette. If the diskette is removed prior to deactivating the
drive data could be lost or corrupted. For details on deactivating media see
[‘Managing Media” on page 393.

4. Select Load to load the profile into the TKE Crypto Adapter.

Other actions and tasks available from this panel are:

« Select Open to work with a profile saved to disk. You will be prompted to select a
file.

+ Select List to return to the list of existing profiles.
e Select Cancel to return to the CNM main window.

Working with User Profiles
From the Profile Management panel you can perform the following:
» Edit a disk-stored user profile
» Edit a user profile loaded in the TKE Crypto Adapter
* Delete a user profile loaded in the TKE Crypto Adapter
* Reset the user-profile-failure count (valid only for passphrase user profiles)

Edit a Disk-Stored User Profile
To edit a profile stored to disk:
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1. From the Access Control pull-down menu, select Profiles; a list of existing
profiles is displayed.

Select Open; you are prompted to choose a file.
Open a file; data is displayed in the User Profile Definition panel.
Edit the profile.

Select Save to save the profile to disk; select Load to load the profile into the
TKE Crypto Adapter. Back-up any changed profiles to diskette.

Warning: If the file is saved to floppy you must deactivate the floppy drive
before removing the diskette. If the diskette is removed prior to deactivating the
drive data could be lost or corrupted. For details on deactivating media see
[‘Managing Media” on page 393.

Edit a User Profile loaded in the TKE Crypto Adapter
To edit a user profile loaded in the TKE Crypto Adapter:

1. From the Access Control pull-down menu, select Profiles; a list of existing
profiles is displayed.

Highlight the profile you want to edit.

Select Edit; data is displayed in the User Profile Definition panel.

Edit the profile.

Select Save to save the profile to disk; select Replace to load the profile into
the TKE Crypto Adapter. Back-up any changed profiles to diskette.

Warning: If the file is saved to floppy you must deactivate the floppy drive
before removing the diskette. If the diskette is removed prior to deactivating the
drive data could be lost or corrupted. For details on deactivating media see
[‘Managing Media” on page 393.

S < A

S A

Delete a User Profile loaded in the TKE Crypto Adapter
To delete a user profile loaded in the TKE Crypto Adapter:

1. From the Access Control pull-down menu, select Profiles; a list of existing
profiles is displayed.

2. Highlight the profile you want to delete.
3. Select Delete; the profile is deleted.

Reset the user-profile-failure count

To prevent unauthorized logons, the access-control system maintains a
logon-attempt-failure count for each passphrase user profile. After three
unsuccessful passphrase attempts, the profile is disabled.

To reset the failure count:

1. From the Access Control pull-down menu, select Profiles; a list of existing
profiles is displayed.

2. Highlight the disabled profile.
3. Select Reset FC; a confirmation dialog box is displayed.
4. Select Yes to confirm; the logon-attempt-failure count is reset to zero.

This function has no effect on smart card or group profiles.
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Master Key Menu

The master key is stored in the tamper resistant TKE cryptographic adapter. It is
used to encipher other keys. The master key is a 168-bit key formed from three
56-bit parts. A random master key is generated and set when the TKE Crypto
Adapter is initialized. If a master key of unknown value is lost, you cannot recover
the keys enciphered under it. We recommend that you load a new master key by
entering clear key parts or by entering key parts generated to TKE smart cards.

The TKE Crypto Adapter has three master key registers:
» The active master key is stored in the current master key register.
* The previous master key is stored in the old master key register.

* The new master key register is an interim location used to combine master key
parts to form a new master key

(J] CCAHMode Management Utility Z el

File  Crypto Node  UE 'l Feys  Key Storage  Access Conmtral  Smart Cand  Help
Auto Set...

Create Random Master Key...
Clear Mew...

Clear Parts
Smart Cand Parts

Figure 294. CNM main window — Master Key pull-down menu

Clearing the new master key register

The new master key register must be empty prior to loading a first key part. If it's
not empty or if you loaded the wrong key part, you can clear the register by:

1. From the Master Key pull-down menu, select Clear New...; you will be
prompted to confirm clearing the new master key register. Select Yes to confirm.

B4 Clear Hew Master Key

Are wou sure that vou want to clear the new master key register?

Figure 295. Clear New Master Key Register — confirm clearing
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Loading a new

2. The new master key register is cleared. Select OK to finish.

B4 Clear Mew Master Key

Mew master key register successfully cleared.

Figure 296. Clear New Master Key Register — register cleared

master key from clear key parts

To set a new master key into the TKE Crypto Adapter, load the first key part, any
middle key parts, and the last key part into the new master key register, and then
set the new master key. The first and last key parts are required. Middle key parts
are optional; you can load multiple middle key parts.

1. From the Master Key pull-down menu, select Clear Parts; the Load Master Key
panel is displayed.

(J] CCAHode Management Utility - Load Master Key 7 e
File Cryptafads Wasterkey  Heys Koy Storege Access Coptoll Smeart Card Help

(@) First Part [ Middle Part () Last Part

Master Key Part

Figure 297. Load Master Key from Clear Parts

2.

Select the radio button for the key part you are loading (First Part, Middle Part
or Last Part).

Enter the clear key part by one of the following:
a. Select New to clear data entered in error.
b. Select Open... to retrieve key parts saved to disk.

c. Select Generate to have the TKE Crypto Adapter randomly generate a key
part.
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[J] CCAHMode Management Utility - Load Master Key oz I |

File Cryptohlads Masterkey  Heys  Hey Storspe Access Contall SmertCard  Help

(@) First Part () Middle Part () Last Part

Master Key Part

7Fo1 |8BYe  |F2R4  |BRAZ
DAAR |sEoz |B3Bs |1FE3
Coss  |S24F 42AB |BEED

Figure 298. Load Master Key from Clear Parts — key part randomly generated

d. Manually enter a key value into the "Master Key Part” fields; each field
accepts four hexadecimal digits

4. Select Load to load the key part into the new master key register; select Save...
To save the key part to disk.

Warning: If the file is saved to floppy you must deactivate the floppy drive
before removing the diskette. If the diskette is removed prior to deactivating the
drive data could be lost or corrupted. For details on deactivating media see
[‘Managing Media” on page 393.

&4 Load Master Key

Master key part successfully loaded.

Figure 299. Load Master Key from Clear Parts — key part successfully loaded

Note: Key parts saved to disk are not enciphered.

5. Repeat the preceding steps to load the remaining key parts into the new master
key register.

6. From the Master Key pull-down menu, select Set... This will do the following:

a. Transfers the key in the current master key register to the old master key
register and deletes the former old master key.

b. Transfers the key in the new master key register to the current master key
register.

After setting a new master key, reencipher the keys currently in key storage. (Refer
to [‘Reenciphering key storage” on page 264.)

We recommend a dual control security policy where the first and last key parts are
loaded by different people.

258 z/0S V1R8.0 ICSF TKE PCIX Workstation User's Guide



Generating master key parts to a TKE smart card
Steps for generating master key parts to a TKE smart card are:

1.

From the Master Key pull-down menu, select Smart Card Parts. You will be
prompted to insert a TKE smart card into smart card reader 2. The Smart Card
Master Key Parts panel is displayed. Any TKE Crypto Adapter master key parts
stored on the TKE smart card are listed in the container. The TKE smart card
description is displayed. Ensure this is the correct TKE smart card you want to
generate the key part to.

Make sure that the cryptographic adapter in the TKE workstation and the TKE
smart cards are in the same zone. To determine the zone for a TKE smart card,
use CNM, see [‘Display smart card details” on page 268 or SCUP
[smart card information” on page 283.To determine the zone of a TKE
cryptographic adapter, use SCUP ['View current zone” on page 295 To use
SCUP, you must first exit from CNM.

g4 Change Smart Card PIN

FIM changed.

Figure 300. Smart Card Master Key Parts panel

2. Select the radio button for the key part you are generating (First Part, Middle
Part, or Last Part).

3. Press the Generate & Save button. You will be prompted for an optional
description for the key part you are generating. A maximum of 32 characters
may be specified.

B coervescipion |

Description for First part

[Procustion A first kp 08/02/2004]

Figure 301. Smart Card Master Key Parts panel — key part description prompt

4.

5.

You will be prompted for the PIN of the TKE smart card inserted in smart card
reader 2.

A secure session is established between the TKE Crypto Adapter and the TKE
smart card. The key part is generated to the TKE smart card. The key part list is
refreshed.

FPlease walt |

Establishing secure session between Ccrydoto
adapter and TEE smart card.

Figure 302. Establishing a secure session between TKE Crypto Adapter and TKE smart card
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9 Please wait

Generating Key Part and sending to TKE
smart card.

Figure 303. Generating key part to TKE smart card

- Bmart Card Master

0
]
X

File :lreto phois Help

“*First Part w~Middle Part . Last Part
Card description: pin=1111
Master key Parts On Smart Card

Key Part: Crypto adapter master key part, first - Production & first kp 08/02/2004

Generate & Save I | Cancel | Help |

Figure 304. Smart Card Master Key Parts panel — key part generated to TKE smart card

Note: The key parts in the container are prefixed as follows:

» Key Part: Crypto Adapter master key part, first - <optional description
follows>

* Key Part: Crypto Adapter master key part, middle - <optional
description follows>

» Key Part: Crypto Adapter master key part, last - <optional description
follows>

A First and Last key part is required. Middle key parts are optional. We
recommend a dual control security policy where the first and last key parts are
generated to different TKE smart cards so that no one person has access to the
complete key. At this point, we recommend that you insert a different TKE smart
card in smart card reader 2 to generate middle or last key parts. Repeat the
preceding steps to generate any middle or last key parts.

Loading master key parts from a TKE smart card

260

Steps for loading Crypto Adapter master key parts from a TKE smart card are:

1. From the Master Key pull-down menu, select Smart Card Parts. You will be
prompted to insert a TKE smart card into smart card reader 2. The Smart Card
Master Key Parts panel is displayed. Any Crypto Adapter master key parts
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stored on the TKE smart card are listed in the container. The TKE smart card
description is displayed. Ensure this is the correct TKE smart card you want to
work with.

2. Highlight the key part you want to load to the Crypto Adapter new master key
register. Press the Load button. You will be prompted for the PIN of the TKE
smart card inserted in smart card reader 2.

I
O
4

File lrvats s Help

“First Part wMiddle Part ~Last Part

Card description: pin=1111
Master key Parts On Smart Card

Key Part Crypte adapter raster key part first - Production & first kp 08/02 /2004
. C fi ion A last kp 0

Cenerate & Save | Load | Cancel | Help |

Figure 305. Master Key Part Smart Card panel — loading a Crypto Adapter key part from
TKE smart card

3. A secure session is established between the Crypto Adapter and the TKE smart
card. A pop-up message will display that the key part was successfully loaded.

=X

j—— | JE |

Establishing secure session between chgato
adapter and TKEE smart card.

Figure 306. Establishing a secure session between Crypto Adapter TKE smart card

B4 Please wait

Loading key from card

Figure 307. Loading key part from TKE smart card
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4 Load Master Key Part

Master key part successfully loaded.

Figure 308. Master key part successfully loaded

4. Repeat the preceding steps to load additional key parts to the Crypto Adapter
new master key register. If key parts are on different TKE smart cards, remove
the TKE smart card from smart card reader 2 and insert the TKE smart card
which contains the next key part to load.

Note: Key parts must be loaded in order; a first key part must be loaded first
(Key Part: Crypto Adapter master key part, first) and the last key part
(Key Part: Crypto Adapter master key part, last) must be loaded last.

5. From the Master Key pull-down menu, select Set... This will do the following:

« Transfers the key in the current master key register to the old master key
register and deletes the former old master key.
» Transfers the key in the new master key register to the current master key
register.
6. After setting a new master key, reencipher the keys currently in key storage.
See [‘Reenciphering key storage” on page 264.|

Verifying Master Key Parts

262

A verification pattern (VP) is generated for each master key stored in the
master-key registers (new, current and old). The 16-byte VP can be used to verify
that the correct key part was entered, for instance, when you have many key parts
stored to disk or TKE smart cards. It can also be used to verify that the key part
was entered correctly, particularly when key parts are entered manually. The VP is
zero when the register is empty. After each key part is entered, the key part is
combined with the existing key in the register and the VP is updated. The VP does
not reveal information about the clear key value.

The VP can be saved to disk for future reference. For example, in the event the
TKE cryptographic adapter is initialized, the master key registers are cleared. When
the master key is reloaded, you can compare the VP of the master key register to
the VP saved to disk. If they are identical, it indicates that the correct master key
parts were loaded. Then you can set the master key. If they are different, you can
clear the new master key register and load the correct key parts.

To verify a master key:
1. From the Master Key pull-down menu, select Verify. A sub-menu is displayed.
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(J] CCAHode Hanagement Utility oz I |

File  Crypto MNode keys Key Storage  Access Contral  Smart Card  Help

Auto et

Create Random Master Key..
Clear Mew..

Clear Parts

Smart Cand Parts

Set..

Currznt
(o]

Figure 309. Master Key Verify sub-menu

2. From the submenu, select the master key register you wish to verify - New,

Current or Old. Typically, you will choose New. You cannot change the current

or old master key.
3. The VP is displayed in the Master Key Register Verification panel.

(J] CCAHode Management Utility - Master Key Reqister Verification = = =

File Cryptohads WMasterbey  Heys  HeyStonepe Access Contrall Smert Cad Help

“erffication pattern

0797  F35E 0878 6F4B 4B&4 5120 BEOD 404D

| Compare” Cancel” HeIpI

Figure 310. Master Key Register Verification panel - verification pattern is displayed
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4. Select Save to Save the VP to a file. A file chooser will be displayed for the
user to specify where to save the file (Floppy Drive or CNM Data Directory) and
a file name.
Warning: If the file is saved to diskette, the floppy drive must be deactivated via
the TKE Media Manager before the diskette is removed or data could be lost or
corrupted.

5. Select Compare to compare the VP to a VP previously saved to disk. A file
chooser will be displayed for the user to specify the location and filename of the
saved VP.

4 Haster Key Register Yerification

Varification succeeded.

Figure 311. Master Key Register VP compare successful

Key Storage Menu

Reenciphering key storage

264

Key storage is a repository of keys that you access by key label. DES keys and
PKA (RSA) keys are held in separate storage systems. The keys in key storage are
enciphered under the current TKE Crypto Adapter master key. When a new master
key is set (becomes the current master key), the keys must be reenciphered to the
current master key.

[J] CCANode Management Utility = =

File  Crypto Mode  Master Key  Keys Access Contral  Smart Card  Help

PEA Key Storage

P Initialize

Figure 312. CNM main window — Key Storage pull-down menu

To reencipher the keys in storage:

1. From the Key Storage pull-down menu, select DES Key Storage or PKA Key
Storage; a sub-menu is displayed.
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2. From the sub-menu, select Manage; the DES Key Storage Management or the
PKA Key Storage Management panel is displayed. The panel lists the labels of
the keys in key storage.

(J] CCAHode Management Utility - DES Key Storage Management = = =

File Cryptohads WMasterbey  Heys  HeyStonepe Access Contrall Smert Cad Help

Filter criteria ||

TKEY42 IMPORTER ﬂ
TEEV 42 IMPPKA
TEE42 IMPPKA RSA ENG

| Newl | Delete.. I | R efresh I | Reencipher. .. I | Cancel I | Help I

Figure 313. Key Storage Management Panel — key labels list

3. Select Reencipher...; the keys are reenciphered using the key in the current
master key register.

Smart card Menu

Change PIN

The TKE smart card is secured with a PIN. You may change your PIN using this
function. You must know your current PIN. If your TKE smart card is blocked due to
too many incorrect PIN attempts, this function will fail. You do not need to logon to
the TKE Crypto Adapter to perform this function.
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Figure 314. CNM main menu — Smart Card pull-down menu

Steps to change the PIN are:

1. From the Smart Card pull-down menu, select Change PIN; you will be prompted
to insert your TKE smart card into smart card reader 2. Insert your TKE smart
card and press OK to continue.

4 Change Smart Card PIN

e ==

Figure 315. Change PIN — insert TKE smart card prompt

2. You will be prompted for your current PIN. Enter your current PIN on the smart
card reader 2 PIN pad.

%4 Change Smart Card PIN

Figure 316. Change PIN — enter current PIN prompt

3. You will be prompted for your new PIN. The new PIN must be entered twice and
both PINs must match.
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g4 Change Smart Card PIN

Flease enter new PIN twice on smart card
reader kevhoard

Figure 317. Change PIN — enter new PIN prompt

4. The PIN is successfully changed on the TKE smart card.

Generate TKE Crypto Adapter logon key

A Crypto Adapter logon key allows a user to logon to the Crypto Adapter using a
TKE smart card to access functions not allowed in the default role. A Crypto
Adapter logon key is an RSA private key pair generated within the TKE smart card.
The private key never leaves the TKE smart card. The public key is read from the
TKE smart card and loaded to the Crypto Adapter when a user profile is defined.
You do not need to logon to the Crypto Adapter to perform this function.

To generate a Crypto Adapter logon key:

1. From the Smart Card pull-down menu, select Generate Crypto Adapter Logon
Key. You will be prompted for a TKE smart card. Insert the TKE smart card into
smart card reader 2.

arate Crypto Adapter Logon

Flease insert a TEE smart card into 5mart Card reader 2.

Ok | Cancel |

Figure 318. Generate Crypto Adapter Logon Key — insert TKE smart card

2. You will be prompted for a PIN. Enter the PIN on the smart card reader 2 PIN
pad.

Flease enter FIM on smart card reader kewtioard

Figure 319. Generate Crypto Adapter Logon Key — PIN prompt

3. You will be prompted for a user ID for the TKE smart card. This user ID will be
read from the TKE smart card when defining a smart card user profile.
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Gensrate Crypto Adapter Logon Ke

Enter a user ID for the smart card TKESC

% Cancel

Figure 320. Generate Crypto Adapter Logon Key — User ID prompt

4. The Crypto Adapter logon key is generated.

Generate CryplLo ﬂdapter Logon K

Cryoto adapter logon key generated.

Figure 321. Generate Crypto Adapter Logon Key — key generated

Display smart card details

Use this function to display public information about a TKE smart card. You do not
need to logon to the Crypto Adapter to use this function.

1. From the Smart Card pull-down menu, select Display Smart Card Details. You
will be prompted for a TKE smart card. Insert the TKE smart card into smart
card reader 2.

§4 Smart Card Details

Flease insert a TKE smart card into Smart Card reader 2.

CGancel

Figure 322. Display Smart Card Details — insert TKE smart card prompt

The TKE smart card is read and the public information is displayed.
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CCAa Node Management Utility - Smart Card Detairls

Figure 323. Display Smart Card Details — public information displayed

The following lists the information displayed for a TKE smart card:

Card type
TKE smart card

Applet version number
Version number of applet loaded on smart card

Card description
description of the TKE smart card; entered when the smart card was
personalized

PIN status
not set/OK/blocked; PIN is set when TKE smart card is personalized

Crypto Adapter user id
user id entered when a Crypto Adapter logon key is generated; may be
blank if the TKE smart card does not have a Crypto Adapter logon key

Crypto Adapter logon key
not present/present

Zone ID
set when the TKE smart card is initialized

Zone Description
set when the TKE smart card is initialized

Manage Smart Card Contents

Use this function to delete keys or key parts from a TKE smart card. A TKE smart
card can hold up to 10 key parts, a TKE authority signature key, and a Crypto
Adapter logon key. You do not need to logon to the TKE Crypto Adapter to use this
function.
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1. From the Smart Card pull-down menu, select Manage Smart Card contents.
You will be prompted for a TKE smart card. Insert the source TKE smart card
into smart card reader 2.

T BRI

Help

Smart Card Contents

Card description: TKE Card A

Cryptu adapter Logon Key Pair: UserID A

Delete| Cancel| Help|

Figure 324. Manage Smart Card contents — contents of TKE smart card are displayed

2. The TKE smart card description is displayed. Ensure this is the correct TKE
smart card you want to work with. Highlight the keys and/or key parts you want
to delete. Press the Delete button.

3. You will be prompted for your PIN. Enter your PIN on the smart card reader 2
PIN pad.

4. You will be asked to confirm the deletion of the selected objects. Press OK to
continue.

: Delete Objecds

Are you sure you want to delete 2 objects %

Cancel

Figure 325. Manage Smart Card contents — confirm delete prompt

5. The objects are deleted and the list is refreshed.
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File Help

Smart Card Contents
Card description: TKE Card A

Crypto adapter Logon Key Pair: UserID A

Key Part: Crypto adapter master key part, middle - Master Key A Middle Part

g oty Cancel| Help|

Figure 326. Manage Smart Card contents

Attention! If you delete a Crypto Adapter logon key, you will not be able to logon to
the TKE Crypto Adapter until you generate a new Crypto Adapter logon key and the
administrator updates your TKE Crypto Adapter user profile.

If you delete a TKE signature authority key, you will not be able to sign a TKE
command until the administrator generates a new authority key and uploads it to
the host.

Copy Smart Card

Use this function to copy a key or key part(s) from one TKE smart card to another.
The two TKE smart cards must belong to the same zone; that is, the Zone ID of the
TKE smart cards must be identical. Use Display Smart Card Details to verify the
Zone ID of the TKE smart cards.

You do not need to logon to the TKE Crypto Adapter to use this function.

Note: Smart card copy does not overwrite the target TKE smart card. If there is not
enough room on the target TKE smart card, you will get an error message.
You can either delete some of the keys on the target TKE smart card (see
[‘Manage Smart Card Contents” on page 269) or use a different TKE smart
card.

1. From the Smart Card pull-down menu, select Copy Smart Card. You will be
prompted for a source TKE smart card. This is the TKE smart card you want to
copy from. Insert the source TKE smart card into smart card reader 1. The
contents of the TKE smart card are displayed in the source container on the
top.
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&4 Insert TKE Smart Card

Insett source TKE Smart Card In Smart Card reader 1.

Gancel

Figure 327. Copy Smart Card — insert source TKE smart card

2. You will be prompted for a target TKE smart card. This is the TKE smart card
you want to copy to. Insert the TKE smart card into smart card reader 2. The
contents of the TKE smart card are displayed in the target container on the
bottom. The contents of this container are greyed.

&4 Insert TKE Smart Card

Inserttarget TKE Smart Card In Smart Card Reader 2.

CGancel

Figure 328. Copy Smart Card — insert target TKE smart card

File

Contents of source Smart Card
Card description: TKE Card 1 - SCUSER1

|Crypte adapter Logen Key Pair: SCUSER1 |
TKE Authority Signature kKey: 34 Authority3ds
Key Part Cryptoe adapter master key part, first - First 4764 MK Part
Key Part Crypto adapter master key part, middle - Middle 4784 MK Part
key Part Crypto adapter master key part, last - Last 4764 MK Part
Key Part: ICSF Operational key part - Operational Key - IMPORTER
Key Part ICSF Operational key part - Operational Key - IMPORTER

Contents of target Smart Card
Card description: TKE Card 2 - SCUSERZ

Crypto adapter Logon Key Pair SCUSERZ =
key Part: Crypto adapter master key part. first - Production First Master Key Part
Key Part: Crypto adapter master key part. last - Production Last Master Key Part

J Cancel | Help
Figure 329. Copy Smart Card — TKE smart card key parts are displayed

3. Highlight the objects in the source container to copy to the target container.
Press OK to continue.
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Contents of source Smart Card

Card description: TKE Card 1 - SCUSER1

|

s |Crypte adapter Logon Key Pair SCUSER1T
TKE futhority Signature Key: 34 duthority34x
Key Part Crypto adapter master key part, flrst F|rst4?64 MK Part

SF Op art Y
Key Part ICSF Operatlonal key part - Operatlonal Key - IM PORTER

Contents of target Smart Card
Card description: TKE Card 2 - SCISER2

Crypto adapter Logon Key Pair SCUSERZ —
Key Part: Crypto adapter master key part, first - Production First Master Key Part
Key Part: Crypto adapter master key part, last - Production Last Master Key Part

% Cancel | Halp

Figure 330. Copy Smart Card — highlight source objects to copy to target

4. You will be prompted for the PIN of the source TKE smart card in smart card
reader 1. Enter the PIN on the smart card reader 1 PIN pad.

8 Type PIN

Type PIM on Smart Card reader 1.

Figure 331. Copy Smart Card — source TKE smart card PIN prompt

5. You will be prompted for the PIN of the target TKE smart card in smart card
reader 2. Enter the PIN on the smart card reader 2 PIN pad. A secure session
is established between the two TKE smart cards and the selected object(s) are
copied. The contents of the target container is refreshed.

B4 Typern |

Type PIN on Smart Card reader 2.

Figure 332. Copy Smart Card — target TKE smart card PIN prompt

B4 Please wait

Establishing secure session between cards

Figure 333. Establishing a secure session between source and target TKE smart cards
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9 Please wait

Copying from Srmart Card reader 1 to Smart
Card reader 2

Figure 334. Objects are copied to the target TKE smart card

File lrvapts pbads Help

Contents of source Smart Card

Card description: TKE Card 1 - SCUSER1

]

Crypto adapter Logon Key Pair SCUSERT

TEE duthority Signature key: 24 Authority3ds

key Part: Crypto adapter master key part, first - First 4764 MK Part

key Part: Crypto adapter master key part, middle - Middle 4784 ME Part
Key Part: Crypto adapter master key part, last - Last 4764 MK Part

Key Part: ICSF Operational key part - Operational Key - IMPORTER

key Part: ICSF Operational key part - Operational Key - IMPORTER

Contents of target Smart Card

Card description: TKE Card 2 - SCUSERZ

Crypto adapter Legoen Key Pain SCUSER2 —
key Part: Crypto adapter master key part. first - Production First Master Key Part
key Part Crypto adapter master key part, last - Proeduction Last Master Key Part
key Part Crypto adapter master key part, middle - Middle 4764 ME Part

key Part: ICSF Operational key part - Operational key - IMPORTER

Cancel | Help

Figure 335. Copy Smart Card — objects are copied to the target container

A TKE smart card can hold a maximum of 10 key parts in addition to a workstation
cryptographic adapter logon key and a TKE authority signature key.

CNM Common Errors

Message: Incorrect passphrase

Return Code: 4

Reason Code: 2042

Explanation: Check that you typed in the passphrase correctly. The
passphrase is case sensitive.

Message: Access is denied for this function

Return Code: 8

Reason Code: 90

Explanation: The role associated with your profile does not allow you to
perform this function. Logoff the crypto module and logon using a profile
associated with a role that allows this function.

Message: Time sent in your logon request was more than 5 min. off
the clock in the secure module

Return Code: 8

Reason Code: 91
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Explanation: The workstation clock is more than 5 minutes off the

TKE Crypto Adapter clock-calendar. This occurs when the clock

changes from Standard Time to Daylight Savings Time and vice-versa.

Read the TKE Crypto Adapter clock-calendar (see

[‘Read Clock-Calendar” on page 240), convert the GMT time to the current
time for your area and set the workstation clock (see

[‘Setting the Clock” on page 209). Logon to the TKE Crypto Adapter with

a profile/role that allows you to set the clock (like TKEADM or SCTKEADM).
Then synchronize the clock-calendar (see

[‘Synchronize Clock-Calendar’ on page 240).

Message: Your user profile has expired

Return Code: 8

Reason Code: 92

Explanation: The TKE administrator must reset the expiration date on
the user profile.

Message: Your authentication data (for example, passphrase) has expired.
Return Code: 8

Reason Code: 94

Explanation: The TKE administrator must change the passphrase and reset
the passphrase expiration date on the user profile. Then select Replace to
load the profile into the workstation coprocessor.

Message: The user profile does not exist

Return Code: 8

Reason Code: 773

Explanation: Check that you typed in the user ID correctly. The user ID is
case sensitive.

Message: The group logon failed because authentication of one or more
group members failed.

Return Code: 8

Reason Code: 2084

Explanation: One or more user profiles in the group failed authentication
(passphrase expired, profile expired, etc) and so the group logon failed.
The group logon window will indicate which user failed and why. Correct
the user profile or attempt group logon again and select a different member
in the group members list for logon.

Message: The profile is included in one or more groups.

Return Code: 8

Reason Code: 2085

Explanation: You attempted to delete a user profile that is currently a
member of a group profile. You must remove the user profile from the group
member list before deleting the profile.

Message: The group role does not exist.

Return Code: 8

Reason Code: 2086

Explanation: You attempted group logon using a group profile that is
associated with a role that does not exist. The TKE administrator must define
the role and load it to the TKE Crypto Adapter before the group profile

may be used.
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Message: Your group profile has not yet reached its activation date
Return Code : 8

Reason Code: 2087

Explanation: The group profile has an activation date that is later than the
current date. The TKE administrator must change the activation date before
the group profile may be used or wait until the activation date arrives.

Message: Your group profile has expired.

Return Code: 8

Reason Code: 2088

Explanation: The group profile has surpassed its expiration date.

The TKE administrator must change the expiration date before the group
profile may be used.
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Appendix D. Smart Card Utility Program (SCUP)

The TKE Smart Card Utility Program (SCUP) supports the smart card system with
the following functions:

* Initialize and personalize the CA smart card

» Backup the CA smart card

* Initialize and enroll TKE smart cards

* Personalize TKE smart cards

* Display smart card information

» Enroll the TKE cryptographic adapter

* Unblock a TKE smart card

* Change PIN number

When you are prompted on the panel to enter PINs, the smart card reader also
shows a prompt. Messages appear for certain tasks that take over a minute. Please
be patient to avoid having to start the task over.

The utility is capable of overwriting your smart cards. You will be prompted to reply
OK before the card is overwritten.

To start SCUP, click on Trusted Key Entry, then Applications. Under Applications,
click on Smart Card Utility Program 1.20. The following screen appears:
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TKE Smart Card Utility Program Ve < . o]
File CASmart Card TKE Smart Card Crypto Adapter Help

Smart card reader 1

Card type: Zone enroll status:
Card 1D: Zone ID:

Card description: Zone description:
PIN status:

TKE Authority key:
Crypto Adapter Logon key:

Key parts:
Key type Description Crigin MDC-4 SHA-1 ERNC-ZERO Control wector Length | |

-

Smart card reader 2

Card type: Zone enroll status:
Card 1D: Zone ID:

Card description: Zone description:
PIN status:

TKE Authority key:
Crypto Adapter Logon key:

Key parts:
Key type Description Crigin MDC-4 SHA-1 ERC-ZERO Control wector Length | |

-

i| Main Menu |

Figure 336. First screen of TKE Smart Card Utility Program (SCUP)

Drop down menus exist for the following tabs on the top of the screen:
 File

* CA Smart Card

* TKE Smart Card

* Crypto Adapter

Tasks associated with the drop down menu for File are:
. Disilay smart card information; see [‘Display smart card information” on page]

o Exit.

Tasks associated with the drop down menu for CA Smart Card are:

« Initialize and personalize CA smart card; see [‘Initialize and personalize the CA|
lsmart card” on page 279 .|

+ Backup CA smart card; see [‘Backup a CA smart card” on page 281 |
+ Change PIN; see[‘Change PIN of a CA smart card” on page 286

Tasks associated with the drop down menu for TKE Smart Card are:
+ Initialize and enroll TKE smart card; see [‘Initialize and enroll a TKE smart card’|
+ Personalize TKE smart card; see [‘Personalize a TKE smart card” on page 285
+ Unblock TKE smart card; see [‘Unblock PIN on a TKE smart card” on page 286.|
+ Change PIN; see[‘Change PIN of a TKE smart card” on page 287.
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Tasks associated with the drop down menu for Crypto Adapter are:

+ Enroll Crypto Adapter; see ['‘Enroll a TKE cryptographic adapter” on page 287
+ View current zone; see [View current zone” on page 295,

Initialize and personalize the CA smart card

A zone is created when a CA smart card is initialized and personalized.

To initialize a CA smart card, follow these steps:
1.

From the CA Smart Card drop down menu, select Initialize and personalize CA
smart card option.

2. When prompted, insert a smart card into smart card reader 1.

B4 CA Smart Card - Initialize and personalize CA smart card

Insert smart card to be initialized and personalized as a CA
smart card in card reader 1.

| Ok | | Cancel |

Figure 337. First step for initialization and personalization of the CA smart card
3. If the smart card is not empty a message is displayed indicating that the smart
card is not empty and all data will be overwritten. If this is acceptable click OK.

B4 CA smart Card - Initialize and personalize CA smart card
The smart card is not empty.
All data will be overwritten.

| 0K | | Cancel |

Figure 338. Message if card is not empty

4. The smart card will now be initialized.

B4 CA Smart Card - Initialize and personalize CA smart card

Smart card is being initialized. This process takes upto 1
minute.

If operation is interrupted card will be corrupted and new
initialization is reguired.

Figure 339. Initialization message for CA smart card
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5. At the prompt, enter a 6-digit PIN number twice. This is the first CA smart card
PIN.

4 CA Smart Card - Initialize and personalize CA smart card

Enter a 6 digit PIN twice to he used as the first CA PIN on
the smart card reader PIN pad.

{To cancel the operation press the red X button on the
smart card reader PIN pad).

Figure 340. Enter first PIN for CA smart card

6. At the prompt, enter a 6-digit PIN number twice. This is the second CA smart

card PIN. For dual control it is recommended that different administrators enter
the first and second CA smart card PIN and the PINs should not be the same.

B4 CA smart Card - Initialize and personalize CA smart card

Enter a 6 digit PIN twice to be used as the second CA PIN
on the smart card reader PIN pad.

{To cancel the operation press the red X button on the
smart card reader PIN pad).

Figure 341. Enter second PIN twice for CA smart card

7. At the prompt, enter a zone description. Although this is optional, it is
recommended.

4 CA Smart Card - Initialize and personalize CA smart card

Each CA smart card should have a unigque zone description
that identifies the zone.

Enter the Zone description.

PRODUCTION

| Ok | | Cancel |

Figure 342. Enter zone description for CA smart card

8. At the prompt, enter a CA smart card description. Although this is optional, it is
recommended. After the description is entered the CA Smart Card will be built.

280 z/0S V1R8.0 ICSF TKE PCIX Workstation User's Guide



B4 CA smart Card - Initialize and personalize CA smart card

Optionally enter a description for the smart card.

CA SMART CARD

0Ok

Figure 343. Enter card description for CA smart card

&4 CA Smart Card - Initialize and personalize CA smart card

Building CA smart card. This process takes up to 1 minute.

If operation is interrupted, card will be corrupted and new
initialization is reguired.

Figure 344. Building a CA smart card

9. You will get a message that a CA Smart Card was successfully created.

Backup a CA smart card

The CA smart card defines the zone. If the CA smart card is lost or blocked the
administrator will not be able to initialize and enroll TKE smart cards, unblock TKE
smart cards or enroll TKE cryptographic adapters in the zone. We recommend that
the CA smart card be backed up and stored in a secure place.

To backup a CA smart card, follow these steps:

1. From the CA Smart Card drop down menu, select Backup CA smart card
option.

2. When prompted, insert the CA smart card to be backed up into smart card
reader 1.

&4 CA smart Card - Backup CA smart card

Insert source CA smart card (card to be backed up) in
smart card reader 1.

| Ok | | Cancel |

Figure 345. Begin creation of backup CA smart card

3. Enter the first CA smart card PIN.
4. Enter the second CA smart card PIN.
5. Insert the target CA smart card in smart card reader 2.
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6.
data on the smart card.
7. The target smart card is initialized.

If the target smart card is not empty, you will be asked to overwrite all of the

CA smart card is being initialized. This process takes up to
1 minute.

If operation is interrupted, card will be corrupted and new
initialization is required.

& CA smart Card - Backup CA smart card

Figure 346. Initialization of backup CA smart card

Prepare CA smart cards for backup procedure.

If operation is interrupted, card will be corrupted and new
initialization is required.

Figure 347. Continue creation of backup CA smart card

4 CA Smart Card - Backup CA smart card

Establish a secure connection between smart cards.

If operation is interrupted, card will be corrupted and new
initialization is reqguired.

Figure 348. Establish secure connection for backup CA smart card

8. At the prompts, enter the first and second CA PINs of the original CA smart card

on the smart card reader 2.

i CA smart Card - Backup CA smart card

Building backup CA smart card. This process takes up to 1
minute.

If operation is interrupted, card will be corrupted and new
initialization is reguired.

Figure 349. Building backup CA smart card
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9. You will get a message that a CA Smart Card was successfully copied.

Display smart card information

After you have created a smart card, you may want to check the results. If you are
copying keys from one TKE smart card to another, you may also want to see if the
TKE smart cards are in the same zone.

1.

Insert smart card(s) to be displayed in smart card reader 1 or 2. From the File
menu, select Display smart card information option.

TKE Smart Card Utility Br Py
File CASmart Card TKESmart Card Crypto Adapter Help
Smart card reader 1
Card type: CASmart Card v0.3 Zone enroll status: Enrolled
Card 1D: 2386A118S Zone ID: 42DD4E1C
Card description: CA smart card Zone description: Production
PIN status: 0Ok
TKE Authority key:
Crypto Adapter Logon key:
Key parts:
Key type Description Qrigin MDC-4 SHA-1 EMC-ZERC Control vector Length

Smart card reader 2

Card type:

TKE Smart Card v0.3 Zone enroll status: Enrolled

Card 1D: F34FED9ES Zone ID: 42DD4E4C

Card description: TKE Smart Card Zone description: Production

PIN status: Ok

TKE Authority key: 45 Eob Jones

Crypto Adapter Logon Key: Not present

Key parts:

Key type Descrigtion Origin | MoC-4 SHA-1 EWC-ZERQ | Contral ...| Length
ICSF symmetric master ... MNSME Crypto adap... |2COF73C0O0OCE. . FS06DA271... FC1BDSFS 16
Operational key part, E... |Operational Ke... |Cryto adap... |SFSCCES4CFS.. |A4C932FC7... B37SEBBI [00417... |16
Operational key part, ©... |Operational Ke... |Cryto adap... [FAE2A134913. . |BSO71FS185.. | 04CB6C29 [002477...[16
Operational key part, D... |(Operational Ke... |Crypto adap... (6201368383E . [061FFB120D... ECOFD2ES |000000...|8
Cperational key part, D... |(Operational Ke... |Crypto adap... |(69BFD4CS0ES. . (7750FGFCCF... BGS LCBFE  [QOO000. . |16
Operational key part, U... |Operational e |Crvoto adap... (D432 9448943, |BCC798C6C... |48B400850 [00004... |16

Figure 350. Display of CA smart card and TKE smart card

The panel provides the following information on the smart card:
» Card type: This is either a CA smart card or TKE smart card.
Card ID: A 9-digit identifier generated when the smart card is initialized.

Card description: This is the description you entered when creating the smart
card. Can be 30 characters in length.

PIN status: OK, Blocked or Not set

TKE Authority key: For TKE smart cards only, the authority index and name is
displayed.

Crypto Adapter Logon Key: For TKE smart cards only, the value can be
Present or Not Present.

Zone enroll status: The Zone enroll status is the status of the card. It is either
Enrolled or Not enrolled.
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Zone ID: When a CA smart card is created, the system will generate an 8-digit
zone number.

Zone Description: This is the description you entered when creating the CA
smart card. Can be 12 characters in length.

Key type: operational key parts, TKE Crypto Adapter master key parts, or ICSF
master key parts

Description: description of key part (optional)
Origin: Crypto Adapter or PIN-PAD

MDC-4: MDC-4 hash value of the key part

SHA-1: SHA-1 hash value of the key part
ENC-ZERO: ENC-ZERO hash value of the key part

Control vector: CCA control vector of operational key parts or blank for master
key parts

Length: 8, 16, or 24 bytes

Initialize and enroll a TKE smart card

To initialize a TKE smart card, follow these steps:

284

1.

From the TKE Smart Card drop down menu, select Initialize and enroll TKE
smart card option.

At the prompt, insert a CA smart card (into smart card reader 1) belonging to
the zone you want to enroll the TKE smart card in.

Enter the first CA PIN on the PIN pad of smart card reader 1.

Enter the second CA PIN on the PIN pad of smart card reader 1.

Note: If you have entered the two PINs for the CA card, have not restarted
SCUP, and have not removed the CA card, the two PINs (of the CA
smart card) may not require reentry when you are initializing TKE smart
cards. This feature is only used when initializing TKE smart cards. All
other functions that require the CA PINs will require reentry every time

At the prompt, insert a smart card to be initialized as a TKE smart card in smart
card reader 2.

B4 TKE Smart Card - Inifialize and enroll TKE smart card

Insert smart card to be initialized as a TKE smart card in
smart card reader 2.

| Ok | | Cancel |

Figure 351. Initialize and enroll TKE smart card

6.

7.

If the card is not empty, you will be asked to overwrite all of the data on the
smart card.

You will see the following screens indicating that the smart card is being
initialized and then the TKE smart card is being built.
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B4 TKE Smart Card - Inifialize and enroll TKE smart card

Smart card is being initialized. This process takes upto 1
minute.

If operation is interrupted, card will be corrupted and new
initialization is required.

Figure 352. Initializing TKE smart card

@4 TKE Smart Card - Inifialize and enroll TKE smart card

Building TKE smart card. This process takes upto 1
minute.

If operation is interrupted, card will be corrupted and new
initialization is required.

Figure 353. Building TKE smart card

8. When complete, you will get a message that the TKE smart card was
successfully created. The TKE smart card must be personalized before it can be

used for storing keys and key parts.

Personalize a TKE smart card

To personalize a TKE smart card, follow these steps:

1. From the TKE Smart Card drop down menu and select Personalize TKE smart
card option.

2. You will be prompted to insert a TKE smart card to be personalized in smart
card reader 2.

@4 TKE Smart Card - Personalize TKE smart card

Insert TKE smart card to personalize in smart card reader
2,

| Ok | | Cancel |

Figure 354. Personalizing TKE smart card

3. At the prompt, enter a 4-digit PIN on the PIN pad of the smart card reader 2.
You will do this twice.
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&4 TKE Smart Card - Personalize TKE smart card

Enter a 4 digit PIN to be used for this smart card twice on
the smart card reader PIN pad.

{To Cancel the operation press the red X button on the PIN
pad).

Figure 355. Entering PIN for TKE smart card

4. At the prompt, enter a description for the TKE smart card (optional).

5. When complete, you will get a message that the TKE smart card personalization
was successful.

Unblock PIN on a TKE smart card

If you enter an incorrect PIN 3 times for a TKE smart card, it will become blocked
and will not be usable. When you unblock the PIN, the PIN does not change. You
still need to enter the correct PIN. You have 3 more attempts to enter the PIN
correctly.

To unblock the PIN on a TKE smart card, follow these steps:

1. From the TKE Smart Card drop down menu, select Unblock TKE smart card
option.

Insert the CA smart card in smart card reader 1 when prompted.

Enter the first CA PIN on the PIN pad of smart card reader 1.

Enter the second CA PIN on the PIN pad of smart card reader 1.

At the prompt, insert the TKE smart card to be unblocked in smart card reader
2.

6. You will get a message that the TKE smart card was successfully unblocked.

ok~ wDd

Change PIN of a CA smart card

To change the PIN of a CA smart card, follow these steps:

1. From the CA Smart Card drop down menu, select Change PIN option.
2. Insert the CA smart card in smart card reader 1.

3. Select either first CA PIN or second CA PIN.

#4 CA smart Card - Change PIN

Select PIN to change.

@ First CA PIN

) Second CA PIN

| Ok | | Cancel |

Figure 356. Select first CA PIN

4. Enter the current 6-digit PIN once.
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5. Enter the new PIN twice — when prompted.
6. You will get a message that the PIN was successfully changed.

Change PIN of a TKE smart card

To change the PIN of a TKE smart card, follow these steps:
1. From the TKE Smart Card drop down menu, select Change PIN option.

2. Insert the TKE smart card in smart card reader 2.

3. Enter the current 4-digit PIN once.

4. At the prompt, enter the new 4-digit PIN twice.

5. You will get a message that the PIN was successfully changed.

Enroll a TKE cryptographic adapter

A TKE workstation with a cryptographic adapter can be enrolled locally or remotely.

Note: This must be done before loading key parts from the TKE smart card.

You can check if the TKE cryptographic adapter is enrolled in a zone from the
Crypto Adapter drop down menu: select View current zone option. You will see the
following if it is not:

l
<

S View current zone
The IEM Crypto Adapter is not enrolled in a zone.

0Ok

Figure 357. View current zone for a TKE cryptographic adapter

Local TKE workstations that have access to the CA Card may be enrolled locally. If
you have offsite TKE workstations without access to the CA card, you may use the
remote enroll to enroll these workstations in the same zone.

If the enroll does not occur as part of the initialization, the current DEFAULT role will
not have the necessary ACPs to perform the enroll. You must reload the
TEMPDEFAULT role (see [‘Open or edit a disk-stored role” on page 242). Once the
enroll is complete, it is critical that the TEMPDEFAULT role be returned to the
normal DEFAULT role. The TEMPDEFAULT role cannot be allowed to stay loaded
as this role has ACPs for all functions.

For a local enroliment:
1. From the Crypto Adapter drop down menu, select Enroll Crypto Adapter option.
2. Select local when prompted for enrollment type.
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Crypto Adapter Enrcll Crypto Adag
Do you want to enroll an IEM Crypto Adapter that is

local gnstalled in this workstation) or remote
@nstalled in another workstation) ?

® Local

) Remote

Ok | ‘ Cancel

Figure 358. Select local zone

3. At the prompt, insert the CA smart card in smart card reader 1.
At the prompt, enter the first CA PIN on the PIN pad of smart card reader 1.
At the prompt, enter the second CA PIN on the PIN pad of smart card reader 1.

You will get a message that the enrollment for the crypto adapter was
successful.

o o M

Crypto Adapter - Enrcll Crypto Adapter

Please wait while enrall request is certified.

Figure 359. Certifying request for local Crypto Adapter enroliment

Crypto Adapter - Enrcll Crypto Adapte a2}
The IEM Crypto Adapter was enrolled successtully.

Ok

Figure 360. Message for successful Crypto Adapter enrollment

7. View the zone information after the crypto adapter is enrolled by selecting View
current zone from the Crypto Adapter drop down menu.
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Crypto Adapter - ¥ iew current zZone

The IEM Crypto Adapter current zone information:
Zone ID: 42DD4E4C
Zone Description: Production

Ok

Figure 361. View current zone after Crypto Adapter enroliment

For a remote/secondary enroliment:
To enroll a remote cryptographic adapter, follow these steps.

Note: If the remote workstation is TKE 4.2, refer to the TKE Workstation User’s
Guide, SA22-7524, on Resource Link for details.

1. On the remote workstation, click on Trusted Key Entry, Applications.
2. Click on Begin Zone Remote Enroll Process for an IBM Crypto Adapter.

3. Respond YES to the following message: This program generates an
enrollment request for the IBM Cryptographic card installed in this
workstation Continue?? (Yes/no)

4. There is a check to see if the crypto adapter is already enrolled. If it is, the
message “A device key is already present in the Crypto Adapter. After the
remote enroll is completed, the device key will be replaced. Continue?“ must
be answered.

Begin Remote Enroll o e

A device key is already present in the Crypto Adapter.
After the remote enroll is completed, the device Key will be replaced.
Continue?

Yes Mo

Figure 362. Crypto Adapter Enrolled

5. The restricted file chooser will open and prompt you for a file name and
destination. Store the file.
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Begin Remote Enroll

Save the enrollment request file.
' Floppy Drive
® SCIP Data Directory

Files
-
File Mame : |EnrnIIRequezt.fiI|
Save | Cancel
Figure 363. Save Enrollment Request
Begin Remote Enrcll Eﬁ,

@ The Crypto Adapter Enrollment request has been stored in the file named: enrollRequestril

Figure 364. Enrolliment Request Stored

Warning: Deactivate the floppy drive via the TKE Media Manager before
removing the diskette or data could be lost or corrupted.

6. Transport this file to the local workstation.

Note: If the local workstation is TKE 4.2, refer to the TKE Workstation User’s
Guide, SA22-7524, on Resource Link for details.

7. On the local workstation, from the Crypto Adapter drop down menu, select
Enroll Crypto Adapter option.

8. Select remote when prompted for enroliment type.
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X

o Adapter - Enrcll Crypto Ada :.
Do you want to enroll an IEM Crypto Adapter that is

local gnstalled in this workstation) or remote
@nstalled in another workstationy ?

) Local

® Remote

i Ok | | Cancel

Figure 365. Select remote zone

I
X

If the remote workstation is a Trusted Key Entry
Yersion 4.20 workstation, execute the program
named enroll_req.cmd from the commmand line.

If the remote workstation is a Trusted Key Entry 5.0
workstation, start the Eegin Remote Enroll program
from the desktop.

These programs create an enrollment request from
the remote workstation cryptographic coprocessor
and write the request to a file.

If this file is available press OK. Otherwise execute
the appropriate program before continuing.

| Ok | | Cancel

Figure 366. Remote zone enrollment instructions

9. At the prompt, insert the CA smart card in smart card reader 1.
10. At the prompt, enter the first CA PIN on the PIN pad of smart card reader 1.

11. At the prompt, enter the second CA PIN on the PIN pad of smart card reader
1.

12. At the prompt, select the enroliment request file (created in step
289).
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Crypto Adapter - Enroll Crypto Ed -
Open file that contains enrollment request from the remote Crypto Adapter.
' Floppy Drive
@ SCUP Data Directory

Files
enrollRequestfil -~
File Mame : enrollEeguest fil
Open Cancel

Figure 367. Open enroliment request file

13. The Crypto Adapter serial number is displayed. You are prompted to confirm
this enrollment.

Crypto Adapter - Enrcll Crypto Adapter e

The enrollment request originates from a IEM Crypto
Adapter with serial number:<94000041 >

Do you want to enroll this IEM Crypto Adapter ?

| 0Ok | | Cancel

Figure 368. Verification of enrollment request

14. An enroliment certificate is created for the remote cryptographic adapter.
15. Specify a file name to save the enroliment certificate.
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Crypto Adapter - Enrcll Crypto

The enrollment has been granted.

The enrollment certificate must be installed in the enrolled Crypto Adapter.
Specify a file name for the enrollment certificate.

2 Floppy Drive
) SCUP Data Directory

Files
enrollRequestril =
=
File Name :  |EnrallCert fil
Save Cancel
Figure 369. Save the enrollment certificate
Adapter - Enroll Crypteo Adapt EX

If the remote workstation is a Trusted Key Entry
Yersion 4.20 workstation, execute the program
named enroll_inst.cmd from the commmand line.

If the remote workstation is a Trusted Key Entry 5.0
workstation, start the Complete Remote Enroll
program from the desktop.

These programs install the enrollment certificate in

the remote Crypto Adapter from the file you just
saved.

Ok

Figure 370. Continue with remote enroliment

Warning: The floppy drive must be deactivated via the TKE Media Manager
before the diskette is removed from the floppy drive or data could be lost or
corrupted.

16. Transport this file to the remote workstation.

Note: If the remote workstation is TKE 4.2, refer to the TKE Workstation
User's Guide, SA22-7524, on Resource Link for details.

17. On the remote workstation, click on Trusted Key Entry, Applications.
18. Click on Complete Zone Remote Enroll Process for an IBM Crypto Adapter.
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19. Respond YES to the following message: This program installs an
enrollment accept in the IBM Cryptographic card installed in this
workstation Continue? (Yes/no)

20. If the TKE Crypto Adapter is already enrolled, you are asked to confirm the
enrollment and then asked to continue.

21. You are prompted for the file that contains the enroliment certificate (from step
15) by the restricted file chooser.
Warning: If the output files/input files are from a floppy you must deactivate
the floppy drive before removing the diskette. If the diskette is removed prior to
deactivating the drive data could be lost or corrupted. For details on
deactivating media see [‘Managing Media” on page 393]

[
1
[X

Comnplete Remocte Enrcll

Open the enrollment request certificate,

' Floppy Drive
® SCUP Data Directory
Files

EnrollCertfil -
enrollRequestril

<]

File Name: |EnroliCert.fil

open | Cancat |

Figure 371. File Chooser Enroll Certificate

22. You will get a message that the remote Crypto Adapter has been installed in
the zone (giving the zone description and ID).

Complete Remote Enroll s e

The remote Crypio Adapter has been enrolled in a Zone.
Zone ID: Production 42DD4E4C

Ok

Figure 372. Remote Enroll Success
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View current zone

Use this function to determine the current zone of the TKE cryptographic adapter.
You may want to compare it to the zone of the TKE smart card when working with
key parts.

To view the current zone of the TKE cryptographic adapter, follow these steps:
1. From the Crypto Adapter drop down menu, select View current zone option.

Crypto Adapter - View current zone X
The IEM Crypto Adapter current zone information:

Zone ID: 42DD4E4C
Zone Description: Production

Ok

Figure 373. View current zone after Crypto Adapter enroliment

A window is returned with the Zone ID and the Zone description (if you had
previously entered one).
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Appendix E. Secure Key Part Entry

This appendix describes how you can enter a known key part value onto a TKE
smart card.

This allows migration of existing key parts to TKE smart cards and provides an
additional mechanism for key part entry. Using the PIN pad on the smart card
reader, the key part can be stored securely on a TKE smart card. You must enter
the key part hexadecimal digits on the smart card reader key pad. See
[key part on the smart card reader” on page 300.|

By entering the key part on the PIN pad, the key part can be stored securely and
any clear copies of the key part can be destroyed. Once stored on the TKE smart
card, TKE can use its existing infrastructure to securely load the key part into key
storage or onto the host.

Steps for secure key part entry

Secure Key Part Entry begins from the Crypto Module Notebook by right-clicking
the desired key type for entry. Right-clicking the desired key type reveals a menu
where there is an entry for secure key part.

. Crypto Coprocessor Crypfo Module Administration : G11 / X00 7 o [

Function

Domain Keys
Status Hash pattern

Hew Symmetric Master Key Empty
Old Symmetric Master Key Valid 2B0C723D1ABICI48EICIEI2EFFFIBTFA
Symmetric Master Key Valid DF3A50AE3546612396EFA57EBBDOTAC

Hew Asymmetric Master Key Empty
Old Asymmetric Master Key Valid EF4C65754B5088C22D03480BC7B952B2
Asymmmetric Master Key ‘alid E83F158521FEEA23986CCI9483DAFDT 11

Select key to work with Key Type

Mew Symmetric Master Key
MNew Asymmetric Master Key
Operational key:

Operational Key - IMPO
Operational Key - IPINE  Load to Key part register »
Cperational Key - OPIN View
Operational Key - PING
Operational Key - PIRYI
Operational Key - IMP-F  ‘Secure key part entry
Operational Key - DATA =

Clear

Toenerar] ey [Goa|

| | UPDATE MODE

Figure 374. Choosing secure key part entry from the domains keys panel

This menu entry will be available for all four crypto module types: CCF, PCICC,
PCIXCC, and CEX2C. Proceed with the following:

1. Select Secure key part entry.
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For master keys on all coprocessors (CCF, PCICC, PCIXCC, CEX2C) and CCF
operational keys, the following panel appears:

4 Enter key part description

Description [Mew Symmetric Master Key |

| Continue || Cancel || Help |

| |Trusted ey Entry |

Figure 375. Enter description panel for secure key part entry

For PCIXCC/CEX2C operational keys only, the following panel appears:

B4 Secure Key Part Entry

Keytype USER DEFINED

Description |Operati0na| key - USER DEFINED

Bytes 0..7 8..15

Control vector |0021480003410000| |0021480003210000

| " Cancel || Help |

Figure 376. USER DEFINED operational key for secure key part entry

For a USER DEFINED operational key, the user is allowed to update the
description, the key length, and the control vector.
For a default operational key, only the description may be updated, unless the
default key type supports multiple key lengths. In that case, the key length field
can also be updated. For a default operational key, the control vector cannot be
updated.

2. After all the appropriate information has been entered for master and
operational keys, the user is prompted to insert a TKE smart card into reader 2.

EN Secure Key Part Enfry

Insert TKE smart card in smart card reader 2.

Figure 377. Secure key part entry — enter TKE smart card into reader

3. Enter the PIN on the smart card reader PIN pad:
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B4 Secure Key Part Enfry

Enter 4 digit PIN on smart card reader 2 PIN pad.

Figure 378. Secure key part entry — enter PIN

4. If the TKE smart card information is correct, press the Yes button to continue:

B4 Secure Key Part Enfry

g The following identifying information was retrieved from the TKE
smart card:

Zone Description: Production
Entity ID: 9B7E10465
Card Description: TKE Card #1

Do you want to continue with secure key part entry?

[ el [ wo ]

Figure 379. Secure key part entry card identification

5. Enter key part digits (see [‘Entering a key part on the smart card reader” on|
page 300) :

B4 Secure Key Part Enfry

Enter key part digits on the smart card reader key pad.

Figure 380. Secure key part entry — enter key part digits

6. After the key part value has been successfully entered on the PIN pad, a panel
is displayed with information regarding the key part just entered. The
ENC-ZERO, MDC-4, and SHA1 values are shown to the user for verification
that the key part was entered correctly. If the key part entered was for an
operational key, the CV would also be displayed on this panel. Press 0K to
continue

8 Smart Card key part information

0 Keytype |CSF symmetric master key part
Description |Wew Symmetric Master Key
Key length |15
ENC-ZERO 29465BAE
MDC-4 3JA97BOAS0CA76BF12989193DC2CAFBIF
SHA1 FCDZ2D5AASBIAECAGIZ22DB324D633795E4F1177F0

Figure 381. Secure key part entry — key part information
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4 Smart Card key part information

0 Keytype | Operational key part, EXFORTER
Description |Operational Key- EXPORTER
Key length |15
Control vector |DD41 700003410000 0041 700003210000
ENC-ZERO BCAGADEY
MDC-4 879EABDCF461597D1FOB017B95303967
SHA1 E129F27C5103BC5CC44BCDFOA 15E160D445066FF

Figure 382. Secure key part entry — key part information for operational key

7. Successful entry

g8 Secure Key Part Entry

0 Command was executed successfully

Figure 383. Secure key part entry — message for successful execution

Entering a key part on the smart card reader

300

A key part is hexadecimal. The PIN pad on the smart card reader does not provide
hexadecimal digits, so you must enter two digits that represent the decimal
equivalent of a hexadecimal digit. The valid range of decimal digit input is 00—15.
This range is equivalent to the hexadecimal digit input range of 0—F. A conversion
table is provided (Table 15 on page 301).

Except for RSA keys, all other key types for all crypto module types can be entered
securely on the smart card reader PIN pad. These key parts can then be used to
load key part registers, key part queues, or master key registers on the host.

Secure key part entry on the smart card reader PIN pad works as follows:

* A key part is separated into blocks. The key length in bytes (2 hexadecimal
characters per byte) is divided by 4 and gives you the number of blocks.

* A block on the smart card reader PIN pad consists of 8 hexadecimal digits.

* Once a hexadecimal digit has been entered, the value cannot be changed.

» After entering the two digit decimal equivalent, the smart card reader records a
hexadecimal digit, updating the smart card reader display with an ' in the
section depicting the number of hexadecimal digits that have been recorded in
the current block.

» After all the hexadecimal digits in a block have been entered, a running counter
of the number of blocks completed on the smart card reader display is updated
and the current block display is reset.

» Once a block is updated with a hexadecimal digit, the values cannot be changed.

* The current decimal digit input is depicted by two lock images. One lock image
flashes, indicating the position of the current decimal input that the smart card
reader awaits.

* The current decimal digit input can be changed. If an invalid two decimal digit
input is entered, a change must occur. The Backspace key (yellow button labeled
with a <-) on the smart card reader PIN pad can be used to undo entered
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decimal digits. The <- button lets the user change the first decimal of the hex
digit. Example: if you entered 0_ you can use the <-button to reenter the 0. The
abort key (red button labeled with an X) on the smart card reader PIN pad can
be used to reset entered decimal digits. It is used to stop the key entering
process.

EXAMPLE

Key part type: 8-byte data operational key

Key part hexadecimal digits: AB CD EF 12 34 56 78 90
Number of blocks: 2

Number of hexadecimal digits per block: 8

Initial Block Counter Value: 1/2

Two decimal digit conversion of key part hexadecimal digits:
1011 1213 1415 0102 0304 0506 0708 0900

Table 15. Decimal to Hexadecimal Conversion Table

Hexadecimal Digit Decimal Digits Entered on PIN PAD

0 00

—_

01

02

03

04

05

06

07

08

09

10

11

12

13

14

MM O|O|W|>|O©|o|N|ojv|n~|[w| N

15
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Appendix F. Access Control Points and Callable Services

The TKE workstation allows you to enable or disable callable service access control
points. For systems that do not use the optional TKE Workstation, all access control
points (current and new) are enabled in the DEFAULT Role with the appropriate
licensed internal code on the PCI Cryptographic Coprocessor, PCl X Cryptographic
Coprocessor, or Crypto Express2 Coprocessor

TKE Version 4.0 and Higher

Access to services that are executed on the PCI X Cryptographic Coprocessor or
Crypto Express2 Coprocessor is through Access Control Points in the DEFAULT

Role. To execute callable services on the PCIXCC/CEX2C, access control points
must be enabled for each service in the DEFAULT Role.

New TKE users and non-TKE users have all access control points enabled. This is
also true for brand new TKE V5.0 users. If you are upgrading from TKE V4.0, V4.1,
or V4.2 to TKE V5.0 and your configuration includes PCIXCCs or CEX2Cs, the
settings, enabled/disabled, for existing access control points remain the same as
they were on TKE V4.0, V4.1, or V4.2. Depending on the ICSF FMID that is
installed, new access control points may need to be enabled.

Note: Access control points DKYGENKY-DALL and DSG ZERO-PAD unrestricted
hash length and PTR Enhanced PIN Security are always disabled in the
DEFAULT Role for all customers (TKE and Non-TKE). A TKE Workstation is
required to enable these access control points. DSG ZERO-PAD and PTR
Enhanced PIN Security are only applicable to the PCIXCC/CEX2C.

If you are upgrading from TKE V4.0, V4.1, or V4.2 to TKE V5.0 and your
configuration includes PCIXCCs or CEX2Cs, the settings (enabled/disabled) for
existing access control points remain the same as they were on TKE V4.0, V4.1, or
V4.2

Access Control Points for HCR7731 are:

* Remote Key Export - Generate or export a key for use by a CCA node
» Trusted Block Create - Activate an Inactive Trusted Key Block

» Trusted Block Create - Create a Trusted Key Block in Inactive Form

* PKA Key Generate - Permit Regeneration Data

» PKA Key Generate - Permit Regeneration Data for Retained Keys

Access Control Points for HCR770B are:

» Diversified Key Generate - TDES-XOR

» Diversified Key Generate - TDESEMV2/TDESEMV4

* PIN Change/Unblock - change EMV PIN with OPINENC
* PIN Change/Unblock - change EMV PIN with IPINENC
» Transaction Validation - Generate

» Transaction Validation - Verify CSC-3

» Transaction Validation - Verify CSC-4

» Transaction Validation - Verify CSC-5

» Key Part Import - RETRKPR
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Access Control Points for HCR770A are:
* CKDS Conversion Program

» Clear Key Import

* Decipher

 Digital Signature Verify

* DSG ZERO-PAD Unrestricted Hash Length
* Encipher

» Key Part Import - ADD-PART keyword
» Key Part Import - COMPLETE keyword
* NOCV Exporter

* NOCV Importer

* Prohibit Export Extended

* Public Key Encrypt

These access control points are only supported on the PCIXCC/CEX2C.

For the relationship between access control points and callable services, see
[Table 16 on page 306]

TKE Version 3.1

304

Access to services that are executed on the PCI Cryptographic Coprocessor is
through Access Control Points in the DEFAULT Role. To execute callable services
on the PCI Cryptographic Coprocessor, access control points must be enabled for
each service in the DEFAULT Role. The ability to enable/disable access control
points in the DEFAULT Role was introduced on OS/390 V2R10 through APAR
0OwW46381 for the Trusted Key Entry Workstation. New TKE customers and
Non-TKE customers have all access control points enabled. This is also true for
brand new TKE V3.1 users (not converting from TKE V3.0).

Note: Access control point DKYGENKY-DALL is always disabled in the DEFAULT
Role for all customers (TKE and Non-TKE). A TKE Workstation is required to
enable this access control point for the Diversified Key Generate service.

For existing TKE V3.0 users, upgrading to TKE V3.1 (APAR OW46381 and its
corresponding ECA), current (for the level of ICSF you are running) access control
points in the DEFAULT Role are enabled. Any new access control points are
disabled in the DEFAULT Role and must be enabled through TKE if the service is
required.

Notes:
1. APAR OW46381 will update the TKE Host Code
2. ECA 186 will update the TKE Workstation Code

3. The latest or most current driver is required for the PCI Cryptographic
Coprocessor licensed internal code for the S/390 G5 Enterprise Server or the
S/390 G6 Enterprise Server

4. The latest or most current driver is required for the PCI Cryptographic
Coprocessor licensed internal code for the IBM @server zSeries 900

All of the above components are required for complete access control point support.

Access to services which execute on the Cryptographic Coprocessor Feature is
through SAF. Disablement through SAF is sufficient to prevent execution of a
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service by either the Cryptographic Coprocessor Feature or the PCI Cryptographic
Coprocessor. For functions which can be executed on the PCI Cryptographic
Coprocessor, enablement of the function requires that the function be enabled
through SAF and through the access control point in the DEFAULT Role.

If you are on OS/390 V2 R10, using a TKE V3.0 workstation, access control points
for new services (requiring APARs OW46380 and OW46382) will be disabled.
Existing access control points will be enabled in the DEFAULT Role. APAR
OW46381 must be installed to enable the OS/390 V2 R10 interface. This will allow
the TKE Administrator to enable any new access control points for ICSF services
that execute in the PCI Cryptographic Coprocessor under the DEFAULT Role.

Access Control Points (requiring APARs OW46380 and OW46382) for 0S/390
V2R10 are:

» DATAM Key Management Control

Note: For existing TKE installations (upgrading to TKE V3.1), it is required that
this access control point be enabled. Failure to do so will result in
processing errors for Double MAC keys in Key Import, Key Export, and
Key Generate.

» Diversified Key Generate - Single length or same halves
» Diversified Key Generate - CLR8-ENC

» Diversified Key Generate - TDES-ENC

» Diversified Key Generate - TDES-DEC

» Diversified Key Generate - SESS-XOR

+ Diversified Key Generate - DKYGENKY-DALL

Note: This access control point is always disabled in the DEFAULT Role for all
customers (TKE and Non-TKE). A TKE Workstation is required to enable
the function.

* MAC Generate - For existing TKE installations, it is recommended that this
access control point be enabled.

* MAC Verify - For existing TKE installations, it is recommended that this access
control point be enabled.

Access Control Points for z/OS V1 R2 are:
* PKA Key Token Change

» Secure Messaging for Keys

» Secure Messaging for PINs

Access Control Points for z/OS V1 R3 are:
* UKPT - PIN Verify, PIN Translate

Access Control Points for APAR OW53666 are:
» Data Key Export - Unrestricted

* Data Key Import - Unrestricted

» Key Export - Unrestricted

» Key Import - Unrestricted

* Key Part Import - Unrestricted
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If an access control point is disabled, the corresponding ICSF callable service will
fail during execution with an access denied error.

Table 16. Callable service access control points

Access Control Point Callable Service
*Clear Key Import CSNBCKI or CSNBCKM
Clear PIN Encrypt CSNBCPE
Clear PIN Encrypt - PTR Enhanced PIN Security CSNBCPE
Clear PIN Generate - 3624 CSNBPGN
Clear PIN Generate - GPB CSNBPGN
Clear PIN Generate - VISA PVV CSNBPGN
Clear PIN Generate - Interbank CSNBPGN
Clear Pin Generate Alternate - 3624 Offset CSNBCPA
Clear PIN Generate Alternate - VISA PVV CSNBCPA
Clear PIN Generate Alternate - PTR Enhanced PIN | CSNBCPA
Security
Control Vector Translate CSNBCVT
Cryptographic Variable Encipher CSNBCVE
*CKDS Conversion Program CSFCONV
CVV Generate CSNBCSG
CVV Verify CSNBCSV
DATAM Key Management Control CSNBKGN, CSNBKIM, CSNBKEX
and CSNBDKG
Data Key Export CSNBDKX
Data Key Export - Unrestricted CSNBDKX
Data Key Import CSNBDKM
Data Key Import - Unrestricted CSNBDKM
*Decipher CSNBDEC
Digital Signature Generate CSNDDSG
*DSG ZERO-PAD unrestricted hash length CSNDDSG
*Digital Signature Verify CSNDDSV
Diversified Key Generate - CLR8-ENC CSNBDKG
Diversified Key Generate - TDES-ENC CSNBDKG
Diversified Key Generate - TDES-DEC CSNBDKG
Diversified Key Generate - SESS-XOR CSNBDKG
Diversified Key Generate - single length or same CSNBDKG
halves
**Diversified Key Generate - TDES-XOR CSNBDKG
**Diversified Key Generate - TDESEMV2/ CSNBDKG
TDESEMV4
DKYGENKY - DALL CSNBDKG
*Encipher CSNBENC
Encrypted PIN Generate - 3624 CSNBEPG
Encrypted PIN Generate - GPB CSNBEPG
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Table 16. Callable service access control points (continued)

Encrypted PIN Generate - Interbank CSNBEPG
Encrypted PIN Generate - PTR Enhanced PIN CSNBEPG
Security

Encrypted PIN Translate - Translate CSNBPTR
Encrypted PIN Translate - PTR Enhanced PIN CSNBPTR
Security

Encrypted PIN Translate - Reformat CSNBPTR
Encrypted PIN Verify - 3624 CSNBPVR
Encrypted PIN Verify - GPB CSNBPVR
Encrypted PIN Verify - VISA PVV CSNBPVR
Encrypted PIN Verify - Interbank CSNBPVR
Encrypted PIN Verify - PTR Enhanced PIN Security | CSNBPVR
Key Export CSNBKEX
Key Export - Unrestricted CSNBKEX
Key Generate - OPIM, OPEX, IMEX, etc. CSNBKGN
Key Generate - EX, IM, OP CSNBKGN
Key Generate - CVARs CSNBKGN
Key Generate - SINGLE-R CSNBKGN
Key Import CSNBKIM
Key Import - Unrestricted CSNBKIM
*Key Part Import - ADD-PART keyword CSNBKPI
*Key Part Import - COMPLETE keyword CSNBKPI
Key Part Import - first key part CSNBKPI
Key Part Import - middle and final CSNBKPI
Key Part Import - unrestricted CSNBKPI
Key Part Import - RETRKPR CSNBKPI
Key Translate CSNBKTR
MAC Generate CSNBMGN
MAC Verify CSNBMVR

*NOCV EXPORTER

CSNBKEX, CSNBSKM, and
CSNBKGN

*NOCV IMPORTER

CSNBKIM, CSNBSKI, CSNBSKM,
and CSNBKGN

**PIN Change/Unblock - change EMV PIN with CSNBPCU
OPINENC

**PIN Change/Unblock - change EMV PIN with CSNBPCU
IPINENC

**PIN Change/Unblock - PTR Enhanced PIN CSNBPCU
Security

PKA Decrypt CSNDPKD
PKA Encrypt CSNDPKE
PKA Key Generate CSNDPKG
PKA Key Generate - Clear CSNDPKG
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Table 16. Callable service access control points (continued)

PKA Key Generate - Clone CSNDPKG
PKA Key Generate - Permit Regeneration Data CSNDPKG
PKA Key Generate - Permit Regeneration Data for | CSNDPKG
Retained Keys

PKA Key Import CSNDPKI
PKA Key Token Change CSNDKTC
Prohibit Export CSNBPEX
*Prohibit Export Extended CSNBPEXX
*Public Key Encrypt CSNDPKE
Retained Key Delete CSNDRKD
Retained Key List CSNDRKL
Remote Key Export CSNDRKX
Secure Key Import - IM CSNBSKI or CSNBSKM
Secure Key Import - OP CSNBSKI or CSNBSKM
Secure Messaging for Keys CSNBSKY
Secure Messaging for PINs CSNBSPN
SET Block Compose CSNDSBC
SET Block Decompose CSNDSBD
SET Block Decompose - PIN ext IPINENC CSNDSBD
SET Block Decompose - PIN ext OPINENC CSNDSBD
Symmetric Key Export - PKCS-1.2 CSNDSYX
Symmetric Key Export - ZERO-PAD CSNDSYX
Symmetric Key Generate - PKA92 CSNDSYG
Symmetric Key Generate - PKCS-1.2 CSNDSYG
Symmetric Key Generate - ZERO-PAD CSNDSYG
Symmetric Key Import - PKA92 KEK CSNDSYI
Symmetric Key Import - PKA92 PIN Key CSNDSYI
Symmetric Key Import - PKCS-1.2 CSNDSYI
Symmetric Key Import - ZERO-PAD CSNDSYI
**Transaction Validation - Generate CSNBTRV
**Transaction Validation - Verify CSC-3 CSNBTRV
**Transaction Validation - Verify CSC-4 CSNBTRV
**Transaction Validation - Verify CSC-5 CSNBTRV
Trusted Block Create - Activate an Inactive Trusted |CSNDTBC
Key Block

Trusted Block Create - Create a Trusted Key Block |CSNDTBC
in Inactive form

UKPT - PIN Verify, PIN Translate CSNBPVR and CSNBPTR
Notes:

1. *indicates that the access control point is only available with a PCI X
Cryptographic Coprocessor or Crypto Express2 Coprocessor.
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** indicates that the access control point is only available with a PCI X
Cryptographic Coprocessor or Crypto Express2 Coprocessor and requires z990
with May 2004 or later version of Licensed Internal Code (LIC, a z890, z9-109,
z9 EC or a z9 BC with MCL 029 Stream J12220.

To use PKA Key Generate - Clear or PKA Key Generate - Clone, the PKA Key
Generate access control point must be enabled or the callable service will fail.
PKA Key Generate - Permit Regeneration or Permit Regeneration Data for
Retained Keys is optional and should be enabled as required for authorized
usage. Enabling this command is not recommended for production and usage
requires special consideration.

To use SET Block Decompose - PIN ext IPINENC or PIN ext OPINENC, the
SET Block Decompose access control point must be enabled or the callable
service will fail.

Diversified Key Generate - single length or same halves requires either
Diversified Key Generate - TDES-ENC or Diversified Key Generate -
TDES-DEC be enabled.

Encrypted PIN Translate - PTR Enhanced PIN Security - enhanced further to
produce return code 8,3016 - The value of the PAD data is not valid.
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Appendix G. LPAR Considerations

Setup for CCF Systems

Prior to activating the Cryptographic characteristics (on the Crypto page), the
cryptographic coprocessors must be selected on the Processor Page of the
Customize Activation Profiles Task. Once a cryptographic coprocessor (0,1, or both)
is selected for the LP, the Crypto tab is automatically displayed so cryptographic
coprocessor characteristics can be defined.

In LPAR mode, only one partition can perform TKE functions at a time. The partition
with this control is referred to as the TKE host. The other partitions that receive key
updates from the TKE host are referred to as the TKE targets. To enable the TKE
host to control the TKE targets, you need to define the control and usage domain
indexes and enable specific profile options.

To configure the TKE host partition, enable the following options on the Crypto page
of the Customize Activation Profiles task:

» Enable public key algorithm (PKA) facility
» Enable cryptographic functions

» Enable public key secure cable (PKSC) and integrated cryptographic service
facility (ICSF)

* Enable Modify authority
» Enable query signature controls
* Enable query transport control

» Enable cryptographic facility (ICRF) key entry (if you intend to use the load to
queue function)

» Enable special secure mode

To configure the TKE target partitions, enable the following options on the Crypto
page of the Customize Activation Profiles task:

» Enable public key algorithm (PKA) facility
* Enable cryptographic functions

» Enable public key secure cable (PKSC) and integrated cryptographic service
facility (ICSF)

» Enable cryptographic facility (ICRF) key entry (if you intend to use the load to
queue function)

* Enable special secure mode

Note: Special secure mode must also be enabled in the installation options data
set in addition to the profile options. You can then use the TKE functions to
dynamically enable and disable special secure mode.

When defining the control and usage domains for the TKE host and TKE target
partitions, assign the same number for both the usage domain index and the logical
partition. This usage domain index and logical partition number should be the same
as the domain number specified in the installation options data set for this partition.
The control domain index list for the TKE host and the TKE target partitions always
includes the logical partition’s usage domain index. In addition, the TKE host
partition’s control domain index list must include the usage domain index for all the
TKE target partitions for which it has control.
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For example, in LPAR 0 is the TKE host and controls the TKE target
partitions 1, 2, and 3. The control domain and usage domain on all partitions are
the same number as the LPAR number. In real installations, this setup scheme is
not possible because the LPAR numbering begins at one and not zero. It is used in
the sample for ease of understanding. The TKE host, however, also includes control
domain indexes for partitions 1, 2, and 3.

TKE Host TKE Target TKE Target TKE Target
LPARO LPAR 1 LPAR 2 LPAR 3

Control Domain Control Domain 1 Control Domain 2 Control Domain 3

OSwN—-O

Usage Domain Usage Domain1  Usage Domain2  Usage Domain 3

Figure 384. An Example of TKE Host and TKE Target LPARs

In this example, the TKE host workstation connects to the host system defined as
LPAR 0. To update DES or PKA master keys for LPAR 0, the TKE administrator
selects domain 0. To load DES or PKA master keys into any of the target LPARs,
the TKE administrator changes the active selection on the TKE workstation to
specify the domain of the target LPAR.

If for any reason you need to reassign a domain currently in use, you should
zeroize the domain first. See [‘Zeroize Domain” on page 93|

Setup for PCIXCC/CEX2C Systems

312

On 2990, z890, z9-109, z9 EC and z9 BC systems, there is no specific field on the
LPAR Activation Profile to identify the TKE Host. You must decide which LPAR will
be the TKE Host and setup the control domain and PCI Cryptographic Candidate
List appropriately.

On 2990, z890, z9-109, z9 EC and z9 BC systems, multiple TKE Target LPARs can
be assigned the same domain number — provided they do not share any
PCIXCCs/CEX2Cs. Therefore, the TKE Host LPAR must have a unique domain
number. The TKE Host LPAR must also have access to all the PCIXCCs/CEX2Cs
that are to be controlled on the system.

In the LPAR Activation, define the control and usage domain index for each LPAR.
Assign the same number for both the usage domain and the logical partition. This
usage domain index and logical partition number should be the same as the domain
number specified in the installation options data set for this partition. The control
domain index list for the TKE Host and the TKE target partitions always includes the
logical partition’s usage domain index. In addition, the TKE Host partition’s control
domain index must include the usage domain index for all the TKE target partitions
for which it has control.

Additionally, the PCI Cryptographic Candidate List and PCI Cryptographic Online
List must be configured in the LPAR Activation Profile. The Candidate List includes
all PCIXCCs/CEX2Cs that CAN be online for the LPAR. The Online List includes all
PCIXCCs/CEX2Cs that will be online when activation is complete (selections in the
Online List must be selected in the Candidate List).
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If TKE Target LPARs are sharing the same domain, the PCIXCCs/CEX2Cs defined
in the Candidate List can not include any of the same PCIXCCs/CEX2Cs. For the
TKE Host, the PCI Cryptographic Candidate List must include all the
PCIXCCs/CEX2Cs for all the TKE target partitions for which it has control.

The example in [Figure 385 has 3 LPARs and 4 PCIXCCs/CEX2Cs: 00, 01, 02, 03.
There is no domain sharing. In this case, all the PCIXCCs/CEX2Cs can be
specified in the Candidate List for each LPAR.

TKE Host TKE Target TKE Target
LPARO LPAR 1 LPAR 2

Control Domain 0 Control Domain 1 Control Domain 2
1
2

Usage Domain 0  Usage Domain1  Usage Domain 2

Candidate List Candidate List Candidate List
00 00 00
01 01 01
02 02 02
03 03 03

Figure 385. An Example of TKE Host and TKE Target LPARs without Domain Sharing

The example in has 4 LPARs, 2 sharing the same domain and 4
PCIXCCs/CEX2Cs: 00, 01, 02, 03. In this case, LPAR 1 and LPAR 2 share the
same domain, but the Candidate List does not share any of the same
PCIXCCs/CEX2Cs.

TKE Host TKE Target TKE Target TKE Target
LPARO LPAR 1 LPAR 2 LPAR 3

Control Domain 0  Control Domain 1  Control Domain 1 Control Domain 3
1
3

Usage Domain 0  Usage Domain1  Usage Domain 1 Usage Domain 3

Candidate List Candidate List Candidate List Candidate List
00 00 02 00
01 01 03 01
02 02
03 03

Figure 386. An Example of TKE Host and TKE Target LPARs with Domain Sharing

If the same domain is specified by more than one LPAR and the Candidate List has
any of the same PCIXCCs/CEX2Cs, the first LPAR that is activated will IPL without
error but the other LPARs with the same domain will fail activation.
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Appendix H. Auditing

ICSF uses SMF record type 82 to record certain ICSF events. Record type 82
contains a fixed header section and subtypes.

ICSF writes to subtype 12 for every PKSC command entered through the
CSFPKSC interface. Subtype 12 contains the following information:

* The complete TKE request to the CCF
* The corresponding complete TKE response from the CCF

ICSF writes to subtype 16 whenever a TKE workstation either issues a command
request to a PCI Cryptographic Coprocessor or PCI X Cryptographic Coprocessor
or Crypto Express2 Coprocessor or receives a reply response from a PCI
Cryptographic Coprocessor or PCI X Cryptographic Coprocessor or Crypto
Express2 Coprocessor. Subtype 16 contains the following information:

» The indicator for request or reply
* The indicator for PCICC or PCIXCC or CEX2C

» The PCI Cryptographic Coprocessor or PCl X Cryptographic Coprocessor or
Crypto Express2 Coprocessor processor number

* The PCI Cryptographic Coprocessor or PCI X Cryptographic Coprocessor or
Crypto Express2 Coprocessor serial number

* The PCI Cryptographic Coprocessor or PCI X Cryptographic Coprocessor or
Crypto Express2 Coprocessor domain index

» The request command block or reply response block length
* The request command data block or reply response data block length
* The request or reply CPRB

ICSF writes to subtype 22 to track the Trusted Block Create Service. Subtype 22
contains the following information:

» Type of call, Activate or Inactive

» If a Public Key Section was present in the Trusted Block Token
» ASID of the Caller

 If Input Trusted Block Token is in the PKDS, save it's Label

» If Output Trusted Block token is in the PKDS, save it's Label
 If the Transport Key Token is in the CKDS, save it's Label

See |z70S MVS System Management Facilities (SMF) for details on the request and
response formats.
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Appendix I. Clear RSA Key Format

An RSA key can be imported from a file holding the unencrypted RSA key. The file

must be an ASCII text file. CR/LF can be inserted at any place for enhanced

readabilitly of the file.

The contents of the file are:

Description Length (characters)

Key modulus length in bits (hex value) 4

Length of Modulus field in bytes (hex value)

Length of Public exponent field in bytes (hex value)

B B N

Length of Private exponent field in bytes (hex value)

Modulus (hex value)

Public exponent (hex value) -

Private exponent (hex value) -

The format follows the key_value_structure format defined for the PKA Key token

Build (CSNDPKB) callable service.

The following are examples of two file contents for the same clear RSA key. The

key length is 512 bits and the public exponent is 65537.

Example 1:

0200

0080

0003

0080
0000000000000000000000000000000000000000000000000000000000000000
0000000000000000000000000000000000000000000000000000000000000000
800000000000000001AE28DA4606D885EB7E0340D6BAAC51991COCDOEAE835AF
DICFF3CD7E7EA74141DADD24A6331BEDF41A6626522CCF15767D167D01A16F97
010001
0000000000000000000000000000000000000000000000000000000000000000
0000000000000000000000000000000000000000000000000000000000000000
0252BDAD4252BDAD425A8C6045D41AFAF746BEBD5F085D574FCD9CO7FOB38C2C
45017C2A1AB919ED2551350A76606BFA6AF2F1609A00A0A48DD7 19A55E9CA801

Example 2:

0200004000030040
800000000000000001AE28DA4606D885EB7E0340D6BAAC51991COCDOEAE835AF
DICFF3CD7E7EA74141DADD24A6331BEDF41A6626522CCF15767D167D01A16F97
010001
0252BDAD4252BDAD425A8C6045D41AFAF746BEBD5F085D574FCD9CO7FOB38C2C
45017C2A1AB919ED2551350A76606BFA6AF2F1609A00A0A48DD7 19A55EDCA801
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Appendix J. Key Token Migration for the 4753

TKE Version 3 and higher supplies a 4753 Migration Ultility. It allows you to migrate
internal DES key tokens from the 4753 to ICSF.

The migration process supports:
» Conversion of the CCA and CUSP/PCF TSS keys
» Customizable mapping from TSS control vectors to ICSF control vectors

ANSI 9.17 and CDMF keys are not supported.
Note: If running TKE V4.1 or higher, to process the converted keys dataset, an

ICSF FMID level no lower than HCR770B is required. If the ICSF level is
below HCR770B, then APAR OA07393 must be installed.

Overview

The primary input to the migration process is a backup of the 4753 key storage.
The primary output is the converted keys that are written to the active CKDS.

The 4753 migration involves three major processes:
1. Setup - Create the input needed by the Migration Utility
The following must be available prior to running the utility:
a. Backup of the 4753 key storage
b. 4753 DES master key parts
c. Atransport KEK between the TKE workstation and ICSF
2. Conversion - Use the Migration Utility to create converted keys
The main steps of the utility are:
a. Analyze the 4753 Backup file

This step produces a Conversion Control file that controls the conversion
step and an Analysis Print file that describes the analysis results for each
key in the 4753 Backup file.

b. Convert Keys
In this step, the keys are translated from being encrypted under the 4753
master key to being encrypted under a transport key-encrypting key shared
between the TKE workstation and ICSF. The converted keys are saved to a
file.

3. Host - Write the converted keys to the CKDS

At the host, these steps must be performed:

a. Send the Keys file and Rename file to the host
The Converted keys file (output from the Convert function) is transmitted to
the host system. If there were any CUSP/PCF keys in the 4753 Backup file,
the Convert function also created a Rename file. The Rename file must also
be transmitted to the host.

b. Write the Converted keys to the CKDS (use batch program CSFTWCKD)
Use KGUP to rename any CUSP keys in the CKDS
If there were any CUSP/PCF keys in the original 4753 Backup file, the

Rename file is used as input to KGUP to rename the CUSP/PCF keys in the
CKDS.
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Key Token Migration Outline

The migration of 4753 key storage requires three major processes to be performed.
An outline of the steps involved in each process follows. A detailed explanation of
each step is also included. See[Table 17 on page 339 for a 4753 Migration Utility
Checklist. You may find it useful to fill out the checklist as you progress through the
TKE Migration Utility.

Preparing the TKE Migration Utility Input
1. Create a Backup of the 4753 Key Storage

2. Prepare 4753 Master Key Parts

3. Customize the Translation Table File

4. Establish Transport Key-Encrypting Key
5. Reboot the TKE workstation

Using the TKE Migration Utility

6. Start the Utility

7. Logon to the TKE Crypto Adapter

8. Import the 4753 Master Key

9. Perform the Analysis
10. Check the results of the analysis
11. Check the Conversion Control File
12. Perform the conversion
13. Check the results of the conversion
14. Remove the partial 4753 Master Key from TKE key storage
15. Close the Utility

Using the Host to install the converted keys in the CKDS
16. Transfer the converted keys file to the host

17. Import the converted keys into the CKDS

18. Transfer the Rename keys file, if any, to the host

19. Use KGUP to rename any CUSP/PCF keys

A detailed explanation of each step follows.

Preparing the TKE Migration Utility Input

320

The first four steps that are listed for preparing the input can be performed in any
order, but they all need to be done prior to invoking the utility.

A reboot is needed once these steps are completed.

Note: Before preparing the TKE Migration Utility input ensure that the TKE
cryptographic adapter has been initialized for the appropriate environment
(passphrase or smart card).

Create a 4753 Backup File

Create a backup of the 4753 key storage by using the functions available at the
4753. Save the backup on diskettes. If your backup has more than one file, you
must copy all the files to the hard drive of the TKE workstation. You must not
change the file names or file extensions for the backup files.
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Prepare the Partial 4753 Master Key

4753 master key parts are stored on diskette, on personal security cards (PSCs), or
printed on paper. The 4753 Migration Utility supports the key parts stored on
diskette.

If you have PSC-based key parts, you must transfer them to files on a diskette. To
do so, use the TSS HIKM utility. See [‘Migrating from TKE Version 2 to TKE Version|

for instructions on using TSS HIKM.

If the key parts are printed on paper, you must enter them into the TKE using the

Cryptographic Node Management Utility (CNM). This is the procedure:

1. Open the CNM application by clicking on Trusted Key Entry, Applications, and
then clicking on Cryptographic Node Management Utility 3.10SC.

2. Select File =>Logon and log onto the crypto module with your User ID and Pass
phrase (TKEUSER for passphrase users and MIGUSER for smart card users).

3. Select Keys =>Primary DES Key Encrypting Keys.

4. Enter the key parts, one at a time, using this window.

Select First Part for the first key part. Select Default Importer as the key type.
Fill in the key label field and select . Use Middle Part for the last key part. Make
sure Default Importer is still selected, and the Key Label is the same as for the
first key part, and select Load.

Note: DO NOT USE THE LAST PART SELECTION.

This key is a partial key. Also, do not fill in the control vector field.
5. When finished, select Cancel.
6. Select File =>Logoff.
7. Close the utility.

Customize the Translation Table File
The Translation Table file controls the conversion in two areas:

» Recognition of compatibility key labels.
» Change of control vectors.

A sample Translation Table file is delivered by IBM. It is found in the Migration Utility
Data Directory as TranslateTable. TKE.

The format of a 4753 CUSP/PCF key label is:
compatibilityLabelMask=$$CUSP$$,
where $$CUSP$$ is the first qualifier of a 4753 CUSP/PCF key label.

An entry in the control vector translation table has three fields separated by
commas:

» 47583 Control Vector Mask Field
64 positions with either a 0, 1, or ? (question mark). The ? does not take part in
the match process.

* |ICSF Control Vector Mask Field
64 positions with either a 0, 1, or ? (question mark). The ? is a copy position and

takes the suggested control vector bit from the same location in the input key
token control vector.
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* 4753 Key Label Mask Field

Optional mask in the format of a TSS key label. The label can include ?’s and
match any single character.

For double-length keys, the control vector fields are for the left part of the control
vector. The right part of the control vector is constructed automatically from the left
part.

If you want to add more control vectors or modify the current definition of the
control vectors, make a copy of this file and update the copy. In general, you should
not edit the Translation Table file. To make a copy of the Translate Table use the
TKE File Management Utility. See ['TKE File Management Utility” on page 355| for
details.

If you will be editing the Translate Table, it is recommended that you rename the
original file to TranslateTableOIld.TKE and name the copy TranslateTable. TKE. This
file should remain in the Migration Utility Data Directory or on diskette. To edit the
new Translate Table use the Edit TKE Files task. See [‘Edit TKE Files” on page 351
for details.

Warning: If the file is saved to floppy you must deactivate the floppy drive before
removing the diskette. If the diskette is removed prior to deactivating the drive data
could be lost or corrupted. For details on deactivating media see [‘Managing Media’]

on page 393

If you have updated the Translate Table and have not saved it to diskette, ensure
that you have executed either Backup Critical Console Data or Save Upgrade Data
so changes are not lost when code is restored/reloaded or upgraded. See |“Backu5|
[Critical Console Data” on page 373 and [‘Save Upgrade Data” on page 378|for
details.

Establish Transport Key-Encrypting Key
A transport key-encrypting key must be established between the TKE workstation
and ICSF.

Before performing this step, you should have already customized TKE. You should
be familiar with TKE and ICSF, especially generating operational keys, using load to
queue, and loading operational keys to the CKDS.

CCF System: This procedure requires you to switch between the TKE workstation
and the ICSF panels on your host session.

1. Preliminary Tasks (TKE Workstation):

* Open the TKE V5.0 application and logon to the TKE Crypto Adapter (use
TKEUSER for passphrase and a profile mapped to SCTKEUSR for smart
card; page or.

* Select the host where the IMPORTER key will reside.

* Logon to the host (see page .

* Load a signature key if one has not already been loaded.
* Select and open the crypto module.

* Go to the Domains Keys page (see page .

2. Generate two or more key parts. Select Operational Key - IMPORTER at the
TKE workstation - see page

3. Install the key parts in the Crypto Adapter key storage (TKE workstation) - see
page
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Select Domains=>Keys=>Operational Key - IMPORTER. Right-click and select
Load to Key Storage.

Use Load First for the first key part and use Load Intermediate for the remaining
key parts, including the last key part.

Do not use Load Last when loading the last key part into the TKE
workstation key storage. This key is a partial key.

It is strongly recommended that the same key label name be used for the
transport KEK at the TKE (in the Crypto Adapter key storage) and at the host.

4. Load the key part to the host by using the Load to Queue function - TKE
workstation, see page [99

You are allowed to load multiple intermediate key parts.

5. Switch to the emulator session (open the Configure 3270 Emulators task. See
[‘Configure 3270 Emulator Sessions for TKE” on page 230| for details).

6. Logon to TSO

7. Import the key part to the CKDS as an IMPORTER key type using the ICSF
panels - see page

Steps 4 and 7 may be repeated as appropriate for the number of key parts.

8. After the final key part is loaded, refresh the CKDS using the ICSF panels - see
page [‘Refreshing the CKDS” on page 182

PCIXCC/CEX2C System: This procedure requires you to switch between the TKE
workstation and the ICSF panels on your host session.

1. Preliminary Tasks (TKE Workstation):

* Open the TKE V5.0 application and logon to the TKE Crypto Adapter (use
TKEUSER for passphrase and a profile mapped to SCTKEUSR for smart
card; page or

» Select the host where the IMPORTER key will reside.
* Logon to the host (see page .
* Load a signature key if one has not already been loaded.
» Select and open the crypto module.
* Go to the Domains Keys page (see page .

2. Generate two or more key parts. Select Operational Key - IMPORTER at the
TKE workstation - see page Save the key parts to binary file.

3. Install the key parts in the Crypto Adapter key storage (TKE workstation) - see
page
Select Domains=>Keys=>Operational Key - IMPORTER. Right-click and select
Load to Key Storage.
Use Load First for the first key part and use Load Intermediate for the remaining
key parts, including the last key part.
Do not use Load Last when loading the last key part into the TKE
workstation key storage. This key is a partial key.

It is strongly recommended that the same key label name be used for the
transport KEK at the TKE (in the Crypto Adapter key storage) and at the host.

4. Load the key parts to the key part register - TKE workstation (see [‘Load to Key
[Part Register - First” on page 123)

5. Switch to the emulator session (double click on the TKE Emulator Icon)
6. Logon to TSO

7. Import the key to the CKDS using the ICSF panels. See [‘Loading Operational|
[Keys to the CKDS” on page 199
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Reboot the TKE Workstation
After using the TKE workstation to create a Transport Key-Encrypting Key, you must
reboot in order to use the TKE Migration Utility.

Using the TKE Migration Utility

324

There are two main functions within the TKE Migration Utility:
* Analyze

The Analyze function examines each key token from a 4753 backup file. Input to
the analyzer is:

— One or more 4753 Backup files
— Translation Table file
— Exclude file (optional)

Output from the analyzer is a Conversion Control file and an Analysis Print file.

For each key token in the 4753 Backup file, the analyzer writes a record to the
Conversion Control file. This record includes the ICSF key label, the ICSF control
vector, and an operation code indicating whether or not the conversion process
must be performed.

The ICSF key label is the label as read from the 4753 backup file.
Convert

The Convert function converts keys encrypted under the 4753 master key to keys
encrypted under a transport key-encrypting key. Input into the converter program
is:

— 4758 Backup file

— Conversion Control file

— Transport KEK label (Workstation)
— Transport KEK label (Host)

— 4753 Master Key label

Output is:

— Converted Keys file
— Key List file

— Conversion Print file
— Rename file

Each entry in the Conversion Control file triggers several operations (as long as
the operation code value allows conversion):

1. The key record with the same key label is read from the 4753 backup file.

2. The control vector is changed to the ICSF control vector defined in the
conversion control file.

3. The key is translated from being encrypted by the 4753 master key to being
encrypted by the transport key-encrypting key.

4. The external token is written to the converted keys file together with other
information related to that key.

The 4753 and ICSF handle CUSP/PCF keys differently. Also, the key labels are
different. The Converter program recognizes a 4753 key token as a CUSP/PCF
key based on the key label. For these keys, a record is written to the Rename
file. The record includes information regarding the 4753 key label, the ICSF key
label, and the key type. The ICSF key label is the third qualifier of the 4753 key
label and the key type is the second qualifier of the 4753 key label. The Rename
file is used at a later step of the migration process.
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Starting the TKE Migration Utility
Click on Trusted Key Entry, Applications, TKE Migration Utility 1.5.

The 4753 Migration Utility is organized as a notebook with 5 pages:

* Analyze page - on this page, you define the analyze environment and start the
analysis.

» Convert page - on this page, you define the conversion environment and start the
conversion.

» Tools page - this page provides sub-pages for logging on and off the TKE crypto
adapter, for importing the 4753 master key parts, and for managing keys in the
TKE Crypto Adapter DES key storage.

» Statistics page - this page displays statistics for the analyze phase and the
conversion phase.

+ Activity Log page - all performed actions are logged, as are all errors. Output
from the analyze and conversion phases is logged.

Logon to the TKE Crypto Adapter

If you use the setup for TKE as delivered and you do not have a smart card setup,
you must logon as TKEUSER. TKEUSER is one of the predefined roles and
profiles.

If you use a smart card setup, you must logon as MIGUSER. MIGUSER is one of
the predefined roles and profiles created when the TKE workstation is initialized for
smart card support.

If you have modified or created your own roles and profiles, you may not be
required to logon to the TKE Crypto Adapter. Check the authorization required for
each step (see [‘Defining Roles and Profiles” on page 337) to determine what user
you need to logon to.

Go to the Tools page and select Logon/Logoff at the left tabs. Select the profile
and press the logon button at the right.
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IEM 4752 Migration Utility A
File Help
Logon / Logoff Available Crypto Adapter profiles
TKEADM Lagom
KEYMANL
KEYMAN2 Logoff
TKEUSER
Figure 387. 4753 Migration Utility Notebook — Passphrase setup
IBM 4753 Migration Utility 2 [ 4]
File Help
Logon | Logoff Available Crypto Adapter profiles
MIGUSER Lo
Logoff

Figure 388. 4753 Migration Utility Notebook — Smart card setup

Import the 4753 Master Key

If you imported the 4753 master key parts from the keyboard (your master key parts
had been printed on paper and you followed the steps in [‘Prepare the Partial 4753
[Master Key” on page 321), nothing needs to be done at this time.
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If the master keys parts are stored in files on the hard drive or on diskette, do the
following:

* Go to the Tools page and select Master Key Import at the left tabs.

» For importing the first master key part, select the First master key part radio
button and enter a valid Crypto Adapter key label. A key label has up to 5 fields
separated by periods, with each field being up to 8 characters. After pressing the
Import button, select the location (Floppy Drive or Migration Utility Data Directory)
and file name for the key part and press Master key import part.

» For importing the second master key part, select the Last master key part radio
button and enter the same key label. After pressing the Import button, select the
location (Floppy Drive or Migration Utility Data Directory) and file name for the
key part and press Master key import part.

Perform the Analysis

To perform the analysis, go to the Analyze page and specify the requested

information:

* 4753 Backup file - Select the 4753 backup file previously created
[4753 Backup File” on page 320).

+ Translation Table file - Select the translation table file you optionally modified
(‘Customize the Translation Table File” on page 321).

+ Exclude file - Optionally select an exclude input file. This file contains a list of
key labels that are not to be migrated.
An exclude file may be useful if you have several different 4753 backup files that
share a CKDS. After the first file is converted, a Key List file is created that can
be used on subsequent 4753 backup files. In that way, common keys would not
be converted a second time.

» Conversion Control file - Select the main output file of the analyze operation.
This file is used as input to the conversion phase.

* Analysis Print file - Select an analyze output file.

* 4753 Master Key label - Select the 4753 master key you previously imported
(‘Prepare the Partial 4753 Master Key” on page 321 or [‘Import the 4753 Master|
[Key” on page 326).

Start the Analyzer by pressing the Analyze button.

Notes:
1. Status bars are displayed that show your progress through the steps
2. There is no way to stop an Analyze or Convert once it is started

Warning: If the output files/input files are from a floppy you must deactivate the
floppy drive before removing the diskette. If the diskette is removed prior to
deactivating the drive data could be lost or corrupted. For details on deactivating
media see [‘Managing Media” on page 393
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L
C
[<

File Help
@ Analyze | 9 [ oot |
r Input
4733 Backup file: |CDA|]KDIR.I]I]1 =
Translation Table file: [TranslateTable. TKE =
Exclude file: [EXCLUDEDAT [ ]
- Output
Conversion Control file: [conctrl.dat =
Analysis Print file: [anapri.dat =
- Keys
4753 Master Key label: MIG4753.MK 7}

Figure 389. 4753 Migration Ulility Notebook — Analyze

Check the Results of the Analysis
When the Analyze function is complete, the Activity Log appears. It contains the
following information:

* Header Information

— File creation date and time

— Exclude file name

— Compatibility label mask

— Translate Table file name

— Conversion Control file name

— Analysis Print file

— Master key label and verification data
* 4753 Key label
» Statistics

Additionally, you can view the Analysis Print file for information regarding the keys
found in the 4753 Backup file. The Analysis Print file is a printable text file. The
Analysis Print file contains much of the same information as the Activity Log, with
the addition of key token entries and key types.

* Header Information
— File creation date and time
— Exclude file name
— Compatibility label mask
— Translate Table file name
— Conversion Control file name
— Analysis Print file
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— Master key label and verification data
* Key token entries
Sequence number
Conversion code, with the following meaning

00 — to be converted
01 — excluded because key label is found in Exclude file

02 — key token is not eligible for conversion (for example, key
register keys

03 — rejected because MKVN of key token is different from current
MKVN

04 — rejected because TVV or RVV of key token is not valid

05 — rejected because key token contains a NULL entry or has been
deleted

06 — rejected because more than one entry in Translation Table is
matching

07 — rejected because no entry in the Translation Table is matching
09 — internal logic error, reason unknown

4753 key label

Key type

MAC padding character (offset 05 in token)
Flag byte 1 (offset 06 in token)

Flag Byte 2 (offset 07 in token)

ICV (offset 08—15 in token)

4753 base control vector

4753 extended control vector

Conversion code in text format
 Statistics

The data remains in the Analysis Print file until it is either erased or written over by
a subsequent analysis.
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File Help

9 Analyze | 9 Convert | 3 Tools | O Statistics | O Activity Log

BEGIN ANALYZERUN - - - - - - - - - - = = - = - = - — o — o m o - - Date Thu Jul 21 13:45:59 EDT 2003

Reading Translate file with name = TranslateTable.TKE
21 translate masks has been read - 0 masks has been ignored...
Reading Exclude file with name = EXCLUDEDAT
Reading 4753 Backup file with name = CDAOKDIR.001
Master key "MU4733.MK verified with Key storage backup. MEKYN=08
SEQNO=2 '$$ CUSP$ $.EXPORTERXPP0O9201" has been excluded via Exclude file
SEQNO=3 "$$ CUSP$ $.EXPORTER.XPPO9202 has been excluded via Exclude file
SEQNO=4 '$3$ CUSP$ $.EXPORTERXPP09203 has been excluded via Exclude file
SEQNO=5 "$$ CUSP$ $.EXPORTER.XPP09204" has been excluded via Exclude file
SEQNO=6"$$ CUSP$ $.EXPORTER.XPPO9205" has been excluded via Exclude file
SEQNO=7 '$$ CUSP$ $.EXPORTERXPPO9206" has been excluded via Exclude file
SEQNO=8 "$$ CUSP$ $.EXPORTER.XPP09207" has been excluded via Exclude file
SEQNO=9'$$ CUSP$ $.EXPORTER.XPPO9208" has been excluded via Exclude file
SEQMO=11"AAADESYL.PINPRINT.PP49HS49.IMPOO000D' has been excluded via Exclude file
ISEQNO=12'ANSIDESV.AKEK.000ABC.AKE excluded because no CV translation entries match.
SEQMNO=13'ANSIDESV.AKEK.AKEDDD' excluded because no CV translation entries match.
SEQMNO=14 "ANSIDESV. AKEK. AKEDOL" excluded because no C\ translation entries match.
SEQNO=15"ASIS.ADMIN.EXPORTER.KEKDAD' has been excluded via Exclude file
SEQNO=16"ASIS.ADMIN.EXPORTER.KEKDADC' has been excluded via Exclude file
SEQMO=17"ASIS.ARKIV.IMPORTER.KEKSMA' has been excluded via Exclude file
SEQMO=18'ASIS.0PERA.CIPHER.KCO' has been excluded via Exclude file
SEQNO0O=19'ASIS.OPERA.CIPHER.KCOM1' excluded because null or deleted record
SEQMNO=20"ASIS.OPERA.CIPHER.KCOP1" has been excluded via Exclude file
SEQMO=21 "ASIS.OPERA.EXPORTER.KEKSNO' has been excluded via Exclude file
SEQNO=22"'ASIS.0PERA.IMPORTER. KEKDOP has been excluded via Exclude file

=23" ' i de file

|::5| »

Figure 390. 4753 Migration Utility Notebook — Activity Log from Analyze Function

A user can clear the Activity Log, if they so desire. In addition to the Activity Log,
you can view the statistics information.

File Help

3 Analyze r J Cohvert r 2 Tools & Statistics 2 Artivity Log |

Analyze Statistics
823 keys records in 4753 Backup file
invalid key entries {deleted or null tokens)
invalid Keys RYY or TV¥ failing)
invalid keys (MKYN does not match current Master Key)

[ |

817 valid key tokens in 4753 Backup file
0 keys excluded (key token flagl value)
16 keys excluded ¢(no CV mask match)
0 keys excluded (several CV masks matches)
709 keys excluded (Exclude file entries)

(=]

keys selected for conversion
CUSP/PCF keys found.

(X1

Figure 391. 4753 Migration Ulility Notebook — Statistics from Analyze Function

The Statistics page provides a summary of the Analysis and the following
information is provided:
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Number of key records in the 4753 Backup file

Number of invalid entries and a brief reason why they were considered invalid
Number of keys excluded and a brief reason for their exclusion

Number of keys selected for conversion

Number of CUSP/PCF keys found

Check the Conversion Control File
The Conversion Control file is produced during the analyze phase and used as
input for the conversion phase. The file has the following contents:

Header Information

File creation date and time

Exclude file name

Compatibility label mask

Translate Table file name

Conversion Control file name

Master key label and verification data

Key token entries
— Sequence number
— Conversion code, with the following meaning

- 00 — to be converted
- 01 — excluded because key Tabel is found in Exclude file

- 02 — key token is not eligible for conversion (for example, key
register keys

- 03 - rejected because MKVN of key token is different from current
MKVN

- 04 - rejected because TVV or RVV of key token is not valid

- 05 — rejected because key token contains a NULL entry or has been
deleted

- 06 — rejected because more than one entry in Translation Table is
matching

- 07 — rejected because no entry in the Translation Table is matching
- 09 — internal logic error, reason unknown

— ICSF key label
— |ICSF Control Vector

You are allowed to edit the Conversion Control file prior to the conversion. However,
it is strongly recommended that you do not edit this file unless you are extremely
familiar with the ICSF control vectors. To edit the Conversion Control file, use the
Edit TKE Files task. For example:

1.

Conversion Code - If you want to suppress the conversion of a certain key or if
you want to enable conversion of a key that the analyzer rejected, you can
change the code. If you want to enable a rejected key, you must also append
the ICSF control vector.

ICSF Control Vector - If you want a certain key to have a different control
vector, you can change it.

Perform the Conversion
To perform the conversion, select the Convert page and specify the requested
information:
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» Conversion Control file - Select the main output file of the analyze operation.

» 4753 Backup file - The filename is read from the Conversion Control file and
displayed for informational purposes.

» Converted Keys file - Select the output file that holds the converted keys. This
file is used as input to the import phase on the host.

* Rename file - Select a Rename file. This file is used as input for the KGUP utility
if CUSP/PCF keys are migrated.

» Key List file - Select an output file that holds a list of all converted keys. This file

can be used as the Exclude file in the analyze phase of a later migration
process. This file is always appended to; it is not overwritten.

» Conversion Print file - Select a conversion output print file.

+ Transport KEK label (workstation) - Select the workstation label for the
transport KEK you established in [‘Establish Transport Key-Encrypting Key” on|

* Transport KEK label (host) - Enter the host label for the transport KEK you
established in [‘Establish Transport Key-Encrypting Key” on page 322

» 4753 Master Key label - The label is read from the Conversion Control file and
displayed for informational purposes.

IBM 4753 Migraticon Utility ]
File Help
© 9 Anabyze | 3 Convert |3 Tools | 3 Statistics [ Activity Log |
- Input
Conversion Control file: |l:l:|nl:lrl.dal =
4733 Backup file: ICDAI]KDIR.I]I]l
- Output
Converted Keys file: [mvsoutdat =
Rename file: [rename.dat =
Key List file: [keysist.dat =
Conversion Print file: [convpre.dat =
- Keys
Transport KEK label Workstationy: [IMPORTER.FORMILKEY1010 =
Transport KEK label (Host: \IMPORTERFOR_MU.KEYlUll]\ |
4753 Master Key label: |[MU4753.MK

Figure 392. 4753 Migration Utility Notebook — Convert

Start the conversion by pressing the Convert button.

Notes:
1. Status bars are displayed that show your progress through the steps
2. There is no way to stop an Analyze or Convert once it is started

Warning: If the output files/input files are from a floppy you must deactivate the
floppy drive before removing the diskette. If the diskette is removed prior to
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deactivatin
media see

the drive data could be lost or corrupted. For details on deactivating

“Managing Media” on page 393

2 keys converted.
You may upload the following files ©o the host using a telnet 3270 session:

Converted Keys File: jconsole/tke/4753migrate/data/ mvsout.dat
Rename File: fconsole/tke,/d4733migrate, data/ rename.dat

Figure 393. 4753 Migration Utility Notebook — Convert

Check the Results of the Convert
When the Convert function has completed, the Activity Log appears.

File Help

Migration Utility

3 Analyze [ 9 Convert | J Tools | O Statistics | @ Adivity Log

BEGIN CONVERSIOM RUNM - - — - - - - - - - = — = = = = - = - === -~ Date Thu Jul 21 13:51:43 EDT 2005

2 keys converted

Reading Translate file with name = TranslateTable. TKE

21 translate masks has been read - 0 masks has been ignored...

Master key 'MU4733.MK verified with key storage backup. MEKYN=08

825 Key entries has been read - 0 has been excluded.

Key test on the Workstation IMPORTER, 'IMPORTER.FORMLU.KEY1010', produced a Random Mumber and YP.
'$$ CUSP$ §.EXPORTERXPPOO200' converted and written to export file.

"$$ CUSP$ $.IMPORTER.DB4711" converted and written to export file.

Cconvert Statistics

0 keys failed conversion

799 keys excluded &y Exclude file entries)

22 keys not converted (due to conversion code greater than 1)
0 keys not converted (due to CV parity erron

8213 total keys processed

0 keys forced to be converted (n the Conversion Code)

0 keys changed (in the suggested Control Vecton)

0 keys changed (in the suggested Control Yector Bxtension)

2 key labels written to the Rename file

You may upload the following files to the host using a telnet 3270 session:
Converted Keys File: jconsole/tke/4733migrate/data/ mvsoutdat
Rename File: [console/tke/4753migrate/data/rename.dat

and written to Converted Keys file

JE

Figure 394. 4753 Migration Utility Notebook — Activity Log from Conversion Function

It contains the following information:
* Results of the Convert
» Header information for the Convert, similar to the information produced from the

Analyze

function

» Key token entries for the Convert, same as the information for the Analyze
except that Base Control vector is for ICSF and the extended control vector is for

ICSF.

In addition,

you can view the Conversion Print file for information regarding the

results of the Convert. The Conversion Print file is a printable text file. At this point,
the Activity Log is no longer necessary and can be cleared.

Appendix J. Key Token Migration for the 4753 333



File

The Statistics page provides a summary of the Convert:

* Number of keys converted and written to the Converted Keys file

* Number of keys that failed to convert and a brief reason why

* Number of keys edited and how the keys are different from the Analyze
* Number of keys written to the Rename file

IBM 4752

Help

Migration Utility

J Analyze r J Convert |/ J Tools @ Statistics || 9 Adtivity Log |

823

Analyze Statistics
keys records in 4753 Backup file

invalid key entries (deleted or null tokens)

0 invalid keys WYY or TV\ failing)

1 invalid keys (dEVYMN does not match current Master Key)

valid key tokens in 4753 Backup file

keys excluded (key token flagl value)
keys excluded (ho CV mask match)

keys excluded (several CVY masks matches)

keys excluded (Exclude file entries)

keys selected for conversion

2 CUSP{PCF keys found.

(S — R — R — |

Convert Statistics
keys converted and written to Converted Keys file
keys failed conversion
keys excluded ¢y Exclude file entries)
keys not converted (due to conversion code greater than 1)

keys not converted (due to CV parity erron

total keys processed

keys forced to be converted ¢in the Conversion Code)
keys changed (n the suggested Control Yecton
keys changed (n the suggested Control Yector Extension)

key labels written to the Rename file

Figure 395. 4753 Migration Ulility Notebook — Statistics from Analyze and Convert
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Remove the Partial 4753 Master Key from the TKE Key Storage
When you have finished using the 4753 Migration Utility for all the 4753’s key
storage that needed to be converted, you should remove the 4753 master key from
the TKE key storage. To do this:

e Go to the Tools tab

» Select Crypto Adapter DES Key Storage
» Highlight the 4753 master key label

e Click delete
¢ Click Yes

Close the Migration Utility

Close the migration utility.
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Install Converted Keys into the CKDS

Upload Converted Files to the Host

The converted keys are now in the Converted Keys files. This is an EBCDIC file
that must be uploaded to the host. It must be uploaded as binary, using a
RECFM=FB, LRECL=225, blocked as appropriate (for example, 8360), to be read
by the Import utility.

Note: For TKE V4.0 and lower, LRECL is 209.

One way of transferring the Converted Keys files to the host is to use the File
Transfer selection from the File option on the Host session window.

1. Ensure that the host is at the Ready prompt (your TSO session from the
Configure 3270 Emulator task)

2. Click on File and then File Transfer

Figure 396. File Transfer

3. Local File Name is the name of the Converted Keys file (the entire path name
must be entered. This information can be found in the Activity Log)

4. Host File Name is the name of the dataset the Converted Keys file will be
loaded into on the Host

5. Select Send to Host
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Select Host is TSO

Select Transfer binary file

Select Record Format Fixed

LRECL = 225 (209 for TKE V4.0 and lower)
BLKSIZE = 8360

Click on Transfer File

- o 0 N

1
1

Import and Install Keys into the CKDS

Once the Converted Keys file is sent to the host, you must import the keys found in
the Converted Keys file and write the keys to the CKDS. The Import host program
performs the following functions for each key entry in the Converted Keys file:

1. The key is imported.

2. AKkey test verification is performed.

3. A CKDS entry is generated.

4. The internal token is written to the CKDS.

Sample JCL for handling the Import and install process is delivered by IBM. You will
need to customize this sample as needed for your installation. The sample is:
CSF.SAMPLIB(CSFTWCKD).

Notes:

1. ’Ensure the ANSI System Keys are in the CKDS (legacy systems) prior to
importing the Converted Keys.

2. If you have RACF profiles defined for your ICSF services in the CSFSERV
class, then the user executing the JCL must have the necessary RACF
authorization.

Upload the Rename File
If the 4753 Backup did not include CUSP/PCF keys, the Rename file is empty and
you can skip this step.

If the 4753 Backup included CUSP/PCF keys, it is necessary to rename these keys
in the CKDS by using the KGUP program. The Rename file holds the input to the
KGUP program. Upload the file to the host.

One way of transferring the Rename files to the host is to use the File Transfer
selection from the File option on the Host session window.

1. Ensure that the host is at the Ready prompt (your TSO session from the
Configure 3270 Emulator task)

2. Click on File and then File Transfer

3. Local File Name is the name of the Rename file (the entire path name must be
entered. This information can be found in the Activity Log)

4. Host File Name is the name of the dataset the Rename file will be loaded into
on the Host

Select Send to Host

Select Host is TSO

Select Transfer ASCII file
Select Record Format Fixed
LRECL = 80

BLKSIZE = 3120

Click on Transfer File

- o 0 No O

—_ -k
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Use

KGUP to Rename CUSP/PCF Converted Keys

For information on using KGUP, refer to [z/OS Cryptographic Services ICSH

[Administrator’s Guide,

Each

record in the Rename file has the following contents:

RENAME LABEL (current-key-label, new-key-label) TYPE(key-type)

The records in the Rename file are in the correct format for use as input to the
KGUP program. You should NOT edit the records in the file.

To use the Rename file in KGUP:
1. Choose 8, KGUP from the ICSF main panel
2. Choose 2, Data Set

a.
b.

The Cryptographic Keys Dataset Name is the name of your CKDS

The Control Statement Input dataset name specified is the name of the
Rename file on the host

The Diagnostics Dataset Name is the name of the dataset that will contain
the KGUP control statements and any diagnostics

The Key Output Dataset Name is the name of the dataset that contains the
key values that are generated to create complementary key values

The Control Statement Output Dataset Name is the name of the dataset that
contains control statements generated to create complementary key values

3. Choose 3, Submit (edit the job card as appropriate and submit)

Note: Special Secure Mode must be Yes for all systems when the job is

submitted. Make sure that Special Secure Mode (SSM) is Yes in the
ICSF Installation Options Dataset, the LPAR Activation Profile, and is
enabled in the ECM (via the TKE Domain Controls Page). See
[Controls Page” on page 140

"For 2990, z890, and z9-109, SSM is only enabled in the Installation
Options Data Set and on the KGUP panel.

4. Choose 4, Refresh

Defining Roles and Profiles

If you want to define specific roles and profiles for the 4753 Migration Utility, you
need to take into consideration the cryptographic services used for each of the
utility’s functions. The access control points required are:

* Analyze page:

Compute Verification Pattern - X'001D"
Load First Key Part - X'001B"
Combine Key Part - X'001C'

» Convert page:

Compute Verification Pattern - X'001D'
Load First Key Part - X'001B'

Combine Key Part - X'001C'
Re-encipher to Master Key - X'0012'
Re-encipher from Master Key - X'0013'
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» Tools, Logon/Logoff page:
— Force User Logoff - X'011B'
— Load Roles and Profiles - X'0116'
» Tools, Master Key Import - part 1:
— Generate Key - X'008E'
— Compute Verification Pattern - X'001D'
— Load First Key Part - X'001B'
» Tools, Master Key Import - part 2:
— Compute Verification Pattern - X'001D'
— Generate Key - X'008E'
— Combine Key Part - X'001C'
* Tools, Crypto Adapter DES Keys, Delete:
— Compute Verification Pattern - X'001D'
* Generally Used:
— Compute Verification Pattern - X'001D'
— Load Roles and Profiles - X'0116'
— Delete Role - X'0118'
— Delete User Profile - X'0117"

ICSF Services for Writing Keys to the CKDS

The ICSF services used for writing the converted keys to the CKDS are:
* CSNBKIM - Key Import

* CSNBKYT - Key Test

* CSNBKRC - Key Record Create

* CSNBKRW - Key Record Write

Checklist

To assist you in the migration, a checklist is provided. Fill in the various file names
as your migration progresses.
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Appendix K. Trusted Key Entry - Workstation Cryptographic
Adapter Initialization

Crypto Node Management Batch Initialization 3.10SC

The Crypto Node Management Batch Initialization 3.10 task allows the user to
execute user created scripts.

User defined scripts can be created using the CNI editor in the Cryptographic Node
Management Utility 3.10SC. Open the Cryptographic Node Management Utility
3.10SC. Click on File and select CNI Editor.

All scripts must be run from the floppy or CNM Data Directory. User created scripts
can be used to further initialize the TKE Crypto Adapter after passphrase or smart
card initialization has been done. For details on Initializing the TKE Crypto Adapter
for Passphrase or Smart Card [Initializing TKE for passphrase” on page 210 and
[‘Initializing TKE for smart cards” on page 217]

To execute a user defined CNI script, click on Trusted Key Entry, Applications, and
then Crypto Node Management Batch Initialization 3.10SC. The Select CNI file to
Run window is displayed. Select the location (Floppy Drive or CNM Data Directory)
and the file name of the CNI to execute. Click on Open.

Select (NI file to Run. =

=== =]

' Floppy Drive
® CNM Data Directory

Files

ppadm2.pro
pparoup.pro
pparp.cni
pparpl.pro
pparp2.pro
ppuserl.pro
PPUUSERZ.PRO
ppuser3.pro
ppusrl.pro
ppusr2.pro
ppusrgrp.pro
scadml.pro

[ b

ll

File Mame : pparg. chi

Open Cancel

Figure 397. Crypto Node Management Batch Initialization 3.10SC Task Window

The output window shows the operations performed. Select OK to exit this task.
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Created user profile PPADM 1
Created user praofile PRADM 2
Created user praofile PRADGEP1
Created user prafile PPUSEL
Created user prafile PRUSERZ
Created user praofile PRUSERS
Created user profile PFGREFPL
Created user role DEFAULT

OK

Figure 398. Crypto Node Management Batch Initialization 3.10SC Task Output Window

CCA CLU 3.10SC

The CCA CLU 3.10SC task is used for loading and checking code on the TKE
Crypto Adapter.

Note: CLU should only be executed when directed by IBM support.

To invoke the CLU Utility, click on Trusted Key Entry, Applications, then select CCA
CLU 3.10SC.

CLU Processing

When CLU is invoked, the Non-Factory Mode is displayed. You can select any
combination of CLU command check boxes.
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CCA CLU Utility 3.103C
File Yiew Help

[1¥] Check Coprocessor Status

| Load Owned Segment 1 ¢ce132200.clu)

[1¥] [Load Owned Segments 2 and 3 (cex310scclu)

[_] Validate IBM P/M 12R8245 Coprocessor Code ¢12r8245v.clu)

] Validate IEM P/M 12R8565 Coprocessor Code ¢(12r8565v.clu)

[ Zeroize and Un-own Segments 2 and 3 (crs31000.clu)

[_] Check System Status

Run

Figure 399. CLU Checked Check Boxes

When RUN is pressed, the commands will execute in the order they appear on the
application window.

Error . x]

The CLU command: csulclu cluout.log PL cr132200.clu
returned a non-zero return code.
See the Qutput Log and Command History windows for more information.

Figure 400. CLU Error

If a command fails, the commands checked after the failing command will not
execute and will remain checked.

After pressing the RUN button view the Output Log or the Command History to

check the output from the CLU commands. Both can be viewed by pressing the
View menu and then selecting Output Log or Command History from the menu.
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CCA CLU Utility 2.1085
File | ¥iew | Help

Output Log

I cH Command History

| Load Owned Segment 1 cel32200.clu)

| Load Owned Segments 2 and 3 (cex310scclu)

[ validate IEM P/N 12R8245 Coprocessor Code (12r8245v.clu)

[_] Validate IBM P/N 12R8565 Coprocessor Code ¢(12r8565v.clup

[ Zeroize and Un-own Segments 2 and 3 ¢crs31000.clu

[_] Check System Status

Figure 401. CLU View Menu

CSULCLU w200 cluout.log 5T begun Mon Aug 8 20:11:239 2005
FrEEEFEEREEE Command 5T started. ———- Mon Aug 8 20011:29 2005

*** %PD data; Parthlum = 12R6535

*** PO data;, EC Mum = 134484

*** WPD data, Ser Num = 94000041

*** %PD data; Description = [BM 4764-001 PCI-X Cryptographic Coprocessor
*** %PD data; mMfg. Loc. = 91

*** ROM Status; PIC ver: 28, EOM ver: a9

=% ROM Status; INIT: INITLALIZED

*** EOM Status; SEG2: RUNMAELE , OWNERZ: 2

*** ROM Status; SECG3: RUMMAELE , OWNERS: 2

*** Page 1 Certified: YES

*** Segment 1 lmage: 2.22 POST 1v2. 16 MB1vl. 25 FPCAWTS
200502150601322200000220000000000000000000000

*** Segment 1 Rewision: 322

*** Spgment 1 Hash: C16F 4102 0989 5 1FE 4FAS 44B6 2B2A 274E 04F4 2DF0
*** Segment 2 Image: 3,10 Linux 05 2002100807503 1000000000000000000000000000000
*** Segment 2 Rewision: 310

*** Segment 2 Hash: C6A5 2FC6 EBZA BECE 3154 4E44 4430 ABCZ D47 CEAF
*** Segment 3 Image: 2. 10.5C CCA 2005040811482 1060000000000000000000000000000
¥ Segment 2 Rewision: 210

*** Segment 3 Hash: 8150 F44B CDBAFSDS DICSS 8204 11A1 B176 EF92 3207
T Queny Adapter Status successful ===

CObtain Status ended successfulld

[FEEEFEEREEE Command ST ended, ---- Mon Aug 8 20:12:58 2005

FrerrEEres Command ST exited. ---- Mon Aug 8 2001318 2005

Clear Log File

4]

Figure 402. Output Log file
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mmand History

**F Segment 2 Image: 2.10.5C CCA 2005040811482 1060000000000000000000000000000
*** Segment 3 Revision: 310

*** Segment 3 Hash: 8150 F44E COBAFSDS DCS5 820A 1141 B176 EF92 3207

FFE Queny Adapter status successful =+

CObtain Status ended successfullbd
FreEEEeeesr Command ST ended. ---- Thu Aug 11 16:56: 44 2005

| ¥

...finishing up...
rrewRweress Command ST exited. Thu Aug 11 16:57:04 2005

CSULCLY 3. 00 cluout.log PL cex310sc.cly begun Thu Aug 11 16:57:04 2005
prrerEErsss* Command PL started. -———- Thu Aug 11 16:57:04 2005

"** Reload Segment 2 command Successful *%*

F** Feload Segment 2 command Successful ***

Microcode download ended successfulld

rreerrererr Command PL ended. ---- Thu Aug 11 17:02:06 2005

...finishing up...
rreerrerert Command PL exited. Thu Aug 11 17:02:26 2005

Figure 403. Command History

If all CLU commands complete without error, a message indicating that all CLU
commands completed successfully will be displayed.

Ok

Figure 404. Successful Completion of CLU Commands

Checking Coprocessor Status

Before loading code you should check the coprocessor status. To use the CLU
utility check status command (ST), you must select the "Check Coprocessor Status”
check box and then press the Run button.

View the results in the Output Log or Command History.

Loading Coprocessor Code
Only IBM Model 01 P/N 41U0441, 12R8245, and 12R8565 Crypto Adapters are
supported.
1. Change segment 1:
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a. If the segment 1 image name indicates ... Factory ...Set the application to
Factory Mode (File -> Factory Mode). The Factory Mode CLU window will
be displayed.

CCA CLU Utility 3.108C
File | View Help

[0 Factory Mode

or Status

Exit
t—cooaovwrcaocg MENt 1 Cel 32 200.clu)y

] Load Owned Segments 2 and 3 (cex310scclu

] validate IEM P/ 12R8245 Coprocessor Code ¢12r8245v.clu)

[ validate IEM P/N 12R8565 Coprocessor Code ¢(12r8565v.clu)

[_] Zeroize and Un-own Segments 2 and 3 (crs31000.clu)

[_] Check System Status

Figure 405. CLU File Menu

Reload segment 1 with the CCA segment 1 file cr132200.clu. Select the
"Load Factory Segment 1 (cr132200.clu)" check box and then press the Run
button.

b. If the segment 1 image name indicates ...CCA ..., and the revision level is
below 3.22, reload segment 1 with the CCA segment 1 file ce132200.clu by
selecting the "Load Owned Segment 1 (ce132200.clu)" check box and then
pressing the Run button.

Note: This choice is only available when the application is not in Factory
Mode (File -> Factory Mode).

2. Change segments 2 and 3:

a. If segment 2 ROM status indicates Unowned... Set the application to Factory
Mode (File->Factory Mode). For IBM 4764 Model 1 P/N 41U0441, select the
“Load IBM P/N 41U0441 Factory Segments 2 and 3 (chnw310sc.clu)” check
box and press the RUN button. For IBM 4764 Model 1 P/N 12R8245 and
12R8565, select the “Load IBM P/N 12R8245 and 12R8565 Factory
Segments 2 and 3 (cnw310sc.12r.clu)” check box and press the RUN
button.

b. If segment 2 and 3 ROM status both indicate owner 02... For IBM 4764
Model 1 P/N 41U0441, select the “Load IBM P/N 41U0441 Owned
Segments 2 and 3 (cex310sc.clu)” check box and press the RUN button.
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For IBM 4764 Model 1 P/N 12R8245 and 12R8565, select the “Load IBM
P/N 12R8245 and 12R8565 Owned Segments 2 and 3 (cex310sc.12r.clu)”.

Note: This choice is only available when the application is not in Factory
Mode (File -> Factory Mode).

3. When you have successfully completed this process, a check of the
coprocessor status or validate of the coprocessor code will indicate that the
segments contain:

Segment 1 Image: 3.22 POST1V2, MB1 V1.25 FPGAv78
Segment 2 Image: 3.10 Linux OS
Segment 3 Image: 3.10.SC CCA

View the results in the Output Log or Command History.

Validating Coprocessor Code

If you want to validate the code loaded on the Crypto Adapter use the CLU utility
validate command (VA). Select the appropriate check box for your Crypto Adapter
and press the Run button.

IBM 4764 Model 01 P/N 41U0441
Validate IBM P/N 41U0441 Coprocessor Code (41u0441v.clu)

IBM 4764 Model 01 P/N 12R8245
Validate IBM P/N 12R8245 Coprocessor Code (12r8245v.clu)

IBM 4764 Model 01 P/N 12R8565
Validate IBM P/N 12R8565 Coprocessor Code (12r8565v.clu)

View the results in the Output Log or Command History.

Checking System Status

If you want to check the system status of your Crypto Adapter, use the CLU utility
check system status command (SS). Select the "Check System Status" check box
and then press the Run button.

View the results in the Output Log or Command History.

Resetting Coprocessor

If you need to reset the Crypto Adapter use the CLU utility reset coprocessor
command (RS). You must enter Factory mode by clicking "Factory Mode" menu
item under the File menu. Then select the "Reset Coprocessor" check box and
press the Run button.

View the results in the Output Log or Command History.

Removing Coprocessor CCA Code and Zeroizing CCA

To Zeroize the CCA node and remove the CCA Coprocessor Code from segments 2
and 3, select the "Zeroize and Unown Segments 2 and 3 (crs31000.clu)" check box
and then press the Run button. This should result in the segment 2 and 3 ROM
Status indicated Unowned.

View the results in the Output Log or Command History.
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Help Menu

The CLU Utility has a help page. To view the contents of Help, select Contents from
the HELP menu.

CCA CLU Utility 3.105C
File V¥iew | Help

Contents
lj Check C processor ocallls

| Load Owned Segment 1 (ce132200.clu

] Load Owned Segments 2 and 3 (cex310scclu)

[ validate IEM P/N 12R8245 Coprocessor Code (12r8245v.clu)

[l validate IEM P/N 12R8565 Coprocessor Code ¢(12r8565v.clu)

[_] Zeroize and Un-own Segments 2 and 3 (crs31000.clu)

L] Check System Status

Figure 406. CLU Help Menu
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Appendix L. Trusted Key Entry - Utilities

Edit TKE Files

The Edit TKE Files task provides a way to edit/browse files on diskette, CD/DVD,
and within the four allowed TKE related data directories on the hard drive:

» TKE Data Directory

* Migration Utility Data Directory
* CNM Data Directory

* SCUP Data Directory

To open the Edit TKE Files task, click on Trusted Key Entry, Utilities, and then click

on Edit TKE Files.

To edit, select a file from the displayed list. If you enter a File Name manually that
does not exist, a new file by that name will be created in the location specified.

Note: Files on a CD can only be browsed. Writing to a CD is not supported.

) Floppy Drive
) CD{DVYD Drive
® Local Hard Drive

=== =3

TEE Data Directory

TKE Data Directory

Migration Utility Data Directory
CHM Data Directory

SCUP Data Directory

current_nmik_kKey
hostdat
OPKEY_EXPORTER
tke_pg.ser
trace.txt

[ »

1]

File Name : |Test.t}{t

Edit

Figure 407. Edit TKE Files Task Window

You will be prompted to confirm creation of a new file.
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Open Text Editor i

Testixt does not exist
Would vou like to create the new file now?

Yes || No

Figure 408. Confirm Creation of a New File Prompt Window

In this case, a file was created using the name Test.txt. You can edit the file within
the edit text box and use File -> Save menu item to save the file.

Edit  Style

Save Ctrl-5
Exit anple text typed in the edit window.

Insert Mode Char46 Ln1l Col 46

Figure 409. Editor - File menu items

Note: Before removing media that has been updated, you must first deactivate it
via the 'TKE Media Manager’ task. If the media is not deactivated before
removal, data may be lost.

The editor provides options for Undo, Cut, Copy, Paste, along with Line Selection
and Search/Replace.
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Style

Redo

Undo addition ©Cirl-2

Crel-¥

ned 1n the edit window.

Cut
Copy
Paste

Cirl-X
Ctrl-iC
CHrl-4

Select Line
Select All

Ctrl-L
Cirl-A

Find...
Replace...
Go To..

Ctrl-F
Cirl-R
Ctrl-i

Insert Mode

Char46 Ln1l Col 46

Figure 410. Editor - Edit menu items

In addition, there are options for Fonts, line wrap, and background.
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5 Testixt

File  Edit
| ® Normal . . .
This 15 | o pold d in the edit window.
012
® 14
D16

® Monospace
' Courier New
2 SansSerif

[0 ¥Wrap Lines

® Positive View

C Negative View

Insert Mode Char46 Ln1l Col 46

Figure 411. Editor - Style Menu Items

Migrate Previous TKE Version to TKE 5.0

354

This task is executed only when you have an existing TKE 3.0, 3.1, 4.0, 4.1, or 4.2
workstation and are migrating to TKE 5.0. It will migrate the default passphrase and
smart card roles and profiles, DES and PKA Key storages, Host.dat, Group.dat,
3270 emulator sessions, FCV, and TCP/IP information. Prior to executing this task,
you must execute the "TKE Backup’ on your existing TKE Workstation. After the
TKE Backup has been executed, if you have Customer defined roles and profiles
for your 4758 crypto adapter stored on the hard drive and you want them migrated,
manually copy the files to the TKE Backup diskette.

Note: Authority signature keys, Master key parts, and Operational key parts cannot
be migrated with this task.

Note: The floppy drive must be deactivated to successfully execute this task.
Check TKE Media Manager to ensure the floppy drive is deactivated.

To invoke this task, click on Trusted Key Entry, Utilities, and then click on
Migrate Previous TKE Version TKE 5.0.
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You will be requested to insert the TKE Backup diskette from the workstation you
are migrating from. Click OK.

TEKE Workstatf

Insert a TKE backup disk into the floppy drive.

Ok Cancel

Figure 412. Migrate to TKE Workstation 5.0 - Backup floppy prompt

Files migrated will be displayed in the Migrate to TKE Workstation 5.0 window.

Migrate to TKE Workstation 5.0 . 02X

Data Migration Progress

lActivating the floppy disk.

lActiwation of the floppy disk completed.
Festoring file: host.dat.

Restaring file: keystore aut

Restaring file: keymanl. pro

Restaring file: keymanl.rol

Restaring file: keyman2. pro

Festoring file: keymanZ.rol.

Restoring file: miguser.pro

Restoring file: miguser.ral

Restoring file: tkeadm.pro.

Restoring file: tkeadm42 rol

Restaring file: tkeuser. pro.

Restaring file: tkeusr42.ral.

Restaring file: sctkeadm. pra.

Restoring file: sctkeadm.rol.

Restoring file: sctkeusr.pro,

Restoring file: sctkeusr.rol

Restoring file: group. dat

Restoring file: desstare dat

Restaring file: desstare NDx

Restaring file: pkastore clat

Restaring file: pkastore NDX,

Restaring file: fov_usa.cr.

Restoring file: config.dat.

Restoring tn2270 session file: hme ws
Restoring tn2270 session file: pkedps 1ws.
Restoring tn3270 session file: pksthubl ws
Restoring tn2270 session file: pakwmtld ws
Restoring tn3270 session file: s380wm.ws,
Restoring tn3270 session file: tke.ws.

Exit
zSeries--ETKE: We BTKE: Tr [Command W Command W Captura b i Mon May 9 09:23:24 2005

Figure 413. Migrate to TKE Workstation 5.0 - Data migration progress window

The task is complete when the ’Exit’ button is no longer greyed out.

TKE File Management Utility

The TKE File Management Utility task allows you to manage files on diskette,
CD/DVD, or within the Supported Data directories. It provides the ability to Delete,
Rename, and Copy files.

To invoke this task, click on Trusted Key Entry, Utilities, and then click on TKE File
Management Utility.
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When the TKE File Management Utility is opened the user is presented with the
following task window.

=l x]
File
' Floppy Drive ) Floppy Drive
) CD{DVD Drive ) CD}DYD Drive
'@ Local Hard Drive M Local Hard Drive
| Migration Ltility Data Directory - |TKE Data Directory -

Files Files
TranslateTable. TKE current_nmk_key
host.dat

[copy > | OPKEY_EXPORTER
By trace.txt

| »
|»

ol
1]

| Delete | | Rename | Delete | | Rename

Figure 414. TKE File Management Utility Task Window

Selecting the hard drive for either Source or Target will allow the user to select from
one of four data directories:

» TKE Data Directory

* Migration Utility Data Directory
* CNM Data Directory

* SCUP Data Directory
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File Management Utility

File

]
O

[X

' Floppy Drive
' () CD/DVD Drive
' @ Local Hard Drive

|Migratinn Utility Data Directory V||

TKE Data Directory

CMNM Data Directory
SCUP Data Directory

TranslateTable.TKE Jisl

1]

| Delete | | Rename |

Figure 415. TKE File Management - Directory options

 Floppy Drive
! CD/DYD Drive
i® Local Hard Drive

|TKE Data Directory g

Files
current_nmik_key
hostdat
OPKEY_EXPORTER
trace.txt

[»

1]

Delete | | Rename

From the displayed list you can select a single file, numerous files, blocks of files,

or the entire display.
» For a single file, just click on it.

» To select more than one file click on the first file, hold down the Ctrl key and click

on each additional file.

» To select a block of files, click on the first file, hold down the Shift key and click
on the last file. All files between the two selected files will be selected.

» To select all the files, hold down the Ctrl key and type an’a’.

Selecting 'Delete’ will present a confirmation window.

Confirm

|B=1

=l

Are you sure you want to delete <FileMgmt=?

OK

Cancel

Figure 416. Delete Confirmation Window

Rename will present a window for inputting a filename.
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Enter a new name for <FileMgmt =,

File_Managerment

1], Cancel

Figure 417. Window for Inputting a Filename

Completion of Delete, Rename, or Copy will present a window similar to the
following.

Management Utility <]
File
' Floppy Drive ' Floppy Drive
' () CD{/DVD Drive ' CD/DVD Drive
! @ Local Hard Drive (@ Local Hard Drive
Migration Utility Data Directory - |TKE Data Directory -

TKE Data Directory

Migration Litility Data Directory
CNM Data Directory

SCUP Data Directory

TranslateTable.TKE

Files
current_nmk_key
hostdat

=Ry OPKEY_EXPORTER
Y trace.txt

D
D

1]
1]

| Delete | | Rename | Delete | | Rename

Figure 418. Completion Window

Warning: If updates are done to the floppy drive or DVD-RAM, the media must be
deactivated before it is removed. Otherwise the updates may be lost.

TKE Workstation Code Information

358

This task window shows information concerning the code used by the TKE
applications. This information can be useful in problem determination. Updates to
TKE Application code will be reflected within this window. This task does not give
information regarding the code on crypto card.

To invoke this task, click on Trusted Key Entry, Utilities, and then click on TKE
Workstation Code Information.
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TEE Wo

TKE Workstation built on: 775705 5:04 PM.

JAF. Matme Size (KE) Last Modified Date Built
sCCOMmman. jar 2549 FTHL2i05 12:10 AM (7f5705 237 PM -
tkejni.jar 128 FI12005% 12:10 AM (628105 1008 AM
tkaS0 jar 2319 FIL2 05 12:10 AM [7f5705 242 PM
tke_migrate. jar 220 F12/05 12:10 AM (672805 10:09 AM [ =

Figure 419. TKE Workstation Code Information window
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Appendix M. System Management - Service Applications

Analyze Console Internal Code

This task is used to work with temporary internal code fixes or to debug problems if
errors occur during a code fix install. This task should only be invoked by your IBM
Customer Engineer or when directed by IBM Product Engineering.

For details, refer to Maintenance Information for Desktop Consoles, GC28-6847.

Authorize Internal Code Changes

This task is used to verify or change the setting that allows using this trusted key
entry workstation to perform installation and activation of internal code changes and
other subsequent operations. This task should only be invoked by your IBM
Customer Engineer or when directed by IBM Product Engineering.

For details, refer to Maintenance Information for Desktop Consoles, GC28-6847.

Change Console Internal Code

This task is used to work with internal code changes for the trusted key entry
workstation. Code changes can be retrieved, installed and activated, removed, and
accepted. This task should only be invoked by your IBM Customer Engineer or
when directed by IBM Product Engineering.

For details, refer to Maintenance Information for Desktop Consoles, GC28-6847.

Hardware Messages

This task displays messages about hardware activity on the Trusted Key Entry
workstation.

When the green 'Status OK' icon (lower left corner of the TKE Console), changes to
the blue 'Status Messages' icon it indicates that a Hardware Message is pending.
The message can be viewed by clicking on the Status icon or by invoking this task.

To invoke the Hardware Messages task, click on System Management, Service
Applications, and then click on Hardware Messages.

Messages are listed from the oldest to the newest message, with the oldest
message displayed at the top of the list.

Date
Displays the date the message was sent.

Time
Displays the time the message was sent.

Message Text
Displays the message.
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TEE: Hardware I s | |

E Hardware Messages

Select | Date Time Iessage Text
O July 20, 2005 5:00:13 PM The following operation was attempted but failed: Backup critical hard disk information. It w
Details | Delete | Select All Messages | Deselect All Messages | Cancel | Help |
4 | ol

Figure 420. Hardware Messages window

Hardware messages notify you of events that involve or affect the TKE workstation
hardware or internal code.

To promptly view, act on, and delete messages:
1. Select a message, then click Details to display details.

TKE: Failure DIEES

'_..J Failure Details

Operation not performed.
missing media

_OK |

Figure 421. Hardware Messages - Details Window

2. If messages details are available and intervention is required, perform the action
recommended in the details.

3. To delete the selected message, click Delete.
A message is displayed until an action causes it to be deleted.

Some messages are deleted automatically after the message or its details are
displayed, if available. These messages generally provide information only, and are
deleted automatically because no further action is required.

Messages that require further action provide message details that include a
recommended action. The message and its details remain available until it is
deleted manually. This allows reviewing the message details to assist intervention.
But the message must be deleted when its information is no longer required.

Deleting messages provides greater assurance of displaying new messages as they
are received.

I Rebuild Vital Product Data
| This task is used to rebuild the Vital Product Data for the TKE machine.
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Transmit Console Service Data

This task is used to select the types of service data and the method to send the
data to aid in the problem determination.

To invoke this task, click on System Management, Service Applications, and then
click on Transmit Console Service Data.

pokpdl6: Transmit Service Data to IBM - Mozilla = m P
g@g Transmit Service Data to IBM
Select the data you want and the destination for the data.
Serviee Data Selections Service Data Destination
[« Trusted key entry console trace Dkt
= Trusted key entry console log & DVD-RAM

[~ Trusted key entry console latest compressed log
[~ Trusted key entry console all compressed logs
- Trusted key entry console log - truncated

Virtual RETAIN Files

= Froblem determination data Yirtual retain files for problem number: |0
Select Files
Mumber of files selected: il

Send | Cancel | Reset | Help |

Figure 422. Transmit Console Service Data - prompt for DVD

Service data is a set of program and event traces and storage dumps. The data in
the traces and the contents of storage assists in servicing the system.

Use this window only when directed by your service representative or IBM Support
Center. Select the service data categories requested by IBM. Service data in
selected categories is collected in a file or group of files for transmission to IBM.

Note: Some service data categories may not be available for selection. Such
categories appear grayed. This indicates that no data is available for that
category.

Service Categories:

Service Data Selections
Use the displayed categories in this section to select the types of service data
to send to IBM.

Service Data Destination
Use this section to specify how your service data is sent to IBM.

Virtual RETAIN Files
Use this section to copy to diskette or DVD-RAM selected virtual RETAIN files
for the specified problem number.

Note: You can select and copy virtual RETAIN files to diskette or DVD-RAM for
only a single problem number at a time.

Note: When using a DVD-RAM for service data it must first be formatted
specifically for Service Data. See ['Format Media” on page 389 for details.
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TEE: Transmilt

o Transmit Service Data

Insert a service data formatted DVD in the drive.
o not use the system backup or the code restore DVD.
Fequest cancel if you do not wish 1o confinue,

Figure 423. Transmit Console Service Data Task Window for DVD-RAM

If Diskette was chosen for the Service Data Destination, the following will be
displayed:

e Transmit Service Data

Insert a formatted diskette in the diskette drive,
Insure that the diskette is not write protected.
Fequest cancel if vou do not wish to continue.

0K || cancel |

Figure 424. Transmit Console Service Data - Task Window for Diskette

Successful completion will present the following window.

pokpdlé: Transmit Service Dat (2

o Transmit Service Data

The data has been written 1o the requested media.

Figure 425. Transmit Console Service Data - Successful completion
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For Virtual RETAIN Files, enter the problem number in the Virtual RETAIN Files for
Problem Number field and click on Select Files.

Transmit Sert Jata to LBM |

BOB0 - TEE:

Ql?ﬂ Transmit Service Data to IBM

Select the data you want and the destination for the data.

Service Data Selections Service Data Destination
[~ Trusted key entry console trace & Diskette
[OTrusted key entry console log  DVD-RAM
[~ Trusted key entry console latest comprassed log
Trusted key entry console all compressed logs
> T P d Virtual RETAIN Files

[~ Trusted key entry console log - truncated
[~ Problem determination data

Yirtual retain files for problem number: |1

Select Files

Number of files selected: 1

Send | Cancel | Reset | Help |

Figure 426. Update Problem Number for Virtual RETAIN File

Select the applicable Virtual RETAIN Files and click OK.

http://127. 0 ESEES

&
22
virtual RETAIN Files

] Cancel

Figure 427. Select the Virtual RETAIN Files

Select the Service Data Destination, Diskette or DVD-RAM on the Transmit Service
Data to IBM window.

Click on Send to transmit the selected Virtual RETAIN files to Media.

Insert the selected media when prompted.
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The selected data is being copied

to the selected media.

Figure 428. Copying Data to Selected Media

Successful completion will present the window displayed in [Figure 425 on page]
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Appendix N. System Management - Configuration

Customize Scheduled Operations

Use this task to customize a schedule for backing up critical hard disk information
to DVD.

It is very important to backup critical console data on a regular basis so the latest
system changes and updates are available for recovery situations.

Note: The DVD used for the Backup Critical hard disk information must be
formatted as ACTBKP. See Format Media for details.

TEE: Cus=to

Customize Scheduled Cperations

View - SOt Help =

All scheduled operations are currently displayed.

Femaining

zelect Target Date Time Cperation Repetitions

Figure 429. Customize Scheduled Operations Task Window

The Backup DVD is intended for use only during a hard disk restore operation
which completely replaces the contents of the hard drive. The hard disk restore
operation loads the system image from the installation DVD (shipped with your TKE
workstation) and then restores the data from the Backup DVD.

Included on the Backup DVD are any Microcode Fixes (MCFs) and Microcode
Loads (MCLs) that have been applied to the system. Also included is TKE related
data. After the restore/reload the system is back to the Service and TKE level of the
last backup.

Scheduled operations are helpful for situations where automatic, delayed, or
repetitious processing of system operations is necessary. A scheduled operation is
started at a specified time, without operator assistance to perform the operation. A
schedule can be set for one operation or repeated many times.

To open this task, click on System Management, Configuration, and then click on
Customize Scheduled Operations.

Click Options on the menu bar to select the following:

New
to create a new scheduled operation
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Delete
to remove a scheduled operation

Refresh
to update the current list of scheduled operations
Select All
to choose all scheduled operations currently displayed
Deselect All
to deselect all scheduled operations that were currently selected
Exit

to exit this task

When New is selected from the Options menu, the Add a Scheduled Operation
screen is displayed.

pokpdlé: Add a Scheduled SESiEpN

Add a Scheduled Cperation

Sefect an Operation

—elect

(e Backup critical hard disk information

CIE, | Cancel | Help |

Figure 430. Customize Scheduled Operations - Add a Scheduled Operation window

Clicking on the 'OK’ button will present the following screen where the Time, Date,
and Repetition of the operation can be specified.
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POEPDLE: Se » & Scheduled Operat :i_-:::urﬁ

I

(|
<

Set up a Scheduled Operation

Dade and Time

The scheduled operations will be created for the selected ohjects listed below:
POKPD1E
Select the date and time, and select a time window,

The scheduled operation will start during the time window that begins af the scheduled
date and time.

Date 4/7/30/05 | | e Window

Time 10:00:00 Ahd & 10 minutes ¢ 20 minutes ¢ 30 minutes
€ 40 minutes € 50 minutes ¢ G0 minutes

Save | Cancel | Help |

Figure 431. Customize Scheduled Operations - Set Date and Time window

=

Enter the date and time for a scheduled operation on the Date and Time window.
The time window defines the time frame in which the scheduled operation must

start.

After you have entered the Date, Time, and selected the Time Window, click on the

Repeat tab.

Select whether the operation is a single occurrence or will be repeated. Select

the

Days of the Week, you want to perform the operation. The Interval is the number of
weeks to elapse before the scheduled operation is executed again. Repetitions is

the number of times you want the scheduled operations performed.
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FOKPDLE: Set up a Scheduled Opera el el 2

below:
POKPD16

The scheduled operations will be created for the selected ohjects listed

Sirge ar Repealod

¢ Set up a single scheduled operation
@& Zet up a repeated scheduled operation

Days af ife Week

Options

™ honday [ Friday
M Tuesday W Saturday
™ Wednesday [T Sunday
[T Thursday

| Save | Cancel | Help ]

Interval 1 110 26

weeks

Fepetitions 1 E 1to 100

¥ Infinite repetitions

Figure 432. Customize Scheduled Operations - Set Repetition of operation

After all the information is selected, press the Save button to complete the

scheduling of the operation.

=LA
=3 Customize Scheduled Operations
Options»  VWiew=  Sortr  Helpw
Al scheduled operations are currently displayed.
. . Remaining
=elect | Target Date Time Cperation Repetitions
L pokpd16 Jun 22, 2005 9:42:47 AW Backup critical hard disk information 1

Figure 433. Completion Window for Adding Scheduled Operation
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=3 Customize Scheduled Operations

Options » Wiew w Sorte Help =

All scheduled operations are currently displayed.

Remaining
Repetitions
] PORPDIEG Jul 30, 2005 10:00:00 Ahkd Backup critical hard disk information Indefinite

Select | Target Date Time Operation

Figure 434. Customize Schedule Operations

Click Sort on the menu bar to sort how you want to view the list of scheduled
operations; By Date and Time, By Object, or By Operation. Date and time will sort
the list according to date in descending order with the most recent operation at the
top. By Object and By Operation have no meaning for TKE. The only object is TKE
and the only operation is Backup Critical Console Data.

Click View on the menu bar to select the following:

Schedule Details
to display schedule information for the selected scheduled operation. For TKE,
Object and Operation are not relevant.

New Time Range
to specify a definite time range (days, weeks, months, or displayed scheduled
operations) for the selected operation.

POKPDl6: Details | O [ %4

Jbject POKPD1E

Operation: Backup critical hard disk
infarmation

The operation is scheduled to start during the following time window.

Window begins at; Jduly 30, 2005
101841 AW EDT

Window length: 10 minutes

Femaining repetitions: Indefinite

Time interval hetween each repetition: 7 days

The operation was scheduled by HMC(TKEUSER) from POKPD16 an July
26, 2005 10:20:14 Ak EDT.

0K || Help

Figure 435. Details View of Scheduled Operation
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All scheduled operations are currently displayed.

Now Tine Ratge

7 =

¢ Days

¢ Wieeks

¢ Months

t# Display all scheduled operations

| Ik, | Reset | _ancel | Help |

Figure 436. New Time Range window for Scheduled Operation
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Appendix O. System Management - Maintenance

Backup Critical Console Data

This task performs the same function as the Customize Scheduled Operations for
Backup Critical Hard Disk Information. Rather than executing it as a scheduled
operation, this task will execute the Backup immediately. The backup critical data
operation copies critical files from the Trusted Key Entry workstation to the Backup
DVD-RAM.

To invoke this task, click on System Management, Maintenance, and then click on
Backup Critical Console Data.

TEE: Backup Critical Conscle Data Contl

I
[
[

% Backup Critical Console Data Confirmation

You have selected to backup critical data for the TKE.

Backup | Cancel | Help |

Figure 437. Backup Critical Console Data Window

The DVD-RAM for the Backup Critical Console Data task must be formatted with a
volume identification of ACTBKP, using the Format Media task.

% Backup Console Data Progress

Function duration time: 00:30:00
Elapsed time: 00:00:08
select | Object Mame Status

(% Backup Console Data  In progress...

8] 4 | Details... | Cancel | Help |

Figure 438. Backup Console Data Progress window - in progress

When the operation is complete the Status will be updated to indicate Success.
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% Backup Console Data Progress

Function duration time: Q03000
Elapsed time: 000124

zelect | Object Mame status
(% Backup Console Data | SUccess

OK || Details.. | | Cancel || Help ]

T

Figure 439. Backup Console Data Progress window - Success

| Lock console configuration
| This task is used to allow customers to lock the TKE console.

To invoke this task go to the Maintenance menu under System Management and
click on the Lock Console task.

Trusted Key Entry Console

& Maintenance
5 Meleome Cortains mantenarce tasks for managing the TRE system
o Trusted Key Entry
5
g 2 System Management il w2 | g |2 o

Service Applications

3 Configuration Bl ~ | Description =
ﬁ? Maintenance i Backup Critical Console Data Make backup of consale's critical data

= Format Media Format a diskette or DVD-RAM

< Hardware Messages Display hardware messages fram selected ohjects

& Lock Cansole Lock the console

E_y Offload Yirual RETAIM Data to DyYD-Rak Offload saved RETAIN problem data to DWD-RAM

L= Save Upgrade Data Save customizable data that is to be restored during an upgrade
& sShutdown or Restart Restart the application or shutdown/restart the consaole

a Users and Tasks Wiew the logged on users and their tasks

| Wiew Console Events Display console's event log

© view Consale Infarmation Display console's internal code change information

= view Console Service Histor Display console's service history

[# view consols Tasks Performed View record of console tasks performed by the console's users
2 view Licenses Read the open-source licenses for the product

Total: 13 Fi\téred: 13

Status: Messages

| Figure 440. Maintenance Menu
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This task prompts the user for a password in order to lock the TKE console.

Passwords can be up to any 12 characters except a space, backspace (\), *, and -.

If any of these characters are entered you will receive an error message.

Enter a password to lock the console with,

*
Password : 7|

| Confirm %

0]4 | Cancel |

Figure 441. Prompt for Password

The user must enter a password and confirm it. If either field is not entered the
following error is displayed:

Lock Console

Q The walue is reguired

Llose Message

Enter a password 1o lock the console with.

Passworg ;TP
Confirm: 4
QK. | Cancel |

Figure 442. Error if no Password is Entered
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If the password value entered does not match the value in the confirmation box the
following error is displayed:

Figure 443. Error if Password Entered Does not match Confirmation

Once you've entered a password value, confirmed it, and selected the OK button, a
screen saver will lock the TKE Console. To unlock the console, move the mouse or
touch the keyboard and you will be prompted for the password.

Trusted Key Entry Conscle
Console Password : 727 ?

Enter pa rd to unlock c

Figure 444. Prompt to Unlock Console

Each keystroke appears as a question mark on the password prompt. If the correct
password is entered, the user returns back to the TKE console. If an incorrect
password is entered, an error message will be displayed informing the user.

Offload Virtual RETAIN Data to DVD-RAM

376

This task is used to select, by problem number, specific virtual RETAIN data to
offload to DVD-RAM.

To invoke this task, click on System Management, Maintenance, and then click on
Offload Virtual RETAIN Data to DVD-RAM.

Note: The DVD-RAM must be formatted with volume identification label VIRTRET,
using the Format Media task.
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TEE: WVirtual RETAIMN Data QOffload

‘lé Virtual RETAIN Data Offload

EETAIN problem data will be offloaded to DY D-EAR.
1. Select a prohlem number: |1 TI

Z. Insert a DY D-RAR which is formatted with no volume label or a
volume label of VIBTREET.

3. Click "0K" to begin the offioad.
I, | Cancel | Help |

Figure 445. Virtual RETAIN Data Offload Window

After selecting the Problem Number click on OK. The selected virtual RETAIN data
is off-loaded to the DVD-RAM.

When the virtual RETAIN data is offloaded successfully, the following is displayed.

TEE: Virtual RETAT [EES

0 Virtual RETAIN Data Offload
COffload of Yirtual RETAIN Data to DVD-RAM was successful,

Figure 446. Successful Offload of Data

If you insert a DVD-RAM that has not been formatted or has the wrong label, the
following errors will be displayed, respectively.

TEKE: Virtual RETAIN Date

‘® Yirtual RETAIM Data Offload

Error mounting, unrecognized filesystem...possibly unformatted media

L OK |

Figure 447. Virtual RETAIN Data Offload Unformatted Media Error
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KEE: Virtual EETAIMN Data

‘® Virtual RETAIN Data Offload

Format DWD-BEAR with VIETEET as volume label,

L

Figure 448. Virtual RETAIN Data Offload Wrong Label Error

Save Upgrade Data

The Save Upgrade Data task is used when a Customer is upgrading to a new TKE
image. The task should only be executed when an Engineering Change (EC)
upgrade or Miscellaneous Equipment Specification (MES) instructs you to save the
Trusted Key Entry workstation’s upgrade data.

All data pertinent to the TKE workstation (ie. TKE related data directories, emulator
sessions, TCP/IP information, etc.) will be saved. Upgrading the Trusted Key Entry

workstation requires saving its upgrade data before installing new EC or MES code,
then restoring the upgrade data afterwards.

To invoke this task, click on System Management, Maintenance, and then click on
Save Upgrade Data.

TEE: Save Upgrade Data

i% Save Upgrade Data

Select either Save to hard drive or DWD-EAk, To Save to DWVD-BAR,
insert the Upgrade Data readiwrite DY D-BAR into the DD 1
drive, then click "OK".

@ Save o hard drive
 Save to DVD-RAM '

Ok | Cancel | Help

Figure 449. Save Upgrade Window

Some upgrade procedures save and restore the Trusted Key Entry workstation’s
upgrade data automatically, and there is no need to use this console action.
Otherwise, if you are following an upgrade procedure that instructs you to save the
Trusted Key Entry workstation’s upgrade data, you must use this console action to
save it manually.

Note: The DVD-RAM for this task must be formatted with a volume identification
label of ACTUPG, using the Format Media task.
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o Save upgrade data completed

The Save of Upgrade data has been

successfully completed to the hard
drive.

_OK |

Figure 450. Save Upgrade Success Window

Note: While the Save to DVD-RAM option is available for Save Upgrade Data, it

should not be used. The restore of Upgrade Data from a DVD-RAM is
currently not supported.

Shutdown or Restart

This task allows you to restart the application/console or power off.

To invoke this task, click on System Management , Maintenance, and then click on
Shutdown or Restart.

TEE: Shutdown or Restari O]

(!) Shutdown or Restart

Lo wou want to restart the application,
restart the console, or power-off the console?

(¢ Festart application
" Festart console
" Power-off'shutdown console

oIk, | Cancel | Help |

Figure 451. Shutdown or Restart Task Window
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Restart Application
To close the Trusted Key Entry workstation and restart the application, select
Restart application.

Restart Console
To close the Trusted Key Entry workstation, perform a system power-on reset,
and restart the console, select Restart console.

Power Off/Shutdown Console
To close the Trusted Key Entry workstation, shut down the operating system,
and power-off the hardware, select Power-off/shutdown console.

Selecting any option will present you with a confirmation window similar to
Figure 452

TEE: Confirm Shutdowt

d) Confirm Shutdown or Restart

Do you want to continue?

Ves| ND|

Figure 452. Confirmation Window

Users and Tasks

380

The Users and Tasks task window displays the users and running tasks on the TKE
Workstation and allows you to Switch to a currently running task or Terminate a task
that perhaps won’t complete.

You can only switch to System Management type tasks. If you attempt to switch to
a Trusted Key Entry task (Applications and Utilities) you will be presented with a
window stating 'This function is not available for Trusted Key Entry tasks. Switch To
only works with System Management tasks’.

The Terminate option can be used to terminate either Trusted Key Entry tasks or
System Management tasks. The only exception is the Trusted Key Entry CCA CLU
3.10SC task. If you attempt to terminate CLU from this task you will be presented
with a window stating "You can not terminate the CCA CLU Utility from the Login
Details and Task menu. If you need to terminate CLU you must use the Exit option
of the CLU Utility.’
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‘@ Users and Tasks

The following is the list of users currently logged on. The table below lists all tasks running in the system.

Users Logged On
Session Id | User Name | Logon Time Running Tasks | Access Location  MNotes
1 TKEUSER | 8/25/05 917 AM 2 | At console This is your gession

Bunning fasks

Select Task Id | Task Mame 'Targets [Session Id | Start Time
& 3 Users and Tasks i BI25/05 10052 AM
C 9 Trusted Key Entry 5.0 1 B/25/05 10:52 AM

Switch To | Terminate \

Close

Figure 453. Login Details Window

View Console Events
This task displays console events logged by the Trusted Key Entry.

To invoke this task, click on System Management, Maintenance, and then click
View Console Events.

Yiew Console Events

Vieww | Helpw
Date Time Console Event
05/06/2005 15:54:56 230 Upgrade data was saved
05/068/2005 1541:43.150 Backup critical data ended
05/068/2005 15:13:10.790 Backup critical data started
05/068/2005 11:57:36.660 Backup critical data ended
05/06/2005 11:34:16.020 Backup critical data started
05/06/2005 00.01:00410 Root password on LINUX updated
05/05/2005 14.31:52.750 An Authorize Internal Code Changes request of Enable for HMC TKE 222227227 and all its defined object:
05/05/2005 13.16:46.780 User TKEUSER was logged on automatically
05/05/2005 131646510 User TKEUSER has logged on in TKEUSER mode
05/05/2005 13:168:36.100 The Hardware Management Console Application (HWMCA) was initialized
05/05/2005 13:16:36.080 Root password on LINUX updated
05/06/2005 13:16:35.390 A user password was changed
05/04/2005 17:02:57 840 User TKEUSER with sessionid utl hmesession 1 has requested to Power-off the Conscle
05/04/2005 1112468 790 User TKEUSER was logged on automatically
05/04/2005 1112468 520 User TKEUSER has logged on in TKEUSER mode
05/04/2005 11:12:36.290 Root password on LINUX updated
05/04/2005 11:12:35.870 The Hardware Management Console Application (HWMCA) was initialized
05/04/2005 11:12:35.360 A user password was changed.
05/03/2005 17.23115.110 User TKEUSER with sessionid ulil hmesession 1 has requested 1o Power-off the Console.
05/03/2005 17.19:26.500 User TKEUSER was logged on automatically
Page 1 of 11 | ,1_ﬂ Total: 205 Displayed: 20

=~ =

Figure 454. View Console Events Window
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The Trusted Key Entry Workstation automatically keeps a log of significant
operations and activities, referred to as console events, that occur while the
application is running.

This window initially displays all console events currently logged and lists them in
reverse order of occurrence (from the most recent event to the oldest event). The
options under View on the menu bar allow you to change the number of events
listed or to change the order the events are listed, select your preference:

* To change how many events are listed change list's time range, by selecting
Using a different time range

* To list events from the oldest event to the most recent, select In order of
occurrence

* To list events from the most recent event to the oldest event, select In reverse
order of occurrence

e To close the window, select Exit.

View Console Information

382

This task shows the Machine Information (Type, Model Number, and Serial Number)
and the Internal Code Change History. The information contained here may be
useful in problem determination.

To invoke this task, click on System Management, Maintenance, and then click on
View Console Information.

Information

‘o View Console Information
1

Machine Information

Type: 2084

hodel number: A4

Serial number; 000000012345

Internal Code Change Information

[EC Retrieved |Installable | Installed | Activated 'Aooepted [Remavable |Removed |
| Nurmber | Level | Concurrent | Level | Level Level Concurrent | Level

O G54126

(& Gs4128

[ Gs4129

Details...
Ok || Help

Select

Figure 455. View Console Information Window

For additional information about an internal code change, select an EC number,
then click Details.
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o Internal Code Change Details

Selected Internal Code Change ftem

Fart number: 12R9153
' | Engineering change number.  G34128
Engineering change type: Base ECs

Engineering change description: Trusted Key Entry Code

Internal Code Change State Details

Type Level Date Time
Retrieved

Installed

Activated

Accepted

Femoved

Figure 456. Internal Code Change Details Window

EC Number
Displays the engineering change (EC) number of the internal code change.

Retrieved Level
Displays the internal code change level that was most recently copied to the
console, making it available for installation.

Installable Concurrent
Displays the highest retrieved internal code change level that can be installed
and activated concurrently. That is, you can install and activate all change
levels retrieved for this console, from the current installed level up to and
including the installable concurrent level, without disrupting the operations of
this console.

Installed Level
Displays the internal code change level that was most recently prepared for
activation as a working part of the licensed internal code of the console.

Activated Level
Displays the internal code change level that was most recently activated as a
working part of the licensed internal code of the console.

Accepted Level
Displays the internal code change level that was most recently made a
permanent working part of the licensed internal code of the console.
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Removable Concurrent
Displays the lowest installed internal code change level that can be removed
such that the remaining installed change level can be activated concurrently.
That is, you can remove all change levels installed for the console, from the
current installed level down to and including the removable concurrent level,
and then activate the change level that remains installed without disrupting the
operations of this console.

Removed Level
Displays the internal code change level that will remain installed and become
activated when the console is activated again, while the installation of all more
recent change levels is undone.

| View Console Service History

384

The View Console Service History is used to review or close problems that are
discovered by Problem Analysis. A problem is opened when Problem Analysis
determines service is required to correct a problem.

To invoke this task, click on System Management, Maintenance, and then click on
View Console Service History.

http://127.0.0.1:8080 - TKE: Service History

Service History ‘

ifieww Close» Sotv  Helpw ‘

Select Date Time Systemn Mame | Froblem Number | Status | Desoription
& 2006-03-01 22522 PM TKE 2 Closed  Licensed internal code problem
& 2005-03-01 22021 PM TKE 1 pen Licensed internal code problem

Figure 457. View Console Service History window

Each record of a problem includes detailed information about the problem and
indicates whether the service required to correct the problem is still pending (Open),
is already completed (Closed), or no longer needed (Closed).

View on the menu bar:

* Problem summary lists information about the problem and what actions are
needed to diagnose and correct it.
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http://127.0.0.1:8080 - TEE:

i

=| Service History

=ystem name: TKE

Machine type: 2084

hMachine model: ADd

Machine serial number: 00a000012345
Froblem management hardware (FMH) number:

Froblem number: 2

Froblem type: 1

Froblem data:

Date Time Froblem State
2006-03-01  02:2527  FProblem detected
2006-03-01  02:25:35  Customer notified

5 Hmp|

Figure 458. Problem Summary

* Problem Analysis Panel shows System Name, Date and Time, Problem
Description, Corrective Actions that a user can take and impact of repair.
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‘127.0.0.1:8080 - TEE: Proklem Znaly

Problem Analysis

System name; TKE
Catea: Mar 1, 2006
Time: 2:25:22 PM

Problem Description

Licensed internal code has detected a problem.

Corrective Actions

It may be possible to restart the console. The internal code requires corrective action.

Service is required.

Impact of Repair

Display Service Information...§| Cancel | Help |

Figure 459. Problem Analysis

If you click Display Service Information you will see the following window.

Problem Analysis

For service, call:
Feport the following information for this problem:

Machine type: 2084

rMachine model. A0

rachine serial number: 000000012345
Froblem type: 1

Froblem number: 2

Froblem data;

Reference code: EFCEO105-00004570

Figure 460. Display Service
» Cancel exits this task and returns to the Trusted Key Entry Console.

Click Close on the menu bar and then select the following:
» Selected Problem changes the status of a problem from Open to Closed
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» All Problem changes the status of all open problems to closed.

View Console Tasks Performed

The View Console Tasks Performed task window shows a summary of the console
tasks performed with the date and time associated with each task. The most recent
tasks invoked are appended to the bottom of the list. This information is useful in
determining past activity performed on the TKE Workstation for auditing or problem
determination.

To invoke this task, click on System Management, Maintenance, and then click on
View Console Tasks Performed.

You must scroll the display to the right until you see the inner right hand scroll bar
for moving the display up and down.

.......... ...05:‘06105 13 58 38Network Dlagnoshc \nfor‘ma.tlon(base 1a5k ne1d|ag)
.......... ...05/06/05 13:68:41 Transmit Gonsole Service Datalbase task ransmitcsd)
.......... ...05/06/05 13:58:45Configure 3270 Emulators{base task cig3270)
.......... ..05/06/05 13:68:53Customize Console Date/Time{base task datetime)
05/06/05 13:58:56Customize Network Setfings{com ibm hwmca base setings network NetworkSettingsTasklet)
.......... ...05/06/05 13:58:08Customize Scheduled Cperationstbase task schedopsc)
05/06/05 13:558:24 TKE Media Manager(tke java. mediamanager mediamanager sh)
.......... ..05/06/05 13:65:25TKE File Management Uility{tke java filemanager filemanagsr sh)
05/06/05 14:00:38Login Details and Tasks(base fask tasklist)
.......... ..05/06/05 14:03:15TKE File Management Uility{tke java filemanager filemanagsr sh)
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Figure 461. View Console Tasks Performed window

View Licenses

This task is used to view the open source licenses for the Trusted Key Entry
Console.

Licenses that can be viewed include:

* Embedded Operating System Readme File

» Eclipse Help System Readme File

* Adobe Reader License

* Mozilla Firefox Browser License

* Opera Browser License

* International License Agreement for Non-Warranted Programs
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« Additional License Information

To view a specific license, click on it. When you are done viewing the license
information click on OK to exit.

If you have not viewed any license information thru this task, the first TKE related
task that you invoke will display the license information. This will only be done once.

View Licenses

The Licensed Internal Code ("LIC") is subject to the IBM Agreement
for Licensed Intermnal Code. LIC does not include programs and
code provided under separate license agreements, including but not
limited to open source license agreements. For notices and licenses
follow the links below. Press the Ok button to continue.

o Embedded Operating Svstem Readme File

¢ Eclipse Help Svstem Beadme File

¢ Adobe Beader License

e [Mozilla Firefox Browser Licensea

o Opera Browser License

¢ nternational License Aqreegment for Mon-‘Warranted
Frograms

e Additional License Information

K]

Figure 462. View Licenses window
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Appendix P. Media Devices

Format Media

Warning: Prior to formatting any media, ensure that the applicable Floppy or
DVD-RAM drive is deactivated in the TKE Media Manager. If the media is not
deactivated, the format will fail.

To invoke this task, click on System Management, Maintenance, and then click on
Format Media.

Note: Format Media is also available under System Management, Service
Applications.

The Format Media task is used to format DVD-RAMs and diskettes only.

P

Media

=elect the desired media format.
& Format DWD-E AR
" Format diskette

K, | Cancel | Help |

Figure 463. Format Media Task Window

Depending on what the DVD-RAM will be used for will determine how the
DVD-RAM is formatted and what label is written on it.
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TEE: Forma

[] Format bvD-RAM
select the appropriate format type for the DVD-FAM.

® Backup/restore

¢ Trusted Key Entry data
" Service data

¢ Upgrade data

 Virtual RETAIN

Format | Cancel | Help |

Figure 464. Format DVD-Ram Window

Table 18. Allowable labels when formatting DVD-RAM

Format Label
Backup/restore ACTBKP
Trusted Key Entry data TKEDATA
Service data SRVDAT
Upgrade data ACTUPG
Virtual RETAIN VIRTRET

The DVD-RAM label is automatically written to the DVD.

ACTBKP
This formatted DVD-RAM is used in the Backup Critical Console Data task and
the Customize Scheduled Operations task. To choose this format type, select
Backup/restore.

TKEDATA
This formatted DVD-RAM is used in the TKE File Management Utility and Edit
TKE Files tasks. TKE data can be related to TKE, SCUP, CNM, the Migration
Utility, or user defined. To choose this format type, select Trusted Key Entry
data.

SRVDATA
This formatted DVD-RAM is used in the Transmit Console Service Data task. To
choose this format type, select Service data.

ACTUPG
This formatted DVD-RAM is used in the Save Upgrade Data task. To choose
this format type, select Upgrade data.

VIRTRET
This formatted DVD-RAM is used in the Offload Virtual RETAIN Data to
DVD-RAM task. To choose this format type, select Virtual RETAIN.
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If the DVD-RAM is not inserted into the DVD drive when the format is selected, you
will get the error 'DVD-RAM not ready. DVD is not properly inserted.' Insert the
DVD-RAM and click Format.

After the format is completed the following screen will be presented.

TEE: Format Media Completed =i

ﬂ Format Media Completed

Format DYD has been successiully completed.
Ok |

Figure 465. Format Completed Window

To format a diskette simply select 'Format diskette’ on the Format Media screen.

=IL].x

=elect the desired media format.
¢ Format D D-E AR
& Format diskette

K, | Cancel | Help |

Figure 466. Format a Diskette

You can either specify your own label or choose to have no label on the diskette. To
specify your own label enter up to 11 characters in the Label field. If you do not
want a label on the diskette, leave the Label field blank. Click on ’Format’ button.
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TKE: Format Digkette O

El Format Diskette

Insert a diskette to be formatted and select a format type.
Farmat Tvpe

& Lser specified label

Labaf

Type a label, up to 11 characters, or leave blank for no label.

Format | ancel | Helg |

Figure 467. Specifying a Label on Diskette

After the format is completed, the following screen will be presented.

TEE: Format Media Completed - [

ﬂ Format Media Completed

Format Diskette has been successiully completed.

ok |

Figure 468. Format of Diskette successfully completed

TKE Media Manager

392

The TKE Version 5 workstation allows the use of the following media devices:
* Floppy Disk

* Compact Disc

+ DVD-RAM Disc

TKE 5.0 is shipped with one TKEWS Binary Keys diskette and one Backup
DVD-RAM disc. The diskette is provided for saving and backing up TKE related files
in the TKE data directories. The DVD-RAM disc should be used to backup critical
console data only. If you would like to use a DVD-RAM for saving or backing up
TKE related files, you will need to supply your own.
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To invoke this task, click on Trusted Key Entry, Utilities, and then click on TKE
Media Manager.

Managing Media
Before accessing or updating an inserted floppy or DVD-RAM/CD-ROM media from
any of the Trusted Key Entry (Applications and Utilities) tasks, the media must first
be activated using the "TKE Media Manager”. The "TKE Media Manager” is located
under "Trusted Key Entry”, "Applications” and "Utilities”. From the "Select
operation” drop down menu, you can activate media that is currently deactivated, or
deactivate media that is currently active by selecting the desired operation and
clicking the "OK’ button. After the operation is finished, the "TKE Media Manager”
will update the status of the corresponding drive. Select the cancel button to exit the
"TKE Media Manager”.

Note: To execute the Migrate Previous TKE Version to TKE 5.0, the floppy drive
must NOT be activated. If it is, the migrate will fail.

TEE Media Manager

Floppy Drive Status: Deactivated DVD Drive Status: Deactivated

Eefore accessing or updating an inserted floppy or DVD media from any of the Trusted Key Enury (Application and Utilities) tasks, the media
must first be activated using this task.

Important notes:

1. Activation/ Deactivation is required ONLY for Trusted Key Entry (Applications and Utilities) tasks. This action locks the media for TKE tasks,
therefore System Management tasks CANNOT be performed until the media is deactivated.

2. When the TKE tasks have been completed, the media MUST be deactivated BEFORE the media is removed from the drive. If the mediais
not deactivated properly, updates may be los.

Select operation:
Activate read only CD/DVD inserted in DVD drive -

Cancel

Figure 469. TKE Media Manager

Important Notes:

1. Only DVD-RAM and CD-ROM disks are supported. The DVD-RAM is R/W while
the CD-ROM is R/O. DVD-RAM format is single-sided Type Il (4.7GB).

2. Activation / Deactivation are required only for Trusted Key Entry (Applications
and Utilities) tasks. This action locks the media for TKE tasks; therefore System
Management Tasks cannot be performed until the media is deactivated.

3. When the TKE tasks have been completed, the media must be deactivated
before the media is removed from the drive. If the media is not deactivated
properly, updates may be lost.

Note: If the CD/DVD aren’t deactivated the drive will remain locked and cannot
be used by any System Management tasks.

4. If a media device is inserted but not activated, and you select to use the device
with a TKE application, the application will attempt to activate the device. Even
though the media was not activated directly with the TKE Media Manager, the
media must still be deactivated using the TKE Media Manager before it is
removed.

5. Any media activated in the DVD-RAM/CD-ROM drive will not eject until the drive
is deactivated. You must use the TKE Media Manager to deactivate a drive.

6. If a floppy disk is ejected without deactivating the drive, your disk may not retain
output written to it and may become corrupted. It is necessary that you
deactivate the floppy drive before you eject your floppy disk.
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Warning: Even if you are using the media for input only, the media must be
deactivated before it is removed. If the media is not deactivated before it is
removed, new media inserted may not be handled correctly.
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Appendix Q. Accessibility

Accessibility features help a user who has a physical disability, such as restricted
mobility or limited vision, to use software products successfully. The major
accessibility features in z/OS enable users to:

» Use assistive technologies such as screen readers and screen magnifier
software

» Operate specific or equivalent features using only the keyboard
» Customize display attributes such as color, contrast, and font size

Using assistive technologies

Assistive technology products, such as screen readers, function with the user
interfaces found in z/OS. Consult the assistive technology documentation for
specific information when using such products to access z/OS interfaces.

Keyboard navigation of the user interface

Users can access z/OS user interfaces using TSO/E or ISPF. Refer to |z/OS TSO/H
[Primen, |z/0S TSO/E User’s Guide, and [z/0S ISPF User’s Guide Vol | for

information about accessing TSO/E and ISPF interfaces. These guides describe
how to use TSO/E and ISPF, including the use of keyboard shortcuts or function

keys (PF keys). Each guide includes the default settings for the PF keys and
explains how to modify their functions.

z/0S information

z/OS information is accessible using screen readers with the BookServer/Library
Server versions of z/OS books in the Internet library at:

[www.ibm.com/servers/eserver/zseries/zos/bkserv/|
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may be
used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you any
license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
USA

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply to
you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements and/or
changes in the product(s) and/or the program(s) described in this publication at any
time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for this
IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of
enabling: (i) the exchange of information between independently created programs
and other programs (including this one) and (ii) the mutual use of the information
which has been exchanged, should contact:

IBM Corporation

Mail Station P300

2455 South Road
Poughkeepsie, NY 12601-5400
USA

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

If you are viewing this information softcopy, the photographs and color illustrations
may not appear.

Trademarks

The following terms are trademarks of the IBM Corporation in the United States or
other countries or both:
* IBM

* IBMLink

* PR/SM

* RACF

* Resource Link

» System z9

* VTAM

» 2z/0OS

e zSeries

The e-business logo is a trademark of IBM.

Other company, product and service names may be trademarks or service marks of
others.
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